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Interaction Attendant 

Interaction Attendant Help 
Interaction Attendant is an easy-to-learn program that configures the auto attendant system built into 
Customer Interaction Center. It automatically answers a call and then it presents the caller with menu 
choices. Then it routes the call according to the caller's choice. 

This publication explains how to use Interaction Attendant to manage menus that callers navigate when 
they telephone your business, and automation that responds to incoming faxes and e-mail.  No post-
installation tasks are required to make Attendant operational.  When Setup Assistant ends, Attendant is 
fully configured and operational on the CIC server. However, most users install Interaction Attendant on 
their local hard drive. Interaction Attendant is an IC Server Manager application. 

Overview 

Interaction Attendant allows the auto attendant designer to link together predefined operations to 
create simple or sophisticated menu applications without writing or modifying handlers. Non-
programmers can create and manage menu interactions by filling out and linking forms in 
Attendant.  Customers who need auxiliary business logic can develop custom handler subroutines in 
Interaction Designer, and call these subroutines in Attendant. 

Interaction Attendant is precise. Calls are compared to user-defined profiles that determine the 
scheduled processing that will occur. Attendant provides complete call control without sacrificing 
features. For example, Interaction Attendant can: 

• Play prerecorded messages, route call to queues, send and receive faxes, or transfer to voice 
mail. 

• Present a different set of menu options during non-business hours or holidays. 

• Look up information in a database, pass control to a submenu, integrate with a CRM, or perform 
dozens of call control operations, ranging from screen pop to automated e-mail processing. 

• With CIC, your communications system adapts to the way you do business, not the other way 
around. You can customize CIC using Interaction Attendant only, handlers, or both. Using 
Interaction Attendant exclusively, it is easy to create sophisticated auto attendant systems that 
require minimal staff training and minimal technical support. Customers who compose handlers 
to automate business processes can achieve even higher levels of customization by integrating 
custom subroutines with Attendant. 

Organization of Help Topics 

This publication, like Attendant itself, was developed with non-programmers and administrators in 
mind.  General familiarity with Microsoft Windows and with the PureConnect platform is 
assumed.  However, no programming experience is required. This documentation is organized into 
sections that may be read in order. Topics are hyperlinked to allow non-linear navigation. 

Attendant Concepts - How Attendant works. 

Procedures - Instructions for completing common tasks.  

User Interface Options - Details about property pages and dialogs in Interaction Attendant.   
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Glossary - Special terms used in Interaction Attendant documentation. 

Document Revision History - Summary of documentation revisions. 
Rev. 9/20/2018 

What's New in Interaction Attendant 
The following changes and enhancements were introduced in Interaction Attendant. 

2018 R5 

• Updated queue repeat description in Repeat a Sequence of queue operations topic. 
• Updated description of Seconds to wait before switching to Auto-Attendant Processing option in the Call 

Processing Style Dialog topic. 

2018 R4 

• Updated Logical transfer topic to include note about using a Logical Transfer in an Expression 
Case. 

2018 R3 

• Added information about average queue length to Data about a particular workgroup (ACD or 
Custom) topic. 

• Updated Disposition Interaction Dialer Call topic to add information about the disposition timer 
associated with the Dialer Call Completed node. 

2018 R2 

• Update with rebranded terminology and screen captures. 

• Updated Other Tools topic to indicate that functionality for Parse Name Pair Attributes option 
has been deprecated. 

2018 R1 

• Rebranded to apply Genesys terminology. Updated copyright and trademark information. 

2017 R3 

• Minor updates to Email-Disconnect topics. 

• Updated Remotely Activate an Unplanned Schedule topic to require Modify permissions instead 
of Administrator rights. 

2015R1 

• Updated documentation to reflect changes required in the transition from version 4.0 SU# to 
CIC 2015 R1, such as updates to product version numbers, system requirements, installation 
procedures, references to PureConnect Product Information site URLs, and copyright and 
trademark information. 

• Added a warning about ACD Server functionality when updating skills in an in-queue interaction. 
When you update skills in an in-queue call, Interaction Attendant temporarily removes the 
interaction from the workgroup queue when updating the ACD skills. The interaction is 
reprocessed when Attendant returns it to the queue, and resets any existing ACD statistics such 
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as Queue Timeout and the interaction's position in queue. For more information about updating 
skills and ACD behavior, see Add and Remove Skills from an In-Queue Call. 

IC 4.0 SU4 

• Speech Recognition is now available for inbound call profiles, schedules, menus, and operations. 
You can set up and configure speech recognition to offer callers the ability to navigate the IVR 
by verbally communicating their choices instead of (or in addition to) using a keypad to enter 
choices numerically. If you have appropriate rights, you can customize default settings, 
configured by your administrator, such as minimum confidence levels, timeouts, audio prompts 
played to the caller if the speech engine cannot determine the caller’s selection, manage custom 
attributes, and record notes about configuration settings and changes. You can also set up 
custom keywords and phrases a caller might use to verbally indicate the location to which they 
want to transfer. You enable speech recognition at the profile level, customize settings at the 
schedule or menu level, and define keywords and phrases at the inbound call operations level. 
For more information or to get started, see Speech Recognition Overview and Working with 
Speech Recognition. 

• Timezone drop-down lists are available in custom inbound call schedules, custom operator 
schedules, and custom email schedules. Use the Timezone drop-down list to optionally 
configure a timezone setting. The IC server uses the setting you select to determine actual 
opening hours for this queue, based on the offset between the IC server and the opening 
hours/timezone. The timezone setting should be optionally and by default it should use the 
server time. 

IC 4.0 SU3 

• When you create a logical expression based upon data about the current call, you can create 
comparison operators for call routing attributes such as ANI, DNIS, trunk line, or call attributes, 
and compare against a value entered numerically or as a string . Prior to IC 4.0 SU 3, you could 
only use a string value. For more information, see Data about the current call. 

• The Queue Update Skills action adds the ability to modify skill requirements while a call is in-
queue. In previous releases, you could only assign skill requirements to an interaction from the 
Advanced Workgroup Settings dialog within a Workgroup Transfer. To modify those skills, the 
call had to be moved to another queue, or re-queued within the same workgroup transfer, 
causing the call to be counted as queueing twice. In IC 4.0 SU 3, add the Queue Update Skills 
action as an in-queue action under a workgroup transfer. This action is called after a certain 
amount of time and allows you to add or remove skills without transferring the call to a 
different queue. For more information, see Add and Remove Skills from an In-Queue Call. 

• In conjunction with the Queue Update Skills action, two new dynamic call attributes were added 
to Interaction Attendant: 

o Eic_AttDynamicSkillstoAdd. This attribute contains a list of skills that can be added to 
an in-queue interaction.  

o Eic_AttDynamicSkillsToRemove. This attribute contains a list of skills that can be 
removed from an in-queue interaction.  

• Dynamic routing enhancements allow the option to transfer interactions to the voice mailbox of 
a user or workgroup as specified by interaction attributes. Use the Set Attribute feature to 
define characteristics for the desired attribute. For more information, see Transfer to Voicemail. 
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o Eic_AttDynamicUserVmail. This attribute contains the user selected for voicemail 
transfer. The voice mailbox of the user defined in this interaction attribute becomes the 
destination for the voicemail.  

o Eic_AttDynamicWorkgroupVmail. This attribute contains the workgroup to use for the 
voicemail transfer. The voice mailbox of the workgroup defined in this interaction 
attribute becomes the destination for the voicemail.  

• The rights required to use Interaction Attendant are configured outside Interaction Attendant, in 
Interaction Administrator. The process of assigning these rights changed in Interaction 
Administrator, and the Rights required to use Attendant was updated to reflect the new 
process. 

• In the Play Info node, when you define an audio file attribute in the Play Info Sequence Entry 
dialog, depending on whether you select Text or Date in the Attribute Format Field, you can 
enter the Date Time attribute in different forms. For more information, see Play Info. 

• The Add additional tools to the Tool list box directs the user to create a text file and name it 
OtherTools.IAT to add additional tools. However, this file already exists in the Resources folder. 
The user should add new tools to this existing file rather than creating a new file. 

• If you have a media server installed with a configured audio source, you can now direct the 
Audio Playback form and the Queue Audio form to play audio from an external source; for 
example, an internet radio station, iPod, or CD player. Interaction Attendant will play audio from 
a file or audio source to a user in the IVR. These external audio sources must be defined and 
configured in Interaction Administrator before you can select them in the Play Audio node or 
the Queue Audio node. For more information, see Play Audio or Play a Message to the caller. 

• If you add a Callback node as part of queue operations, you can configure a prompt to inform 
the caller that the system successfully processed and scheduled the callback. An Announce 
Callback Scheduled frame within the Request Callback node provides controls for setting the 
callback announcement. This frame only appears in an in-queue menu, and gives the caller 
confirmation that an agent is scheduled to return the call. The caller can disconnect the 
interaction, rather than continuing to wait for an available agent. For more information, see 
Callback Request. 

• You can now place the Caller Data Entry node within an in-queue menu. When you also add a 
Request Callback node to the in-queue menu, you can configuring the Caller Data Entry node's 
Action When Finished frame to jump to the Request Callback node, and set the Request Callback 
node's Callback Number frame to the appropriate Caller Data Entry node listed in the in-queue 
menu. This configuration lets the caller enter a specific telephone number during a callback 
request, and Interaction Attendant will pull that number from the Caller Data Entry node when 
processing the callback request. For more information, see Caller Data Entry and Callback 
Request. 

IC 4.0 SU2 

• Added a new feature, Add Inbound IVR Surveys to a Profile, which details how to create an on-
demand survey, such as employee satisfaction requests and mandatory health management 
surveys, in Interaction Feedback and initiate it within an Interaction Attendant profile. 

• Enable IVR Reporting was added to all operations for email configuration profiles. This option 
determines whether or not reporting data will be collected when control passes through this 
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node. Several IVR Reports summarize this information. IVR Reporting is disabled by default. 
Enable it to capture the date, time and duration of time that the email remained in the node 
and its children. This option is hidden when Attendant is connected to a server that does not 
have reporting installed. For more information about this feature, see IVR Reporting Option. 

• The right to create a new profile is configured in Interaction Administrator, and they can be 
assigned at the Default User, Role, User, or Workgroups level. Create profile rights are managed 
on the Security tab in Interaction Administrator. This tab allows the Administrator to grant a 
user the rights to create inbound, outbound, operator, and email profiles. In Interaction 
Attendant, if the New Profile button on the toolbar is greyed out, or the New Profile option 
located in the Insert menu is unavailable, you do not have the appropriate rights to create a new 
profile. 

If you have the appropriate rights to create a new profile, Interaction Attendant also 
automatically grants you the rights to modify that profile. This feature allows you to edit any 
profile you create. For more information, about appropriate rights to create a new profile, see 
Custom Inbound Call Profile, Custom Outbound Call Profile, Custom Operator Profile, Email 
Custom Profile, Rights required to use Attendant, Access Right Examples, or contact your 
administrator. 

• You can now Configure Selection Nodes and Configure Expression Cases for e-mail interactions 
as well as calls. 

• Reason and finish codes have been replaced by wrap-up codes and wrap-up categories. See 
Disposition Interaction Dialer Call. 

IC 4.0 SU 1 

• Updated the Modify CustomSubroutineInitiatorRouter.ihd topic to reflect handler changes in 
Interaction Designer. 

Graphics in this document 
Screen Shots 

Most of the graphics in this publication are partial images of forms (called property sheets) that you can 
fill out in Attendant.   Rather than include the complete image of a form in the topic that explains it, 
partial screen shots are provided instead.  This prevents pages from being overwhelmed by large 
graphics, and makes it easier to locate the explanation of individual visual elements. 

The sectional portions of a form are represented by graphics with beveled edges.  You may need to 
scroll a page to locate help for the form section you are interested in.  In most cases, everything about a 
form is explained in one topic.   

Hiding Large Graphics in Online Help 
The online edition of this publication allows large graphics to be hidden by pressing the Hide Large 
Graphics button ( ) in the page header.  This allows you to view more text in the help window at 
one time.  To redisplay all graphics, press the Show Large Graphics button ( ). 

Icons in Topic Titles identify Toolbar and Menu Commands 

All commands in Interaction Attendant are invoked by pressing toolbar buttons, or by selecting menu 
options.  Each command is documented in its own help topic.  The icon that represents each command 
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appears in the topic that explains it.  In the figure below, the explanation of "Dial by Name" identifies 
the icon used in toolbars and menus to invoke the command. 

 
  

Attendant Concepts 

Attendant Concepts 
Interaction Attendant configures the auto attendant system built into Customer Interaction Center.  An 
auto attendant automatically answers a call.  It prompts the caller to make menu choices, and routes 
the call according to that caller's choice.  Callers select options by pressing keys on their telephone's 
keypad.   Based on these interactions, the auto attendant can: 

• Play prerecorded prompts     

• Transfer calls to an agent, operator, queue, or voice mail 

• Look up information in a database 

• Dynamically convert text to speech 

• Offer a sub menu 

• Send or receive a fax 

• Provide access to voice mail 

• Search an employee directory, and more. 

Interaction Attendant provides complete control over what happens when each key is pressed.  For 
example, you might play a prerecorded message, route the call to a queue, send a fax, look up 
information in a database, or pass control to a submenu.  Interaction Attendant's predefined 
operations can be linked together any way you wish to create sophisticated menu applications. 

Attendant empowers non-programmers to manage the interactions that callers encounter when they 
phone your business.  Menus, operator access, direct dialing, and dial-by-name services are configured 
by filling out forms in Attendant.  Customers manage call flows without having to customize handlers. 

With CIC, your communications system adapts to the way you do business, not the other way 
around.  If you need custom business logic that Attendant does not offer, you can extend its 
functionality by developing custom handlers.  Handlers are created outside of Interaction Attendant 
using Interaction DesignerTM—CIC's visual programming tool.  Handlers extend the PureConnect 
platform to meet unique business requirements.  They can perform just about any conceivable data 
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processing task.  But most customers find that Attendant provides all of the tools that they need to 
create robust IVR interactions. 

Advantages of Interaction Attendant 

• Interaction Attendant was written for non-programmers, with a non-system administrator in 
mind.  It is easy to use, yet powerful.  You can create sophisticated IVR menus with it. 

• Interaction Attendant is visual.  It displays hierarchical relationships between configuration 
objects, and flags errors before configurations are published.  This makes the system easy and 
safe to use. 

• Interaction Attendant doesn't require special hardware.  Voice prompts are recorded within 
Attendant using a station phone.   

• Interaction Attendant is flexible.  Configurations can be published to a server, exported to a 
file, or imported from a file.   A single instance of Attendant can edit the auto-attendant 
configuration of many CIC servers.  Attendant keeps track of who is editing each configuration 
and locks files to prevent conflicts. 

• Interaction Attendant is robust.  It provides the ability to control calls after they have been 
routed to a workgroup queue.  It offers advanced scheduling mechanisms, database 
functionality (insert, query, update) and sophisticated profile-based routing.  You can gather 
information from a caller, and write it to a database, or use caller-entered data in another 
menu interaction.  For example, you might ask a user to enter a PIN number and then use it to 
look up an account balance that is read back to the caller. 

• Interaction Attendant is extensible.  It can invoke custom handlers for unlimited 
functionality.  However, the primary benefit of Attendant is that it allows users to design 
simple call flows without writing handlers.  

• Interaction Attendant is precise.  Calls are compared to user-defined profiles that determine 
the scheduled processing that will occur.  For example, inbound calls can be filtered using 
DNIS, ANI, and/or trunk line information associated with the call.  Afterwards, schedules select 
the most appropriate call processing based upon the time of day.  For example, persons who 
phone your company after business hours can be presented with different options from those 
that are presented during daytime hours.  IVR interactions can be customized to any extent 
required by the customer. 

How does Attendant work? 
In a nutshell, here's how Attendant works: 

Interaction Attendant uses profiles and schedules to determine which operations it should perform to 
interact with a contact.  The basic steps are as follows: 

1. The IC server gives Interaction Attendant a call to process.  Most often, this is an inbound call, or 
a call that was routed to an operator.  But it could be an outbound call that was placed by 
Interaction Dialer or a custom telephony application.  

2. Attendant analyzes the call to accumulate information about it.  It determines whether the call 
is inbound or outbound.  If the call is inbound, it acquires the telephone number that was dialed 
(DNIS), the caller's telephone number (ANI), and the line or line group that the call is on.  
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3. Attendant compares these call characteristics to predefined profiles for that server.  It gives 
control over the call to the profile that most closely matches the call. 

A profile is a collection of predefined call characteristics that Attendant compares to an 
interaction, to figure out how to process it. 

Profiles are best understood by example.  Suppose that your company offers two levels of 
technical support: Silver and Gold.  Silver members call 555-1111, and Gold members call 
555-2222.  To tell Attendant how to handle support calls, you would use Attendant to 
create an inbound profile for each telephone number.  For now, don't worry about how 
that is done. 

Each profile filters calls to match one of the numbers.  When callers dial 555-2222, their 
call is processed by the profile for Gold support. When callers dial 555-1111, their call is 
processed by the profile for Silver technical support.  In this scenario, Attendant uses 
Dialed Number Identification Service (DNIS) to determine the number dialed.  Since 
Attendant knows the dialed number, it can perform unique processing on the call. For 
example, it might play special messages or offer alternate menu choices.  

The main idea is that profiles are compared to calls to see if the call matches a profile 
characteristic of some sort.  E.g.: Was this particular number dialed?  Did they call our 800 
number?  You can define as many profiles as you wish.  Let's look at another scenario.  

Suppose that Marketing needs special call routing. They want to automatically route calls 
from their biggest customer directly to the person who manages that account.  To catch 
these calls, you would define a profile that examines the caller's telephone number, 
rather than the number dialed.  A profile of this type uses a process called Automatic 
Number Identification, or ANI for short.  ANI is sometimes called Caller ID, and it is the 
opposite of DNIS.  DNIS indicates the number that was called.  ANI provides the caller's 
telephone number.  

Profiles don't have to be very specific.  They can examine a wide range of incoming call 
characteristics, using wildcards, and a combination of ANI, DNIS, and line criteria.  When a 
profile is evaluated, the logical OR operator is used.  If more than one criterion is 
specified, the interaction matches the profile if any of the profile's criteria are met.  But 
what happens if you don't create a profile for every conceivable type of call? 

The answer is that Attendant provides a default profile that catches calls that don't 
match user-defined profiles.  You can customize a default profile to play a wave file, but 
its filtering criterion are disabled.  This insures that the default profile will match all calls 
that get past your custom profiles. 

4. Since profiles merely set up comparisons, they do not carry out actions, such as 
transferring a call.  The tasks that Attendant can perform are called 
operations.  Operations do work of some sort, such as prompting a caller to enter an 
account number, or reading back an account balance that was retrieved from a 
database.  

But, what if your best customer calls at midnight, when the account rep is not there?  Or, 
what if someone calls Technical Support on Christmas, when the entire company is on 
holiday?  What if it snows, and you have to suspend operations for a day or two?  As you 
can see, operations are time-sensitive.  Attendant handles these considerations rather 
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nicely.  Once a matching profile is given control of a call, Attendant evaluates 
schedules to select an appropriate set of operations to perform. 

A schedule determines whether a menu of operations is active, based upon a date, 
range of dates, time, or special event.  

A profile may have many schedules attached to it.  Schedules stipulate when a 
menu of operations can run.   You can define schedules to handle recurring 
events, holidays, or special situations, such as your regular business hours, after-
hours support, or an office closing due to poor weather conditions.  But what if 
you don't think of every contingency? 

You guessed it—every profile has a default schedule.  Attendant creates it for 
you automatically.  The menu attached to a default schedule is given control of 
the call when no other schedule in the profile has precedence. 

A default schedule ensures that all calls are processed, should a call arrive 
during a period that is undefined by custom schedules. 

Since the default schedule is designed as a catch-all, you can't edit it to 
define a start or end date, or to specify daily, weekly, monthly, yearly, 
unplanned, or system events.  Those items can only be configured in a 
custom schedule form. 

5. When call flow is passed to a schedule, the schedule's menu operations 
are executed.  Up until now, call processing has been largely invisible to 
callers.  But from this point forward, callers interact with menu 
operations attached to the schedule.  You've probably guessed that 
Attendant allows you to define as many schedules as you need to 
perform whatever actions are appropriate for a given date, time, or 
situation.  
 
You can even set up unplanned schedules and activate them over the 
phone.  For example, you might create an unplanned schedule for a 
"snow day" to tell customers that your business is closed.  In a weather 
emergency, you can remotely activate the schedule from home. 
 
Menus are created when you associate operations with a 
schedule.  Attendant provides dozens of operations that help you build 
menus.  For example, you can create menus that allow callers to dial by 
name, dial by extension, or transfer a call.  Attendant even provides an 
operation that creates a submenu.  However, Attendant is not limited to 
mundane tasks.  For example, it can obtain data from a caller, look up 
information from a database, and update records.  If you need 
functionality that Attendant does not offer, you can call custom 
handlers from Attendant.  Handlers are custom programs created using 
Interaction Designer—the CIC's visual programming tool.  Handlers can 
perform just about any conceivable data processing task.  They extend 
the PureConnect platform to meet unique business requirements.  But 
most people find that Attendant provides all of the tools that they need 
to create robust IVR interactions. 
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Related Topics 

• Procedures 

• User Interface Options 

How does the user interface work? 

How does the user interface work?  
Let's examine Interaction Attendant's user interface, to see how profiles, 
schedules, and operations are implemented in the software.  The figure below 
shows an inbound call flow: 

 
Since Interaction Attendant is a utility for configuring CIC's auto attendant, its 
user interface is designed to help you construct automated attendant menus.  A 
menu is a collection of one or more operations that process calls based on the 
keys a caller presses. A caller chooses menu entries by pressing keys on a 
telephone. Based on the caller's choice, an auto attendant will offer a submenu, 
transfer a call to a queue, allow callers to search an employee directory, send or 
receive a fax, or perform many other actions. 

A menu is attached to a schedule that determines when the menu will run.  A 
schedule is attached to a profile, which examines incoming calls to select calls to 
process.  A server has one default profile and one default schedule, and may 
have any number of custom profiles and schedules 

Attendant's visual metaphor is effective. It displays profiles, schedules, and 
operations for multiple servers and different call flows in a Tree pane on the left 
side of the display.  The right side of the screen displays a property sheet for the 
currently selected node.  Subsequent topics discuss these items in more detail. 

Related Topics 

• Tree Pane 

• Nodes 

• Property Sheets 

• Hierarchical Relationships in the Tree 

Tree Pane 
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Interaction Attendant's tree pane visually displays the design of auto-attendant 
menus.  It displays profiles, schedules, and menus for each server in a 
hierarchical arrangement.  You must be connected to a CIC server to see its call 
flow configuration (schedules, profiles and menus).  The tree displays an 
inbound, outbound, or operator call flow. 

Splitter Bar 

You can narrow or widen the tree by clicking and dragging a splitter bar to a 
new horizontal position. 

 
Related Topics 

• How does the user interface work? 

Nodes 
A node is an item in the tree that you can select for editing.  Interaction 
Attendant supports four types of nodes: 

1. Server nodes organize the configuration of connected servers.  All 
interactions for a given call flow type appear below its server node in 
the tree.  To add a server to the tree, issue a connect command and 
specify the server name, user name, and password.  You can also 
connect to a server by importing an Attendant Configuration file. 

2. Profiles define characteristics that are compared to incoming 
calls.  Profiles are compared to call characteristics to select the best 
matching profile.  Afterwards, its schedules are evaluated to 
appropriately process the call.  Every server has a default profile that is 
used when no other profiles are defined, or have precedence.  Default 
Profiles are generic and do not filter out calls.  Custom profiles select 
calls based upon a variety of criteria. 

3. Schedule nodes determine whether an attached menu is active, based 
upon the date, time of day, or an event.  Schedules are always attached 
to Profiles.  Interaction Attendant automatically creates a Default 
Schedule, and executes its menu when no other schedule has 
precedence.  

4. Operations are menu actions that Interaction Attendant performs in 
response to a keystroke entered by the caller or in response to a system 
event.  
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When profiles, schedules, or operations are added to the tree (using menu 
commands or toolbars), they are called nodes.  Call flows are constructing by 
adding nodes to the tree.   When you click on a node in the tree, you can edit its 
properties on the right side of the screen.  To build a menu, one adds, arranges, 
and configures nodes in the tree.  See manage nodes for procedural 
information.  

Nodes displayed at startup 

At startup, the tree expands automatically to reveal schedules and profiles, but 
not menus.  This presents an appropriate level of detail, especially if the tree 
contains many profiles, schedules, and menus. 

Related Topics 

• How does the user interface work? 

Property Sheets 
When a node is selected in the tree view, its Property Sheet is displayed on the 
right side of the screen.  A property sheet is just a form that you fill out to 
configure a node.  For example, you name a node by filling in the Name field on 
its property sheet. Each type of node has its own unique property sheet. 

Edits are cached until you publish or discard them 
 
The changes you make to a property sheet are retained if you edit 
another node.  Interaction Attendant saves changes at the server level—
that is, it saves the changes you make to the entire server configuration at 
one time.  If you click on another node, Attendant remembers changes 
that you have made.  Changes do not go into effect until you publish 
them. 

Related Topics 

• How does the user interface work? 

Hierarchical Relationships in the Tree 

Hierarchical Relationships in the Tree 
Attendant enforces a hierarchical relationship between nodes in the tree.  It 
uses simple rules to determine the order of items, and the options that are 
available in menus and toolbars.  The figure below shows the relationship 
between servers, profiles, schedules, and operations.  The basic structure is: 
Server > Profile > Schedule > Operation. 
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• The highest-level node is a Server that you have connected (logged in) 

to.  If you connect to more than one server at a time, nodes for servers 
are siblings in the tree.  

• Attendant attaches a default Profile below each server, to processes calls 
that do not match custom profiles.  When you add your own custom 
profiles to filter calls based upon ANI, DNIS, Line Group, Line, and other 
criterion, they are listed at the same level as the default profile.   

• Schedules are attached below profiles.  Attendant attaches a default 
schedule to each profile, in case none of your schedules are selected to 
process the call. 

• Operations are attached to schedules (and in a few cases, to other 
operations).  You can add as many operations as you want to build each 
menu. The lowest-level items in the tree are the operations that 
Attendant performs when a caller presses a key.  One example of an 
operation is playing back an audio file.  A digit symbol appears next to 
each operation in the tree, so that you can visually see which key the user 
must press to select the operation. 

Related Topics 

• How does the user interface work? 

Simple rules govern the tree 
Simple rules determine the order of items in the tree, and the options that are 
available.  

Toolbars and menus are enabled or disabled based upon 
selections you make in the tree 

• Server nodes are topmost in the tree.  You can't insert a profile, 
schedule, menu, or operation unless you are connected to a server and 
have selected the name of a server in the tree. 

• To insert a new profile, a server or existing profile must be selected in 
the tree. 
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• To insert a new schedule, a profile or existing schedule must be 
selected in the tree. 

• To insert an operation, a schedule or existing operation must be 
selected in the tree. 

Menu operations are the lowest items in a logical hierarchy 

• Operations are attached to menus (a schedule is also a menu). 

• Menus are attached to Schedules. 

• Schedules are attached to Profiles. 

• Profiles are attached to Servers. 

The hierarchical relationship of items relative to one another is 
determined as follows 

• Whenever possible, new nodes are inserted as children.  Otherwise, 
nodes are inserted as siblings. 

• An inserted item becomes the last child of the selected node, if the 
selected node supports children.  If you select a menu, and add an 
additional operation to it, the operation is added as the last child of 
the menu. 

• If the selected node does not support children, the new node is added 
as a sibling.  For example, if you select a default profile, and add a new 
profile, the new profile has a sibling relationship to the default 
profile.  The profile form allows schedules to be added as children, but 
you can't add a profile as a child. 

Related Topics 

• How does the user interface work? 

Tasks that Attendant can perform 
Interaction Attendant's powerful, easy-to-use interface makes it easy to 
develop auto-attendant menus for an enterprise or call center.  Here's a 
sampling of what can be done: 

• You can customize the way in which inbound calls are answered (via 
DNIS, ANI or line name) by creating unlimited menu levels and menu 
transfers. 

• You can edit menus, schedules, and profiles for many CIC servers at 
once. Profiles, schedules, and menu operations are displayed in an 
easy-to-understand tree structure. The tree visually indicates when 
someone else is editing the server configuration. In addition, errors 
and default conditions are visually flagged using special icons and 
colors. 
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• You can record prompts using an ordinary telephone. Prompt playback 
is supported in most menu operations. 

• Menu configurations can be imported and exported. You can easily 
back up a server configuration and restore it later. 

• Attendant's database operations allow you to interact with data 
sources. For example, you can prompt users to enter data and save 
their entries in a database.  

• Answering can be customized according to time sensitive 
parameters:  month, day, day of week, hour, or minute for after hours 
/ holiday call routing.  Using the Logical Transfer operation, you can 
branch to menus based on data entered by a caller, data about the 
current call, the current time, data about a workgroup, or data in a 
database. 

• You can schedule menus to run at different times or schedule menus 
based on incoming call criteria, such as DNIS, ANI or line information. 
You can create unscheduled menus and activate them from a touch-
tone telephone. 

• You can route calls to any system workgroup (ACD, hunt, standard), 
user queue, or station queue. 

• You can play an audio file in response to a particular menu option. 

• You can prompt the caller to enter data, such as a FAX number.  

• You send a FAX to a number entered by a caller. 

• You can receive FAX transmissions.  Automatic FAX Detection at a 
menu allows a workgroup or main number to function as a fax number 
as well. 

• You can route a call to the appropriate unified messaging inbox 
(Voicemail / Email / fax). 

• You can transfer a call to an external number. 

• You can customize voice prompts and record greetings. 

• You can direct calls to the Dial by Name subsystem. 

• Flow-of-control is configurable. You can define error handling at the 
schedule and form level, and use "Action when Finished" branching 
options. When a menu operation finishes, you can return control to 
the previous menu, disconnect, or pass control to any profile, 
schedule, or menu you define for the current server. 

• You can interface with the CIC's powerful handler customization 
subsystem by sending a call to an Interaction Handler from a menu 
option.  

Related Topics 
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• Procedures 

• User Interface Options 

Attendant Commands 

Attendant Commands 
All commands in Attendant are issued by selecting from pull-down menus, or 
by pressing toolbar buttons.  Attendant supports a few context menus also.  To 
control the program, there are no commands to memorize, or type in.  

Summary 

Interaction Attendant's user interface is designed to manage auto-attendant 
menus.  A menu is a collection of one or more entries (operations) that process 
calls based on the keys a caller presses.  A caller chooses menu entries by 
pressing keys on a telephone.  Based upon the caller's choice, the auto-
attendant will offer a submenu, transfer the call to a queue, allow callers to 
search an employee directory, send or receive a fax, or perform other 
operations. 
 
When you connect to a server, its auto-attendant menu configuration is loaded 
into Attendant for editing.  Attendant also retrieves other details from the 
server at this time, such as information about lines, workgroups, and 
users.   Whenever you modify a menu configuration, your changes are not 
saved or put into effect until you publish them.  
 
Attendant's user interface is straightforward.  A tree on the left allows a node 
to be selected for editing.  The properties of the selected node appear are 
edited on the right side of the screen.  To view or edit the properties of 
another node, select another node in the tree. 
 
A node is an item in the tree.  Usually this is an operation, such as playing an 
audio file for the caller.  Some nodes are containers for other nodes.  The 
Server node, for example, organizes configuration settings for a CIC server.  

Related Topics 

• Pull-Down Menu Commands 

• Context Menu Commands 

Pull-Down Menu Commands 
Pull-down menus in Interaction Attendant allow you select 
commands quickly.  These menus organize all of the commands that 
Interaction Attendant recognizes. 

File Menu 
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File commands that connect or disconnect from CIC servers, export Attendant 
(*.att) configuration files, or close the application. 

 Connect 

Opens a login dialog.  Once the login is validated, Attendant adds a server node 
to the tree.  The Connect command allows you to administer multiple servers 
and see them all in the tree view.  

 Disconnect 

Disconnect releases the connection between Interaction Attendant and an CIC 
server.  See disconnect from a server. 

 Publish 

This command saves changes made to menu configurations, and puts them 
into effect.  See publish a configuration. 

 Import File 

Import loads an Attendant configuration file into the interface for editing.  See 
manage configuration files. 

 Export File 

Export saves an Attendant configuration file to disk.  See manage configuration 
files. 

Package… 

This option is similar to export, but instead of exporting all nodes in the tree, it 
exports the selected node along with any children it might have. Unlike 
configurations, which save all nodes of the call flow to a file, package files 
contain a selected portion of the call flow. See manage configuration files. 

Exit 

This command closes Interaction Attendant.  You may be asked to save 
changes.  See Exit Attendant for more information. 

Edit Menu 

Edit commands manage servers, cut, copy, paste, sort, rename, or delete items 
in the tree structure. 

 Manage Servers 

This command opens the Manage Servers dialog so that you can apply publish, 
export, refresh, and disconnect commands to multiple connected servers at 
once.  You can also connect to additional servers from this dialog. 

 Cut 
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The Cut command removes the selected node, and places a copy on the 
system clipboard.  You can cut and paste tree nodes.  Cut deletes a selection 
and places a copy on the clipboard.  

You can drag and drop or cut/copy/paste nodes from one area to another. 
However, Interaction Attendant won't let you drag nodes from one server to 
another, or to paste nodes from one server to another. All node movement is 
restricted to the current server.   Interaction Attendant also checks to see if 
the dropped/pasted node is assigned to a digit that is already in use by an 
existing node in the menu.  If the new node is assigned the same digit as an 
already existing node, The dropped/pasted node's digit is reassigned to 
<none>.   

 Copy 

Copies a selection to the clipboard. 

 Paste 

Pastes an item from the clipboard to the control that has focus. 

Multi-Language Prompts 

Opens the Prompt Management dialog, which allows any prompt to be 
selected to find out what languages the prompt has been recorded in. 
 Prompts can be recorded in additional languages directly from this 
dialog.  This dialog does not set the language used to play back a prompt.  See 
manage voice prompts. 

 Sort Tree 

This command reorders items in the tree structure according to 
precedence.  Schedules and menu options are sorted based on the time in 
which they are active.  See sort the tree for procedural details. 

Rename 

This command renames the selected node in the tree structure. 

Delete 

This command deletes the selected node from the tree structure. 

 Refresh Server Data 

This command polls each connected server to retrieve information about 
workgroups, schedules, users, stations, skills, DB sources, lines, line groups, 
schedules, languages, and the default language. 

 Disconnect Server 
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This command releases the Notifier connection to the server whose node is 
selected.  In effect, this "logs off" Interaction Attendant from a server.  This 
option is disabled until a server node is selected in the tree. 

 Load Active Configuration 

This command abandons changes that you have made and reloads the 
configuration that is currently active and taking calls on the selected server.  

View Menu 

View commands toggle the display of status and tool bars. 

 Toolbar 

Toggles display of the main toolbar on or off.  The main toolbar provides 
pushbutton icons that are equivalent to the File, Edit and Insert menus.  The 
operations toolbar is always available cannot be toggled on or off. 

 Status Bar 

This command toggles the status bar on or off.  The status bar displays helpful 
information at the bottom of the screen when you "mouse over" a toolbar 
element or select a menu item. 

Insert Menu 

Insert commands add server, profile, schedule, or operation nodes to the tree. 

 New Server 

This command opens the Interaction Attendant Login dialog so that you can 
connect to an existing server.  

 New Profile 

A profile is a collection of one or more menus.  Interaction Attendant 
automatically creates default profiles for you.  You can add your own custom 
profiles to filter calls using specific criteria.  See profiles. 

 New Schedule 

A schedule stipulates when a menu can run.  The New Schedule command adds 
a new Schedule node, so that you can specify when the menu will be 
initiated.  See schedules. 

New Operation 

Operations are actions that Interaction Attendant can perform in response to a 
menu selection.  This cascading menu allows you to insert a new 
operation.  See operations. 
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Help Menu 

Help commands open online help topics, web links, display version information 
and particulars of your computing environment.  See accessing context-
sensitive help. 

Context Menu Commands 
You can right-click on nodes in the tree view to open Attendant's context 
menu.  A context menu works like a pull-down menu to issue commands.  The 
list of available commands vary based upon the type of object that is selected, 
or the status of that object.  Inappropriate commands are disabled. 

For example, if you right-click on a server, you can disconnect from it, but you 
cannot cut, copy, or paste.  The figure below shows all available context menu 
commands.  If you select New Operation, a submenu of available operations is 
presented.  See menu operations. 

Related Topics 

• Commands 

• Procedures 

• User Interface Options 

Call Flows 

Call Flows 
Attendant manages three types of call flows (inbound, outbound, and calls to the 
operator).  Configurations for a given call flow type are displayed in the tree view.  If you connect to 
more than one server, call flows for that type (inbound, outbound, or operator) appear in the pane.  For 
example, the inbound call flow tree might contain icons for several connected servers. 

If you do not use a command-line switch to select a call flow, the inbound call flow is loaded by 
default.  See Start Interaction Attendant for more information about command-line parameters. 

Access to call flows is rights-based.  If you do not have rights to edit a call flow type (inbound, 
outbound, or operator), you cannot view configurations of that type in the tree.  See Rights required 
to use Attendant. 

• Inbound call flows are most commonly defined.  Inbound profiles analyze an incoming call to 
figure out which schedule best applies.  The call is then routed to the most appropriate IVR 
interaction. 

• Operator call flows are auto-attendant menus that process calls to the operator.  They are 
similar to inbound call flows,  but use different call selection criteria.  Inbound call profiles 
select calls based upon ANI, DNIS, and line information.  Operator call flows examine the queue 
or Attendant profile that the call came from.  Operator call flows are managed separately, in 
their own pane.  The nodes that control processing of operator calls are not intermixed with 
nodes that process other call flows.  This makes it easier to visualize and manage operator call 
processing. 
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• Outbound call flows process calls that have been placed and which are already connected.  For 
example, an Outbound call flow might process a call that Interaction Dialer placed to someone 
in a contact list.  You can connect Custom Outbound Call Schedules to an outbound profile, and 
then use call analysis information in the schedule to route the call to menus that are tailored to 
interact with live persons, answering machines, or Fax machines.  If the Outbound profile is 
configured for Direct-to-Queue processing, the connected call is routed to a user, station, or 
workgroup queue, or to any outbound profile defined for that server.  Outbound call flows add 
a new dimension of call processing capability to the CIC environment. 

• Email call flows implement simple routing rules based upon the senders' address or domain, or 
based upon words or phrases used in an Email. Skills and priorities can be set, and routing 
assigned to selected workgroups.  Interaction Attendant provides Email-specific profiles, 
schedules, and operations 

Related Topics 

• Manage nodes in the tree 

• Rights required to use Attendant 

• Start Interaction Attendant 

  

Basic steps to build a Call Flow 
Servers, Profiles, Schedules, and Operations 

When you connect (login) to a server in Attendant, Attendant adds a node for that Server to its 
tree.  The Server node is an conceptual device that Attendant uses to organize call processing 
configurations for that server.  Nodes below the server select calls to process, select the most timely 
menu, and interact with the caller: 

• Profiles select calls to process. 

• Schedules pass control to the menu that best matches the time of day, current date, range of 
dates, or special event, such as a snow day. 

• Operations carry out work in accordance with Schedules.  Operations build the menus that 
callers interact with. 

• Once you understand the relationship between servers, profiles, schedules, and operations, 
you can begin building interactions in Attendant.  The basic steps are: 

1. Start Attendant (using command-line parameters if desired) 

2. Connect to the server whose IVR interactions you want to edit.  Once connected, its 
configuration appears in the tree below a server node. 

3. Expand the server node.  

4. Select nodes that you wish to edit, or add child nodes to. 

5. Add profiles, schedules, or operations as needed.  

6. Fully configure each node by completing its property sheet. 
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7. Publish your configuration, or export it to a file that you can load in later to finish. 

Related Topics 

• Procedures 

• User Interface Options 

Handlers used by Interaction Attendant 
This topic discusses the relationship between Interaction Attendant and handlers.  When you publish a 
configuration in Interaction Attendant, configuration data is written to the Directory Services section of 
in the Windows NT registry on the CIC server.  When a call comes in, handlers look up this information 
and process it to perform the auto attendant interaction.  

Warning—Interaction Attendant's functionality depends upon the handlers listed below.  We do not 
recommend that you change any handlers whose name begins with IntAtt. Even small changes made 
to these handlers could cause your auto attendant menus to stop functioning. 

The following handlers are used internally by Interaction Attendant.  Please do not modify these 
handlers.  
IntAttAcdAudio.ihd                       IntAttAcdStatisticsInteraction.ihd 
IntAttAcdStatisticsQueue.ihd             IntAttAgentTransfer.ihd 
IntAttAttendantTransfer.ihd              IntAttAudioPlayback.ihd 
IntAttCallerDataEntry.ihd                IntAttDBDelete.ihd 
IntAttDBInsert.ihd                       IntAttDBQuery.ihd 
IntAttDBUpdate.ihd                       IntAttDialByName.ihd 
IntAttDialerCompleted.ihd                IntAttDirectProcessing.ihd 
IntAttExpressionEvaluation.ihd           IntAttExtensionDialing.ihd 
IntAttExternalTransfer.ihd               IntAttFaxBack.ihd 
IntAttGetAudioPath.ihd                   IntAttGetProfileKeyPath.ihd 
IntAttGetScheduleKeyPath.ihd             IntAttIncomingCall.ihd 
IntAttLogging.ihd                        IntAttLogicalTransfer.ihd 
IntAttManageUnplannedSchedules.ihd       IntAttProcessAcdWait.ihd 
IntAttProcessError.ihd                   IntAttProcessEvent.ihd 
IntAttProcessMenu.ihd                    IntAttProcessProfile.ihd 
IntAttProcessQueueTimeout.ihd            IntAttProcessRelocation.ihd 
IntAttPromptResource.ihd                 IntAttReceiveFax.ihd 
IntAttRecordPrompt.ihd                   IntAttRemoteAccess.ihd 
IntAttRequestCallback.ihd                IntAttSetAttribute.ihd 
IntAttSubroutineInitiator.ihd            IntAttVoicemailTransfer.ihd 
IntAttWorkgroupTransfer.ihd              IntAttAdvancedStatistics.ihd 

  

For more information about handlers, refer the Interaction Designer online help. 

Procedures 

Procedures 
This section contains procedures that help you perform common tasks in Attendant.  The major 
procedures are listed below: 

• Install Interaction Attendant explains how to install Interaction Attendant on your personal 
computer. 
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• Rights required to use Attendant explains how the right to view or modify call flows is 
managed in Interaction Administrator.  Access rights must be assigned to you by your system 
administrator before you can use Attendant. 

• Start Interaction Attendant covers command-line parameters, call-flow configuration switches, 
and shortcuts used to run the program. 

• Connect to a Server explains how to open the auto-attendant configuration of one or more 
servers for editing. 

• Manage Nodes in the Tree explains how to use Attendant's visual metaphor effectively. 

• Manage Voice Prompts explains audio controls and recording of voice prompts. 

• Manage Configuration Files explains how to import, export, and publish auto-attendant 
configurations. 

• Configure Remote Monitoring is for advanced users who are familiar with Attendant and 
Interaction Designer.  This procedure explains how to configure remote continuous listening—
a feature that allows a Supervisor to continuously listen, from a remote location, calls sent to 
queues that the Supervisor has rights to monitor.  

• Disconnect from a Server explains how to release the Notifier connection between Interaction 
Attendant and a CIC server.  

• Exit Attendant explains how to close Attendant safely. 

• Set Up Voice Mail Distribution in Attendant explains how to configure a workgroup distribution 
list for voicemail distribution in Attendant. 

Install Interaction Attendant 
To install Interaction Attendant, run the IC Server Manager Applications install from the 
IC_ServerManagerApps share on your CIC server.   

1. Locate the IC Server Manager Applications install, by navigating to the IC_ServerManagerApps 
share on your CIC server. 

2. Double-click ICServerManagerApps.msi to run the install program.  Then follow the on-screen 
instructions that appear. 

3. The IC Server Manager Applications install includes the following applications: 

• Interaction Designer 

• Interaction Administrator 

• Interaction Attendant 

• IC System Manager 

• Interaction Host Recorder Client 

• SOAP Tracer 

You may optionally select other applications to install besides Attendant. 

Related Topics 



Rights required to use Attendant 

24 

• Start Interaction Attendant 

• Attendant Concepts 

• Connect to a server 

Rights required to use Attendant 

Rights required to use Attendant 

 
The right to view or modify Attendant configurations is configured outside of Interaction Attendant, in 
Interaction Administrator.  Rights to view, search, or modify a call flow can be assigned at the Default 
User, Role, User, or Workgroups level.  Rights are managed on the Access Control dialog box, located 
from the Configuration-->Security tab-->Access Control button in Interaction Administrator. The table 
below lists Access Control List (ACL) rights that pertain to Interaction Attendant. 

Call Flow Type 
Assignable 
Rights Notes 

Email View 
Attendant 
Email Profiles 

Search 
Attendant 
Email Profiles 

Modify 

View rights grant read-only access to individual Profiles, or to all Profiles 
when *[All] is selected.  A user who has read-only rights to an Attendant 
configuration cannot publish or export the server's configuration, and 
may not browse or record prompts (since doing so might change 
prompts stored on the server).  Read-only rights are similar to access 
granted when another user has locked an Attendant configuration.  The 
difference is that a locked configuration may be exported by the user, 
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Attendant 
Email Profiles 

while a read-only configuration may not be exported. 

Search rights determine which Interaction Attendant profiles are 
available in the "Transfer to" box. Users who can view a profile have a 
lock on the Profile icon. A tool tip is displayed over the icon, explaining 
why the profile is locked. 

Modify rights grant the ability to view, modify, publish, and export 
Profiles within a call flow type. Administrators can restrict access to 
individual Profiles, or grant access to all Profiles by selecting *[All] for a 
right. 

Inbound View 
Attendant 
Inbound 
Profiles 

Search 
Attendant 
Email Profiles 

Modify 
Attendant 
Inbound 
Profiles 

Operator View 
Attendant 
Outbound 
Profiles 

Search 
Attendant 
Email Profiles 

Modify 
Attendant 
Outbound 
Profiles 

Outbound 
Profiles 

View 
Attendant 
Operator 
Profiles 

Search 
Attendant 
Email Profiles 

Modify 
Attendant 
Operator 
Profiles 

See also: Access Right Examples. 

Create New Profiles 
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The right to create a new profile is also configured in Interaction Administrator, and they can be 
assigned at the Default User, Role, User, or Workgroups level.  Create profile rights are managed on 
the Security Rights dialog box, located from the Configuration-->Security tab-->Security Rights button 
in Interaction Administrator. This dialog allows the Administrator to grant a user the rights to create 
inbound, outbound, operator, and email profiles.  If you have the appropriate rights to create a new profile, Interaction 
Attendant also automatically grants you the rights to modify the profile.  This feature allows you to edit any profile you create. 

In Interaction Attendant, if the New Profile button ( for Inbound, Outbound, or Operator profiles or 
 for Email profiles) on the toolbar is greyed out, or the New Profile option located in the Insert 

menu is unavailable, you do not have the appropriate rights to create a new profile.  See your 
administrator for information about obtaining your profile rights. 

Access Right Examples 
When enforcing access rights assigned to the user, Attendant will either: 

• Not show a profile if the currently logged in user doesn't have access to it. 

• Show the profile but with the lock icon and no changes can be made to that profile (and all 
child nodes) if the currently logged in user has view only access to it. 

• Show the profile and changes can be made to it if the currently logged in user has modify rights 
to it. 

• Disable a toolbar button or menu option if the user does not have the appropriate access 
rights. For example, if you do not have the appropriate security rights to create a new profile, 
the New Profile button on the toolbar will be disabled, and you cannot access the New Profile 
option from the Insert menu. 
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The examples below illustrate visual indicators displayed in Attendant for various ACL combinations. 
For more information about access rights, refer to the Access Control topic in the Interaction 
Administrator Online Help. 

No Rights 

A user with no rights to View a call flow will see a padlock icon at the root node, which cannot be 
expanded to reveal any details of the configuration. 

 

View-only Rights 

A user with View-only rights to a call flow can expand locked portions of the tree, but the user cannot 
make changes or export the call flow configuration.  

 

Modify Rights 

A user who has the right to modify one or more Profiles can expand the call flow to view individual 
nodes. Profiles that the user cannot modify have a Padlock icon. 

 
In the example above, the user can modify the Custom Profile, but not the Default Profile, since the 
Modify right was assigned to a single profile in Interaction Administrator.  If *[All] had been selected, 
the right would allow access to all Profiles for that call flow type. 
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See also: Rights required to use Attendant 

Start Interaction Attendant 

Start Interaction Attendant 
Once you have installed Interaction Attendant, you can follow these steps to start the program: 

1. Press the Start button.  

2. Select All Programs, PureConnect, and then Interaction Attendant.  After a few seconds, its 
splash screen will appear. 

Automatic Authentication  
 
If you are already logged in to a CIC server using Interaction Client or third party CIC 
application, you do not need to connect to that server manually.  Attendant authenticates 
CIC users and will grant access automatically if your NT credentials match the needed CIC 
user account, or you already have a Notifier connection.  When authentication succeeds, a 
node for the server is added at startup, and you can begin editing its configuration. 

3. The default shortcut does not pass any ID and password information to Attendant.  If 
you specified a different server name during installation, Attendant will display a "login 
failed" alert.  Press OK to dismiss this message if it appears.  

4. If a Login dialog appears, enter a valid CIC username and password. Then specify a 
configuration type (inbound, outbound, operator, or All).  Press OK.  If authentication 
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fails, Attendant redisplays the Login dialog, so that you can correct a typing error or 
login using a different ID.  Once you are logged in, a server node will appear in the tree. 

5. After Attendant connects to a server, it attempts to load a call flow configuration into 
memory for editing.  If the call flow configuration does not exist, it adds default profile 
and default schedule forms below a node for the server.  This provides the default 
structure needed to build a menu interaction.  

6. If you need to edit the configuration of another server, connect to the server now. 

Optional Command-Line Parameters 

You can log in to any server automatically by adding optional parameters to the shortcut used 
to start Interaction Attendant.  Command-line switches are not case-sensitive. Just add server, 
ID, and password information to the shortcut: 

Parameter Abbreviation Description 

/notifier /n Specify the CIC Server name to connect to. 

/user /u Specify the CIC User login name. 

/password /p Password for CIC User's password. 

/readonly /r Opens Attendant in Read Only mode, preventing the 
configuration from being changed or exported to a disk file. 
See Interaction Attendant Read Only Feature. 

/offlineedit /oe Opens Attendant in Read Only with Edit mode allowing the 
in-memory configuration to be edited. See Interaction 
Attendant Read Only Feature. 

/export=[filepath] none Export a backup configuration, where [filepath] is replaced 
with the location to which you want to export the backup 
configuration. See Export a Configuration file (entire call 
flow). 

/fullexport=[filepath] none Export a full configuration, where [filepath] is replaced with 
the location to which you want to export the full 
configuration. See Export a Configuration file (entire call 
flow). 

For example, if the name of your CIC server is Athena, your CIC UserID is myID, and your 
password is myPassword, the command line would read: 
"C:\Program Files\Interactive Intelligence\InteractionAttendantUD.exe" /n=Athena /u=myID 
/p=myPassword 

Command line arguments are separated by a space.  If you prefer to use the verbose  form of 
the command-line switches, the same command line would be: 
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"C:\Program Files\Interactive Intelligence\InteractionAttendantUD.exe" /notifier=Athena 
/user=myID /password=myPassword 

Call Flow Configuration Switches 

Additional startup switches determine which call flow is displayed in the tree view at 
startup.  Switches are not case-sensitive; you can user upper or lower case. 

Call Flow Abbreviation Description 

Inbound /in or /inbound Display Inbound Call Flow Configuration 

Outbound /out  or 
/outbound 

Display Outbound Call Flow Configuration 

Operator /op or /operator Display Operator Call Flow Configuration 

Email /e or /email Display Email Call Flow Configuration 

For example, to open the email configuration: 

InteractionAttendantUD.exe /n=servername /u=CICUserName 
/p=password /e 

Related Access Rights 

Call Flow Configuration Switches work only if the right to view or modify Attendant call flow 
types (Inbound, Outbound, or Operator) is assigned to the user outside of Interaction 
Attendant, using Interaction Administrator.  These rights may be assigned to the default user, 
users, workgroups, and roles.  See Rights required to use Attendant for details. 

Related Topics 

• Optional Command Line Parameters 

Optional Command-Line Parameters 

Modifying shortcuts 
To modify the shortcut used to start Attendant, follow these steps: 

1. Press the Start button. 

2. Select All Programs, PureConnect, and then right-click Interaction Attendant to open 
its context menu. 
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3. Select Properties from the context menu. 

 
4. Modify the Target statement to add Notifier, user, and password arguments. 

5. Press OK.  The next time you start Attendant using this shortcut, it will connect to the 
specified server automatically. 

Note—if you start Interaction Attendant without any command line parameters, you must 
connect to an CIC server by pulling down the File menu and selecting the Connect 
command. 

Related Topics 

• Install Interaction Attendant 

• Attendant Concepts 

• Connect to a server 

Access Help, Web, and System Information 

Access Help, Web, and System Information 
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The Help menu opens help topics and web resources.  It also displays version information 
about Attendant and your computing environment.  

Online Help 

There are several ways to open online help: 

1. To display help for the current node, press F1 or the Form Help button ( ) button in 
the main toolbar.  It opens a topic that explains the current property sheet.  

2. To open the default help topic, press Shift-F1 or press the Help Contents toolbar 
button ( ). 

Version and System Information 

Collectively, these options provide information that may be useful in a technical support 
situation.   However, you do not need to understand these items of data in order to use 
Interaction Attendant. 

1. For general information about your computing environment, choose About Attendant 
from the Help menu. 

2. Then press CIC Info for information about your CIC server.  The version number of CIC is also the 
version of Interaction Attendant. 

 

3. For information about Internet Protocol, press IP Configuration.  When you are 
finished, press Close. 

4. For information about your computer system, press the System Info button.  This 
opens the System Information dialog shown below. 
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5. When you are finished, dismiss the dialog by clicking Close. 

6. Press OK to close the About IC dialog. 

  

Contact Genesys 
It is easy to access Genesys online resources from this application.  From the Help menu, 
select Genesys.  Then choose one of the following: 

• Home—opens the Genesys web site using the default web browser installed on your 
computer. This URL is http://www.genesys.com/. 

http://www.genesys.com/


Connect to a Server 

34 

• Support—opens the Support Services section of the Genesys web site.  An ID and 
password is required to obtain access to support tips, files, and product updates. 

• Community—takes you to PureConnect Community Forum, a free public forum 
provided by Genesys that promotes the sharing of ideas and information regarding 
PureConnect software. Opinions expressed on the PureConnect Community are not 
those of Genesys, and Genesys accepts no legal responsibility for their veracity or 
nature. 

• Feedback—opens a web form that allows you to submit feedback to Genesys 
regarding products and enhancements that you would like to see in future products 
or product releases. 

In many applications, this feature is also available from the Help > About dialog. To 
access it, pull down the Help menu and select About. When the About dialog appears, 
press the Genesys button to display the options listed above.  

  

Connect to a Server 

Connect to a Server 
Attendant adds a Server node when you connect (login) to a server.  The nodes that collectively 
configure the server appear beneath the server node.  Interaction Attendant can connect to more than 
one CIC server at a time.  This makes it easy to administer multiple servers and see them all in the tree 
view.  If you run Interaction Attendant and the tree structure is empty, or the tree structure does not 
display a server form for the server that you wish to configure, you need to establish a connection 
between Interaction Attendant and the desired CIC server. 

The Connect command establishes a connection.  It opens Interaction Attendant's login dialog so that 
you can login to a server.  A successful login loads that server's configuration into Interaction Attendant 
for editing, and adds its server node to the tree view.  When you are finished, publish the configuration 
to put changes into effect. 

Automatic Authentication 

If you are already logged in to a CIC server using Interaction Client or another application, you do not 
need to connect to that server to access its profiles.  Interaction Attendant automatically 
authenticates valid CIC users to grant access.  If your NT credentials match the needed CIC user account, 
or you already have a Notifier connection established, a node for the server is added to the tree at 
startup. 

Connect Procedure 

1. Invoke the Connect command using one of the following methods: 

• Pull down the File menu and select Connect. 

• Pull down the Insert menu and select New Server. 

• Press the  (New Server) button on the main toolbar. 
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• Pull down the Edit menu and select Manage Servers (or press the   Manage Servers toolbar 
button).  When the Servers dialog appears, press the Connect button. 

2. When the Login dialog appears, enter a valid CIC username and password.  Select a 
configuration type (inbound, outbound, operator, or All).  Then press OK.  If authentication fails, 
Attendant redisplays the Login dialog, so that you can correct a typing error or login using a 
different ID.  

3. When authentication succeeds, Attendant checks to make sure that needed directories exist.  If 
a new language has been defined on the server, Attendant attempts to create a folder to store 
prompts for that language.  If for some reason it cannot create a needed folder, it displays an 
alert: 
 

 
If this alert appears, ask your system administrator to create a folder on the server for the 
needed language.  He or she needs to know the name of the directory (locale code) that appears 
in the alert.  In the example above, the needed directory is AttendantWaves\es-MX.  If the 
directory does not exist, Attendant will be unable to save prompts for the new language.  See 
where files are stored for more information. 

4. Next, Attendant checks to see if anyone is editing the configuration of the server that you are 
connecting to.  If no one is making edits, Attendant adds a node for the server to the tree view 
and you are free to begin working with it. 
 
However, if the server's configuration files are already open for editing, Attendant considers the 
configuration to be locked.  It displays one of the following dialogs: 

• The Attendant In Use Dialog will appears if another person is editing the configuration of the 
server.   Press OK to dismiss this dialog.  You can use Attendant to view and modify the 
configuration, but you will not be able to publish any changes to the server.  To save your edits, 
you must backup export the configuration to a disk file, and import it later when no one else is 
editing.  Since importing a configuration will overwrite all changes that the other person is 
making, a gentler and kinder approach might be to contact the person who is editing the 
configuration to find out when they will be done. 

• The Stale Lock Dialog appears when the configuration of the server has been locked for more 
than 24 hours. This typically indicates that the user did not shut down Attendant 
properly.   Attendant displays information about the lock, and provides the option to overwrite 
it.  If you overwrite the lock, you can edit and publish configuration data for the server without 
any restrictions.  If you do not overwrite the lock, Attendant will prevent you from publishing 
changes to the server.  To save your edits, you must backup export the your configuration to a 
disk file, and import it later when the lock has been removed. 
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• The Same User Lock dialog appears if a second instance of Interaction Attendant is connecting to 
the server using your ID.  If you are confident that no one else is running Attendant with your 
User ID (perhaps you started Attendant twice), you can overwrite this lock and continue safely.  

However, we do not recommend that you overwrite the lock if someone else is using your ID, 
since Attendant will allow both of you to publish changes that could collide logically with one 
another.  

It is safe to run more than one instance of Interaction Attendant if you connect to different CIC 
servers.  If you connect multiple instances to the same server, Interaction Attendant won't stop 
you from saving a configuration that is open in another session.  This could potentially lose 
changes made in another instance.  That's why Attendant displays the Same User Lock dialog to 
warn you. 

"Read Only" and "Read Only with Offline Editing" modes 
 
A user can login to Interaction Attendant without locking the entire configuration. A check box on 
the login dialog selects Read Only mode, in which actions views are disabled, and no adding or 
deleting of nodes can occur. Read-only mode disables modification of actions, schedules, and 
profiles. In this mode, the in-memory configuration cannot be exported. 
 
The login dialog also provides a With offline editing check box, which allows the configuration to be 
edited in-memory and exported for later importing. In this Read Only with Edit mode, you can use 
Attendant to view and modify the configuration, but you will not be able to publish any changes to 
the server.  To save your edits, you must backup export the configuration to a disk file, and import it 
later when no one else is editing.  
 
These modes may be specified when starting Attendant using optional command line parameters. 
For background information about read-only modes, see Interaction Attendant Read Only Feature. 

  

Related Topics 

• Login Dialog 

• Attendant In Use Dialog 

• Stale Lock Dialog 

• Same User Lock 

• Server Form 

• Manage Configuration Files 

Interaction Attendant Read Only Feature 
This topic describes Read Only mode features in detail. 

Feature Overview 

Selecting a Read Only mode when connecting to a server 

Related Command Line Parameters 

Related Toolbar and Menu Commands 
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Dialogs that appear when switching modes 

Overview 

By default, when a user runs or logs into Attendant, it tries automatically to gain a lock on the entire 
server configuration. If no other user has a lock on the configuration, it will successfully acquire the 
lock. At that point, no other user can edit and publish changes while the lock is in place. The lock exists 
for as long as the user is connected to that server through Attendant. 

This can be problematic for customers who have users that occasionally want to examine the 
configuration without locking it, and thereby denying others the ability to edit and publish changes. 
The read only feature introduced in CIC 3.0 SU12 is a solution to that problem. Using this feature, users 
can open Attendant in read only mode without locking the configuration. 

Two slightly different read only modes are available: 

• Read Only mode disables all actions views, preventing addition or deletion of nodes, including 
actions, schedules, and profiles. In this mode, the in-memory configuration cannot be 
exported. 

• Read Only with Edit mode allows the configuration to be edited in-memory and exported for 
later importing. In this mode, users can view and modify the configuration, but not publish 
changes to the server.  To save edits, users must export the configuration to a disk file, and 
import it later when no one else is editing. 

Selecting a Read Only mode when connecting to a server 

Checkboxes on the Login dialog optionally select read only mode with or without editing capability: 

 

Read Only check box 

Use this option to login without locking the entire configuration. It selects Read Only mode, disabling 
modification of actions, schedules, and profiles. In this mode, the in-memory configuration cannot be 
exported. 
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With offline editing check box 

The additional option is disabled unless the Read Only check box is also checked. It allows the 
configuration to be edited in-memory and exported for later importing. In this Read Only with Edit 
mode, users can view and modify the configuration, but cannot publish changes to the server.  To save 
edits, the user must export the configuration to a disk file.  

Related Command Line Parameters 

Read only modes can be specified when starting Attendant using optional command line parameters. 
The command line options for specifying read only are: 

• /r or /readonly connects Attendant to the server in Read Only mode. 

• /oe or /offlineedit connects Attendant to the server in Read Only with Edit mode, allowing the 
in-memory configuration to be edited and exported to disk, potentially to be imported later. 

Related Toolbar and Menu Commands 

Toolbar and menu commands allow a user to switch between read only modes. These options are 
enabled when the server node is selected. To use these commands, the user must have selected a read 
only mode when connecting to the server, or when starting Attendant using command line 
parameters. 

• The Modify Mode button ( ) selects Read Only with Edit mode. 

• The Read Only button ( ) selects Read Only mode. 

Similar selections appear in the File menu. 

Dialogs that appear when switching modes 

Several dialogs appear when switching between modes: 

• In Read Only with Edit mode, a warning dialog appears when the user makes any change, 
reminding that changes cannot be published, but may be exported. That warning is displayed 
once, following the first edit. 

• If changes are made in Read Only with Edit mode and the user subsequently switches to Read 
Only mode or close the application, the user is prompted to export changes to an export file. 

• When a user opens Attendant using /r on the command line (to specify Read Only mode), but 
then switches to Modify mode when the lock is already taken, the mode is switched to Read 
Only with Edit mode. This is functionally similar to Attendant's default behavior when someone 
else has the configuration locked. 

• The mode is managed in this way because the user could switch to modify mode with the 
intention to edit the configuration. Since the user cannot obtain the lock at this time since 
someone else has it, Attendant provides the next best thing, which is Read Only with Edit with 
the ability to export changes to a file. 

• When the user switches to Read Only mode using the toolbar or menu option, the user is asked 
whether or not editing capability is desired. (i.e. offline mode). 
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Manage Nodes in the Tree 

Manage Nodes in the Tree 
The following topics explain how to work with nodes in Attendant's tree.  

• Add a custom Profile 

• Add a custom Schedule 

• Add an Operation 

• Add Dial by Name functionality to a menu 

• Add Dial Extension functionality to a menu 

• Add Group Transfer functionality to a menu 

• Collapse Tree 

• Create a Menu 

• Create a submenu 

• Cut, copy, and paste nodes 

• Deactivate/Activate nodes in the tree 

• Delete a node 

• Error Resolution 

• Expand Tree 

• Invoke a menu operation automatically 

• IVR Reporting Option 

• Listen for Extension Dialing option 

• Modify properties of an existing node 

• Refresh Server Data 

• Rename a node 

• Repeat a Menu 

• Show or Hide the Main Toolbar 

• Show or Hide the Status bar 

• Sort the Tree 

• The default Auto-Attendant menu 

• View the Interaction Log 

• View Information about an error 

• Visual Indicators in the Tree 
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Add a custom Profile 
1. To add a new profile, select a server or profile node in the tree.  This enables the New Profile 

command. 

2. Do one of the following: 

• Press the New Profile button ( ) on the main toolbar. 

• Pull down the Insert menu and select New Profile. 

• Press the right mouse button while the mouse is over an object, and choose Insert then New 
Profile from the context menu. 

3. Fill out the property sheet for the profile.  See Profiles for more information. 

Add a custom Schedule 
1. To add a new schedule, select a profile or schedule in the tree to enable the New Schedule 

command.  Schedules stipulate when a menu can run.   

2. 2.  Do one of the following: 

• Press the  New Schedule button ( ) on the main toolbar. 

• Pull down the Insert menu and select New Schedule. 

• Press the right mouse button while the mouse is over a profile or schedule. Then choose Insert 
> New Schedule from the context menu. 

3. Fill out the property sheet for the schedule.  See Schedules for more information. 

Add an Operation 
Operations are actions that Interaction Attendant performs within a menu, usually in response to a user 
key press.  To add an operation, follow these steps: 

1. Select a Schedule, menu, or multi-action node in the tree. 

2. Do one of the following: 

• Pull down the Insert menu and select New Operation. 

• Press the right mouse button and choose Insert > New Operation from the context menu. 

• Press a button on the Operations toolbar. 

3. Fill out the property sheet for the operation.  See Operations for more information. 

Add Dial by Name functionality to a menu 
Dial by Name allows callers to review a company directory and select a user extension.  

1. Select a schedule node.  

2. Pull down the Insert menu.  Select New Operation, then Dial by Name. 

3. Dial by Name1 is fairly descriptive.  You can leave the text in the Name box unchanged, or type 
in a different name. 
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4. In the Digit list, type or select the number that your extensions start with. 

5. Ensure that the Active check box is checked.  The Default Action check box should not be 
checked. 

6. In the Match By box, click "Last Name" as the pattern you want to match by. 

7. In the Matching Style box, select use a specific number of characters as the style you want to 
match by.  Set the number of characters to at least 3 characters. 

8. Under Filtering, select search the entire company directory. 

9. When you are done, the tree structure should resemble the graphic below.  The digits that you 
assign may differ, depending upon the configuration of your server. 

 
  

Add Dial Extension functionality to a menu 
If you have extensions (user, workgroup or station) configured in Interaction Administrator, you can add 
nodes that allow a caller to enter an extension and be connected immediately.  The digit that you assign 
to this operation should be the first digit of the range of extensions you want to catch.  Once that digit is 
pressed, it is recognized as the first digit on an extension.  Therefore, if your company has employees 
assigned to extensions 100-199 and 8000-8999, you would need to set up two extension dial nodes—
one with digit 1 and one with digit 8. 

For purposes of example, these instructions assume that your company has extensions assigned in the 
100 to 199 range, and in the 8000 to 8999 range.  Your actual extension numbers (and the digit that 
identifies them in a menu) may be different. 

1. Select a schedule node if it is not already selected.  

2. Pull down the Insert menu.  Select New Operation, then Dial Extension.  

3. Type Extensions 100-199 in the Name field. 

4. In the Digit list, type for select the number that your extensions start with.  To match our 
example, you would enter 1 for numbers in the 100 to 199 range, or enter 8 for numbers in the 
range 8000-8999.  

5. Ensure that the Active check box is checked. 

6. In the seconds to wait (between digits) before timing out box, type or select the number of 
seconds you want to wait before timing out.  The default is 3 seconds, which means that user 
data entry will fail if the use pauses more than 3 seconds between key presses. 
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7. In the File to Play to re-prompt the caller box, select ICBadExtension.wav. This audio file will be 
played if the call times out.  

8. In the Number of times to re-prompt the caller box, type or select the number of times you want 
to re-prompt the caller.  The default value (3) is usually ok. 

9. Repeat steps 1-8 to add a form for extensions in the 8000-8999 range.  When you repeat step 3, 
name the form Extensions 8000-8999.  When you repeat step 4, set the digit number to 8. 

10. When you are done, the tree structure should resemble the graphic below.  The digits that you 
assign may differ, depending upon the configuration of your server. 

 

Add Group Transfer functionality to a menu 
This menu option allows callers to transfer to a predefined workgroup, such as "Support" or 
"Marketing.   It uses a Group Transfer node to transfer a caller to the workgroup queue that you 
specify.  In this example, the name of the workgroup is "Marketing".  You may substitute the name of 
any workgroup in your organization. 

1. Select the Default Schedule node if it is not already selected.  

2. Pull down the Insert menu.  Select New Operation, and then Transfer to a Workgroup.  A form 
named Group Transfer1 appears. 

3. In the Name field, replace Group Transfer1 with a more descriptive name.  This is the name that 
appears in the tree structure.  It does not have to be the name of an actual workgroup in your 
organization.  However, it is good practice to use the workgroup name in the title (e.g. "Transfer 
to Marketing Queue") 

4. In the Digit list, click the number that your extensions start with. 

5. Ensure that the Active check box is checked.  The Default Action check box should not be 
checked. 

6. Select the name of a workgroup from the Workgroup list. 

7. You have the option to specify an audio prompt that will play when the call enters the 
workgroup.  Use the embedded audio controls in the form to import, select, play, or record .wav 
files.   In this case, we will not play an audio file when users enter the queue.  Instead, we are 
going to add Queue Audio operations that inform the caller concerning position in queue and 
estimated wait time. 

8. Make sure that the Group Transfer form is selected.  

9. Pull down the Insert menu.  Select New Operation, then Queue Operations and then Play a 
Message to the Caller.  A new Queue Audio form will appear in the form area. 

10. Ensure that the Active check box is checked.  
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11.  Ensure that the Position in queue radio button is selected.  The next step is to add another 
Queue Audio form, to update the caller regarding estimated wait time. 

12. Pull down the Insert menu.  Select New Operation, then Queue Operations and then Play a 
Message to the Caller.  Another Queue Audio form will appear in the form area. 

13. Ensure that the Active check box is checked.  

14. Ensure that the Estimated wait time radio button is selected.   When you are done, the tree 
structure should resemble the graphic below.  The digits that you assign may differ, depending 
upon the configuration of your server. 

Collapse Tree 
This command collapses all nodes in the tree for a given server, so that only the server node is visible. 

1. Select a server node or any node below the server you wish to collapse. 
2. Perform one of the following actions: 

• Press the Collapse Tree button ( ) on the main toolbar, or… 

• Pull down the View menu and select Collapse Tree. 

Related Topics 

• Expand Tree 

• Procedures 

Copy a node 
The Copy command copies the selected node to the clipboard.  You can drag and drop or cut/copy/paste 
nodes from one area to another in the tree.  However, Interaction Attendant won't let you drag nodes 
from one server to another, or to paste nodes from one server to another. All node movement is 
restricted to the current server.  Interaction Attendant also checks to see if the dropped/pasted node is 
assigned to a digit that is already in use by an existing node in the menu.  If the new node is assigned the 
same digit as an already existing node, The dropped/pasted node's digit is reassigned to <None>. 

Usage 

This command may be invoked using any of the following methods: 

• Press the Copy button ( ) on the main toolbar. 

• Pull down the Edit menu and select Copy. 

• Press the right mouse button while the mouse is over a node, and choose Copy from the context 
menu. 

Related Topics 

• Cut 

• Paste 

• Procedures 
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 Create a Menu 
Follow these general steps to create a menu interaction: 

Connect to a CIC server.   

Select the server in the tree.  

Add a new profile by pressing the New Profile button on the main toolbar.  A profile determines which 
menu will process an incoming call, based call selection criteria of some type.  For instance, an inbound 
profile examines the calls DNIS, ANI values, or the line or line group that the call came in on.  

Set options on the profile form.  

Attach a new schedule by pressing the New Schedule button on the main toolbar.  

Set options on the schedule form.  

Press buttons on the operations toolbar to add as many new menu operations as you like.  Operations 
are actions that Interaction Attendant performs within a menu, usually in response to a user key 
press.  Each menu item that you add is added to the tree structure.  Each menu item has its own 
node.  To configure a menu node, select it in the tree and fill out its property sheet.  

Creating a submenu is also easy.  A submenu is a menu form that is attached to another menu or 
schedule as a child node.  To create a submenu, select an existing menu in the tree before adding a new 
menu item.  Menus are added by pressing the New Menu button in the toolbar, or by selecting New 
Operation | Play a Menu from the Insert menu.  

Save your changes, by pressing the Publish button in the toolbar, or by selecting Publish from the File 
menu. 

Create a submenu 
Submenus are menus within menus.  A submenu is a menu node that is attached to another menu as a 
child.  A submenu is created when you select a existing menu form in the tree before adding a new 
menu item. 

Submenus allow you to add branches to your auto attendant menus. For example, you can set up a 
submenu for each workgroup in your company, allowing callers to perform a variety of actions within 
each workgroup. Submenus also allow you to re-use the keys that are used in higher menus. For 
example, pressing 4 in the top level menu might allow callers to enter a Support submenu. In the 
Support submenu, callers might press 4 to send a fax.  

To insert a submenu 

In the tree structure in the left panel, select the menu in which you will add the submenu.  

Press the Menu button in the operations toolbar to open a new Menu form.  A new menu entry appears 
under the menu you selected in step one. 

Configure the properties of the new menu item. 

Cut a node 
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The Cut command removes the selected node, and places a copy on the system clipboard.  You can 
drag-and-drop or cut/copy/paste nodes from one area to another in the tree structure.  However, 
Interaction Attendant won't let you drag nodes from one server to another, or to paste nodes from one 
server to another. All node movement is restricted to the current server. 

Interaction Attendant also checks to see if the dropped/pasted node is assigned to a digit that is already 
in use by an existing node in the menu.  If the new node is assigned the same digit as an already existing 
node, The dropped/pasted node's digit is reassigned to <None>. 

This command may be invoked using any of the following methods: 

• Press the Cut ( ) button on the main toolbar. 

• Pull down the Edit menu and select Cut. 

• Press the right mouse button while the mouse is over a node, and choose Cut from the context 
menu. 

Related Topics 

• Copy 

• Paste 

• Procedures 

Deactivate/Activate nodes in the tree 
If the name of a node is gray in the tree, the node's "Active" check box is unchecked.  This causes 
Attendant to ignore the node and its children.  Deactivated nodes allow you to save a configuration 
without making it available to callers.  To reactivate the form, open the form and check the "Active" 
check box. 

 

To Deactivate a node 

Select the node in the tree to display its  property sheet. 

Locate the Node Characteristics frame, and uncheck the Active check box. 

Activate a node 

Select the node in the tree to display its  property sheet. 
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Locate the Node Characteristics frame, and check the Active check box. 

Delete a node 
The Delete command removes a node from the tree, along with its children.  You cannot undo a delete.  

1. Select the node you wish to delete from the tree. 

2. Press the Delete key. If the node has children, you are asked to confirm this operation: 

 
3. Press Yes to delete the node and its children.  Or press No to cancel the delete operation.   If the 

node contains child objects, they will be deleted along with the parent. 

Usage 

This command may be invoked using any of the following methods: 

• Press the Delete ( ) button on the main toolbar. 

• Pull down the Edit menu and select Delete. 

• Press the right mouse button while the mouse is over an object, and choose Delete from the 
context menu. 

Error Resolution 
The error indicator will go away when you make a change that fixes all of the errors.  If you fix an error, 
and the indicator doesn't disappear, this means that there is another error waiting to be 
resolved.  Check the tool tip again to read an explanation of the next error. 

Suppose, for example, that tool tip error text says something like "such and such a field can't be 
empty".  If the "!" doesn't go away when you put something in the field, this just means that there was 
more than one error that must be resolved.  Check the tool tip again for an explanation of the next 
error.  

Interaction Attendant flags all errors that it finds.  You must correct them before publishing the 
configuration.  It won't publish a configuration that contains errors.  You must fix, delete, or deactivate 
the offending nodes.  

Related Topics 

• View information about an error 

• Visual Indicators in the Tree 

Expand Tree 
This command expands all nodes in the tree for a given server, so that you can view hidden items. 
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1. Select a server node or any node below the server you wish to expand. 

2. Perform one of the following actions: 

• Press the Expand Tree button ( ) on the main toolbar, or… 

• Pull down the View menu and select Expand Tree. 

Related Topics 

• Collapse Tree 

Invoke a menu operation automatically 

 
Most of the time, menu operations are invoked when callers press a key.  However, a menu can execute 
an operation automatically when the menu is entered—without requiring a key press. 

Here's how to create a menu that automatically invokes an operation:  

1. Add a new menu. 

2. Set the menu's "digit" to <None>.  This prevents callers from invoking the menu by pressing a 
key. 

3. Set the "Audio File Name" to <None>. 

4. Set "Number of times to repeat this prompt" to 0. 

5. Set the "Number of seconds to wait before repeating" to 0. 

6. Insert a form for the operation that you want to execute when the menu is entered.  Check the 
default action check box on the operation form (do not check this box on the menu). 

7. The operation will run whenever the menu is invoked by a routing operation.  For example, you 
might jump to this menu using a Menu Transfer operation.  Whenever you set up an automatic 
menu operation, you must also establish a return path for control to follow once the  operation 
has executed. 

IVR Reporting Option 
Options in this frame name the node, assign the digit used to select it,  and establish whether or not it is 
active, used by default, logged, or tracked for reporting purposes. 
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Many Attendant nodes provide a check box that enables IVR Reporting.  This option determines whether 
or not reporting data is collected when control passes through the node.  This information is 
summarized in several IVR Reports.  Data can be collected when Attendant profiles, schedules, menus, 
and complex action nodes are traversed.  This feature makes it easy to establish IVR Reporting as an 
interaction flow is being built, without having to customize handlers and tool steps. 

IVR Reporting allows customers to generate reports based on the activity of interactions through an 
Attendant IVR.  

IVR Reporting is disabled by default.  Check this option to enable capture of information about a node 
and its children for reporting purposes.  The date, time and duration of time that the interaction 
remained in the node will be recorded.  IVR Reporting allows an administrator to see how the 
Attendant interaction flow is being used by customers.  Reports show the number of interactions that 
have traveled through each node, the average amount of time interactions have spent in a particular 
node, menu or IVR application (a multi-action node and it's children).  IVR Reports also indicate where 
callers disconnect.  For more information, see Run Subroutine and the Interaction Designer help 
system. 

IVR Reports 

IVR reports summarize the activity of auto-attendant and IVR processes: 

• IVR Summary 

• IVR Summary by Date 

• IVR Abandoned Summary 

• IVR Exit Path 

• IVR Breakdown 

• IVR Audit 

IVR Reports make it easier to monitor the effectiveness of IVR menus and prompts to determine if a 
desired behavior is being achieved. The end result is better IVR, ACD and auto-attendant 
applications.  See PureConnect Reporting Technical Reference  for comprehensive information about 
IVR reports. 

Listen for Extension Dialing option 
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The Listen for Extension Dialing option appears on schedule and menu forms.  It sets up processing that 
Attendant interprets to handle multiple incoming digits as extension numbers, rather than as menu 
selections.  This option is disabled by default.  

In releases prior to 2.3.1 Feature Pack 1, "Listen for Extension Dialing" enabled always treated the # 
key as a termination digit.  Attendant has been modified to allow the # key when used by itself to work 
as any other menu digit and when used with other digits to work as a termination digit. 

• If # is pressed by itself, Attendant handlers interpret the pound key as a menu digit.  

• If # is preceded by other digits, it is interpreted as a terminator. 

Listen for Extension Dialing offers advantages and disadvantages.  It is a good idea to use it with 
discretion, since it causes user-entered digits to be processed differently, depending upon how quickly 
the user pressed keys.  A user who is familiar with a menu may enter digits quickly, fooling Attendant 
into processing menu selections as an extension-dialing request.  In general, you should use Listen for 
Extension Dialing only in situations that expressly call for it.  Otherwise, Attendant may perform the 
undesired behavior of transferring calls to extension numbers that correspond to legitimate menu 
selections. 

• If you use it, you may be able to reduce the number of extension dialing nodes in your menu 
interactions. 

• The downside is that menu interactions are slowed down by the delay interval specified.  For 
example, suppose that maximum delay is left at its default value of 2.5 seconds.  A caller who 
enters a digit to select a menu item will wait 2.5 seconds for Attendant to process the 
selection.  

• This feature can potentially dial an extension, when the intent of the caller is to select menu 
items.  If a caller enters digits too rapidly, the entry will be interpreted as extension numbers to 
dial. 

Maximum delay (seconds) for extension dialing spin control 

This spin control sets the amount of time (in seconds) that Attendant shall wait for the caller to enter 
the next digit of an extension number.  If another digit is detected within this interval, Attendant 
considers that digit to be part of an extension number, rather than as a menu selection.  Attendant 
then waits the specified interval for another digit to be entered.  The default interval is 2.5 
seconds.  Note—the number of seconds to wait before repeating value in the menu should be longer 
than the value set for maximum delay (seconds) for extension dialing. 

Extension dialing takes precedence over menu option selection 

When Listen for Extension Dialing in effect, extension dialing takes precedence over menu option 
selection.  This can cause unexpected processing behaviors to occur.  Suppose, for example, that callers 
press 3 to select a menu node, and then press 1 to transfer to a Marketing queue, whose workgroup 
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extension is 3.  This works fine until Listen for Extension Dialing is enabled in the default schedule. 
 
When Listen for Extension Dialing is enabled, any caller who presses 3 to select the menu is transferred 
to the Marketing queue, bypassing the menu node and any recording that it might play.  
 
In this scenario, Attendant had to decide whether the digit entered (3) was an extension number or a 
menu selection.  As a rule of thumb, Attendant gives extension dialing precedence over menu option 
selection when Listen for Extension Dialing is in effect.  Since 3 matches the extension of a workgroup, 
Attendant transferred the call to that queue.  To resolve this situation, you could change the Attendant 
menu selection digit so that it does not match an extension number. 
 
When an extension number conflicts with a menu option, and Listen for Extension Dialing is active, 
Attendant assumes that the digit should be used to perform an extension transfer, rather than to 
invoke a menu selection.  In a complex menu interaction, there is no good way to make extension 
numbers disambiguous from menu selections, so use Listen for Extension Dialing carefully. 

  

Modify properties of an existing node 
To modify an item in the tree, click on the node you wish to change.  This displays the node's property 
sheet on the right side of the screen.   Changes made to a property sheet do not go into effect until the 
configuration is published. 

Paste a node 
Paste inserts an item from the clipboard as a child or sibling of the node that has focus.  You can drag 
and drop or cut/copy/paste nodes from one area to another in the tree structure.  However, 
Interaction Attendant won't let you drag nodes from one server to another, or to paste nodes from 
one server to another.  All node movement is restricted to the current server.  

Interaction Attendant also checks to see if the dropped/pasted node is assigned to a digit that is 
already in use by an existing node in the menu.  If the new node is assigned the same digit as an 
already existing node, The dropped/pasted node's digit is reassigned to <None>. 

Before pasting a node, Attendant checks to see if any sibling nodes with the same name exist in the 
destination tree. If a sibling node has the same name, Attendant prefixes the node name with "Copy 
of" to differentiate it from the existing node. If no nodes have the same name, the node is pasted using 
its original name. 

Usage 

This command may be invoked using any of the following methods: 

• Press the Paste button ( ) on the main toolbar 

• Pull down the Edit menu and select Paste 

• Press the right mouse button while the mouse is over an object, and choose Paste from the 
context menu 

Related Topics 
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• Cut 

• Copy 

Refresh Server Data 
This command polls all connected servers to retrieve information about workgroups, schedules, users, 
stations, skills, DB sources, lines, line groups, schedules, languages, and default language—in other 
words, for information that is managed outside of Attendant in Interaction Administrator. 

When you connect to a server, Attendant queries it for configuration data.  Refreshing data ensures 
that Attendant is synchronized with the configurations of connected servers.  If you have been working 
in Attendant for an extended period of time, it is a good idea to refresh Attendant's internal snapshot 
of the server configuration before publishing changes. 

Nothing obvious happens when you execute the Refresh Server Data command.  However, Interaction 
Attendant uses the information received to update options presented in property sheets and 
dialogs.  Major changes to the server configuration could invalidate a configuration, and cause error 
indicators to be displayed in the tree.  For example, if an CIC Administrator removed a workgroup 
referenced in an auto-attendant menu, Attendant would flag one or more nodes in error.  For this 
reason it is a good idea to refresh periodically, especially before publishing. 

Refresh Server Data is disabled in the Edit menu unless a Server node is selected in the tree.  It 
refreshes all connected servers, unless you refresh specific servers using the Manage Servers dialog. 

1. Select a Server node in the tree. 

2. Pull down the Edit menu and select Refresh Server Data.   

3. Wait a few seconds for the operation to complete.  Then resume your work in Attendant. 

Usage 

This command may be invoked using any of the following methods: 

• Press the Refresh Server Data button ( ) on the main toolbar. 

• Pull down the Edit menu and select Refresh Server Data. 

• Press the Refresh button on the Manage Servers dialog. 

Rename a node 
You can rename any node in the tree except default profiles, default schedules or servers.  Follow 
these steps: 

1. Select the node you want to rename in the tree. 

2. Pull down the Edit menu and select Rename. 

3. Type a new name. 

4. Press Enter, or click the mouse button outside of the selection. 

Usage 

This command may be invoked using any of the following methods: 
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• Pull down the Edit menu and select Rename 

• Press the right mouse button while the mouse is over a node in the tree structure.  Then 
choose Rename from the context menu. 

• Edit the Name of the node using its property sheet. 

Repeat a Menu 
It's a good idea to add an option that allows callers to repeat a menu interaction from the top.  This is 
easily accomplished by adding a Menu Transfer form that passes control to the default schedule. 

1. Select the Default Schedule node if it is not already selected.  

2. Pull down the Insert menu.  Select New Operation, and then Transfer to a Different Menu.  Or 
press the  button on the main toolbar.  A form named Menu Transfer1 appears. 

3. In the Name field, change Menu Transfer1 to Repeat Menu.   

4. In the Digit list, select the asterisk (star) key. 

5. Ensure that the Active check box is checked.  The Default Action check box should not be 
checked. 

6. Select Default Schedule in the Transfer the call to this menu list.  When you are done, the tree 
structure should resemble the graphic below.  The digits that you assign may differ, 
depending upon the configuration of your server. 
 

 

Show or Hide the Main Toolbar 
Interaction Attendant provides two toolbars that issue commands quickly.  The Main toolbar contains 
options equivalent to the File and Edit pull-down menus.  This toolbar can be hidden to recover 
screen space.  The Operations toolbar adds operations to menus.  It cannot be hidden. 

1. The Main toolbar is displayed by default.  To hide it, pull down the View menu and select 
Toolbar.  

2. To toggle the toolbar back on, repeat step 1. 

Show or Hide the Status bar 
Attendant displays messages in a status bar at the bottom of the window.  Help text and 
informational messages appear in the status bar.  
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Hide the status bar 

The status bar is displayed by default.  You can hide it to recover screen space. 

1. Pull down the View menu and select Status Bar. 

2. To redisplay the status bar, repeat step 1. 

View information about a toolbar command 

1. Display the status bar, if it is not already visible. 

2. Position the mouse over the toolbar command that you want to learn about.  A description of 
the command will appear in the status bar. 

Sort the Tree 
This command reorders items in the tree structure according to precedence.  Schedules and menu 
options are sorted based on the time in which they are active.  This provides a better indication of the 
logical flow of control that occurs.  Since the sort order is time-based, rather than alphabetic, this 
provides a better indication of the logical flow of control that will occur. 

The figure below shows a sorted list of schedules.  The default schedule is evaluated first, followed by 
the daily, weekly, monthly, yearly, and unplanned schedules.  If two or more forms of the same type 
are attached to a node (for example, two unplanned schedules), those items are listed in alphabetical 
order within precedence. 
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Usage 

This command may be invoked using either of the following methods: 

• Press the Sort Tree ( ) button on the main toolbar. 

• Pull down the Edit menu and select Sort Tree. 

The Default Auto-Attendant Menu 

The Default Auto-Attendant Menu 
This topic explains functionality provided by the default inbound configuration.  This configuration is 
created by the install, unless you are upgrading and a previous configuration was found.  The default 
configuration will match the configuration discussed in this topic, with the exception that Setup 
Assistant may have added an additional custom schedule for your hours of operation.  It may also 
have customized workgroup transfers for your organization, depending upon options selected when 
the server was set up. 
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Explanation of Default Nodes 

A The Default Inbound Call Profile plays ICMainGreeting.wav, which is a "Thank you for calling" 
wave file.   

B 
When control passes to the Default Inbound Call Schedule, it plays ICMainMenu.wav, which 
says, "If you know your party's extension, press 1.  To dial by name, press 2.  For an operator, 
press 0. To return to this menu at any time during your call, press the star key." 

C 
The Disconnect node plays a wave file (ICDisconnect.wav) and then disconnects if the caller 
does not enter digits in response to voice prompts.  The wave file says, "thank you for 
calling…goodbye". 

D If callers press 0, an Attendant Transfer operation transfers the call to the Operator profile 
that matches this call. 

E-
F 

If callers press 1 to Dial an Extension, a menu node plays a wave file (ICEnterExtension.wav) 
that says, "Please enter the extension for the party you would like to call.  To return to the 
previous menu, press the star key".  Subsequent digits are processed by Dial Extension nodes 
attached to the Dial an Extension menu.  These nodes search the company directory to match 
extension numbers entered by the caller.  When a match is found, the call is transferred to 
the specific extension. 

G If callers press *, a Menu Transfer returns control to the schedule.  This is the default action if 
a caller does not make a selection in the Dial an Extension menu. 

H 
When callers press 2, a Dial by Name node prompts callers to enter the first three characters 
of a last name.  The company directory is searched to find matching agents.  When a match is 
found, the call is transferred to the agent's extension. 

I  When callers dial 9, control is passed to a second-level menu node.  The options in this 
extended menu are: 

J Multi-Site allows the caller to pickup an inbound multi-site call. 

K Play Station Information uses a subroutine initiator to invoke the PlayStationInformation 
handler.  

L Queue Monitoring uses another subroutine initiator to invoke the SystemIVRChooseQueue 
handler. 

M 
Call Picked Up allows the caller to pickup a call that is waiting in a queue—the call may be 
held, parked, or alerting.  The user must have modify rights to the queue that contains the 
call. 

O Agent Login/Logout allows an agent to login or logout from a station phone. 
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P Unified Messaging allows the caller to access voice and Email messages. 

Q A Menu Transfer node attached to the extended menu passes control back to the schedule 
when the star key is pressed. 

R The next Menu Transfer node is attached to the schedule.  It allows callers to repeat the main 
menu when the star key is pressed.   

  

Related Topics 

• Options Configured by Setup Assistant 

• Manage Nodes in the Tree 

Options Configured by Setup Assistant 

Options Configured by Setup Assistant 
Some default auto-attendant menu options can be configured when the CIC server is installed, using a 
program called Setup Assistant.  To use Attendant, you do not need to understand how Setup 
Assistant works, or how the CIC server was configured.  However, two dialogs in Setup Assistant 
potentially modify the default inbound call flow. 

Default Hours of Operation 

 
Setup Assistant displays this dialog to collect information about your company's normal hours of 
operation.  The information provided is used to add a Custom Inbound Call Schedule node to the 
inbound call flow. 

Group Call Processing 
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Setup Assistant uses another screen to configure a list of menu items associated with workgroups 
defined earlier within the wizard. For each menu item, a digit, workgroup, and optional overflow 
queue is specified.  The figure below shows the wizard page and related dialogs that configure 
workgroup transfers in Setup Assistant.  

 
Setup Assistant uses this information to define menu options that route calls to specific workgroup 
queues.  The resulting workgroup transfers are added to the default inbound menu.  

Related Topics 

• Default Auto-Attendant Menu 

View the Interaction Log 
When a user checks "Add entry to the Interaction Log" in an Attendant profile, information about the 
node is appended to the call's Interaction Log when the interaction enters the node.  The Interaction 
Log contains a record of nodes traversed in Attendant, along with messages from other CIC systems 
that process the Interaction.  The Interaction Log provides an audit trail of call processing throughout 
CIC.  

When this option is enabled, a line of text is written to the Interaction Log each time the interaction 
passes through that node or one its descendants.  The message logs the name of the node and the 
node type.  For example, when an Attendant node is traversed, Attendant appends an entry to the 
Interaction Log to denote the event.  The format of the log entry is: 

User-defined Node name (Attendant Form Name) 
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For example, if you create a Workgroup Transfer form and name it "Transfer to Marketing", the 
corresponding Interaction Log entry would be: 

Transfer to Marketing (Workgroup Transfer) 

Using Interaction Client to view the Interaction Log 

Agents can open the Interaction Log in Interaction Client to reveal the path that the call (or Email) 
took through Attendant.  In many cases, this helps the agent to discern what the caller is looking for 
without having to ask the caller questions.  Follow these steps: 

1.  Activate Interaction Connect. 

• If the call is in progress, select My Interactions tab. Select an interaction and select Interaction 
Properties, Interaction Log, or Interaction Notes from the sidebar control.  

• If the call has completed, select the Call History tab and select the Properties button.  To 
select which interaction properties to display, click Notes or Log. 
 
The Log tab describes changes in the interaction's state. This information is stored in a log 
file for reporting purposes. 

 For more information about viewing and editing interaction properties, refer the Interaction Connect 
help. 

View information about an error 
If you hover the mouse cursor over a node that has an error indicator, Interaction Attendant will display 
a tool tip that describes the error condition.  

1. Position the mouse over a node in the tree that is flagged with an error indicator (red 
exclamation point, or blue down arrow). 

2. Wait for a description of the error to appear as a tool tip: 

 
Related Topics 

• Visual Indicators in the Tree 

• Manage Nodes in the Tree 

Visual Indicators in the Tree 
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Interaction Attendant adds visual indicators to the tree to call attention to error conditions, default 

nodes and disabled operations.  

  

A padlock icon indicates that someone else is updating the server, or that the user has read-only rights 
to the call flow.  When a server's configuration is locked by another user, Attendant displays a padlock 
icon to indicate that you cannot publish changes to this server.  You can export changes, however.  See 
manage configuration files. 

  

Attendant draws a green border around default nodes.  At any level in the tree structure, one node can 
be marked as the default action to perform if the caller does not press a key within the timeout specified 
by that menu.  To configure a node as the default action, check the Default Action check box in its 
property sheet. 
 
Default profiles and schedules are always green, since they receive control when custom profiles and 

schedules do not match the call. 

               

 A red exclamation point indicates that Attendant has found something wrong with a configuration 
setting.  This usually indicates that a field was left empty, or that a selection was not made from a list 
box. 
 
When you leave a node, Interaction Attendant validates it to catch problems.  If a problem is found, it 
places a red exclamation point (!) to indicate that you need to update its property sheet.  See error 
resolution. 

                

Blue down arrows indicate that an error exists in a child node.  This helps locate problems in nodes 
whose red exclamation point is hidden because a parent node is collapsed.   In very rare cases, the blue 
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down arrow may be drawn incorrectly or appears partially drawn.  This problem is caused by display 
drivers on the local computer, and does not indicate a fault in Interaction Attendant. 

                

Gray text indicates that a node is inactive.  By default, nodes are "on", or "active", which means that 
Interaction Attendant will process them.  If you uncheck a node's Active check box, the node turns 
gray to indicate that Attendant will ignore the node and its children.  Inactive nodes are invisible to 
callers.   

Manage Voice Prompts 

Manage Voice Prompts 
This section explains how to manage voice prompts in Interaction Attendant.  

A prompt is an audio message that informs the caller that an action is required or that a process is 
complete.  In Interaction Attendant, prompts are wave audio files that Attendant plays to guide 
callers through an interaction of some sort.   For example, Attendant can play a prompt when control 
is passed to a menu, or when a call is transferred to a workgroup.   In general, prompts tell callers 
what to do. 

Prompts are recorded using your telephone.  Interaction Attendant does not use your PC's sound card 
to record prompts.  However, it does use your sound card and speakers to play prompts when you are 
working in Attendant.  

There are two ways to record voice prompts in Interaction Attendant.  You can record prompts using 
audio controls embedded in forms, or you can use the Prompt Management dialog.  The latter displays 
information about a selected prompt, such as which languages it has been recorded in.  This makes it 
easy to manage prompts at a high level without having to open forms. 

Prompt Format 
 
Customers who use Interaction Attendant may choose to have their prompts recorded by a third 
party and need to know our native prompt format, which is: CCITT u-law, 8kHz, 8 bit, Mono for best 
results. 

Attendant makes it easy to offer prompts in multiple languages.  To do this, you need to understand 
the difference between available languages, the default language, and the current language: 

Available Languages 

Interaction Attendant lists the names of available languages in audio-related forms and dialogs, so 
that you can record or play back a prompt in a particular language.  The names of supported 
languages (e.g. English, Spanish, etc.) are defined outside of Interaction Attendant, using Interaction 
Administrator.  If you need to record prompts in a language that Interaction Attendant does not 
support, you can configure CIC to support additional languages. 

When an additional language is defined, CIC creates a folder on the server to store prompts for that 
language.  Since voice prompts are stored in language-specific directories, the same filename is used 
to refer to a prompt, regardless of the language it is recorded in.  For example, you might record 
"greeting.wav" in English, Spanish, and French.  The same name is used to refer to all versions of the 
file.  For more information about language folders, read where files are stored.  Attendant makes it 
easy to record a prompt in different languages, using a simple set of audio controls. 
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Default language 

When you record a new prompt, Attendant assumes that you are recording in the default language 
defined for the server.  The default language is defined outside of Interaction Attendant, using 
Interaction Administrator (on the Languages page of the System Configuration container).   CIC 
supports multiple languages, but one language is configured to be used by default.  Callers hear 
prompts in the default language unless you configure Attendant to change the current language. 

Current Language 

The language used to play prompts at runtime is known as the current language.  The current 
language tells Attendant which directory to play a prompt from.  You can control the language that 
Attendant uses in several ways: 

• By specifying a specific language in a profile form.  Profile forms filter incoming calls by 
examining a range of incoming call characteristics.  For example, you can create a profile that 
plays voice prompts in Spanish when a specific number is called (DNIS), or when preferred 
Spanish-speaking customers call from known telephone numbers (ANI).  Profiles make it easy 
to select a language based upon the line, line group, or number that was dialed (DNIS) or by 
examining the telephone number that was called (ANI).   

• By allowing callers to choose the language used to play back prompts.  You can use Language 
Selection operations to create menus that prompt callers to select a preferred language.  This 
allows callers to dynamically choose the language used to play back prompts in other menus.  

When you configure an IVR interaction in Attendant, you can preset the current language or allow 
callers to choose a preferred language.  The current language is also evaluated when text is converted 
to speech. 

For example, suppose that a caller's preferred language is Spanish based upon a profile form or based 
upon the caller's language selection.  Attendant plays "greeting.wav" from the Spanish language 
directory on the server.  When Attendant needs to play the same prompt to an English-speaking 
caller, it plays the file found in its English language directory. 

Related Topics 

• Manage Voice Prompts 

Where files are stored on the server 

Where files are stored on the server 
Voice prompt files that you record (or import) in Attendant are saved as wave audio (.wav) files on 
the CIC server when a configuration is published.  The table below shows the physical paths and share 
names: 

Physical Path Share Path 

\I3\IC\Resources\InteractionAttendantWaves \\server\AttendantWaves 

Default Language folder 
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Wave files are stored in language-specific folders below the AttendantWaves share.  Prompts can be 
recorded in any language that is defined on the CIC server.  When CIC is configured, one language is 
identified as the default language.  Handlers play prompts in the default language when a language 
attribute is unspecified or is unknown.  The folder that contains wave files recorded in the default 
language is called the default language folder. 

Locale Codes 

Languages come in various dialects.  Attendant stores prompts for each language in a folder that it 
names using a locale code.  Locale codes are just abbreviations that the system uses internally to 
identify a dialect.  For example, the locale code for United States English is en-US.  Accordingly, 
Attendant stores prompts for that dialect in \i3\IC\Resources\InteractionAttendantWaves\en-US, 
which is shared as \\server\AttendantWaves\en-US. 

Alternate Language folders 

Attendant creates language folders automatically—you don't have to create folders or worry about 
folder names.  When Attendant reads the list of supported languages from the CIC server, it checks to 
make sure that all needed language subfolders exist.  If a needed directory does not exist,  it creates 
needed directories automatically.  If it is unable to do so, it displays an error message that you should 
report to your system administrator—see connect to a server for details. 

Language Codes 

To record prompts in Attendant, you only need to understand that prompts are stored in different 
folders for each supported language.  Here's some additional information for those who want to 
know more: the CIC uses language codes to name language folders.  Language codes have two parts: 
a country part and a language part, since people in different countries sometimes speak different 
dialects of a language.  For example, the language folder for United States English prompts is "en-
us".  A folder for the German language spoken in Germany is "de-de".  Attendant's user interface 
automatically converts language codes to friendly names (e.g. U.S. English) so that you don't have to 
care about language codes.  All nodes with audio controls display the friendly audio names on all their 
menus and drop-down buttons.  But if you browse directories on the server, you will see folders 
named using language codes. 

Remote access to wave files on the server 

Remote users who start Interaction Attendant may encounter a message similar to: 

Error: The language "English (United States)" is defined by the CIC 
server but Attendant could not find the "AttendantWaves\en-US" 
directory on the server, nor could the directory be created. 

If Interaction Attendant is started on the server (via the console, or Terminal Server), this message 
does not appear. This behavior affects remote users only, and is related to the Operating System, not 
to Attendant. By default, a remote user does not have access to the AttendantWaves directory on the 
server, since it is not shared by default.  

As a work around, remote users can set up a mapped drive that points to the CIC server.  The mapped 
drive does not necessarily have to point to the AttendantWaves directory.  Mapping makes the local 
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PC and the remote server aware of each other, so that the share reference can be resolved by 
Attendant. 

Related Topics 

• Manage Voice Prompts 

Using Embedded Audio Controls 

Using Embedded Audio Controls 
Many property pages in Interaction Attendant contain embedded audio controls.  These controls 
record new prompts, or select a previously recorded prompt to play in an interaction.  Use audio 
controls to import, select, record, or play wave audio files in any needed language.   These controls 
make Attendant easier to use, since frequently used features are implemented consistently 
throughout the program.  

 
The procedures that follow this topic provide step-by-step instructions for managing prompt files.  

Audio File Name list box 

Selects an existing recording by name.  This drop down is populated with audio files from both the 
"Language-locale" folder and the "Language" folder. See Record in Alternate Language list box below. 

Preview Play button 

Plays the selected prompt in the language selected using the Preview Language list box.    This does 
not assign the language used to play the prompt in an interaction.  The language used to play back a 
prompt at runtime is controlled by the current language setting, set by a profile form (based upon 
incoming call characteristics) or by a user who has interacted with a language selection node in a 
menu. 
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Preview Language list box 

This drop-down lists the names of languages that the prompt has been recorded in, which is not 
necessarily the complete list of languages that are supported by the server.  When you select a 
language, the prompt is played using your PC's sound card. 

Preview Stop button 

Halts playback immediately.  

Browse button 

This button opens a standard File Open dialog, so that you can select a wave file to import as the 
default language prompt.  You can select files from any drive or server that is available to you.  When 
you publish the configuration, the imported wave file is copied to a language-specific directory below 
the AttendantWaves share on the server.  See where files are stored on the server. 

All files that you import using the Browse feature are assumed to have been recorded in the CIC 
server's default language.  There is currently no way to import files that were recorded in alternate 
languages. 

Record in Default Language button     

Press this button to record a new wave file, using your telephone handset.  When prompted to enter 
a name for the new prompt, type a descriptive name in the Name field and then press OK.  If you 
enter the name of an existing prompt, it will be replaced by your new recording. 

 
When you create a new recording, Attendant requires you to record in the default language.  Later, 
when you record the prompt in another language, Attendant uses the same filename to save another 
version of the file in a language-specific directory.  All versions of each prompt use the filename 
established when the default language version was created. 

Prompts in Attendant are always recorded using a telephone handset.  You cannot record messages 
using a microphone plugged into your sound card.  If you are running Interaction Client remotely, or 
use a SIP phone, your telephone will ring.  When it does, pick up the receiver and begin speaking the 
prompt.  When you are finished, press 1 to save the prompt. 
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If you are not using SIP or a remote connection, you are prompted by a dialog to pick up your 
telephone handset.  Press OK once your phone is off hook.  Then record the new prompt in 
accordance with the audio instructions that you hear. 

 
Record always creates a new prompt file.  To record a prompt in another language, use the Record in 
Alternate Language feature.  

Record in Alternate Language list box 

Select a language in this drop-down list to re-record the selected prompt in that language.  The 
procedure is similar to recording a new prompt, except that you are not prompted to enter a file 
name.  See where files are stored for information about storage of prompt files in language-specific 
directories on the server. 

Interaction Attendant creates language folders using the language code and dialect. For example, the 
folder for English language, United States dialect would be us-en.  However, not all languages have 
dialects, and in other cases it is desirable to aggregate all dialects for a language. For this reason, 
Attendant also supports folders named after the language code only. In CIC 3.0 SU1 and later, some 
default prompts are stored in folders that do not named using dialect. 

Attendant looks for "language-dialect" folders first, and then for a folder named after the language 
only. For example, if the language attribute of a call is es-AR for Spanish language, Argentina dialect", 
Attendant looks in  the \I3\IC\Resources\AttendantWaveFiles\es-AR folder first, and then looks 
for  \I3\IC\Resources\AttendantWaveFiles\es. Since it is possible for both to exist, you may see a 
selection for the language (e.g. Spanish) in this drop list, and another selection that contains both 
language and dialect, such as Spanish (Argentina). 

Prompt Details button 

This button opens the Audio File Details dialog, which displays the language, playback duration, and 
encoding format of the wave audio files for the selected prompt.  If the Details button is disabled, you 
can enable it by choosing a prompt file from the Name combo box. 
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The Audio File Details dialog. 

Related Topics 

• Manage Voice Prompts 

Record a new prompt in the default language 
This procedure explains how to record a new prompt in the default language.  You can perform this 
procedure from any form or dialog that contains embedded audio controls.  

1. Press Record to create a new wave audio file. 

 
2. When the Audio Prompt Name dialog appears, type a descriptive name (without path 

information).  Attendant adds ".wav" to the filename, if you do not supply the extension. 

  

3. Press OK.  When you create a new prompt, you must record it using the server's default 
language.  Attendant stores new prompts in the default language folder.  If you record the prompt in 
another language later, Attendant uses the same filename, but saves that version in a different language-
specific folder.  All versions of a prompt use the filename established when the default language prompt 
was recorded.  Alternate-language versions of a prompt are stored in the appropriate language folder. 

Tip 
 
If you enter (or select) the name of an existing prompt, the default-language version of 
that prompt will be replaced by your new recording.  This does not affect alternate-
language versions of the prompt, if any exist.  
 
Prompts in Attendant are always recorded using a telephone handset.  You cannot record 
prompts using a microphone plugged into your PC.  
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4. The action you perform next depends upon whether or not you are using a SIP phone 
or are running Interaction Client in remote mode. 

• Your telephone will ring if you are running Interaction Client remotely, or use a SIP 
phone.  When it does, pick up the receiver and begin speaking the prompt.  See also: 
Tips for recording prompts from SIP phones. 

• If you are not using SIP or a remote connection, you are prompted to pick up your 
telephone handset.  

 
• Take your telephone off-hook.  Press OK to dismiss the dialog, and listen to the audio 

prompt:  

• "Please record your prompt after the tone.  When you are finished, press 1."  

• Begin speaking when you hear the tone. 

5. When you are done, press 1 to tell the system to stop recording. 

6. Press any of the following digits to review, re-record, save, or discard the prompt: 

• To save your prompt, press 1. 

• To review (listen) to your prompt, press 2. 

• To record the prompt again, press 3. 

• To discard the prompt, press 4. 

7. When you are finished, hang up or disconnect the call. 

Key Concepts 
 
When you record a new prompt, Attendant assumes that you will record it in the default 
language that is defined in Interaction Administrator.  Think of it this way: when 
Attendant asks you to supply a filename, it assumes that the default language will be 
used.  Thereafter, you can record the prompt in another language by making a selection 
from the Record in Alternate Language list box—don't press Record. 
 
You must record a prompt in the default language before you can record the prompt 
again in another language.  Attendant uses the filename that you give to the first 
recording when it saves versions of the file in language-specific directories.  All versions 
of a prompt have the same filename.  Files are simply stored in different locations.  
 
New prompts are created when your press the Record button, or press Browse to import 
an existing wave audio file.   

Related Topics 

• Manage Voice Prompts                   
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Record a prompt in another language 
Follow these steps to record a prompt in a language other than the default language.  You 
can perform this procedure from any form or dialog that contains embedded audio 
controls. This procedure can be used to re-record any prompt, including the default 
language prompt. 

1. Select a prompt file in the Audio File Name list box. 

2. Select a language from the Record in Alternate Language list box.  Checks indicate 
which language the prompt has been recorded in.  In the example below, the 
prompt has been recorded in English only. 

 
3. The action you perform next depends upon whether or not you are using a 

SIP phone or are running Interaction Client in remote mode. 

• Your telephone will ring if you are running Interaction Client remotely, or use a SIP 
phone.  When it does, pick up the receiver and begin speaking the prompt.  See 
also: Tips for recording prompts from SIP phones. 

• If you are not using SIP or a remote connection, you are prompted to pick up your 
telephone handset.  

•  
• Take your telephone off-hook.  Press OK to dismiss the dialog, and listen to the 

audio prompt:  

• "Please record your prompt after the tone.  When you are finished, press 1."  

• Begin speaking when you hear the tone. 

4. When you are done, press 1 to tell the system to stop recording. 

5. Press any of the following digits to review, re-record, save, or discard the prompt: 

• To save your prompt, press 1. 
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• To review (listen) to your prompt, press 2. 

• To record the prompt again, press 3. 

• To discard the prompt, press 4. 

6. When you are finished, hang up or disconnect the call. 

Related Topics 

• Manage Voice Prompts 

Import a prompt file 
This topic explains how to import an existing .wav file into Interaction Attendant, to use as the default-
language prompt.  You can perform this procedure from any form or dialog that contains embedded 
audio controls.  

1. Press the Browse button.  

 
2. Use the standard File Open dialog box to select a wave audio file.  Press Open. 

 
3. The filename you selected now appears in the Name field of the embedded audio controls.  You 

can play the file, view details about its size and format, etc.  When you publish the updated 
configuration, the imported file will be saved on the server in the directory that Attendant uses 
to store wave files for the default language. 
 
Limitations 

• You can import wave audio (.wav) files only.  Sound files in other formats cannot be 
imported. 
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• Attendant assumes that the imported file was recorded in the server's default 
language.  In this release of Interaction Attendant, you cannot import a file and assign it 
to a non-default language. 

• Attendant copies imported files to the server when the configuration is published. 

Related Topics 

• Manage Voice Prompts 

An easier way to manage multi-language prompts 

 
The Prompt Management dialog. 

There are two ways to record prompts in Interaction Attendant.  You can record prompts using 
embedded audio controls on a form, or you can use the Prompt Management dialog.  The latter displays 
the languages a prompt has been recorded in.  This makes it possible to manage multi-language prompts 
at a high level without opening forms.  

To open this dialog, select Multi-Language Prompts the Edit menu.  See Prompt Management Dialog for 
usage details. 

Related Topics 

•  Manage Voice Prompts 

Re-record default prompts in handlers 

Re-record default prompts in handlers 
Some default prompts are stored in a handler rather than in wave audio files.  These prompts cannot be 
updated in Attendant, since they are embedded in a handler and are not externally stored .wav 
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files.  This procedure explains how to optionally re-record default prompts to match the voice used in 
your own custom menus.  

The handler named Prompt_Attendant.ihd contains all of Attendant's default prompts.  To change 
these prompts, you must re-record them using Interaction Designer.   The procedure below assumes 
that you are using the CIC version of the Interaction Designer, the CIC's graphical development tool.  

A word of caution—you should not open or modify Interaction Attendant handlers other than 
Prompt_Attendant.ihd.  Changing Attendant's other handlers may cause your menus to stop functioning 
correctly.   The prompts you need to re-record are all located in Prompt_Attendant.ihd, and referenced 
from there by Attendant's other handlers using Play Prompt Extended tools. 

Steps to Complete 

1. Start Interaction Designer.  

2. Pull down the File menu and select Open.  

3. Select \ic\handlers\30handlers\<lang>\Prompt_Attendant<lang>.ihd.  Press the Open button. 
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4. Double-click the Play Prompt step to open its Property sheet. 

5. Click on the Inputs tab.  Then press the Edit button. 

 
6. Select a prompt to re-record, and press click the Record button to begin recording. 

 
7. Repeat step 3 to re-record other prompts as needed. 

8. Press OK to close the Prompt Editor window. 

9. Press OK again to close the properties page. 

10. Select Save from the File menu to save changes. 

11. Select Publish from the File menu to put changes into effect.  Interaction Attendant will begin 
using the new prompts immediately. 

Transcript of the default prompts 
Here is a transcription of default voice prompts in the Prompt_Attendant handler: 

Handler Name/Prompt Name Transcription 

CallerDataEntry_NUMBER_ENTERED_IS The number you entered is… 

CallerDataEntry_VERIFICATION_MENU If this is the desired entry, press 1.  Otherwise, to 
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reenter, press 2. 

DialByName_CALL_PERSON_NOW To call this person now, press 1. 

DialByName_CHARS_NAME characters of your party's name… 

DialByName_CHARS_NAME_FIRST characters of your party's first name… 

DialByName_CHARS_NAME_FIRST characters of your party's last name… 

DialByName_DIAL_BY_NAME_ENTIRE_DIR To hear the company directory, press the pound 
sign. 

DialByName_ENTER_EXTENSION Please enter the extension number. 

DialByName_EXTENSION extension 

DialByName_MULTIMATCH Several people match that entry.  They are . . . 

DialByName_NO_MATCH Sorry.  That does not correspond to a known 
name.  To hear the company directory, press the 
pound key.  To try again,… 

DialByName_ONEMATCH To call this person now, press 1.  To try again, press 
the star key. 

DialByName_OPERATOR_TRANSFER_OPTION For an operator, press zero. 

DialByName_PLEASE_ENTER_CHARS_NAME Please enter the characters of your party's name. 

DialByName_PLEASE_ENTER_CHARS_NAME_FIRST Please enter the characters of your party's first 
name. 

DialByName_PLEASE_ENTER_CHARS_NAME_FIRST Please enter the characters of your party's last 
name. 

DialByName_PLEASE_ENTER_FIRST Please enter the first . . . 

DialByName_PLEASE_WAIT Please wait. 

DialByName_RETURN_PREVIOUS_MENU To return to the previous menu, press the star key. 

DialByName_USE_7_Q_9_Z …use seven for 'Q' and nine for 'Z' 

ExpressionEvaluation_FALSE False 
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ExpressionEvaluation_TRUE True 

ExtensionDialing_INVALID_EXTENSION Sorry, this is not a valid extension. 

FaxBack_IVR_FAX_SEND_FAILURE An error occurred while sending your fax. 

FaxBack_IVR_FAX_SEND_SUCCESSFUL Your fax has been successfully sent. 

ProcessAcdWait_ACD_AUDIO_AHEAD …calls ahead of you. 

ProcessAcdWait_ACD_AUDIO_APPROX …will be approximately… 

ProcessAcdWait_ACD_AUDIO_ESTIMATED_WAIT Your wait time… 

ProcessAcdWait_ACD_AUDIO_LESS_MINUTE  …should be less than one minute. 

ProcessAcdWait_ACD_AUDIO_MINUTE Minute 

ProcessAcdWait_ACD_AUDIO_MINUTES Minutes 

ProcessAcdWait_ACD_AUDIO_NO No 

ProcessAcdWait_ACD_AUDIO_POSITION There are currently… 

ReceiveFax_PRESS_START_NOW You may press 'Start' on your fax machine, now. 

Related Topics 

• Manage Voice Prompts 

Tips for recording prompts from SIP phones 
In releases of Attendant prior to 2.2 SR-A, prompts could not be recorded using SIP phones.  Using the 
SIP platform, neither users nor administrators could record prompts via the phone handset in Attendant. 
When a user selected Record, he was prompted to pick up the handset and select OK. The dialog box 
was continually re-displayed after OK was selected. 

To resolve this problem, Interaction Attendant no longer checks phone status.  When a user clicks on 
record, he is prompted to enter the name of the .wav file to record and then the recording process 
begins. 

• If the user is a SIP user, the SIP phone will ring to start the recording process. 

• If the user is off-hook, station audio will play to guide the user through the process of recording 
a prompt. 

• If the user is on-hook, a new station audio object is placed in the user's queue, but the user is 
not alerted.  The user must pick up the phone without being prompted to do so.  
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Related Topics 

• Manage Voice Prompts 

Configure CIC to support additional languages 
Languages are defined in Interaction Administrator.  Interaction Attendant lists the names of supported 
languages in audio-related forms and dialogs, so that you can select a particular language for playback 
or recording of a voice prompt.  This topic explains how to configure a CIC Server to support additional 
languages. 

If you need to support a language that does not appear in Interaction Attendant's list of available 
languages, use the procedure below to add a new language entry to the list of languages supported by 
the cUSTOMERInteraction Center server:  

1. Run Interaction Administrator. 

2. Click on the System Configuration container in the tree view. 

3. Open the property sheet for the Configuration entry by double-clicking Configuration in the list 
view. 
Click on the Languages tab. 
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4. Press Add to open the Languages dialog. 

 
5. Select a language from the list.  Then press OK. 

6. Repeat steps 5-6 to add additional languages if need be. 

7. Press OK to close the System Configuration property sheet. 

8. Close Interaction Administrator by selecting Exit from the File menu. 

Related Topics 

• Manage Voice Prompts 

Manage Configuration Files 

Manage Configuration Files 
The call flow interactions that you design in Attendant are called configurations.  Configurations can be 
connected, locked, loaded, published, exported, imported and disconnected.  You can export a server's 
configuration data to an Attendant file (*.att) to create a backup, or a file that can be imported into 
another server.  Configuration files back up existing servers, and make it easier to configure multiple 
servers. 

Understanding Packages vs. Configurations 
 
When part of a call flow is saved to disk, the resulting file is called a package.  The command that 
saves a portion of the call flow is called Package, to distinguish it from Export, which saves the entire 
call flow in a configuration file. For procedural details, see export a configuration file and export a 
package file. 



Printed Documentation 

77 

 
Packages allow part of a call flow to be moved from a test environment to a production 
server.  Packages can be used to create a template call flow that can be loaded onto a server and 
then customized. 
 
Configuration files have an extension of .att. Package files have an .atp extension.  The difference 
between a package (created using the Package command) and a configuration (created using the 
Export command) is that: 
 
A configuration always describes the entire Attendant tree: all profiles and everything below it. A 
package is a sub-section of a tree that could be any node along with all of its children, grandchildren 
and so on.  A package could contain a profile, a schedule, a complex action node, or any other 
combination of call flow logic. 
 
When you import a configuration, all of the existing call flow is replaced by the imported 
configuration, but when you import a package, nothing is deleted. The nodes in the package are 
simply added to the existing configuration.  See import files. 

Connect opens the last published configuration 

When you login to a server with Attendant, you become connected to the configuration that is 
currently running, and the call flow is loaded into Attendant for editing.  If no one else is editing the 
configuration, Attendant locks it for your exclusive use.  This prevents other persons from publishing 
the configuration while you are editing it.  Attendant notifies you if the configuration is locked by 
someone else. 

Export copies the configuration to a disk file 

Exporting a configuration saves a copy of it to a file.  You can export an inbound, outbound, or operator 
configuration in one of three ways: 

• As a server-specific backup that can be imported only by the server from which it was copied. 

• As an exact full copy that can be loaded onto a similarly configured server. This is typically used 
to move a configuration from a test server to a production server. 

• As a generic configuration template that can be loaded on any server.  This contains the 
general call flow layout, but without server-specific information, such as workgroup names, 
user names, or audio files.  The resulting file can be loaded onto a server and customized to 
match the destination server.  This option does not require servers to be identically 
configured.  It is geared for partners and administrators who manage multiple sites. 

Import opens a configuration file for editing in Attendant 

Import reads a configuration file (or package) from disk into Attendant for editing.  Import does not 
automatically replace the server's running configuration.  You must explicitly publish it. 

Load Active Configuration 

Load Active Configuration abandons the changes that you have made and loads the configuration that 
is currently active and taking calls on a server. 

Publish puts the loaded configuration into effect 
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When you edit a configuration, you can publish it to put changes into effect.  Partial or unfinished 
configurations can be exported for later editing.  If you connect to a configuration that has been locked 
by another user, you can still use Attendant to edit the configuration, but you cannot publish it.  When 
you finish making changes, you can export them to disk, and import them later. 

Disconnect closes the connection to the server, and its configuration 

When you disconnect from a server, Attendant's connection to its Notifier subsystem is released, your 
lock on the data (if any) is removed, and the configuration is removed from the tree structure.  If you 
disconnect without saving changes first, Attendant provides an opportunity to save your work. 

Related Topics 

• Stale Lock Dialog 

• Same User Lock Dialog 

Publish a Configuration 
The Publish command saves loaded call flow configurations, and puts them into effect immediately. 

Scope of Publish Command 
 
If more than one configuration is loaded, care must be taken not to publish a configuration 
unintentionally.  The publish command applies to all loaded configurations unless you use the 
Servers dialog to restrict publishing to specific servers.  (See publish selected configurations below.) 

Publish a Single Configuration 

If only one configuration is open for editing, follow these steps to publish changes: 

1. Pull down the File Menu and select Publish, or press the Publish toolbar button ( ).  The 
Publish confirmation dialog appears: 
 

 
2. Press Yes to proceed.  Published changes go into effect immediately.  Publishing updates 

System and Application logs.  When a configuration is published, Attendant records 
publishing errors, warnings, and other problems to the System Error log.  It also adds entries 
to the Application log, to note user name, station name, time, and the profiles and schedules 
that changed. 

Publish Selected Configurations 

If more than one configuration is loaded in the tree, you should use the Manage Servers command to 
select a subset of servers to publish: 

1. Pull down the Edit menu and select Manage Servers.  
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2. Ctrl-click in the server list to select the names of servers that you with to update.  Then press 
the Publish button. 

Locked Configurations 

You cannot publish if the Server configuration is locked by another user.  When you connect to a 
server, Attendant displays the Attendant In Use dialog if someone else is updating its auto-attendant 
configuration.  

It indicates this by displaying a padlock icon ( ) next to the Server node in the tree.  In this 
situation, you can edit the configuration and export it to a file, but you cannot publish since the 
configuration is locked by someone else. 

Publishing Errors 

If you modify a configuration and introduce errors, Interaction Attendant won't allow you to publish 
until all errors are fixed.   The following message is displayed if you attempt to publish settings that 
contain errors: 

 
In the actual dialog, <Servername> is replaced by the name of your CIC server, and <Call Flow Type> is 
replaced by Inbound Call Configuration, Outbound Call Configuration, or Operator Call Configuration. 

Tip—If you hover the mouse cursor over a node that has an error indicator, Interaction 
Attendant will display a tool tip that describes the error condition.  

If you must stop working in Attendant, you can save the broken configuration as an Attendant 
Configuration File, using the File | Export File command.  Later, when you have time to fix the 
problem, you can reload the configuration using the File Import command, fix the problems, and 
publish changes. 

Related Topics 

• Manage Configuration Files 

• Visual Indicators in the Tree 

• Stale Lock Dialog 

• Import Files 

• Servers Dialog 

Import Files 
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The Import command imports a call flow configuration or package.  If you do not have appropriate 
modify rights, Interaction Attendant will create a new profile instead of overwriting an existing one. 

To import a package file: 

1. Open the File menu and select Import File, or press the Import from File button ( ) on the main 
toolbar.  

2. When a standard File Open dialog appears, select an Attendant package (*.atp) to import.  Then 
press Open. A message appears, asking if you want to overwrite the existing profile. 

 
3. To overwrite the existing profile, click the Yes button. 

4. To create a new profile, click the No button.  Attendant prompts for the location in the tree 
where the file's contents will be inserted. Use the list box to select this.  Press OK. 

 
5. Attendant displays a dialog to confirm that the contents of the external file were inserted: 

 
6. Press OK to dismiss this dialog.  

To import an Attendant configuration file: 
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1. Open the File menu and select Import File, or press the Import from File button ( ) on the main 
toolbar.  

2. When a standard File Open dialog appears, select an Attendant configuration file (*.att).  Then 
press Open. The remaining steps apply only if you are importing a configuration file: 

3. Attendant analyzes the file to determine the type of configuration data that it contains.  The 
prompt that appears next depends upon the type of backup information found in the 
file.  Attendant recognizes three backup types: 

• Backup configuration files contain server-specific information that must be imported by the 
same server.  If you are importing this type of file, skip to Step 4. 

• Full configuration files contain an exact copy of one server's configuration that can be loaded on 
to an identically configured server.  This is designed to move a configuration from a test server 
to a production server.  The source server must be identical to the destination server in terms of 
line names, workgroup names—everything except server name and password. If you are 
importing this type of file, skip to Step 5. 

• Configuration Template files contain generic configuration data that can be loaded onto any 
server.  This file type contains the general Attendant layout, but without server-specific 
information, such as workgroup names, user names, or audio files.  The resulting file can be 
loaded onto a server and customized to match the destination server.   This option is geared for 
partners and administrators who manage multiple sites.  It does not require servers to be 
identically configured.  If you are importing this type of file, skip to Step 6. 

4. If the file is a Backup configuration, Attendant prompts for confirmation. 

 
 
Press Yes to replace the loaded configuration with the contents of the file, or press No to cancel. 
Remember – loading a configuration has no effect on the server until it is published. Attendant 
displays a dialog to confirm the backup configuration was inserted: 

 
Press OK to dismiss the dialog. 

Attendant will not import a configuration for a server that is unreachable on the 
network.  This prevents it from crashing while trying to disconnect from a non-existent 
server.  If it cannot locate the specified server, it alerts the user and aborts the import 
operation.  

5. If a Full Configuration is detected, Attendant prompts for a server to connect to, since 
the file does not contain any information about the origin of the data.  It displays a 
dialog that lists connected server configurations. 
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Select a destination server from this list, or select <Other> to connect to an unlisted 
server.   When Other is selected, the configuration is loaded into another server, leaving 
the configuration of currently connected servers intact.  If you choose an existing 
connection, you are asked to confirm the import operation: 

 
 
Select Yes to import the Full Configuration, or select No to cancel the import 
command. Attendant displays a dialog to confirm the configuration was inserted: 

 
 
Press OK to dismiss this dialog. 
 
When a Full Configuration is imported, Attendant flags nodes that are in error due to 
missing prompt files, differences in workgroup settings, etc.  For example, if a wave file 
was recorded on the test server and does not exist on the production server, Attendant 
would flag that node so that you can recreate the prompt on the production 
server.   Another example might be a workgroup that is named Support on one CIC 
system, but is called Customer Support on the other. 

6. If a configuration Template is detected, Attendant prompts for a server to connect to, 
since the file does not contain any information about the origin of the data.  It displays a 
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dialog that lists connected server configurations. 

 
 
Select a destination server from this list, or select <Other> to connect to an unlisted 
server.  If you choose an existing connection, you are asked to confirm the import 
operation: 

 
 
Select Yes to import the configuration template, or select No to cancel the import 
command.  Attendant displays a dialog to confirm the template was inserted: 

 
 
Press OK to dismiss this dialog. 
 
When a template is imported, Attendant recreates the call flow tree exactly, but any 
item of information that is server-specific (user names, workgroup names, audio files, 
skills, etc.) is left blank.  Incomplete nodes are flagged as errors, so that you can 
customize these nodes to match the destination server. 
 
Starting with Attendant 2.4, the import feature was enhanced to display information 
about the type of data imported; whether it was a server-specific backup, full 
configuration, or template file. Attendant displays an import results message when the 
import ends.  

• If a backup configuration was imported, the message indicates which server the 
user is connected to and the account used to log in. 
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• If a full configuration was imported, the message indicates whether the full 
import was successful. 

• If a template was imported, it tells you that it was a template import and 
describes the information that must be supplied before the configuration can be 
published. 

7. Resolve errors, if any are visually indicated in the tree. 
 
Import loads a configuration file into the interface for editing.  You must use the Publish 
command to "activate" imported configurations.   If the imported .att file contains 
information about other servers, those configurations are loaded into Attendant's user 
interface.  

Scope of Publish Command 
 
Care must be taken not to publish a configuration unintentionally.  The publish 
command applies to all loaded configurations unless you use the Servers dialog to 
restrict publishing to specific servers. 
 
To publish configurations for all servers displayed in the user interface, select 
Publish from the File menu or press the  (Publish) button on the main toolbar. 
 
To publish configurations for selected servers, pull down the Edit menu and select 
Manage Servers.  Ctrl-click in the server list to select the names of servers that you 
with to update.  The press the Publish button. 

Related Topics 

• Visual Indicators in the Tree 

• View information about an error 

• Error Resolution 

• Export a Configuration File 

Load Active Configuration 
Attendant allows you to load the active configuration that is running on a server.  Follow 
these steps to abandon the changes that you have made and load the configuration that 
is currently active and taking calls on a server: 

1. Select the server node in the tree view. 

2. Pull down the Edit menu and select Load Active Configuration.  This command is 
disabled unless a server node is selected and some part of its configuration has 
changed.  

Export a Configuration file (entire call flow) 
The Export command saves call flow configurations in Attendant configuration (*.att) 
files.  Export saves the entire inbound, outbound, or operator call flow that is open for 
editing.  If you want to export a portion of the call flow, use the procedure described in 
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export a package file.  A future release of Attendant may export all three call flow types 
at once.  Right now, you must export different call flows separately. 

At export time, Attendant prompts you to select the amount of server-specific 
information to include in the export file.  This configures the export file for use as a 
server-specific backup, portable "full" configuration, or as an application template.  

1. Start Attendant and connect to call flows you want to export. 

2. Pull down the File menu and select Export File.  The Export Wizard appears, 
prompting for the type of export: 

 
Backup creates a server-specific configuration file that can be imported only by 
the server from which it was exported.  This type of export saves server name, 
username, and password in the export file.  You can Backup more than one server 
at a time.  Its functionality is identical to backups that could be performed in 
releases of Attendant prior to release 2.3. 

Full Configuration exports an exact copy of one server's configuration that can be 
loaded onto any other server.  This saves the entire server configuration, except 
for the server name, login ID and password.  This makes it possible to move a 
configuration from a test server to a production server.  The test server must be 
identical to the production server in terms of line names, workgroup names—
everything except server name and password. 

When the file is imported, Attendant prompts for a server to connect to, since 
the file does not contain any information about the origin of the data.  Attendant 
analyzes the configuration and flags nodes that are in error (due to missing 
prompt files, differences in workgroup settings, etc.).  For example, if a wave file 
was recorded on the test server and does not exist on the production server, 
Attendant would flag that node so that you can recreate the prompt on the 
production server. 

Configuration Template exports a generic configuration that can be loaded onto 
any server.  This export type saves the general Attendant layout, but does not 
save server-specific information, such as workgroup names, user names, or audio 
files.  The resulting file can be loaded onto a server and customized to match the 
destination server.   This option is geared for partners and administrators who 
manage multiple sites.  It exports a general configuration that does not require 
servers to be identically configured.  

For example, a workgroup might be named Support on one CIC system, and 
Customer Support on another.  When the template is imported, Attendant 
recreates the call flow tree exactly, but any piece of information that could be 
server-specific (user names, workgroup names, audio files, skills, etc.) is left 
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blank. Incomplete nodes are flagged as errors, so that you can customize these 
nodes to match the destination server.  Configuration templates allow developers 
to build custom solutions for customers, or to deploy an IVR interaction to many 
servers in an organization. 

A backup export can save configurations for multiple servers.  Full 
Configuration and Configuration Template exports apply to a single server 
only. 

2. Follow the on-screen instructions as prompted by the Export Wizard. 

Related Command Line Parameters 

Full and backup configuration export modes can be specified when starting 
Attendant using optional command line parameters. The command line options 
for specifying configuration export are: 

• /export=[filepath] exports a backup configuration, where [filepath] is 
replaced with the full path and filename to which you want to export 
the backup configuration. 

• /fullexport=[filepath] exports a full configuration, where [filepath] is 
replaced with the full path and filename to which you want to export 
the full configuration. 

Related Topics 

• Export Wizard 

• Import Files 

• Publish a configuration 

• Servers Dialog 

Export a Package file (portion of call flow) 
The Package command exports part of a call flow to a file.  If you wish to export 
an entire call flow, see export a configuration file.  When a portion the call flow 
is saved to disk, the resulting file is called a package. A package is a sub-section 
of a tree that contains a node along with all of its children, grandchildren and so 
on. For example, a package might contain a profile, a schedule, a complex action 
node, or any other combination of call flow logic. 

Use packages to move portions of a call flow from a test environment to a 
production server, or to create "template" call flows that can be imported onto 
another CIC server and then customized. 

1. Start Attendant and connect to call flows you want to package. 

2. Select a node in the tree to export. 

3. Pull down the File menu and select Package, or… 
 
press the Package toolbar icon ( ), or… 
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right-click the selected node and choose Package from the context 
menu. 

4. The Export Wizard appears to prompt for the type of export.  Select Full 
Configuration or Configuration Template.  Then press the Next button to 
proceed. 

Full Configuration 

Creates a package file that contains an exact copy of the selected nodes' 
configuration. This package option is useful for moving part of a call flow 
from a test environment to a production server. 

Configuration Template 

Creates a package file that contains a generic copy of the selected nodes' 
configuration. The package will contain the general Attendant layout of 
the selected nodes, but will not contain any server specific information 
such as workgroup or user names, or audio files. This option can be used 
to create a template call flow that can be loaded onto a server and then 
customized. 

5. When the Save dialog appears, specify a filename and path. Package 
files have an .atp extension.  Press Finish to create the file. 

Related Topics 

• Export Wizard 

• Import Files 

Manage Speech Recognition 

Working with Speech Recognition 
In Interaction Attendant, you can set up and configure speech recognition to 
offer callers the ability to navigate the IVR by verbally communicating their 
choices instead of (or in addition to) using a keypad to enter choices 
numerically. 

For example, if a caller wants to find the balance on a credit card account, he or 
she might hear one of the following: 

• “To hear your current balance, press 1.” 

• “To hear your current balance, say ‘Balance’.” 

• “To hear your current balance, press 1 or say ‘Balance’.” 

Speech engines defined by your administrator match a caller’s spoken audio to 
menu operations you configure with keywords and phrases, and Interaction 
Attendant transfers the caller to the appropriate destination. 

In some cases, callers might use different terms to refer to a department or 
choice. For example, “customer service”, “customer support”, and “support” 
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may all be contained in one department. You can add multiple keywords and 
phrases to increase the speech engine’s ability to find an appropriate match to 
the caller’s request. 

To get started 

1. Enable Speech Recognition at the Profile level: Before you can use the 
speech recognition feature, you must first enable it at the profile level. 

2. Configure Speech Recognition for Schedules and Menus: Next, at the 
schedule or menu level, optionally configure such settings as confidence 
levels, timeouts, and prompts to play when the speech engine does not 
recognize the spoken audio or finds multiple matches. By default, these 
settings use the configured parameters set by your administrator in 
Interaction Administrator. 

3. Add keywords or phrases to Speech Recognition in Inbound Call 
Operations:  Finally, in each inbound call operation included in the 
schedule, set up keywords and phrases. You can also select the 
language to use, and which node to navigate to if the speech engine 
locates a match anywhere in the schedule. 

Speech Recognition overview 
With Interaction Attendant’s speech recognition feature, you can designate words and phrases 
associated with any schedule, profile, or menu node for inbound calls, providing callers the ability to 
verbally select the options they want, rather than using the telephone keypad to navigate the IVR. You 
can select a speech engine to compare a caller’s spoken audio to a list of keywords or phrases. Speech 
engines are added and configured by your administrator in Interaction Administrator. 

When you configure a schedule or menu in Interaction Attendant, you can define one of the following 
options to present to callers who enter that schedule or menu: 

• Specify the numerical key a caller presses to select the schedule or menu item 

• Set speech recognition to interpret a caller’s verbal selection 

• Provide both numerical and verbal options, giving users the choice of using the keypad or verbally communicating which menu they 
want to reach 

Speech Recognition default settings 
Your administrator configures the Interaction Attendant speech recognition settings in Interaction 
Administrator. Here, the administrator defines such parameters as minimum confidence levels, 
timeouts, audio prompts played to the caller if the speech engine cannot determine the caller’s 
selection, manage custom attributes, and record notes about configuration settings and changes. If you 
have the appropriate rights, you can override these default settings for any schedule or menu. 

Enable Speech Recognition 
Before you give callers the ability to verbally indicate their menu selections, you must first make speech 
recognition available on menus. To enable speech recognition, open the desired profile and select the 
Configure Speech Recognition button. By default, speech recognition is enabled for the company 
directory only. If you choose to enable speech recognition on menus and also leave it enabled for the 
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company directory, callers will not be prompted to say the name of the person they want to reach. If 
you want to keep this option, you must modify the main greeting prompt to present the option to the 
caller. 

Configure Speech Recognition for Schedules or Menus 
If you have the appropriate rights granted by your administrator, you can override the speech 
recognition default settings at the schedule or menu level. Your administrator configures these settings 
in Interaction Administrator. For example, you can: 

• Adjust the minimum confidence level, or the highest scoring the phrase must receive to achieve a successful match. 

• Set the maximum time to wait after caller provides a valid speech input and stops talking before 
the system presents a positive match. 

• Choose the length of time to wait after caller stops talking and when the verbal selection is invalid before the system indicates no 
match is found. 

• Specify the length of time allotted to the caller to make his or her verbal selection before the system times out and either prompts 
the caller to make a selection or disconnects the call. 

• Select which audio prompts the system presents to the caller when the speech engine cannot find a specific match and the order in 
which to play them. 

Configure Speech Recognition for Inbound Call Operations 
For every inbound call operation, you can enter keywords and phrases a caller might use to verbally 
indicate the location to which they want to transfer. You can choose from a list of languages and you can 
enter multiple words and phrases, particularly useful if callers use different terminology for the same 
destination. For example, callers who want to reach the customer service department might say 
“customer service”, “customer support”, “support”, “product assistance”, and so on. If the speech 
recognition engine finds multiple matches to a caller’s request, or if it does not find an appropriate 
match, Interaction Attendant begins the invalid or ambiguous input prompt sequence to give the caller 
the opportunity to narrow down a selection or clarify his or her choice. 

  

  

Enable Speech Recognition for a Profile 

Speech recognition is enabled at the profile level. Before you give callers the ability to verbally indicate 
their selection, you must first make speech recognition available on menus. 

To enable speech recognition for schedules and menus in a profile 
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1. Select the desired profile and click Configure Speech Recognition. The Speech Recognition 
Configuration dialog box for Profiles opens: 

  

2. Select the Enable speech recognition on menus check box. 

3. Optionally clear the Enable speech recognition for company directory check box. 

Note: By default, speech recognition is enabled for the company directory. If you choose to 
enable speech recognition on menus and leave it enabled for the company directory, callers 
will not be prompted to say the name of the person they want to reach. 

To keep both options selected and direct the system to ask callers to say the name of the 
person or department they wish to transfer to, you must modify the main greeting 
prompt to include this option for the caller. You can re-record the prompt in the profile’s 
Profile Greeting area.  If your prompts are professionally recorded, obtain an updated 
recording from the recording company and place it in the Attendant audio files directory 
on the CIC server (usually \I3\IC\Resources\InteractionAttendantWaves). 

4. Optionally select a speech engine from the Speech engine drop-down list. 

5. Click OK. 

  

Configure Speech Recognition for Schedules and Menus 
If you have the appropriate rights granted by your administrator, you can override the speech 
recognition default settings configured in Interaction Administrator. For example, you can: 

• Minimum confidence level: Adjust the minimum confidence level, or the highest scoring 
the phrase must receive to achieve a successful match. 

• Complete timeout: Set the maximum time to wait after caller provides a valid speech 
input and stops talking before the system presents a positive match. 

• Incomplete timeout:  Choose the length of time to wait after caller stops talking and 
when the verbal selection is invalid before the system indicates no match is found. 

• Speech timeout. Specify the length of time allotted to the caller to make his or her 
verbal selection before the system times out and either prompts the caller to make a 
selection or disconnects the call. 
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• Invalid or ambiguous input prompt sequence: Select which message or messages the 
system presents to the caller, and the order in which to play them, when the speech 
engine cannot find a specific matchand the order in which to play them. 

To configure speech recognition for schedules and menus 

1. Select the desired schedule or menu and click Configure Speech Recognition. The 
appropriate Speech Recognition Configuration dialog box opens (for menus, click the 
Menu Settings tab): 

 
Speech Recognition Configuration dialog box for Schedules 
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Speech Recognition Configuration dialog box for Menus 

2. Select the preferred confidence and timeout levels: 

• In the Minimum confidence level area, clear the Use default check box and use the up 
and down arrows to select the scoring percentage the phrase must receive to achieve a 
successful match. 

• In the Complete timeout area, clear the Use default check box and use the up and down 
arrows to select the maximum time in seconds to wait after caller provides a valid 
speech input and stops talking before the system presents a positive match. 

• In the Incomplete timeout: area, clear the Use default check box and use the up and 
down arrows to select the length of time to wait after caller stops talking and when the 
verbal selection is invalid before the system indicates no match is found. 

• In the Speech timeout area, clear the Use default check box and use the up and down 
arrows to select the length of time allotted to the caller to make his or her verbal 
selection before the system times out and either prompts the caller to make a selection 
or disconnects the call. 

3. Configure which messages and in what order to play them when the speech recognition engine 
does not recognize the caller’s verbal request: 
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• In the Invalid or ambiguous input prompt sequence area, clear the Use default check 
box. 

• In the Invalid or ambiguous input prompt sequence area, clear the Use default check 
box. 

• To add a prompt, click Add and in the Add Audio Prompt dialog box, click the arrow at 
the end of the drop down list, select a prompt, and click OK. Or click the Browse button 
to search for the desired prompt and then click OK. 

• To remove a prompt, select the prompt from the list and click Remove. 

• To change the order in which the prompts are played to the caller, select the prompt 
and click Move Up or Move Down until the prompt is placed in the desired position. 

4. To save your changes and close the Speech Recognition Configuration dialog box, click 
OK.  

Add Speech Recognition keywords or phrases for Inbound Call Operations 
For every inbound call operation, you can enter keywords and phrases a caller might use to 
verbally indicate the location to which they want to transfer. You can choose from a list of 
languages, and you can enter multiple words and phrases, particularly useful if callers might use 
different terminology for the same destination. For example, callers who want to reach the 
customer service department might say “customer service”, “customer support”, “support”, 
“product assistance”, and so on. You can also direct the system to immediately send the caller 
to the current node if the speech recognition engine matches the verbal request anywhere 
within the current schedule. See To configure speech recognition for inbound call operations 
below. 

If the inbound call operation is a menu, you have the additional option to modify confidence 
levels, timeouts, and which messages and in what order to play them when the speech 
recognition engine does not recognize the caller’s verbal request. See To configure speech 
recognition for menu operations below. 

To configure speech recognition for inbound call operations 
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1. Select the desired inbound call operation and click Configure Speech Recognition . The 
Speech Recognition Configuration dialog box for inbound call operations opens: 

 
2. To change the default language for speech recognition, click the arrow at the end of the 

Language drop-down list and select the desired language. 

3. To add a keyword or phrase, type the word or phrase in the blank field below the 
Language drop-down list and click Add or press Enter on the keyboard. 

4. Repeat step 3 for each keyword or phrase you want to add. 

5. To remove a keyword or phrase, select the word or phrase from the list and click 
Remove. 

6. To immediately send the caller to the current menu operation if the speech recognition 
engine matches the verbal request anywhere in the current schedule, select the If 
matched anywhere in this schedule, jump to this node check box. 

7. To save your changes and close the Speech Recognition Configuration dialog box, click 
OK.  

To configure speech recognition for menu operations 
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1. Select the desired menu and click Configure Speech Recognition. The Speech 
Recognition Configuration dialog box for menu operations opens: 

 
2. On the Keywords/Phrases tab, to change the default language for speech recognition 

click the arrow at the end of the Language drop-down list and select the desired 
language. 

3. To add a keyword or phrase, type the word or phrase in the blank field below the 
Language drop-down list and click Add or press Enter on the keyboard. 

4. Repeat step 3 for each keyword or phrase you want to add. 

5. To remove a keyword or phrase, select the word or phrase from the list and click 
Remove. 

6. To immediately send the caller to the current menu operation if the speech recognition 
engine matches the verbal request anywhere in the current schedule, select the If 
matched anywhere in this schedule, jump to this node check box. 

7. To configure confidence levels, timeouts, and which messages and in what order to play 
them when the speech recognition engine does not recognize the caller’s verbal request 
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click the Menu Settings tab: 

 
8. Select the preferred confidence and timeout levels: 

• In the Minimum confidence level area, clear the Use default check box and use the up 
and down arrows to select the scoring percentage the phrase must receive to achieve a 
successful match. 

• In the Complete timeout area, clear the Use default check box and use the up and down 
arrows to select the maximum time in seconds to wait after caller provides a valid 
speech input and stops talking before the system presents a positive match. 

• In the Incompletetimeout: area, clear the Use default check box and use the up and 
down arrows to select the length of time to wait after caller stops talking and when the 
verbal selection is invalid before the system indicates no match is found. 

• In the Speech timeout area, clear the Use default check box and use the up and down 
arrows to select the length of time allotted to the caller to make his or her verbal 
selection before the system times out and either prompts the caller to make a selection 
or disconnects the call. 
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9. Configure which messages and in what order to play them when the speech recognition 
engine does not recognize the caller’s verbal request: 

• In the Invalid or ambiguous input prompt sequence area, clear the Use default check 
box. 

• To add a prompt, click Add and in the Add Audio Prompt dialog, click the arrow at the 
end of the drop down list, select a prompt, and click OK. Or click Browse to search for 
the desired prompt and then click OK. 

• To remove a prompt, select the prompt from the list and click Remove. 

• To change the order in which the prompts are played to the caller, select the prompt 
and click Move Up or Move Down until the prompt is placed in the desired position. 

10. To save your changes and close the Speech Recognition Configuration dialog box, click 
OK.    

Configure Remote Monitoring 
Remote monitoring allows a Supervisor to continuously listen, from a remote location, calls sent 
to queues that the Supervisor has rights to monitor.  For more information about continuous 
listening, see Listen to a Call in a Queue in the Interaction Desktop help. 

To enable remote monitoring, Interaction Attendant users must make several modifications to 
menu nodes and handlers. Use the following procedure: 

1. In Interaction Attendant, open the Profile and Schedule node from you want to enable 
remote monitoring login. 
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2. Add a new menu node, and name it Remote Monitoring Menu. Give it the properties 
shown below. 

 
3. Add a Subroutine Initiator node that calls the Remote Monitoring Menu when the user 

presses pound, as shown in the figure below.  Type " SystemIVRChooseQueue" in the 
Subroutine field. 

Note—in this example, the user has chosen to have users press ## to launch the 
subroutine (once for the first menu, and once to launch the subroutine in the node 
beneath. 
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4. Save and publish your changes.  Then close Interaction Attendant. 

5. Open Interaction Designer, and edit the CustomSubroutineInitiatorRouter 
handler from your \IntAttHandlers directory.  

6. Add a new selection to step three that starts when Interaction Attendant 
generates a subroutine call where SubroutineName=" 
SystemIVRChooseQueue", as shown in the following figure. 

 

7. Link that to a call to the SystemIVRChooseQueue subroutine, located in your 
nnHandlers directory (such a andlers), as shown in the figure below. 

8. In the properties for SystemIVRChooseQueue step, map the Input Call ID to the 
Call1 variable in CustomSubroutineInitiatorRouter. Map the Output Transferred. 

9. Save and publish the handler.  Now when a Supervisor calls into the new menus 
and presses ##, the SystemIVRChooseQueue subroutine gets his or her login 
information and selects a queue from among those the user has rights to 
monitor. 

Disconnect from a Server 
Disconnect releases the Notifier connection between Interaction Attendant and a Customer Interaction 
Center server.  The Notifier is a Customer Interaction Center module that acts as a communication 
center for all other modules.  It listens for events generated by other modules and "notifies" other 
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modules that an event has occurred.  The disconnect command tells Interaction Attendant to "log out" 
of its session with a server.  Disconnect does not close Attendant.  

This option is disabled in the Edit menu unless a Server node is selected in the tree. 

Disconnect removes a server form and all of its child nodes from the tree view.  The option to 
disconnect is enabled when a server form is selected in the tree. 

1. Click the server node in the tree view that you want to disconnect. 

2. Issue a disconnect command using any of the following methods: 

• Pull down the File menu and select Disconnect 

• Pull down the Edit menu and select Disconnect Server 

• Press the Disconnect Server button ( )on the main toolbar 

• To disconnect from multiple servers at once, pull down the Edit menu and select Manage 
Servers.  When the Manage Servers dialog appears, select servers to disconnect by alt-clicking 
entries in the list.  Then press the Disconnect button. 

3. The Save Changes dialog will appear for each server whose configuration has changed.   Use 
pushbuttons on this dialog to publish, discard, or export configuration data.  You can also cancel 
the disconnect operation. 

Related Topics 

• Login Dialog 

• Manage Servers Dialog 

Exit Attendant 
The Exit command closes Attendant immediately if no configuration data has changed.  This command is 
invoked using one of the following methods: 

• Pull down the File menu and select Exit. 

• Close the Attendant window. 

• If configuration data was changed and has not been published, Attendant displays the Save 
Changes dialog, so that you can publish, abandon, or export configuration data, or cancel the 
shutdown process. 

Set up Skills-based routing in Attendant 
Skills-based routing can be performed by Attendant once skills have been assigned to individual users in 
Interaction Administrator. 

1. In Attendant, add a Transfer to a Workgroup or Station group node. 

2. Press the "Advanced Workgroup Settings" button. 

3. Check skills that an agent must have to receive the interaction. Then press OK to dismiss the 
dialog. 
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4. From now on, calls routed to the workgroup specified in the "Group Transfer" step, will only be 
routed to agents in that workgroup who possess the skills you selected. 

Set Up Voice Mail Distribution in Attendant 
Use this procedure to configure a workgroup distribution list for voicemail distribution in Attendant: 

1. In Interaction Administrator, set up a work group with no Queue. 

2. Set up the work group to use a Mail box. 

3. Open Attendant and create a new profile that includes a Transfer to Voice mail operation. 

4. Set it as the Default action for the profile and remove any greetings. 

5. Select the newly created work group from the Transfer To section. 

6. Now go back to IA and change the work group back to 'No Mailbox' and remove anything in the 
Display name. 

7. Add a new Server parameter: Workgroup Distribution List Behavior and set the value to True. 

8. Add users to the workgroup and deactivate them from it. 

User Interface Options 

User Interface Options 
This section contains a topic for each property page and dialog in Interaction Attendant.  It explains the 
options you can configure for server, profile, schedule, and operation nodes. 

• A server node is a conceptual device that Attendant uses to organize configuration data. When 
you connect to a CIC server, Attendant adds a Server node for that server to the tree.  Server 
nodes are the highest-level nodes in the tree.  These nodes do not display editable 
information.  Instead, they work like folders to organize configuration data for a CIC server.   

• A profile is a collection of predefined call characteristics that Attendant compares to a call, to 
decide whether to select it for processing.   

• A schedule stipulates when a menu can run, based upon the date, time, or special event. 

• Operations are actions that Interaction Attendant performs, usually in response to a user key 
press.  Operations are added below schedule nodes to create menus.  

Servers 
When you connect to a CIC server in Attendant, it adds a Server node for that server to the 
tree.  Attendant adds a Server node automatically if it can authenticate an existing Notifier connection 
or your NT credentials. 
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A Server node is a conceptual device that Attendant uses to organize configuration data.  Server nodes 
are the highest-level nodes in the tree.  These nodes do not display editable information.  Instead, they 
work like folders to organize configuration data for a CIC server.  You can quickly show or hide child 
nodes of a server form by double-clicking a Server icon in the tree view.  Nodes below the Server node 
filter calls to process and select the timeliest menu to process the call. 

To view nodes for a CIC server in the tree view, you must connect to the server.  

If you run Interaction Attendant and the tree is empty or does not display a node for the server that 
you wish to configure, you must establish a connection between Interaction Attendant and the desired 
CIC server.  See connect to a server for details. 

Once you are connected to a CIC server, its schedules, profiles and menus will appear below the Server 
node.  If you connect to more than one server, nodes for each server appear as siblings in the tree.  

Server nodes are particularly helpful when Interaction Attendant is connected to several servers at one 
time.  A Server node contains all profiles, schedules and operations that are defined for a connected 
server, for a given call flow (inbound, outbound, or operator). 

The property sheet for a Server does not contain any configurable settings.  It displays the name of the 
server, and the type of call configuration that is displayed in the tree. 

Related Topics 

• Profiles 

• Schedules 

• Operations 

• Dialogs 

Profiles 

Profiles 
Key Concept 
 
A profile is a collection of predefined characteristics that Attendant compares to an interaction, to 
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decide whether to select the profile for processing.  Profiles don't have to be very specific.  They 
can examine a wide range of incoming characteristics.  For example, inbound call profiles support 
wildcards and examine a combination of ANI, DNIS, and line criteria.  When a profile is evaluated, 
the logical OR operator is used.  If more than one criterion is specified, the interaction matches the 
profile if any of the profile's criteria are met. 

Overview 

When interactions such as telephone calls or emails come into Attendant, they are filtered by 
profiles.  Information about the interaction is compared to predefined characteristics defined in 
profile nodes. The interaction is processed by the custom profile that matches the interaction or by a 
default profile if the interaction does not match user-defined custom profiles.  

The default profile matches all interactions that get past custom profiles. Default profiles do not 
contain specific filtering criterion.  Custom profiles contain predefined characteristics that Attendant 
compares to an interaction, to decide whether to select the profile for processing. 

After a profile match is performed, the schedules attached to the selected profile are evaluated. Since 
processing logic is attached to schedules, control is passed to logic that can most appropriately 
process the interaction. 

For example, an incoming call to the Marketing department is matched to a profile for Marketing's 
800 number. Schedules attached to that profile route the call to a selected menu, based upon 
whether or not the call was received during working hours, at night, or during a company holiday. 

Attendant analyzes interactions to select the best matching profile. This ensures that the interaction 
is processed by the most appropriate profile, schedule, and menu operation.  

Profile Types 

Attendant profiles examine criteria specific to the interaction type and call direction (inbound or 
outbound): 

• Inbound Call Profiles examine the number dialed, Caller ID data, and the line or line group 
that the call is on.  This can be used to filter calls based on the DNIS ("to") and ANI ("from") 
information on the call. 

• Operator Profiles examine the user queue, workstation queue, or Attendant Profile that the 
call arrived on. 

• Email Profiles compare the "To:", "Cc:", and "From:" fields in the Email message header to 
characteristics defined in the profile. 

• Outbound Profiles examine Call Analysis information, since outbound calls are already 
connected to a contact when the call is passed to Attendant.  Outbound call matching is 
based upon whether the call was answered by a live person, fax machine, or answering 
machine.  

Call Analysis is a CIC process that analyzes a connection to determine if the call reached a live 
person, a Fax machine, an answering machine, and whether or not an agent is available to process 
the call.  Outbound profiles use call analysis criteria to route calls based upon the type of party 
connected. 

Call Profiles 
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• Call Flow Configuration Switches 

• Default Inbound Call Profile 

• Custom Inbound Call Profile 

• Default Outbound Call Profile 

• Custom Outbound Call Profile 

• Operator Profiles 

• Default Operator Profile 

• Custom Operator Profile 

Email Profiles 

• Email Default Profile 

• Email Custom Profile 

Other 

• Schedules 

• Operations 

• Dialogs 

Call Profiles 

Call Profiles 
When telephone calls come into Attendant, they are filtered by inbound or outbound call profiles.  

Inbound call profiles compare DNIS ("to") and ANI ("from") information about the call with 
predefined call characteristics defined in the profile, as well as the line or line group that the call is 
on.  The call is processed by the custom profile that matches the call, or by a default profile that 
Attendant uses to process calls that don't match user-defined profiles.  You can customize a default 
profile to play a wave file, but its filtering criteria are disabled.  This insures that the default profile 
will match all calls that get past your custom profiles. 

Outbound profiles examine calls analysis information, since outbound calls are already connected to 
a contact when the call is passed to Attendant.  Outbound call matching is based upon whether the 
call was answered by a live person, fax machine, or answering machine.  

Call Analysis is a CIC process that analyzes a connection to determine if the call reached a live 
person, a Fax machine, an answering machine, and whether or not an agent is available to process 
the call.  Outbound profiles use call analysis criteria to route calls based upon the type of party 
connected. 

Default Inbound Call Profile 
Calls come into a server and then are filtered by profiles.  Information about the call is compared to 
call characteristics defined in profile nodes.  The call is processed by the custom profile that matches 
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the call, or by a default profile that Attendant uses to process calls that don't match user-defined 
profiles.  Interaction Attendant creates a default profile automatically for each call flow.  A default 
profile cannot be deleted.  The default profile is used when: 

• It is the only profile, or... 

• The characteristics of the incoming call do not match the criteria defined by any of your 
custom profiles. 

• You can customize a default profile to play a wave file, but its filtering criterion are 
disabled.  This ensures that the default profile always matches calls that get past your 
custom profiles.  The following options are always disabled on a Default Profile: 

Node Characteristics frame 

Name 

The name field is disabled so that the profile is always named Default Profile for easy identification. 

Active check box 

This check box is disabled, since default profiles are always available at runtime. 

Incoming Call Selection frame 

You cannot configure DNIS, ANI, Line, or Line Name values for a default profile. This is because the 
default profile is designed to pick up all calls that are not picked up by other profiles.  However, you 
can create custom profiles that filter calls by examining specific DNIS or ANI values, particular line 
groups, or individual line names.  

For information about other options on this form, see Custom Inbound Call Profile. 

Related Topics 

• Call Flow Configuration Switches 

• Custom Inbound Call Profile 

• Profiles 

• Schedules 

• Operations 

• Dialogs 

Custom Inbound Call Profile 
Custom inbound call profiles filter incoming calls by examining a range of incoming call 
characteristics.  Information about each call is compared to all inbound profiles to select the profile 
that matches the call.  If no match if found, the call is processed by a Default Inbound Call Profile. 

Note:  If the New Profile button ( ) on the toolbar is greyed out, or the New Profile option 
located in the Insert menu is unavailable, you do not have the appropriate rights to create a 
new profile.  See your administrator for information about obtaining your profile rights. 
 However, if your Administrator grants you the appropriate rights to create a new profile, Interaction 



Custom Inbound Call Profile 

106 

Attendant also automatically gives you the right to modify the profile.  This feature allows you to edit any 
profile you create. 

Node Characteristics frame 

Options in this frame name the profile, establish whether or not it is active, logged, or tracked for 
IVR reporting purposes.  Unlike operation nodes, profiles cannot be assigned a digit, since profiles 
are always compared to the characteristics of a call.  

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Profile names should not contain the name of a workgroup 

Please ensure that your profile name does not contain the name of a 
workgroup.  If it does, a loop can occur, since the Find toolstep (step 162) in the 
InteractionAttendantEntryPoint handler checks the target workgroup name 
against profile names on a voicemail transfer request. 

For example, a profile named "Acme - 1234" with only a Default Schedule which 
contains a single default action of transferring the caller to voicemail for 
workgroup "Acme" won't appear to work due to the find step in 
InteractionAttendantEntryPoint.  That part of the handler compares the target 
workgroup to all profile names. Since workgroup name "Acme" is embedded in the 
profile name "Acme - 1234",  the call will end up back at the profile which 
attempts to send it back to the workgroup's voicemail which sends it back to the 
profile. 

This behavior is intentional and is not a bug. It is part of a workgroup transfer 
overload feature that forces workgroup transfers to go through an Attendant 
profile beginning in the same name as the workgroup.  The feature is intended to 
allow a single place for defining ACD wait behavior no matter how the workgroup 
call is placed.   

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active checkbox, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore 
the form and its children.  Use this feature to save a configuration that you are testing.  Inactive 
forms are invisible to callers. When a node is inactive, it appears grayed out in the tree view. 
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Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the 
node and its children.  This option is hidden when Attendant is connected to a server that does 
not have reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 
Select the Configure Speech Recognition button to enable or disable speech recognition for the company directory, on menus, or 
both. By default, speech recognition is enabled for the company directory. If you choose to enable speech recognition on menus and 
leave it enabled for the company directory, callers will not be prompted to say the name of the person they want to reach. 

To keep both options selected and direct the system to ask callers to say the name of the person or department they wish to transfer 
to, you must add it to the main greeting prompt. For more information on configuring speech recognition at the profile level, see 
Enable Speech Recognition for a Profile. 

Profile Greeting frame 

Controls in this frame set a prompt to play when a call enters this profile. If you do not select or 
record a prompt using the embedded audio controls, no voice prompting will occur.   See manage 
voice prompts for details. 

 

Call Processing Style button 

 
This button opens the Call Processing Style dialog.  It determines whether calls are directed to a 
menu (Auto Attendant Processing) or to a User, Station, Workgroup queue, or operator profile 
(Direct to Queue Processing).  Auto Attendant Processing is used by default—inbound calls are 
directed to the menu attached to the best matching schedule.  In other words, Call Processing 
Style determines whether calls are directed to: 

• A menu attached to a schedule in this profile.  This is the default call processing behavior. 

• A user, station, or workgroup queue. 

• An operator profile. 

Language frame 
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Profiles make it possible to set a language based upon the line, line group, or number that was 
dialed (DNIS) or by examining the telephone number that was called (ANI). For example, you can 
create a profile that plays voice prompts in Spanish when a specific number is called (DNIS), or 
when preferred Spanish-speaking customers call from known telephone numbers (ANI).   

 

Language list box 

This option affects the language used to play back voice prompts.  It presents a list of languages 
defined on the IC server.  

• If a user selects a language from the list, that language becomes the current language 
used to play prompts. 

• If the user selects <Default>, prompts will be played using the server's default language. 

• If the user selects <Do Not Change>, the language that is currently set on the call won't 
be updated by this Profile.  For example, a caller might select Spanish in a menu.  If the 
call is routed back to this Profile somewhere down the line, the Profile would play the 
prompt using its language setting unless <Do Not Change> is selected.  This option tells 
the Profile not to change the language set by another node, if the call returns to the 
profile.  

Transfer Target option 

 

Allow calls to be transferred to this profile 

This checkbox determines whether or not Interaction Supervisor or Interaction Client users can 
transfer calls to this inbound Attendant profile.  Rather than open up the entire Attendant tree 
when calls are transferred, calls must be transferred into profiles, just like inbound calls. The call 
is then processed according to the profile's settings. 

If this box is checked, then users see the profile as a potential transfer target. Otherwise the 
profile is only available to inbound calls.  Profiles are not targeted by default.   

This feature allows operators to send calls into queues using Attendant, ensuring that both 
inbound callers and callers transferred into a queue have the same in-queue experience. For 
example, if there are customer service menus in Interaction Attendant before a call is sent to that 
workgroup's queue, users can intuitively transfer callers to the Customer Service Profile rather 
than directly into the queue. This way, callers will hear the same prompts and menus as other 
callers for that group.  

This feature is limited to inbound call profiles.  Users cannot transfer calls to operator profiles 
(except by transferring the calls to the operator) or to outbound profiles.  
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Incoming Call Selection frame 

This section of the page defines call characteristics that will be compared to the characteristics of 
an incoming call to determine whether it should be processed by this profile.  A Custom Inbound 
Call Profile can filter calls based upon DNIS, ANI, line, or line group information that is associated 
with each call.  

You can filter on any or all of these criteria at the same time.  If you check a checkbox, you must 
enter data in the associated field.  If you don't, a red exclamation point (!) will appear next to the 
profile in the tree.  If you move the mouse pointer over this node, tool-tip help will appear to 
explain the error. 

 

You can filter incoming calls based upon any combination of DNIS, ANI, or Line criteria.  At 
runtime, these are evaluated using the logical AND operator.  If more than one criterion is 
specified, the interaction matches the profile of all of the profile's criteria are met.  Telephone 
numbers must be entered without formatting, and may contain wildcards—see formatting help.  

ANI, DNIS, line, and line group information is evaluated before calls are answered.  Thereafter, 
that information is ignored.  For example, ANI/DNIS data is not evaluated when an error handler 
transfers a call to the menu associated with a profile.  If an Attendant profile is configured to 
route a call based on ANI, and if in the rare case that the DNIS numbers matches the ANI as well, 
the DNIS routing will take precedence over the ANI routing rule. 

The ANI and DNIS numbers sent by your phone company will usually contain between 4 and 
11 digits.  The DNIS string you receive may contain more or fewer digits than the ANI 
string.   Please consult with your System Administrator or Phone Company to find out how 
many digits to expect for your DNIS and ANI strings. 

Use this profile to process incoming calls with any of the following DNIS (the number 
the caller dialed) values 
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Dialed Number Identification Service (DNIS) is a feature of digital T-1 and ISDN lines (e.g. 800 
and 900 lines).  DNIS provides the telephone number that the caller dialed.  Knowing the dialed 
number allows Interaction Attendant to perform unique processing on the call, such as playing 
special messages or offering alternate menu choices.   

Suppose, for example, that a company offers two levels of technical support, silver and gold. 
Silver members call 555-1111, and Gold members call 555-2222.  In Interaction Attendant you 
would create a profile for each number. When callers dial 555-2222, their call is processed by 
profile for gold support. When callers dial 555-1111, their call is processed by the profile for the 
silver technical support. 

If your company's phone lines are configured to accept DNIS, you can configure a profile to play 
for a call dialed to that number. Ask your CIC administrator if your company's phone lines accept 
DNIS information; if so, he or she can provide a list of DNIS numbers.  You can then create a 
profile for one or more of these DNIS entries. If the number dialed does not match any of your 
DNIS profiles, the default profile is played.  You can assign DNIS or line name settings to each 
profile (except the default profile). 

You can assign more than one DNIS value to a profile. Separate individual values with 
a comma (8723000, 8723500) and specify a range with a hyphen (8723000-8723005). 
This is similar to specifying a page range when printing in most Windows application. 

If a call is transferred using Attendant extension dialing, then the call will be routed using 
the following order of precedence to resolve duplicate extensions and/or DNIS numbers in 
custom profiles: 
 
User -> Workgroup -> Station -> Stationgroup -> Profile 

Use this profile to process incoming calls with any of the following ANI (the number 
from which the caller is calling) values 

Automatic Number Identification (ANI) provides the caller's telephone number.  ANI is often 
called Caller ID.  By creating profiles for ANI values, you can: 

• Provide tailored menus to preferred clients or companies. 

• Route calls from employees to special menus. 

Use this profile to process incoming calls which arrived from this line or line group 

You can also filter based upon the line or line group that the incoming call came in on.  This list 
box displays lines and line groups that are defined for the current server. 

Handlers perform DNIS Lookup for Attendant 
 
This information is for advanced CIC users who are familiar with handlers—small programs 
in CIC that carry out tasks for Attendant and other systems.  The IntAttIncomingCall 
handler looks to see if the DNIS information for a call is associated with a profile. If the 
DNIS is matched to a profile, the call is placed on that profile. If one is not found, the 
IntAttIncomingCall handler looks for a matching line name. Failing that, the call is placed 
on the default profile in the currently scheduled menu.  If you want modify the DNIS value 
before it is evaluated by Interaction Attendant, CustomGetDNIS is the customization point 
in which you should make the changes. 
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Caution—Changing IntAttIncomingCall can cause Interaction Attendant to function 
incorrectly or not at all. Any customizations you make to DNIS modification should be 
created in the CustomGetDnis handler. 

Formatting Help button 

 

Telephone numbers must be entered without formatting.  When you press this button, you 
are provided with tips for using wildcards and for entering ranges.  See Formatting Help 
dialog. 

Formatting DNIS/ANI routing for SIP 
 
In a SIP/HMP environment, special care must be taken when formatting wildcards for 
ANI and DNIS profiles. Matches can fail when wildcards  are used, since Wildcard 
matching compares STRINGS and allows for ? to match. 
 
For example, 666666? does not match sip:6666666@domain.com, since the range 
matching looks at 6666666 part of the DNIS and treats it as a number. The Wildcard 
does not. In order to work correctly, the exact string needs to be entered in the DNIS 
routing: 
 
sip:666????@xxx.x.xx:5060 or sip:666????@domain.com:5060 
 
Range matching always works if you specify an exact telephone number (e.g. 4445555). 

Incoming call criteria is analyzed to find the best match 

To determine which profile best matches incoming call criteria, Interaction Attendant 
analyzes custom profiles to find the best match.  Suppose, for example, that you create a 
profile for All 800 numbers, and another for calls to one Customer Support number.  The 
example below illustrates how the profiles might look: 

 
When 800-432-8321 is called, the profile named "800 Customer Support" is a more specific 
match than "All 800 Numbers", so the profile for the specific number would be used when 
an incoming call comes in on that line. 



Default Outbound Call Profile 

112 

Speech Recognition frame 

Disable Speech Recognition check box 

Attendant Profiles are speech-enabled by default. This option disables the default dial-by-
name prompting with speech recognition, to prevent Attendant from barging in to prompt 
for a name to dial. When checked, the Attendant profile does not prompt for ASR input. 

This option is unchecked by default, so that ASR speech recognition is enabled, and 
prompting occurs.  Internally, this option sets a profile node attribute named 
"DisableSpeechRec" with a value of "Yes" or "No". If the attribute is not present (as in 
existing profile configurations), the profile defaults to unchecked so that prompting occurs. 

For more information about speech recognition, refer to these Technical Reference 
documents in the PureConnect Documentation Library: 

• Getting Started with Speech Recognition in CIC 

• Installing and Configuring ASR Technology 

Default Outbound Call Profile 
Outbound calls can be transferred to Attendant so that the connected party can interact with auto-
attendant menus.  Outbound call flows can route calls to users or groups, and may perform other 
operations (such as surveys) without requiring handler customization.  When Attendant receives an 
outbound call, it is already connected to a contact.  

For example, a doctor's office might set up an outbound call flow to automate appointment reminder 
processing.  Or a contact center might use Interaction Dialer to contact thousands of customers, and 
pass each call to Interaction Attendant without agent intervention. 

Synergy with Interaction Dialer 

Attendant and Interaction Dialer work cooperatively as follows: 

1. Dialer places the call and analyzes it to figure out what the call is connected to (live party, 
answering machine, etc.) 

2. Dialer looks at its configuration and determines, based on the campaign that generated the call, 
which outbound profile should take the call. 

3. Dialer places two attributes on the call; a call analysis code (SIT, Fax, connected, answering 
machine, busy, etc.), and the name of the Attendant profile that should process the call when it 
is passed to Attendant. 

4. When Attendant receives the call, it routes it to the profile identified by the call attribute, and 
then routes the call to an outbound schedule based on the call analysis code. 

5. Standard Attendant routing is used after that.  

6. If the call passes through a Disposition Interaction Dialer Call node, a custom finish code is set 
on the call for reporting purposes.  

7. When the call ends, its disposition and reason codes are returned to Dialer. 
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Disabled Options 

You can customize a Default Outbound Call Profile to play a wave file, but the you cannot rename this 
node.  Its Name field is disabled so that the profile is always named Default Outbound Profile for easy 
identification.  Likewise, its Active check box is disabled to insure that the profile is always available at 
runtime. 

Configurable Options 

See Custom Outbound Call Profile. 

Related Topics 

• Call Flow Configuration Switches 

• Profiles 

• Schedules 

• Operations 

• Dialogs 

Custom Outbound Call Profile 
Outbound profiles establish a configuration to process outbound calls—calls that have been placed and 
which are already connected.  For example, an Outbound call flow might process a call that Interaction 
Dialer placed to someone in a contact list.  You can connect Custom Outbound Call Schedules to an 
outbound profile, and then use call analysis information in the schedule to route the call to menus that 
are tailored to interact with live persons, answering machines, or Fax machines.  

If the Outbound profile is configured for Direct-to-Queue processing, the connected call is routed to a 
user, station, or workgroup queue, or to any outbound profile defined for that server.  Outbound call 
flows add a new dimension of call processing capability to the CIC environment. 

Note:  If the New Profile button ( ) on the toolbar is greyed out, or the New Profile option 
located in the Insert menu is unavailable, you do not have the appropriate rights to create a new 
profile.  See your administrator for information about obtaining your profile rights.  However, if your 
Administrator grants you the appropriate rights to create a new profile, Interaction Attendant also 
automatically gives you the right to modify the profile.  This feature allows you to edit any profile 
you create. 

Node Characteristics frame 

Options in this frame name the profile, establish whether or not it is active, logged, or tracked for IVR 
reporting purposes.  Unlike operation nodes, profiles cannot be assigned a digit, since profiles are 
always compared to the characteristics of a call. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers. When a node is inactive, it appears grayed out in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Profile Greeting frame 

Controls in this frame set a prompt to play when a call enters this profile. If you do not select or record 
a prompt using the embedded audio controls, no voice prompting will occur.   See manage voice 
prompts for details. 

 

Call Processing Style button 
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This button opens the Call Processing Style dialog.  It determines whether calls are directed to a menu 
(Auto Attendant Processing) or to a User, Station, Workgroup queue, or operator profile (Direct to 
Queue Processing).  Auto Attendant Processing is used by default—inbound calls are directed to the 
menu attached to the best matching schedule.  In other words, Call Processing Style determines 
whether calls are directed to: 

• A menu attached to a schedule in this profile.  This is the default call processing behavior. 

• A user, station, or workgroup queue. 

• An operator profile. 

Language frame 

This option affects the language used to play back voice prompts.  It presents a list of languages 
defined on the CIC server.  

 

Language list box 

• If a user selects a language from the list, that language becomes the current language used to 
play prompts. 

• If the user selects <Default>, prompts will be played using the server's default language. 

• If the user selects <Do Not Change>, the language that is currently set on the call won't be 
updated by this Profile.  For example, a caller might select Spanish in a menu.  If the call is 
routed back to this Profile somewhere down the line, the Profile would play the prompt using 
its language setting unless <Do Not Change> is selected.  This option tells the Profile not to 
change the language set by another node, if the call returns to the profile.  

Related Topics 

• Call Flow Configuration Switches 

• Default Outbound Call Profile 

• Disposition Interaction Dialer Call 

• Profiles 

• Schedules 

• Operations 

• Dialogs 

Operator Profiles 

Operator Profiles 
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Calls to the operator are filtered by Operator Profiles that examine the user queue, workstation queue, 
or Attendant Profile that the call arrived on.  Attendant supports two types of Operator profiles: 

• Attendant compares the characteristics of a call to the operator with Custom Operator Profiles 
to determine which profile should process the call.  Filtering is performed by comparing the 
user queue, workgroup queue, or Attendant Profile that the call came from with characteristics 
stored in the profile. 

• Default Operator Profiles select calls that do not match Custom Operator profiles.  

Default Operator Profile 
Calls to the operator are filtered by operator profiles.  Information about the call is compared to call 
characteristics defined in operator profile nodes.  The call is processed by the custom profile that 
matches the call, or by a default operator profile that Attendant uses to process calls that don't match 
user-defined profiles.  Interaction Attendant creates a default profile automatically for each call 
flow.  A default profile cannot be deleted.  The default profile is used when: 

• It is the only profile, or... 

• The characteristics of the incoming call do not match the criteria defined by any of your 
custom profiles. 

• You can customize a default operator profile to play a different wave file, but its incoming call 
selection filtering criterion are disabled.  This insures that the default operator profile always 
matches calls that get past custom operator profiles.  The following options are always 
disabled on a Default Operator Profile: 

Name 

The name field is disabled so that the profile is always named Default Profile for easy identification. 

Active check box 

This check box is disabled, since default profiles are always available at runtime. 

Incoming Call Selection options (user, workgroup, Attendant Profiles) 

Incoming call section options that screen calls based upon originating user queue, workgroup queue, or 
Attendant Profile are disabled. You can create custom operator profiles that filter calls by examine 
these criteria, however.  

For information about other options on this form, see Custom Operator Profile. 

Related Topics 

• Call Flow Configuration Switches 

• Custom Operator Profile 

• Profiles 

• Schedules 

• Operations 
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• Dialogs 

Custom Operator Profile 
Custom Operator profiles screen calls to the operator by examining the originating queue 
or  Attendant Profile.  Information about each call is compared to all operator profiles to select the 
profile that matches the call.  If no match if found, the call is processed by a default operator profile. 

Note:  If the New Profile button ( ) on the toolbar is greyed out, or the New Profile option 
located in the Insert menu is unavailable, you do not have the appropriate rights to create a new 
profile.  See your administrator for information about obtaining your profile rights. However, if 
your Administrator grants you the appropriate rights to create a new profile, Interaction Attendant also 
automatically gives you the right to modify the profile.  This feature allows you to edit any profile you create. 

Node Characteristics frame 

Options in this frame name the profile, establish whether or not it is active, logged, or tracked for 
IVR reporting purposes.  Unlike operation nodes, profiles cannot be assigned a digit, since profiles 
are always compared to the characteristics of a call. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers. When a node is inactive, it appears grayed out in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 
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When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 
Select the Configure Speech Recognition button to enable or disable speech recognition for the company directory, on menus, or both. By 
default, speech recognition is enabled for the company directory. If you choose to enable speech recognition on menus and leave it 
enabled for the company directory, callers will not be prompted to say the name of the person they want to reach. 

To keep both options selected and direct the system to ask callers to say the name of the person or department they wish to transfer to, 
you must add it to the main greeting prompt. For more information on configuring speech recognition at the profile level, see Enable 
Speech Recognition for a Profile. 

Profile Greeting 

These embedded audio controls manage the optional greeting that plays when a call enters this 
profile.  See manage voice prompts for more exhaustive information. 

 

Call Processing Style button 

 
This button opens the Call Processing Style dialog.  It determines whether calls are directed to a 
menu (Auto Attendant Processing) or to a User, Station, Workgroup queue, or operator profile 
(Direct to Queue Processing).  Auto Attendant Processing is used by default—operator calls are 
directed to the menu attached to the best matching operator schedule.  In other words, Call 
Processing Style determines whether calls are directed to: 

• A menu attached to a schedule in this profile.  This is the default call processing behavior. 

• A user, station, or workgroup queue. 

• An inbound profile. 

Language frame 

Profiles can set a language based upon incoming call characteristics of some sort.  The language list 
box affects the language used to play back voice prompts.  It presents a list of languages defined on 
the CIC server, and some special options. 

 

Language list box 
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If a user selects a language from the list, that language becomes the current language used to play 
prompts. 

If a user selects <Default>, prompts will be played using the server's default language. 

If a user selects <Do Not Change>, the language that is currently set on the call won't be updated by 
this Profile.  For example, a caller might select Spanish in a menu.  If the call is routed back to this 
Profile somewhere down the line, the Profile would play the prompt using its language setting 
unless <Do Not Change> is selected.  This option tells the Profile not to change the language set by 
another node, if the call returns to the profile.  

Incoming Call Selection frame 

This section of the page defines call characteristics that will be compared to the characteristics of an 
incoming call to determine whether it should be processed by this profile.  A custom operator 
profile can filter calls based upon the user queue, workgroup queue, or Attendant Profile that the 
call came from. 

 
You can filter on any or all of these criteria at the same time.  If you check a check box, you must 
configure its associated field.  If you don't, a red exclamation point (!) will appear next to the profile 
in the tree.  If you move the mouse pointer over the node, tool-tip help will appear to explain the 
error.   At runtime, your choices are evaluated using the logical OR operator.  If more than one 
criterion is specified, the interaction matches the profile if any of the profile's criteria are met.  

Use this profile to process calls coming from the following user queues check box 

Check this box to process calls that originate from user queues.   When the Users button is pressed, 
a dialog lists the names of user queues defined on the server. 
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Select user queues in the list on the left.  Click and drag to make contiguous selections, or ctrl-click 
to make discontinuous selections.  Then press >> to add your selections to the list on the right.  It 
contains the names of queues that you have selected.  Items can be removed from the rightmost list 
by selecting them and pressing <<.  To quickly select all user queues (present and future), add 
<<All>> to the right side list.  

When you are finished, press OK to dismiss the dialog.  The names of the first few selections are 
displayed in the read-only field. If you press Cancel,  the dialog is closed without saving changes. 

Use this profile to process calls coming from the following workgroup queues check box 

Check this box to process calls that originate from workgroup queues.   When the Groups button is 
pressed, a dialog lists the names of workgroup queues defined on the server. 

 
Select workgroup queues in the list on the left.  Click and drag to make contiguous selections, or ctrl-
click to make discontiguous selections.  Then press >> to add your selections to the list on the 
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right.  It contains the names of queues that you have selected.  Items can be removed from the 
rightmost list by selecting them and pressing <<.  To quickly select all workgroup queues (present 
and future), add <<All>> to the right side list.  

When you are finished, press OK to dismiss the dialog.  The names of the first few selections are 
displayed in the read-only field. If you press Cancel,  the dialog is closed without saving changes. 

Use this profile to process calls coming from the following Attendant Profiles check box 

Check this box to process calls that originate from an Attendant profile.   When the Profiles button is 
pressed, a dialog lists the names of Profiles defined on this server. 

 
Select profiles by name in the list on the left.  Click and drag to make contiguous selections, or ctrl-
click to make discontiguous selections.  Then press >> to add your selections to the list on the 
right.  It contains the names of profiles that you have selected.  Items can be removed from the 
rightmost list by selecting them and pressing <<.  To quickly select all profiles (present and future), 
add <<All>> to the right side list.  

When you are finished, press OK to dismiss the dialog.  The names of the first few selections are 
displayed in the read-only field. If you press Cancel,  the dialog is closed without saving changes. 

Related Topics 

• Call Flow Configuration Switches 

• Default Operator Profile 

• Profiles 

• Schedules 

• Operations 

• Dialogs 
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Email Profiles 

Email Profiles 
A profile is a collection of predefined characteristics that Attendant compares to an interaction, to 
decide whether to select the profile for processing.  Email profiles examine address information in 
an email message.  Attendant supports two types of email profiles: 

• Custom Email profiles analyze messages from specific mailboxes. Filtering is performed by 
examining "From:" fields in each message.  

• Default Email profiles select messages that do not match custom email profiles.  Since 
default email profiles do not examine fields in a message, or allow selection of mailboxes to 
monitor, they catch messages that do not match custom profiles. 

• Attendant's Email handlers monitor the mailboxes specified by non-default profiles. When a 
new message enters one of those mailboxes, the handlers find the best-matching profile for 
the email interaction. The "best" match is the most specific match among all of the profiles 
that are configured to monitor the mailbox from which the email was retrieved. If none of 
the profiles match the email, then the message is handled by the Default Email Profile. 

Email Default Profile 
The Default Email Profile catches messages that get past your custom Email profiles.  Most criterion 
are disabled, since default Email profiles do not examine fields in a message, or allow selection of 
mailboxes to monitor.  

Attendant's Email handlers monitor all the mailboxes specified by the non-default profiles. When a 
new message enters one of those mailboxes, the handlers find the best-matching profile for the 
Email interaction. The "best" match is the most specific match among all of the profiles that are 
configured to monitor the mailbox from which the Email was retrieved. If none of the custom 
profiles match the Email, then the message is handled by the Email Default Profile. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or tracked for 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 
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By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers. When a node is inactive, it appears grayed out in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Related Topics 

• Email Profiles 

• Email Schedules 

• Email Operations 

Email Custom Profile 
Custom email profiles filter messages from specific mailboxes by comparing static values stored in 
the profile with "To:", "Cc:", and "From:" fields in each message. These comparisons select the 
profile that best matches the message.  If no match if found, the call is processed by a Default Email 
Profile. 

Note:  If the New Profile button ( ) on the toolbar is greyed out, or the New Profile option 
located in the Insert menu is unavailable, you do not have the appropriate rights to create a new 
profile.  See your administrator for information about obtaining your profile rights.  However, if 
your Administrator grants you the appropriate rights to create a new profile, Interaction Attendant also 
automatically gives you the right to modify the profile.  This feature allows you to edit any profile you create. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or tracked 
for reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the 
form and its children.  Use this feature to save a configuration that you are testing.  Inactive forms 
are invisible to callers. When a node is inactive, it appears grayed out in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Mailboxes to Monitor 

 
The check boxes in this list determine which mailboxes are monitored by this profile.  Mailboxes 
are configured outside of Attendant, in Interaction Administrator or Post Office Server. 

Incoming E-mail Selection frame 

Use this frame to define specific email addresses that this profile should match against "From" 
fields in email messages.  
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To enable entry of an email address, type email addresses in the text box. Use semicolons (;) to 
separate Multiple email addresses. 

Email addresses are evaluated using a logical OR operator. A match occurs when any address in the 
profile matches an address in the email interaction. 

Formatting Help button 

The E-Mail Formatting Help dialog appears when the Formatting Help button is pressed. It displays 
tips for entering multiple email addresses and for using wildcards to filter a profile based upon 
"To", "Cc" and "From" fields in an email message.  

Related Topics 

• Email Profiles 

• Email Schedules 

• Email Operations 

Schedules 

Schedules 
A schedule stipulates when a menu can run, based upon the date, time, or special event.  You can 
define schedules (and associated menus) to handle recurring events, holidays, or special situations, 
such as your regular business hours, after-hours support, or an office closing due to poor weather 
conditions. See Schedule Types for details. 

Schedules are attached to profiles.  A single profile can have many child schedules.  Operations are 
attached to schedules to build menus.  

Custom schedules define when a menu should be active based upon time-related 
criteria.  Attendant creates a default schedule for you, and uses it when no custom schedules 
are defined, and when custom schedules do not match the current date or time.  

Each call flow type (inbound, outbound, operator) provides default and custom schedules that 
have different property settings.  Subsequent topics discuss these settings in detail. 

Related Topics 

• Call Schedules 
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• Operator Schedules 

• Email Schedules 

Call Schedules 

Call Schedules 
After a telephone call is matched to a call profile, the receipt date/time of the call is compared to 
one or more schedule nodes.  Schedules select the menu that matches the current date, time of 
day, or a scheduled event, such as a holiday.  Attendant provides default and custom schedules 
for inbound and outbound calls: 

Inbound Calls Outbound Calls 

Default Inbound Call Schedule Default Outbound Call Schedule 

Custom Inbound Call Schedule Custom Outbound Call Schedule 

Custom Call Schedules determine whether a menu is active, based upon a date, range of dates, 
time, or a special event.  Schedule forms stipulate when a menu can run.  You can define 
schedules (and associated menus) to handle recurring events, holidays, or special situations, such 
as your regular business hours, after-hours support, or an office closing due to poor weather 
conditions. 

Interaction Attendant automatically creates a DefaultCall Schedule, which it uses when no other 
schedule has precedence.  

Default Inbound Call Schedule 
Interaction Attendant automatically attaches a Default Inbound Call Schedule to each inbound 
profile.  The default schedule ensures that all calls are processed, should a call arrive during a 
period that is undefined by custom schedule nodes. 

The menu attached to the Default Inbound Call Schedule receives the call when no other 
schedule in the profile is selected based upon the current date, time, or events.  The Default 
Inbound Call Schedule also has precedence if no custom schedules are defined for a profile.  

Disabled Options 

Since the Default Inbound Call Schedule is designed as a catch-all, some of its features are 
disabled: 

• You cannot rename a Default Inbound Call Schedule or make it inactive. 

• You cannot set Schedule Start and Schedule End dates, or specify daily, weekly, monthly, 
yearly, unplanned, or system schedule criteria. 

However, all of these items can be configured for Custom Inbound Call Schedules.  

Configurable Options 

The following aspects of a default schedule are configurable: 

•    You can set a voice prompt that plays when the schedule executes. 
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•    You can set the maximum number of times that the voice prompt will be played before 
control is passed to the form's error handler.  If you do not define special error handling 
the call is be disconnected after the maximum number of playbacks.  

•    You can set the number of seconds to wait for user input before repeating the greeting. 

•    You can enable auto-detection of extension dialing, which sets up processing that 
Attendant interprets to handle multiple incoming digits as extension numbers, rather 
than as menu selections. 

•    You can tell Attendant to listen for fax tones, so that fax handling is automatically 
invoked should a call arrive from a fax machine.  If a fax tone is detected, the fax is 
received in the Default Mailbox, or in the user or workgroup mailbox that you specify.  

•    You can optionally set error handling options to trap errors that might occur when 
menus are processed.  The error handler can optionally play a message, and then transfer 
the call to a (user, station, or workgroup) queue, or transfer the call to any menu that has 
defined for the server.  

•     You can configure and customize speech recognition settings configured in Interaction 
Administrator, including confidence level, timeouts, and to configure audio prompt 
settings when the speech engine cannot find a match to the caller’s audio input. For more 
information, see Configure Speech Recognition for Schedules and Menus.  

All of these options are explained in the Custom Inbound Call Schedule topic. 

Custom Inbound Call Schedule  
After an inbound profile is selected, calls are filtered by the schedules below that profile.  A 
Schedule determines whether a menu is active, based upon a date, range of dates, time, or a 
special event.  Schedule forms stipulate when a menu can run.  You can define schedules (and 
associated menus) to handle recurring events, holidays, or special situations, such as your regular 
business hours, after-hours support, or an office closing due to poor weather conditions. 

• Daily, weekly, monthly and yearly schedules are fully supported. 

• Unplanned schedules for events that have no fixed date ("snow day") must be activated 
to take effect, and can be activated by phone.  

• System schedules can be used to create a link between Interaction Attendant and 
schedules defined in Interaction Administrator.  

• Interaction Attendant automatically creates a default schedule, which it uses when no 
other schedule has precedence.   

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or tracked 
for IVR reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

This check box determines whether or not a schedule is considered by the system.  If you uncheck 
this box, it is as if the schedule doesn't exist.  Unchecked schedules are invisible to remote access 
operations.  Note also that the Active check box does not activate an unplanned schedule. 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore 
the form and its children.  Use this feature to save a configuration that you are testing.  Inactive 
forms are invisible to callers. When a node is inactive, it appears grayed out in the tree view. 

When a schedule node is active, Interaction Attendant examines the schedule to see if it has 
precedence.  When a schedule node is inactive, Interaction Attendant ignores the schedule and 
does not compare the current date and time to schedule dates and times. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the 
node and its children.  This option is hidden when Attendant is connected to a server that does 
not have reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to customize default speech recognition settings configured in Interaction 
Administrator, including confidence level, timeouts, and to configure audio prompt settings when 
the speech engine cannot find a match to the caller’s audio input. For more information, see 
Configure Speech Recognition for Schedules and Menus. 

Schedule Greeting frame 
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Controls in this frame set a prompt to play when call control is passed to this schedule. If you do 
not select or record a prompt using the embedded audio controls, no voice prompting will 
occur.   See manage voice prompts. 

Repetition frame 

Options in this frame set the maximum number of times that the voice prompt will be played 
before control is passed to the form's error handler.  

 

Number of times to repeat this greeting spin control 

This value determines the number of times that a greeting message will be played before control 
is passed to the form's error handler.  If you do not modify the default error handling (by pressing 
the Schedule Error Handling button), the call will be disconnected after the maximum number of 
playbacks. 

Number of seconds to wait before repeating spin control 

This sets an interval, in seconds, that Interaction Attendant waits for user input before replaying 
the wave file.  

By default, a schedule's greeting message is repeated three times with a 15-second wait for 
user-input in between.  In releases prior to 2.3, repeat and repetition values were processed, 
even if the audio name field was left blank, or its value is <None>.  For example, if the repeat 
count was 2 and the delay time was 10, the caller heard 20 seconds of dead air before the 
default action or error handler is invoked. 
 
By default, a schedule's greeting message is repeated three times with a 15-second wait for 
user-input in between. In 4.0, if you publish a profile with a value of <none> in the audio 
field, the repeat count will be set to 0; however, you must modify the “seconds to wait before 
repeating” so the caller does not hear 15 seconds (the default value) of dead air. 

Extension Dialing frame 

Settings in this frame enable auto-detection of extension dialing, which sets up processing that 
Attendant interprets to handle multiple incoming digits as extension numbers, rather than as 
menu selections.   See Listen for Extension Dialing option for details about this feature. 
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Fax Options button 

 
Press this button to optionally configure Attendant to listen for Fax tones.  This enables Fax 
handling, should a call arrive from a Fax machine.  If a Fax tone is detected, the Fax is received in 
the server's Default Mailbox, or in the user or workgroup mailbox that you specify in the Fax 
Listener Options Dialog. 

Schedule Error Handling button 

 
You can optionally set error handling options to trap errors that might occur when menus are 
processed.  The error handler can optionally play a message, and then transfer the call to an 
operator profile, to a user, station, or workgroup queue, or to any menu that has defined for the 
server.  For details, refer to the Default Error Handler Dialog. 

Timezone drop-down list 

 
Use the Timezone drop-down list to optionally configure a timezone setting.  The CIC server uses 
the setting you select to determine actual opening hours for this 
queue, based on the offset between the CIC server and the opening hours/timezone. 

The timezone setting should be optionally and by default it should use the server time. 

Note: The timezone for a schedule automatically adjusts to Daylight Saving Time (DST). 

Schedule Start Date frame 

Schedule Start Date and Schedule End Date settings do not determine when a menu will 
run.  Instead, these controls set time boundaries that determine when scheduling criteria on 
the schedule tabs are evaluated.  

 
Start and End dates apply to daily, weekly, monthly and yearly schedules, but have no effect 
upon unplanned or system schedules. 
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 This schedule should take effect starting 

This calendar control select the start date for the schedule.  

1. To set a date, click the mouse on the date combo box.  This displays a date selection 
dialog. 

 
2. Use the pushbuttons to navigate to the previous or next month.  

3. Click on a day of the month to select a new date. 

4. The date selected has a blue fill. A red circle designates the current date. 

Schedule End Date frame 

Schedule End Date establishes when criteria on the schedule tabs should no longer be 
evaluated.  

This schedule does not expire 

This option indicates that the schedule should not expire, meaning that once the start date is 
reached, settings on the schedule tabs should always be evaluated.  

This schedule expires on 

This option sets a date when criteria on schedule tabs should be evaluated through. The 
schedule will be evaluated through the date set but not beyond it. Therefore, set this date to 
the last day when the schedule should be evaluated. For example, you might think that setting 
the end date to 9/1 would cause the schedule not to be evaluated after 8/31. However, in 
practice you must set the schedule end date to 8/31, because schedules are evaluated to the 
date listed, but not again afterwards. 

Schedule Tabs 

 
The tabbed pages at the bottom of the Schedule node set scheduling criteria.  These settings 
establish daily, weekly, monthly, yearly, unplanned, or system criteria that determine when 
menu operations attached to the schedule will execute.  See Schedule Types. 

Related Topics 

• Call Schedules 

Default Outbound Call Schedule 
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Interaction Attendant automatically attaches a Default Outbound Call Schedule to each outbound 
profile.  The default schedule ensures that all calls are processed, should a call arrive during a period 
that is undefined by custom schedule nodes. 

The menu attached to the Default Outbound Call Schedule receives the call when no other schedule is 
selected for the profile, based upon the current date, time, or events.  The Default Outbound Call 
Schedule also has precedence if no Custom Outbound Call Schedules are defined for a profile.  

Disabled Options 

Since the Default Outbound Call Schedule is designed as a catch-all, some of its features are disabled: 

• You cannot rename a Default Outbound Call Schedule or make it inactive. 

• You cannot set Schedule Start and Schedule End dates, or specify daily, weekly, monthly, yearly, 
unplanned, or system schedule criteria. 

However, all of these items can be configured for Custom Outbound Call Schedules.  

Configurable Options 

The following aspects of a Default Outbound Call Schedule are configurable: 

• You can set a voice prompt that plays when the schedule executes. 

• You can set the maximum number of times that the voice prompt will be played before control 
is passed to the form's error handler.  If you do not define special error handling the call is be 
disconnected after the maximum number of playbacks.  

• You can set the number of seconds to wait for user input before repeating the greeting. 

• You can enable auto-detection of extension dialing, which sets up processing that Attendant 
interprets to handle multiple incoming digits as extension numbers, rather than as menu 
selections. 

• You can tell Attendant to listen for fax tones, so that fax handling is automatically invoked 
should a call arrive from a fax machine.  If a fax tone is detected, the fax is received in the 
Default Mailbox, or in the user or workgroup mailbox that you specify.  

• You can optionally set error handling options to trap errors that might occur when menus are 
processed.  The error handler can optionally play a message, and then transfer the call to a 
(user, station, or workgroup) queue, or transfer the call to any menu that has defined for the 
server.  

These options are explained in the Custom Outbound Call Schedule topic. 

Related Topics 

• Schedules 

Custom Outbound Call Schedule 
Custom Outbound Call Schedules select one or more outbound call connections to process. 

Node Characteristics frame 
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Options in this frame name the node, and establish whether or not it is active, logged, or tracked for IVR 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

This check box determines whether or not a schedule is considered by the system.  If you uncheck this 
box, it is as if the schedule doesn't exist.  Unchecked schedules are invisible to remote access 
operations.  Note also that the Active check box does not activate an unplanned schedule. 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If you 
uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the form 
is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are invisible to callers. When a 
node is inactive, it appears grayed out in the tree view. 

When a schedule node is active, Interaction Attendant examines the schedule to see if it has 
precedence.  When a schedule node is inactive, Interaction Attendant ignores the schedule and does not 
compare the current date and time to schedule dates and times. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through this 
node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by default.  Enable it 
to capture the date, time and duration of time that the call remained in the node and its children.  This 
option is hidden when Attendant is connected to a server that does not have reporting installed.  For 
more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log when 
the call enters this node.  This helps track the path that a call took through Attendant.  The Interaction 
Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Schedule Greeting frame 
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Controls in this frame set a prompt to play when call control is passed to this schedule. If you do not 
select or record a prompt using the embedded audio controls, no voice prompting will occur.   See 
manage voice prompts. 

Repetition frame 

 

Number of times to repeat this greeting spin control 

This value determines the number of times that a greeting message will be played before control is 
passed to the form's error handler.  If you do not modify the default error handling (by pressing the 
Schedule Error Handling button), the call will be disconnected after the maximum number of playbacks. 

Number of seconds to wait before repeating spin control 

This sets an interval, in seconds, that Interaction Attendant waits for user input before replaying 
the wave file.  

margin-left: .3in; margin-right: 0in; 

By default, a schedule's greeting message is repeated three times with a 15-second wait for user-
input in between.  In releases prior to 2.3, repeat and repetition values were processed, even if the 
audio name field was left blank, or its value is <None>.  For example, if the repeat count was 2 and 
the delay time was 10, the caller heard 20 seconds of dead air before the default action or error 
handler is invoked. 
 
The publish process now sets the repeat count and "seconds to wait before repeating" count to 0 for 
schedule nodes that don't have any audio specified. This prevents callers from hearing dead air if an 
Attendant user forgets to set those values to 0. 

Schedule Error Handling button 

 
You can optionally set error handling options to trap errors that might occur when menus are 
processed.  The error handler can optionally play a message, and then transfer the call to an operator 
profile, to a user, station, or workgroup queue, or to any menu that has defined for the server.  For 
details, refer to the Default Error Handler Dialog. 
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Calls to Process frame 

These options select which outbound call connections to process. 

 

Live Voice 

This option processes calls that were answered by a live person. 

Answering Machine 

This option processes calls that were answered by an answering machine. 

Fax Machine 

This option processes calls that were answered by a Fax machine. 

Operator Schedules 

Operator Schedules 
When a telephone call is placed to an operator or operators, it is matched to an operator profile. The 
date and time of the call is compared to one or more schedule nodes.  Schedules select the menu that 
matches the current date, time of day, or a scheduled event, such as a holiday.  Attendant provides 
default and custom schedules for inbound operator calls: 

• Custom Operator Schedules determine whether a menu is active, based upon a date, range of 
dates, time, or a special event.  Schedule forms stipulate when a menu can run.  You can define 
schedules (and associated menus) to handle recurring events, holidays, or special situations, 
such as your regular business hours, after-hours support, or an office closing due to poor 
weather conditions. 

• Interaction Attendant automatically creates a Default Operator Schedule, which it uses when 
no other schedule has precedence.  

Default Operator Schedule 
Attendant provides a call flow type for handling all calls routed to an operator or operators.  The 
operator call flow tree configures all operator routing operations and allows for easy visualization of a 
server's operator processing. Interaction Attendant automatically attaches a default operator schedule 
to each operator profile.  This insures that all operator calls are processed, if no custom operator 
schedules are defined or have precedence.  

Operator schedules are like Inbound schedules, except that Operator call flows are managed in their 
own pane, separately from inbound call processing. 
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Disabled Options 

Since the default operator schedule is designed as a catch-all, some of its features are disabled: 

• You cannot rename a default schedule or make it inactive. 

• Connection types (Live Voice, Answering Machine, Fax Machine) cannot be defined as selection 
criteria.  However, these items can be configured for custom operator schedules.  

Configurable Options 

The following aspects of a default schedule are configurable: 

• You can play a greeting message when the schedule executes. 

• You can set the maximum number of times that the voice prompt will be played before control 
is passed to the form's error handler.  If you do not define special error handling the call is be 
disconnected after the maximum number of playbacks.  

• You can set the number of seconds to wait for user input before repeating the greeting. 

• You can optionally set error handling options to trap errors that might occur when menus are 
processed.  The error handler can optionally play a message, and then transfer the call to a 
(user, station, or workgroup) queue, or transfer the call to any menu that has defined for the 
server. 

•     You can configure and customize speech recognition settings configured in Interaction 
Administrator, including confidence level, timeouts, and to configure audio prompt settings 
when the speech engine cannot find a match to the caller’s audio input. For more information, 
see Configure Speech Recognition for Schedules and Menus.   

All of these options are explained in the Custom Operator Schedule topic. 

Custom Operator Schedule 
After an operator profile is selected, schedules below that profile determines whether a menu is active, 
based upon a date, range of dates, time, or a special event.  Operator schedules are similar to Inbound 
schedules, except that Operator call flows are managed in their own pane, separately from inbound 
call processing.  

You can define operator schedules (and associated menus) to handle recurring events, holidays, or 
special situations, such as your regular business hours, after-hours support, or an office closing due to 
poor weather conditions. 

• Daily, weekly, monthly and yearly schedules are fully supported. 

• Unplanned operator schedules for events that have no fixed date ("snow day") must be 
activated to take effect, and can be activated by phone.  

• System schedules allow Interaction Attendant to utilize schedules defined in Interaction 
Administrator.  

• Interaction Attendant automatically creates a default schedule, which it uses when no other 
schedule has precedence.   



Printed Documentation 

137 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or tracked for 
IVR reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

This check box determines whether or not a schedule is considered by the system.  If you uncheck this 
box, it is as if the schedule doesn't exist.  Unchecked schedules are invisible to remote access 
operations.  Note also that the Active check box does not activate an unplanned schedule. 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers. When a node is inactive, it appears grayed out in the tree view. 

When a schedule node is active, Interaction Attendant examines the schedule to see if it has 
precedence.  When a schedule node is inactive, Interaction Attendant ignores the schedule and does 
not compare the current date and time to schedule dates and times. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to customize default speech recognition settings configured in Interaction 
Administrator, including confidence level, timeouts, and to configure audio prompt settings when the 
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speech engine cannot find a match to the caller’s audio input. For more information, see Configure Speech 

Recognition for Schedules and Menus.  

Schedule Greeting frame 

 
Controls in this frame set a prompt to play when call control is passed to this schedule. If you do not 
select or record a prompt using the embedded audio controls, no voice prompting will occur.   See 
manage voice prompts. 

Repetition frame 

Options in this frame set the maximum number of times that the voice prompt will be played before 
control is passed to the form's error handler.  

 

Number of times to repeat this greeting spin control 

This value determines the number of times that a greeting message will be played before control is 
passed to the form's error handler.  If you do not modify the default error handling (by pressing the 
Schedule Error Handling button), the call will be disconnected after the maximum number of 
playbacks. 

Number of seconds to wait before repeating spin control 

This sets an interval, in seconds, that Interaction Attendant waits for user input before replaying the 
wave file.  

By default, a schedule's greeting message is repeated three times with a 15-second wait for user-
input in between.  In releases prior to 2.3, repeat and repetition values were processed, even if the 
audio name field was left blank, or its value is <None>.  For example, if the repeat count was 2 and 
the delay time was 10, the caller heard 20 seconds of dead air before the default action or error 
handler is invoked. 
 
The publish process now sets the repeat count and "seconds to wait before repeating" count to 0 
for schedule nodes that don't have any audio specified. This prevents callers from hearing dead air 
if an Attendant user forgets to set those values to 0. 

Extension Dialing frame 
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Settings in this frame enable auto-detection of extension dialing, which sets up processing that 
Attendant interprets to handle multiple incoming digits as extension numbers, rather than as menu 
selections.   See Listen for Extension Dialing option for details about this feature. 

 

Fax Options button 

 
Press this button to optionally configure Attendant to listen for Fax tones.  This enables Fax handling, 
should a call arrive from a Fax machine.  If a Fax tone is detected, the Fax is received in the server's 
Default Mailbox, or in the user or workgroup mailbox that you specify in the Fax Listener Options 
Dialog. 

Schedule Error Handling button 

 
You can optionally set error handling options to trap errors that might occur when menus are 
processed.  The error handler can optionally play a message, and then transfer the call to an operator 
profile, to a user, station, or workgroup queue, or to any menu that has defined for the server.  For 
details, refer to the Default Error Handler Dialog. 

Timezone drop-down list 

 
Use the Timezone drop-down list to optionally configure a timezone setting.  The CIC server uses the 
setting you select to determine actual opening hours for this 
queue, based on the offset between the CIC server and the opening hours/timezone. 

The timezone setting should be optionally and by default it should use the server time. 

Note: The timezone for a schedule automatically adjusts to Daylight Saving Time (DST). 

Schedule Start Date frame 

Schedule Start Date and Schedule End Date settings do not determine when a menu will 
run.  Instead, these controls set time boundaries that determine when scheduling criteria on the 
schedule tabs are evaluated.  
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Start and End dates apply to daily, weekly, monthly and yearly schedules, but have no effect upon 
unplanned or system schedules. 

This schedule should take effect starting 

This calendar control select the start date for the schedule.  

1. To set a date, click the mouse on the date combo box.  This displays a date selection dialog. 

 
2. Use the pushbuttons to navigate to the previous or next month.  

3. Click on a day of the month to select a new date. 

4. The date selected has a blue fill. A red circle designates the current date. 

Schedule End Date frame 

Schedule End Date establishes when criteria on the schedule tabs should no longer be evaluated.  

This schedule does not expire 

This option indicates that the schedule should not expire, meaning that once the start date is 
reached, settings on the schedule tabs should always be evaluated.  

This schedule expires on 

This option sets a date when criteria on schedule tabs should be evaluated through. The schedule 
will be evaluated through the date set but not beyond it. Therefore, set this date to the last day 
when the schedule should be evaluated. For example, you might think that setting the end date to 
9/1 would cause the schedule not to be evaluated after 8/31. However, in practice you must set the 
schedule end date to 8/31, because schedules are evaluated to the date listed, but not again 
afterwards. 

Schedule Tabs 
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The tabbed pages at the bottom of the Schedule node set scheduling criteria.  These settings 
establish daily, weekly, monthly, yearly, unplanned, or system criteria that determine when menu 
operations attached to the schedule will execute.  See Schedule Types. 

Related Topics 

• Schedules 

Email Schedules 

Email Schedules 
When an email message is matched to an Email Profile, the date and time of the call is compared to 
one or more schedule nodes.  Schedules select the menu that matches the current date, time of day, 
or a scheduled event, such as a holiday.  Attendant provides default and custom schedules for 
inbound operator calls: 

• Custom Email Schedules pass control to a menu, based upon a date, range of dates, time, or 
a special event.  Schedule forms stipulate when a menu can run.  You can define schedules 
(and associated menus) to handle recurring events, holidays, or special situations, such as 
your regular business hours, after-hours support, or an office closing due to poor weather 
conditions. 

• Interaction Attendant automatically creates a Default Email Schedule, which it uses when no 
other schedule has precedence.  

Default Email Schedule 
Interaction Attendant automatically attaches a Default Email Schedule to each Email profile.  The 
default schedule ensures that all Email messages are processed, should a message arrive during a 
period that is undefined by Custom Email Schedules. 

The menu attached to the Default Email Schedule receives control when no other schedule in the 
profile is selected based upon the current date, time, or events.  The Default Email Schedule also has 
precedence if no custom schedules are defined for a profile.  

Disabled Options 

Since the Default Email Schedule is designed as a catch-all, some of its features are disabled: 

• You cannot rename a Default Email Schedule or make it inactive. 

• You cannot set Schedule Start and Schedule End dates, or specify daily, weekly, monthly, 
yearly, unplanned, or system schedule criteria. 

These restrictions do not apply to Custom Email Schedules.  

Configurable Options 

The following aspects of a Default Email Schedule are configurable: 

• You can add an entry to the Interaction log.  When this option is checked, information about 
this node is appended to the Email's Interaction Log when the call enters this node.  This 
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helps track the path that the interaction took through Attendant.  Interaction Logs are 
maintained for reporting purposes.  See View the Interaction Log for details. 

• You can press the Schedule Error Handling button to optionally set error handling options to 
trap errors that might occur when menus are processed.  The error handler can disconnect 
the interaction, or transfer the Email message to a menu, user queue or workgroup 
queue.  See Default Error Handler Dialog (Emails). 

Custom Email Schedule 
After an Email profile is selected, calls are filtered by the Email schedules below that 
profile.  Schedules are evaluated to select a menu, based upon a date, range of dates, time, or a 
special event.  Schedules stipulate when a menu can run.  You can define schedules (and associated 
menus) to handle recurring events, holidays, or special situations, such as your regular business 
hours, after-hours support, or an office closing due to poor weather conditions. 

• Daily, weekly, monthly and yearly schedules are fully supported. 

• Unplanned schedules for events that have no fixed date ("snow day") must be activated to 
take effect, and can be activated by phone.  

• System schedules can be used to create a link between Interaction Attendant and schedules 
defined in Interaction Administrator.  

• Interaction Attendant automatically creates a Default Email Schedule, which it uses when no 
other schedule has precedence.   

• Email schedule nodes are similar to Call schedule nodes, except that Call actions that do not 
apply to Email objects (play audio file, transfer to a station group) are not 
available.  Otherwise, the options for specifying dates, times, and periodicity of an Email 
routing schedule are identical to Call schedules. 

• Email schedules provide different error handling actions. If there is an error during the 
processing of an Email anywhere under a schedule, the Email can be disconnected, or 
transferred to a specific user or workgroup queue. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or tracked for 
IVR reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 
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This check box determines whether or not a schedule is considered by the system.  If you uncheck 
this box, it is as if the schedule doesn't exist.  Unchecked schedules are invisible to remote access 
operations.  Note also that the Active check box does not activate an unplanned schedule. 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active checkbox, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers. When a node is inactive, it appears grayed out in the tree view. 

When a schedule node is active, Interaction Attendant examines the schedule to see if it has 
precedence.  When a schedule node is inactive, Interaction Attendant ignores the schedule and does 
not compare the current date and time to schedule dates and times. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the Interaction Log when 
the Interaction is processed by this node.  This helps track the path that it took through 
Attendant.  The Interaction Log is maintained for reporting purposes.  See View the Interaction Log 
for details. 

Schedule Error Handling button 

 
You can optionally set error handling options to trap errors that might occur when menus are 
processed.  You can terminate the Email interaction, or transfer the Email message to a menu, user 
queue, or workgroup queue.  See Default Error Handler Dialog (Emails). 

Timezone drop-down list 

 

Use the Timezone drop-down list to optionally configure a timezone setting.  The CIC server uses the 
setting you select to determine actual opening hours for this 
queue, based on the offset between the CIC server and the opening hours/timezone. 

The timezone setting should be optionally and by default it should use the server time. 

Note: The timezone for a schedule automatically adjusts to Daylight Saving Time (DST). 

Schedule Start Date frame 

Schedule Start Date and Schedule End Date settings do not determine when a menu will 
run.  Instead, these controls set time boundaries that determine when scheduling criteria on the 
schedule tabs are evaluated.  
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Start and End dates apply to daily, weekly, monthly and yearly schedules, but have no effect upon 
unplanned or system schedules. 

This schedule should take effect starting 

This calendar control selects a start date for the schedule.  

1. To set a date, click the mouse on the date combo box.  This displays a date selection dialog. 

 
2. Use the pushbuttons to navigate to the previous or next month.  

3. Click on a day of the month to select a new date. 

4. The date selected has a blue fill. A red circle designates the current date. 

Schedule End Date frame 

Schedule End Date establishes when criteria on the schedule tabs should no longer be evaluated.  

This schedule does not expire 

This option indicates that the schedule should not expire, meaning that once the start date is 
reached, settings on the schedule tabs should always be evaluated.  

This schedule expires on 

This option sets a date when criteria on schedule tabs should be evaluated through. The schedule 
will be evaluated through the date set but not beyond it. Therefore, set this date to the last day 
when the schedule should be evaluated. For example, you might think that setting the end date to 
9/1 would cause the schedule not to be evaluated after 8/31. However, in practice you must set 
the schedule end date to 8/31, because schedules are evaluated to the date listed, but not again 
afterwards. 

Schedule Tabs 
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The tabbed pages at the bottom of the Schedule node set scheduling criteria.  These settings 
establish daily, weekly, monthly, yearly, unplanned, or system criteria that determine when menu 
operations attached to the schedule will execute.  See Schedule Types. 

Schedule Types 

Schedule Types 
The tab pages at the bottom of a Schedule node establish criteria that determine when the menu 
attached to the schedule will execute.  Attendant evaluates settings on the active tab only.  It 
ignores settings on the other tabs. 

Each tab represents a discrete type of criteria that determines when a menu will 
execute.  Interaction Attendant is flexible and accommodates a wide range of scheduling needs.  It 
provides many scheduling options—some of which you may never use.  

It is entirely possible to activate a menu using different types of schedule criteria.  For example, a 
schedule that runs all day, every day, could be defined by setting options on the daily tab, or by 
setting options on the weekly tab.  One method isn't more correct than another, so long as a 
schedule works that way you need it to. 

Schedule tabs are disabled on the default schedule, since it is designed to catch calls that other 
schedules do not trap.  Custom schedules allow you to establish the following schedule criteria: 

Daily              Runs a schedule at the same time every day between the schedule start date and the 
schedule end date. 

Weekly           Runs a schedule on a particular day or days of the week. 

Monthly           Runs a schedule on a particular day or date range every month. 

Yearly             Runs a schedule on a particular date or range of dates every year. 

Unplanned       Allows you to define schedules that run during specific times of the day, but without 
specifying any particular date.  This is useful for snow days, or unplanned office closings. 

System           System schedules link an Interaction Attendant schedule to a system schedule 
defined in Interaction Administrator.  This permits changes made in Interaction Administrator to be 
reflected by Auto-Attendant processing. 

Priority order criteria that CIC uses to pick a schedule 

The type of schedule determines the order in which CIC selects the schedule to play. The order of 
priority is as follows: 

• Unplanned: Highest priority.  

• One Time.  This is an Interaction Administrator schedule type. The One Time schedule 
should not be confused with the Unplanned schedule type available in Interaction 
Attendant.  An unplanned schedule specifies an indefinite end time, staying active until it is 
turned off. See Unplanned Schedules. 

• Yearly 

• Monthly 
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• Weekly 

• Daily: Lowest priority 

If there is more than one schedule that matches in priority, then the start and end times are 
compared. The schedule containing the closest comparable times is the higher priority.  

Settings on inactive tabs are ignored 
 
You may be wondering, what happens if I set options on more than one tab?  Does Attendant 
reconcile schedule settings on all of the tabs?  The answer is that it does not.  Attendant 
evaluates settings on the active tab only.  It ignores settings on all other tabs. 

Subsequent pages explain each scheduling tab in detail.  

Daily Schedules 

 
Daily schedules run a menu at the same time every day, between the start date and the end 
date.  The menu can run all day, or between start and end times. 

Settings on this tab are evaluated only if the call arrives between the Schedule Start and 
Schedule End date and time.  The Schedule's Active check box must also be checked. 

Time Range frame 

This schedule should run all day 

Runs the schedule all day, every day. 

This schedule should run between these times 

Runs the schedule every day between the starting and ending times.  

Example Daily Schedule 
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The example schedule below is designed to run seven days a week, 365 days a year from 8 AM 
to 5 PM every day. 

 
Selecting the daily tab creates a schedule that runs every day, without regard for the day of the 
week, day of the month or any other constraint.  

Daily schedules can be set up to become active for a certain time window each day (8 AM – 5 
PM in the example above) by selecting the "This schedule should run between these times" 
option in the time range box.  Similarly, the schedule can be set to run all day, 24 hours a day, by 
selecting the "This schedule should run all day" option in the same box.  

A daily schedule that is set to run all day essentially replaces the default schedule for the date 
range specified in the Schedule Start Date box and the Schedule End Date box. 

Holiday Schedule Example 

This schedule shows how to handle a specific holiday—in this case, Thanksgiving. It will be active 
all day, 24 hours a day from the 23rd through the 26th of November. 
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By setting the Schedule Start Date and Schedule End Date to fields to specific dates and then 
creating a daily schedule, it is possible to define schedules that handle specific holidays or 
vacation periods.  The schedule above will take effect at midnight on the 25th of November 
2003 (Thanksgiving) and continue to run until midnight on November 27th 2003. 

A user could create a yearly schedule to handle holidays like Thanksgiving and Christmas, but 
since the actual vacation dates usually fall on different calendar day each year, daily schedules 
with specific start and end dates work as well. 

Weekly Schedules 
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Weekly schedules run a menu on a particular day or days of the week.  The menu can run all 
day, or between start and end times. 

Settings on this tab are evaluated only if the call arrives between the Schedule Start and 
Schedule End date and time.  The Schedule's Active check box must also be checked.  

Start On (Day of Week) combo box 

Selects the day when the schedule starts in relation to days selected in the Days frame.  

Start On (Time) spin control 

Sets a start time for the start day. 

End On (Day of Week) combo box. 

Sets a day of week for the schedule to end on in relation to days selected in the Days frame. 

End On (Time) spin control 

Sets an end time for the end day. 

Time Range frame 

This schedule should run all day radio button 

This option runs the menu all day during the days selected. 

The schedule should run between radio button 

Runs the menu between specific start and end times during the days selected. 

Days frame 

These check boxes select specific days of the week for the schedule to run on. 

All button 

Checks all days of week check boxes. 

None button 

Unchecks all days of week check boxes. 

M – F button 

Checks days of week from Monday to Friday. 

Weekends 

Checks Saturday and Sunday only. 

Typical Work Week Example 
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The example schedule below is designed to run during a typical workweek, 8 AM to 5 PM each 
day, Monday through Friday. 

 
Selecting the Weekly tab creates a schedule that runs on a particular day or days of the week, 
regardless of calendar date.  Weekly schedules can be used for reoccurring weekly events or 
for things like the standard work week. 

The schedule shown above is set to become active every Monday morning at 8 AM.  It will 
become dormant again on Friday evening at 5 PM.  Because the Time Range selection is set to 
"This schedule should run between", the schedule will only be active from 8 AM and 5 PM each 
day. 

If the time range selection in this example was changed to be "This schedule should run all 
day", then the schedule would become active at 8 AM on Monday and run 24 hours a day each 
day until 5 PM on Friday. 

By using the check boxes in the Days box, you could also configure the schedule to run on only 
some of the days between Monday and Friday.  As the "Start on" and "End on" fields are 
changed, the individual days of the week in the Days box will be enabled or disabled, showing 
the complete range of days that the schedule would be active as specified by the schedule.  

The check boxes can then be used to either turn on or off the schedule for a given day.  In the 
example above, the schedule is set to run each day from Monday through Friday.  If a user 
clicked on the Wednesday check box in the Days box so that its check mark disappeared, the 
schedule would then be configured to run from 8 AM to 5 PM on Mondays, Tuesdays, 
Thursdays and Fridays, and not run at all on Wednesdays. 

Short Workday Example 

The example below illustrates a workweek where the office shuts down on noon every 
Friday.  It will run from 7 AM to 5 PM on Monday through Thursday and run from 7 AM to 
noon on Friday. 
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The schedule above is very similar to the weekly schedule, except that it is set to start at 7 AM 
instead of 8 AM, and the "End on" fields are set to Friday at noon instead of Friday at 5 PM.   

This has the effect of turning the schedule off at noon on Friday, but not affecting the rest of 
the week.  (7 AM – 5 PM Monday through Thursday, 7 AM – 12 PM on Friday). The weekly 
schedule is designed so that it will not start any earlier on the first day than the day of week 
and time specified by the "Start on" fields and will not run any later on the last day than the 
date of week and time specified by the "End on" fields.  This gives the user the ability to set up 
a schedule that starts later on the first day of the schedule or ends earlier on the last day of the 
schedule. 

Evening Schedule Example 

This schedule was designed to run after hours during the typical workweek.  Monday through 
Thursday night, this schedule will become active and run from 5 PM until 8 AM the next 
morning.  The evening of Friday night was left out of the schedule because it can be covered by 
a weekend schedule. 
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This schedule was designed to handle all the "After hours" calls that come in once the 
company's employees have gone home for the night.  When a schedule is set up to run 
between 5 PM and 8 AM in the Time Range box, the schedule will start at 5 PM one evening 
and continue running until 8 AM the following morning. 

Weekend Schedule Example 

This schedule was designed to run for the entire weekend.  It will become active at 5 PM on 
Friday night and run 24 hours a day until Monday morning at 8 AM. 

 
This schedule has it's time range set to "This schedule should run all day", so it will begin 
running at the day and time specified by the "Start on" fields and run 24 hours a day, each day 
until the day and time specified by the "End on" fields. 
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Monthly Schedules 

 
Monthly schedules run on a particular day or range of dates each month.  You must set boundary dates 
to identify when the schedule starts and ends.  You must also specify whether the schedule runs all day, 
or between specific times of day. 

Settings on this tab are evaluated only if the call arrives between the Schedule Start and Schedule End 
date and time.  The Schedule's Active check box must also be checked.  

Start Day frame 

First day of the Month 

Configures the schedule to start on the first day of the month. 

Last day of the Month 

Configures the schedule to start on the last day of the month. 

Particular Day 

Configures the schedule to start on any day of the month. 

End Day frame 

First day of the Month 

Configures the schedule to end on the first day of the month. 

Last day of the Month 

Configures the schedule to end on the last day of the month. 

Particular Day 
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Configures the schedule to end on any day of the month. 

Time Range frame 

These options restrict the schedule to specific starting and ending times, or set the schedule to run all 
day. 

This schedule should run all day 

Indicates that the schedule should run all day between Start Day and End Day. 

This schedule should run between 

This option allows you run the schedule between start and end times, between Start Day and End Day. 

End-of-Month Schedule Example 

The end-of-month schedule below handles a special situation that happens at the end of every month. 

 
Monthly schedules are configured by selecting the day of the month that the schedule should take 
effect in the Start Day box and the last day of the month that the schedule should be effective in the 
End Day box. 

For example, Selecting "First day of the month" in the Start Day box and selecting "Particular day" in 
the End Day box and setting the associated control to 7 would create a schedule that becomes active 
on the first day of the month and continues to stay active through the 7th day of the month, every 
month. 

The "Last day of the month" option gives a user the ability to configure a schedule to start or end on 
the last day of the month regardless of what day that might be (28th, 29th, 30th or 31st). 

Like the time ranges, selecting a day of the month in the Start Day box that is later in the month than 
the day selected in the End Day box will create a schedule that becomes active on the day specified in 
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the Start Day box of one month and continues to be active through the day specified in the End Day 
box of the following month. 

Yearly Schedules 

 
Yearly schedules are infrequently used, since they set schedule boundaries based upon fixed dates and 
times.  For example, this option might be used to schedule a menu that runs from Christmas Eve 
through the end of the year, or on New Years day only.  

Settings on this tab are evaluated only if the call arrives between the Schedule Start and Schedule 
End date and time.  The Schedule's Active check box must also be checked.  

Unplanned Schedules 

Unplanned Schedules 
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Unplanned schedules are useful when you don't know exactly when a menu will be needed.  For 
example, you might create a menu for a snow day, and remotely activate the schedule over the 
phone when bad weather conditions affect business hours.  

Time Range frame 

These settings control the time of day that the schedule should run. 

This schedule should run all day 

Sets the schedule to run all day. 

This schedule should run between these times 

Enables spin controls that set runtime start and end times. 

Duration Frame 

Options in the Duration frame control how long the unplanned schedule remains in effect.  

This schedule will stay active until it is turned off 

Sets the schedule to run until it is manually deactivated.  A snow day schedule, for example, could 
continue to run every day until you turn it off. 

This schedule will expire after it has run once 

This option tells schedule to automatically deactivate itself once its time range expires. 

Schedule is now in effect check box 

To activate an unplanned schedule, check the schedule is now in effect check box, or use remote 
access services to activate the schedule remotely using a touch-tone telephone.  To activate a 
schedule using the telephone, you must have system administrator rights.  To learn how to use 
remote access services, see Remotely Activate an Unplanned Schedule. 

Remotely Activate an Unplanned Schedule 
Unplanned schedules are useful when you don't know exactly when a menu will be needed.  For 
example, you can create a menu for a snow day, and activate the schedule when bad weather 
conditions affect business operations.  If you are in the office, you can use Interaction Attendant to 
activate an unplanned schedule by opening the schedule, and checking its now in effect check box. 

If you are out of the office, you can activate an unplanned schedule using a touch-tone 
telephone.  The following caveats apply: 

• Only unplanned schedules can be activated using a the telephone.  You cannot activate other 
schedule types (daily, weekly, etc.) using remote access services. 

• To activate an unplanned schedule using the telephone, you must have Modify permissions 
set on the Inbound Profiles category at the user, workgroup, or role level. For details 
concerning access rights, refer to the Interaction Administrator help system. 
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Steps to Remotely Activate an Unplanned Schedule 

The process of remotely activating an unplanned schedule is similar to the procedure used to 
remotely access voice mail, faxes, and Email using a telephone.  You dial into the CIC Server, identify 
yourself, and make selections from a menu tree.  Here's what to do: 

1. Call the CIC server, by dialing your company's main telephone number.  If you are at a station 
that is connected directly to the CIC, you may dial an asterisk (*) instead of the main number.  

2. Dial 99, followed by your extension number, your password, and a pound (#) sign.  The CIC 
does not prompt for your extension and password. 
 
The CIC plays a "Welcome to voicemail for extension nnnn" message. You are prompted to 
press 5 for Personal Options.  

3. Press 5 to select Personal Options. 

4. Press 9 to enter the Interaction Attendant submenu.  A text-to-speech voice prompt is played 
for this option. You must have Modify permissions set on the Inbound Profiles to use this 
option. The system builds a list of Profiles that contain at least one unplanned 
Schedule.  From this point on, voice prompts are generated using text-to-speech 
technology.  The system dictates a list of profiles you can choose from: 
 
"To modify unplanned schedules for <Profile_Name>, press n" 

5. Press the digit (n) that corresponds to the profile you wish to select.  This causes the CIC to 
build a list of unplanned schedules for the selected profile.  It dictates schedule names to you, 
so that you can make a selection: 
 
To modify the unplanned schedule, <Schedule_Name>, press n" 

6. Press the digit that corresponds to the unplanned schedule you wish to activate or 
deactivate.  The voice prompt that you hear next varies.  
 
If the schedule is currently inactive, the voice prompt is "To activate <Schedule Name>, press 
1".  
If the schedule is currently active, the prompt is "To deactivate <Schedule_Name>, press 1". 

7. Press 1 to activate or deactivate the schedule.  The system responds with a message stating 
that "schedule <Schedule_Name> has been" activated or deactivated. 
 
At this point, control returns to the menu that you entered in step three. 

System Schedules 
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Schedules can be defined Interaction Attendant, and also in Interaction Administrator using the 
People > Schedules container.  Schedules created in Interaction Administrator are similar to schedules 
created in Interaction Attendant; both define a span of time.  The System Schedule type in Interaction 
Attendant allows you to utilize one or more schedules that were defined in Interaction 
Administrator.  This creates a linkage that allows the Attendant schedule to utilize schedule 
configurations managed in Interaction Administrator. 

The figure below shows a schedule entry in Interaction Administrator: 

 
System schedules have no effect on Interaction Attendant unless you create an Interaction Attendant 
schedule form, choose the System tab, and add the names of schedules to the Linked System 
Schedules list. Interaction Attendant can read system schedules, but it cannot modify them. 

For more information about schedules in Interaction Administrator, refer to the topic titled About 
Schedules in the Interaction Administrator Help. 

System Schedule frame 

Defined System Schedules 
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This lists contains the names of system schedules that have been defined in Interaction 
Administrator.  To link an Interaction Attendant schedule to an Interaction Administrator system 
schedule, choose a system schedule from the list, and then click Add.  Repeat to add additional 
schedules as needed. 

Once a link is in place, changes made to the schedule using Interaction Administrator are 
automatically reflected in the auto-attendant processing.  Interaction Attendant's handlers read and 
interpret system schedules in order to determine which menu to play at any given moment of any 
given day.  

Linked System Schedules list 

This list contains the names of schedules in Interaction Administrator that you have linked for use in 
this Attendant schedule.  Clicking the Remove button removes the selected schedule from this list. 

Show Schedule button 

Click this button to display system schedule settings, which are read-only.   Then click OK to close 
the System Schedule dialog. 

 
Note—Prior to Interaction Attendant 2.1, system schedules that were marked inactive in 
Interaction Administrator did not appear in the System Schedule combo box.  In Attendant v2.1 
and later, inactive system schedules appear in the combo box as grayed out items with an 
inactive marker.  This makes it possible to select an inactive schedule that might be made active 
later. 

Additional information about system schedules can be found in the Interaction Administrator help. 

Resolution of Schedule Conflicts 
Scheduling conflicts can occur when two menus are scheduled to play at the same time. For 
example, both the December 25 and the weekend menu are scheduled to play on a particular 
Saturday. Interaction Attendant will play the December 25 menu because days of the year take 
priority over days of the week. 

This list below demonstrates how Interaction Attendant determines which schedule to play in a 
conflict. 

Yearly 
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An unplanned menu scheduled to run on a specific day of the year takes priority over any other 
menu, if the unplanned menu is activated. That means that if you have a Saturday menu and 
Christmas menu, and Christmas falls on Saturday, the Christmas menu is played. 

Monthly 

A menu based upon monthly criteria takes priority over a menu scheduled to run every week. 

Weekly Schedule 

A menu scheduled to run on a specific day of the week takes priority over a menu scheduled to run 
every day. For example, if you have a lunch menu that plays every day from 1 until 2, and a 
weekend menu that plays on Saturday and Sunday, the weekend menu has priority. 

Daily Schedule 

If there is an overlap between two menus both scheduled to run every day, then the menu that 
started more recently is used. For example, suppose you have a menu that runs every day from 6 
AM to 6 PM, and a lunch menu scheduled to run from 12 PM to 1 PM. When a call comes in at 
12:30 PM, Interaction Attendant sees that the lunch menu was started more recently, and 
therefore uses the lunch menu.  This "tie-breaker" also applies when there are conflicts between 
two weekly or monthly schedules. 

Operations 

Operations 
Operations are actions that Interaction Attendant performs, usually in response to a user key 
press.  Operations are added below schedule nodes to create menus.  Operations are scoped to 
the server whose node is selected.  For example, you can't use an operation to transfer a call to a 
workgroup on another server.  Interaction Attendant provides operations for each object type 
(telephone calls and Emails): 

Object Types 

• Call Operations 

• Email Operations 

Call Operations 

Call Operations 
Attendant provides many call operations, so we have categorized them into related groups: 

• Standard operations perform ordinary IVR actions, such as dialing by name, dialing an 
extension, or transferring the call. 

• Database operations query a database and can play back a field to the caller using text-to-
speech.  These nodes can also insert a new row, or update a database field. 

• Queue operations interact with callers who are waiting in queues, by playing messages, 
presenting menus, or allowing the caller to request a callback. 
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Standard Operations 

Standard Operations 
Standard Operations perform ordinary IVR actions, such as dialing by name, dialing an extension, 
or transferring the call. 

Caller Data Entry 

Prompts callers to enter a string of digits. 

Dial by Name 

Prompts a caller to enter the first few digits of an Interaction Client user's first or last name. 

Dial Extension 

Dial Extension transfers a call to the extension of an Interaction Client user.  The caller, who must 
know the number beforehand, enters the extension number. 

Disconnect 

This operation provides callers with a graceful way to exit a menu system. 

Disposition Interaction Dialer Call 

This operation dispositions an Outbound call that was placed by Interaction Dialer.  You can assign 
Reason and Finish codes to classify the call for reporting purposes, and then disconnect or transfer 
the call to a menu, profile, or operator call flow. 

Fax Back 

Sends a FAX to a caller's FAX machine. 

Language Selection 

Sets the current language used to play back prompts in other menus. 

Logging 

Logging appends information to the call's Interaction Log.  Agents can view this information in 
Interaction Client to reveal the path that the call took through Attendant.  This helps the agent to 
discern what the caller is looking for without having to ask the caller questions. 

Logical Transfer 

Uses a logical expression to decide which node to transfer control to. 

Multi-Action Container 

A Multi-Action node groups related steps of a process together to create a call flow routine. This 
node does not perform any actions itself. It is a container for other nodes that perform related 
actions of some sort. 

Other Tools 

This operation is available exclusively in editions of the CIC that do not include Interaction Designer 
for handler customizations.  It allows you to execute predefined handlers by selecting them from a 
combo box. 
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Play a Menu 

Presents a menu of choices to the caller. 

Play Audio 

Plays a wave audio (.wav) file for the caller.  This form provides audio controls that help 
administrators select, record, or playback message prompts. 

Play Info 

The Play Info action plays wave audio files like the Play Audio action, but adds the ability to play 
audio containing information retrieved from call attributes. You can specify an ordered sequence 
of audio bits to be played. Each audio bit can consist of an audio wav file followed by audio 
generated from a specified call attribute. 

Receive Fax 

Prompts a caller to press start on a FAX machine. 

Remote Access 

Allows a caller to retrieve voice mail from a remote location, to change status, or manage recorded 
prompts. 

Remote Data Query 

The Remote Data Query action calls a web service to retrieve data returned in call attributes. 

Run Subroutine 

Runs a custom handler. 

Screen Pop 

Screen Pop executes an action previously configured using the Actions container in Interaction 
Administrator. Actions can be thought of as a direct communications link between two application 
programs. Data is passed to a third party application to perform some action. For example, a URL 
can be passed to a web browser. In Attendant, a profile can be set up to invoke a screen pop 
action. 

Selection 

A Selection action branches after evaluating one or more expression cases. This action is similar to 
a Logical Transfer, but easier to set up when multiple expression cases must be evaluated. 

Set Attribute 

Attaches an attribute to the call object. 

Transfer to a Different Menu 

Transfers a call to another menu within the same profile or another profile. 

Transfer to a Workgroup or Station Group 

Transfers a call to a specific workgroup or station group. Station groups are groups of phones in 
break rooms, conference rooms, and other public areas. 
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Transfer to an Agent 

Sends a call to a specific user queue or station queue. 

Transfer to an External Number 

Transfers a call to a telephone number outside of your organization. 

Transfer to Voicemail 

Transfers a call to the voice mailbox of the user or workgroup queue you specify. 

Transfer to an Attendant Profile 

Transfers the current call to any inbound, outbound, or operator profile defined for this server. 

Add inbound IVR surveys to Interaction Attendant profiles 
You can create an on-demand survey in Interaction Feedback and initiate it within an Interaction 
Attendant profile. Such surveys do not require agent interaction.  Examples of such surveys include 
employee satisfaction requests solicited via coupon validation codes and mandatory health 
management surveys from outsourced health care providers to ensure patient benefit retention. 
 These surveys allow companies to measure satisfaction and improve service. 

A designated Interaction Feedback administrator creates the survey through Interaction Center 
Business Manager.  Obtain the name of the survey you want to add to the Interaction Attendant 
profile before you begin. 

Note: The survey must be marked as Active in Interaction Feedback in order to be available for 
use in Interaction Attendant. 

To add an inbound IVR survey to a profile: 

1. Do one of the following to open the Survey1 form: 

•  Open the Insert menu and select Present Survey. 

• Click the  button in the Interaction Attendant toolbar. 

2. In the Node Characteristics area, complete the following: 

 

Name field 
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The name of the survey. The label you enter here becomes the name of the node in the 
tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry 
operation.  When you assign a digit, the list displays only available digits—those that are 
not already in use at this level of the tree.  If no digit is assigned, callers cannot invoke the 
operation directly.  It is possible to create menu options that are invoked by a routing 
process, rather than by a user selection.  For details, see invoke a menu operation 
automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will 
process them.  If you uncheck a form's Active check box, the name of the node turns gray 
in the tree to indicate that the form is inactive.  Interaction Attendant and its handlers will 
thereafter ignore the form and its children.  Use this feature to save a configuration that 
you are testing.  Inactive forms are invisible to callers.  When a node is inactive, it appears 
grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default 
action.  The operation defined by the default node is performed if the caller does not press 
a key within the timeout period specified by that menu. The icon for default forms has a 
green border in the tree structure.  Any node below a menu or schedule can be marked as 
the default action, by checking the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control 
passes through this node.  Several IVR Reports summarize this information.  IVR Reporting 
is disabled by default.  Enable it to capture the date, time and duration of time that the call 
remained in the node and its children.  This option is hidden when Attendant is connected 
to a server that does not have reporting installed.  For more information about this 
feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's 
Interaction Log when the call enters this node.  This helps track the path that a call took 
through Attendant.  The Interaction Log is maintained for reporting purposes.  See View 
the Interaction Log for details. 

Configure Speech Recognition... button 
Select this button to configure words or phrases that can be associated with menu options. Callers can verbally indicate the 
options they want in the IVR instead of pressing a digit on the phone. You can enter multiple words and phrases for each 
menu item, just as callers may phrase the same request in different ways. For example, "transfer funds" or "funds transfer". 
See Add Speech Recognition keywords or phrases to Inbound Call Operations. 
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3. In the Survey drop-down list, select the IVR survey you wish to use in this profile. 

 
4. Click Save to publish the changes to the profile. 

  

Caller Data Entry 
Caller Data Entry prompts callers to enter a string of digits using their telephone keypad.  For 
example, it might ask a caller to enter a FAX number or an account number.  User input ends after 
a specified number of digits are received, or when a terminating character is received.  You have 
the option to convert the entry to speech, and read it back to the caller.  The input data can also 
be attached to the call object as a call object attribute.  Call object attributes can be used in DDE 
operations, and may be accessed by handlers.  Data attached to a call is sometimes used in screen 
pops. 

Understanding How Timeout Behavior is Calculated 

If a user presses the key specified in the Digit list box, he or she has a predetermined amount of 
time to enter subsequent numbers before the system times out.  The system also times out after 
a set period if a user enters less than the specified number of digits set in the End of Input 
Condition frame and does not enter a terminating character.  Interaction Attendant will wait 
twice the set timeout value to receive the first digit and waits the exact timeout value for all 
subsequent digits.   For example, if the timeout value is set to 3 seconds, the system will wait 6 
seconds to receive the first digit, and will wait three seconds to receive each subsequent digit. 

Note: Timeout values are set in the Caller Data Entry Error Handling Options Dialog.  

You can determine the flow of control that occurs after data entry has been completed.  For 
example, you can return to the previous menu, disconnect the call, or jump to any profile, 
schedule, menu, or operation.  However, control cannot be passed to a profile, schedule, menu, 
or to an operation on another server. 

In-Queue menus 

You can place the Caller Data Entry node within an in-queue menu. When you also add a 
Request Callback node to the in-queue menu, you can configuring the Caller Data Entry node's 
Action When Finished frame to jump to the in-queue menu's Request Callback node. This 
configuration lets the caller enter a specific telephone number during a callback request, and 
Interaction Attendant will pull that number from the Caller Data Entry node when processing 
the callback request. 

 
Note: Make sure you also configure the Request Callback node's Callback Number frame 
to call the appropriate Caller Data Entry node listed in the in-queue menu. 
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Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether 
or not it is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When 
you assign a digit, the list displays only available digits—those that are not already in use at this 
level of the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is 
possible to create menu options that are invoked by a routing process, rather than by a user 
selection.  For details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore 
the form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers.  When a node is inactive, it appears grayed out 
in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the 
tree structure.  Any node below a menu or schedule can be marked as the default action, by 
checking the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled 
by default.  Enable it to capture the date, time and duration of time that the call remained in 
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the node and its children.  This option is hidden when Attendant is connected to a server that 
does not have reporting installed.  For more information about this feature, see IVR Reporting 
Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction 
Log when the call enters this node.  This helps track the path that a call took through 
Attendant.  The Interaction Log is maintained for reporting purposes.  See View the Interaction 
Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. 
Callers can verbally indicate the options they want in the IVR instead of pressing a digit on the 
phone. You can enter multiple words and phrases for each menu item, just as callers may 
phrase the same request in different ways. For example, "transfer funds" or "funds transfer". 
See Add Speech Recognition keywords or phrases to Inbound Call Operations. 

Prompt frame 

 
Controls in this frame set a prompt to play when control is passed to this node.  If you do not 
select or record a prompt using the embedded audio controls, no voice prompting will 
occur.   See manage voice prompts for details. 

Use speech recognition for the data entry 

 
Select this check box to allow callers to speak the numbers instead of manually entering them. 

End of Input Condition frame 
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The options in this frame determine what signals Attendant to stop listening for incoming 
digits.  You can end the data entry process when a fixed number of digits are received, or stop 
accepting data once a terminating character is pressed. 

Exact number of digits 

This radio button enables the digits spin control.  Data acquisition is terminated once the 
number of digits that you select are received.  

Terminating Character 

This radio button enables the Stop when caller enters combo box, so that you can select the 
value that will be used to signal end of data entry.  The possible values are 0-9, #, and 
*.  <None> is also an option, but you should never use it.  If you do, Attendant will never stop 
accepting data. 

Verification frame 

Options in the Verification frame control feedback given to callers about data entered. 

 

Read the input back to the caller for verification check box 

When verification is enabled, data entered by the caller is converted to speech and is read 
back to the caller.   Afterwards, Attendant prompts the caller to confirm or reject the entry: 

• "If this is the desired entry, press 1.  Otherwise to reenter, press 2." 

• If the caller selects 1, the input data is accepted.  If the caller presses 2, the caller is 
prompted to reenter the data.  The radio buttons control the way in which numeric 
input data is pronounced by the text-to-speech engine: 

As Unique Digits radio button 

1234 will be read back as "one two three four". 

As a Numeric Value radio button 

1234 will be read back as one thousand, two hundred and thirty four". 

As a Monetary Value radio button 

1234 will be read back as "twelve hundred thirty four dollars".  Since the caller data entry 
operation does not provide a way to delimit dollars and cents, it doesn't offer a built-in method 
of capturing decimal numbers.  However, you could use two caller data entry operations; one 
to capture the whole dollar amount, and another to capture the cents.  
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If the verification option is unchecked, no data is read back to the caller, and confirmation 
prompting does not occur.  It's a good idea to provide callers with the ability to accept or reject 
data entered.  You should always enable verification unless you are prompting for simple 1-
digit values (e.g. 1=Yes, 2=No). 

Call Attribute frame 

 
You can attach data entered by the caller to the call itself as a call attribute.  An attribute is a 
piece of information about an object that travels with it throughout the Customer Interaction 
Center.   For example, one standard attribute of a call object is the telephone number of the 
person who placed the call.  A call object can have as many attributes as are 
needed.  Attributes stay with a call until it is disconnected. 

CIC supports application programming interfaces (API's) that provide access to call object 
attributes.  Dynamic Data Exchange (DDE) is commonly used to accomplish this, as is the 
Interaction Client Win32 COM API.  Attributes typically store information that is passed to a 
database or a third-party application.  For example, the IC can be set up to "pop" a database 
application when an incoming call arrives at an agent's workstation.  

Related Documentation 
 
For more information about DDE and other APIs, see the System APIs section of the 
master documentation library on your IC server.   The Interaction Attributes Technical 
Reference (in the PureConnect Documentation Library) describes attribute names that are 
reserved by IC.   If you assign data to a standard IC attribute, you could potentially affect 
the execution of a handler.  The Interaction Attributes Technical Reference identifies 
attributes whose value you should never change. 

Suppose, for example, that you use caller data entry to capture an account number and store 
it as a call attribute.  This preserves the account number as the call is routed throughout 
CIC.  If the call is routed to an agent's desktop, the account number can be used to look up 
the customer record in a database.  Information about the customer can be displayed on the 
screen at the time when an agent receives the call. 

Assign the results to a call attribute for later use 

Enable this check box to assign data entered by the caller to a call attribute.  Each call 
attribute is a name/value pair.  The attribute name can be anything you like, since it identifies 
the data.  

Attribute 

This field stores the name of the attribute that input data will be assigned to.  Since many 
handlers in CIC process attributes, attribute names have been standardized to identify 
common types of data.  Type the name of a standard call attribute in this field, or enter your 
own custom attribute name.   
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You can name a custom attribute anything you like.  Custom names can contain spaces and 
special characters.  To avoid potential conflicts with reserved attribute names, do not begin 
the name with the letters EIC_.  CIC's standard attribute names begin with those letters.  If 
you overwrite a standard attribute, you could accidentally interfere with normal operation of 
the IC server. 

Advanced Error Handling Options 

 
The Caller Data Entry form provides advanced error handling options that supplement the 
error handling provided by the schedule that the form is attached to.  To define these 
options, press the Advanced Error Handling button. 

Advanced Error Handling button 

Opens the Caller Data Entry Error Handling Options Dialog.  It defines the maximum length of 
time that Interaction Attendant should wait for keys to be pressed before re-prompting the 
caller, and establishes the maximum number of times that the prompt will be repeated 
before control is passed to the Schedule's error handler, or to the profile, schedule, menu, or 
operation that you select. 

Action When Finished frame 

These options set the processing that occurs after the operation completes successfully, 
when flow of control leaves this node.  You can return control to the previous menu, 
disconnect the call, transfer to an operator profile, or jump to any node or action that has 
been defined for the current server. 

 

Go back to previous menu 

This option returns control to the parent menu.  This sets up a simple loop that "reruns" the 
menu from the top. 

Disconnect 

This option disconnects the call when the data entry operation is completed successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 
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Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for 
the current server. 

Dial by Name 
Dial by name allows a caller to find an agent by name.  It prompts a caller to enter the first 
few digits of an Interaction Client user's first or last name.  The digits can be compared to first 
name only, last name only, or to both first and last names.  Matching can be restricted to 
selected workgroups, or to the entire company directory.  You can match after a specific 
number of characters, or wait until the user enters a unique match. 

• If a single match is found, the caller can press 1 to call the extension.  If more than 
one match is found, Interaction Attendant plays each name and extension, and then 
allows the caller to enter the correct extension. 

• If no matches are found, a prompt explains this to the caller. Interaction Attendant 
returns to the menu from which Dial by Name was called. 

• The matching style is configurable.  You can require a unique match, or can approve a 
match based upon a defined number of matching characters. 

Essential Guidelines for using the Dial by Name Action 

Due to a limitation in handler logic, ASR Speech Recognition does not work properly unless: 

• The Dial by Name action is attached to a Schedule.  Speech Recognition isn't used if 
the Dial by Name node is placed under a menu instead of a schedule. 

• The Schedule's "Number of Seconds to wait before repeating" setting is greater than 
0 seconds. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether 
or not it is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 
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Use this list to select the key that callers press to enter a caller data entry operation.  When 
you assign a digit, the list displays only available digits—those that are not already in use at 
this level of the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is 
possible to create menu options that are invoked by a routing process, rather than by a user 
selection.  For details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree 
to indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter 
ignore the form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers.  When a node is inactive, it appears grayed out 
in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within 
the timeout period specified by that menu. The icon for default forms has a green border in 
the tree structure.  Any node below a menu or schedule can be marked as the default action, 
by checking the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled 
by default.  Enable it to capture the date, time and duration of time that the call remained in 
the node and its children.  This option is hidden when Attendant is connected to a server that 
does not have reporting installed.  For more information about this feature, see IVR Reporting 
Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction 
Log when the call enters this node.  This helps track the path that a call took through 
Attendant.  The Interaction Log is maintained for reporting purposes.  See View the 
Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. 
Callers can verbally indicate the options they want in the IVR instead of pressing a digit on the 
phone. You can enter multiple words and phrases for each menu item, just as callers may 
phrase the same request in different ways. For example, "transfer funds" or "funds transfer". 
See Add Speech Recognition keywords or phrases to Inbound Call Operations. 

Match By frame 

These options determine what the digits entered by the caller are compared to. 
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First Name radio button 

When this option is selected, user input is matched against the first names of Interaction 
Client users. 

Last Name radio button 

When this option is selected, user input is matched against the last names of Interaction 
Client users. 

First or Last Name radio button 

When this option is selected, user input is matched against the first and last names of 
Interaction Client users. 

Matching Style 

These options determine whether a complete matching is required. 

 

Wait for unique match 

When selected, users must enter characters until a unique match is found. 

Use a specific number of characters 

When selected, enables the number of characters spin control, which sets the number of 
matching characters that users must enter before matches are evaluated. 

Filtering 

These options determine whether digits entered by the caller are compared to the entire 
company directory or to specific workgroups. 
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Search entire directory 

Check Search the entire company directory to match user input against all names in the 
company directory. 

Search only the following workgroups 

Check Search only the following workgroups to restrict matching to the workgroups whose 
name are checked in the workgroups list. 

Workgroups list 

The names of workgroups appear in this list box. Check or uncheck workgroup names in this 
list to include or exclude them from workgroup searches. 

Dial Extension 
This operation allows the caller to dial and be transferred to a specific extension.  The caller, 
who must know the number beforehand, enters the extension number.  Matching can be 
restricted to selected workgroups, or to the entire company directory. 

The extension can be an Interaction Client user's extension, a workgroup extension, or a 
workstation extension. The call is then transferred to that extension, or a prompt is played if 
the extension is not valid.  If the extension is valid, the call is transferred.  If the extension is 
not valid, the caller is returned to the menu from which Dial Extension was called.  Interaction 
Attendant's handlers listen for digits entered by the caller.  You are responsible for setting up 
a voice prompt that is played when a user does not respond within a specified time period.  

Dial Extension entries can be a little tricky to set up, so be sure to read this topic 
carefully.  Like most auto-attendants, Dial Extension allows callers to dial an extension as 
soon as the call is picked up. For example, when the call is picked up and the prompt 
says "Welcome to Acme Explosives Corporation" the caller can dial 123 to call extension 
123 without navigating your entire menu structure. 
 
To enable this functionality, you will need to know the number used to begin all 
extensions. For example, all extensions in your company could begin with a 1, 7, or 8. 
Individual extensions start with a 1, such as 114, 133, or 155. Workgroup extensions start 
with a 7, such as 701 for sales and 702 for support. And workstation extensions begin 
with 8, such as 810 for the conference room and 825 for the shop floor. 
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Once you've identified the numbers that start extensions, you should add an Dial Extension 
entry with an assigned key for each of these numbers. This is shown in the following 
diagram. 

Once this is configured as described above, a caller dialing an extension will invoke the 
menu entry with the first key press. The Dial Extension entry knows that the caller is trying 
to dial an extension, recognizes that the first digit dialed was part of the extension, and uses 
that first digit and any following digits to determine the requested extension. It then looks 
up the extension and transfers the call, or plays an error message if the extension is invalid. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish 
whether or not it is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When 
you assign a digit, the list displays only available digits—those that are not already in use at 
this level of the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is 
possible to create menu options that are invoked by a routing process, rather than by a user 
selection.  For details, see invoke a menu operation automatically. 

Active check box 
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By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree 
to indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter 
ignore the form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers.  When a node is inactive, it appears grayed 
out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default 
action.  The operation defined by the default node is performed if the caller does not press a 
key within the timeout period specified by that menu. The icon for default forms has a green 
border in the tree structure.  Any node below a menu or schedule can be marked as the 
default action, by checking the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is 
disabled by default.  Enable it to capture the date, time and duration of time that the call 
remained in the node and its children.  This option is hidden when Attendant is connected 
to a server that does not have reporting installed.  For more information about this feature, 
see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's 
Interaction Log when the call enters this node.  This helps track the path that a call took 
through Attendant.  The Interaction Log is maintained for reporting purposes.  See View the 
Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. 
Callers can verbally indicate the options they want in the IVR instead of pressing a digit on 
the phone. You can enter multiple words and phrases for each menu item, just as callers 
may phrase the same request in different ways. For example, "transfer funds" or "funds 
transfer". See Add Speech Recognition keywords or phrases to Inbound Call Operations. 

Filtering frame 

These options determine whether digits entered by the caller are compared to the entire 
company directory or to specific workgroups. 
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Search entire directory 

Check Search the entire company directory to match user input against all names in the 
company directory. 

Search only the following workgroups 

Check Search only the following workgroups to restrict matching to the workgroups whose 
name are checked in the workgroups list. 

Workgroups list 

The names of workgroups appear in this list box. Check or uncheck items in this list to 
include or exclude them from workgroup searches. 

Error Handling frame 

These options tell Attendant what to do if the caller does not enter digits very quickly. 

 

Seconds to wait (between digits) before timing out spin control 

This control sets the amount of time, in seconds, that Attendant waits for the caller to press 
a key.  If a timeout occurs, control is passed to the schedule's error handler.  The caller will 
be re-prompted as per the re-prompt controls.  After 'n' re-prompts the error handler is 
ignored. 

File to play to re-prompt the caller list box 
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The embedded audio controls in this frame are used to select or record a voice prompt file 
that will play if the caller does not enter a digit within the period of time specified by 
seconds to wait between digits before timing out.  

Number of times to re-prompt the caller 

This spin control sets the number of chances that a caller has to enter a valid extension 
before control is passed to the schedule's error handler.  After 'n' re-prompts the error 
handler is ignored. 

Disconnect 
Disconnect provides callers with a graceful way to exit a menu system.  It disconnects the 
call immediately.  It is good practice to provide a Disconnect option, so that callers will know 
when it is appropriate to hang up.  You can optionally play a wave file before the call is 
disconnected (e.g. "thank you for calling").  This gives callers a way to say goodbye to the 
auto-attendant.  If you leave callers in a menu that lacks an exit path, they may feel trapped, 
and may dislike the system. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish 
whether or not it is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When 
you assign a digit, the list displays only available digits—those that are not already in use at 
this level of the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is 
possible to create menu options that are invoked by a routing process, rather than by a user 
selection.  For details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree 
to indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter 
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ignore the form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers.  When a node is inactive, it appears grayed 
out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default 
action.  The operation defined by the default node is performed if the caller does not press a 
key within the timeout period specified by that menu. The icon for default forms has a green 
border in the tree structure.  Any node below a menu or schedule can be marked as the 
default action, by checking the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is 
disabled by default.  Enable it to capture the date, time and duration of time that the call 
remained in the node and its children.  This option is hidden when Attendant is connected 
to a server that does not have reporting installed.  For more information about this feature, 
see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's 
Interaction Log when the call enters this node.  This helps track the path that a call took 
through Attendant.  The Interaction Log is maintained for reporting purposes.  See View the 
Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. 
Callers can verbally indicate the options they want in the IVR instead of pressing a digit on 
the phone. You can enter multiple words and phrases for each menu item, just as callers 
may phrase the same request in different ways. For example, "transfer funds" or "funds 
transfer". See Add Speech Recognition keywords or phrases to Inbound Call Operations.. 

Audio File frame 

The options in this frame manage an optional voice prompt that plays before the user is 
disconnected.  

 

Name 

This field stores the name of the prompt. See Using embedded audio controls. 
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Disposition Interaction Dialer Call 
The ability to disposition an outbound call made by Interaction Dialer is available in outbound call flows 
only.  You can assign Wrap-up categories and Wrap-up codes to classify the call for reporting purposes, 
and then disconnect or transfer the call to a menu, profile, or operator call flow.   

In general, Wrap-up codes add granularity to reporting, while Wrap-up categories provide for 
standardized reporting across multiple campaigns. Attendant passes Wrap-up categories and Wrap-up 
codes back to Interaction Dialer when the call is completed. 

The Dialer Call Completed node triggers a timer that sends the disposition information to Dialer to be 
written, after which time we are unable to set a different disposition for the interaction (since there can 
only be one disposition per Dialer interaction). This timer can be configured via the Dialer Disposition 
After Call Transfer Delay optional server parameter. 

Configure call disposition preferences in the Dialer Call Completed node. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it, and establish whether or not it is 
active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign a 
digit, the list displays only available digits—those that are not already in use at this level of the tree.  If 
no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu options 
that are invoked by a routing process, rather than by a user selection.  For details, see invoke a menu 
operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If you 
uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the form 
is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are invisible to callers. When a 
node is inactive, it appears grayed out in the tree view. 
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Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through this 
node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by default.  Enable it 
to capture the date, time and duration of time that the call remained in the node and its children.  This 
option is hidden when Attendant is connected to a server that does not have reporting installed.  For 
more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log when 
the call enters this node.  This helps track the path that a call took through Attendant.  The Interaction 
Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can enter 
multiple words and phrases for each menu item, just as callers may phrase the same request in different 
ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases to Inbound 

Call Operations. 

Wrap-up Category drop-down list 

Wrap-up categories generically classify the result of a campaign call for reporting purposes.  Interaction 
Dialer creates a set of wrap-up categories during installation, but you can also create your own.  Any 
pre-defined wrap-up category may be used, and the category properties determine how Dialer 
interprets the results of the call. 

 

Wrap-up Code drop-down list 

Your CIC administrator can associate wrap-up codes with any workgroup queue. Wrap-up codes indicate 
the nature of an interaction; for example, a billing problem, a new order, or a service request. Your CIC 
administrator can generate reports to categorize call details by wrap-up codes. 

Each campaign may have its own set of custom wrap-up codes.  Wrap-up codes categorize the result of 
a call for reporting purposes, but are more specific than wrap-up categories.  For example, a newspaper 
campaign might use wrap-up codes to record reasons given by customers for not subscribing.   These 
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wrap-up codes might be: "doesn't read a newspaper”, "subscribes to a different newspaper", or 
something similar.   The corresponding wrap up category would be "Failure", which is much less specific. 

 

Action When Finished frame 

These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves this node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server. 

 

Go back to the previous menu radio button 

This option returns control to the parent menu from which the message was played.  This sets up a 
simple loop that "reruns" the parent menu from the top. 

Disconnect radio button 

This option disconnects the call. 

Transfer to Operator Processing radio button 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location radio button 

The Jump to a custom location radio button allows you to jump to any profile, schedule, menu, or 
operation that is defined for the current server. 

Fax Back 
This operation sends a Fax to the number specified by the caller.  The Fax is sent over the current call 
connection, or to the telephone number acquired by a Caller Data Entry node.  Fax Back does not 
prompt the caller to enter a number.  You must also specify which file to Fax, and the action to perform 
when finished.  

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it is 
active, used by default, logged, or tracked for reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign a 
digit, the list displays only available digits—those that are not already in use at this level of the tree.  If 
no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu options 
that are invoked by a routing process, rather than by a user selection.  For details, see invoke a menu 
operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If you 
uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the form 
is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are invisible to callers.  When a 
node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through this 
node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by default.  Enable it 
to capture the date, time and duration of time that the call remained in the node and its children.  This 
option is hidden when Attendant is connected to a server that does not have reporting installed.  For 
more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log when 
the call enters this node.  This helps track the path that a call took through Attendant.  The Interaction 
Log is maintained for reporting purposes.  See View the Interaction Log for details. 
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Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can enter 
multiple words and phrases for each menu item, just as callers may phrase the same request in different 
ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases to Inbound 

Call Operations. 

File to Fax frame 

This section identifies the file to Fax.  

 

File to Fax 

Selects an existing Interaction Fax file from the AttendantFaxes share on the CIC server.  Fax files are 
created outside of Attendant using the Interaction Fax application. 

Browse button 

You can browse for *.i3f files anywhere on your network.  When the configuration is published, the 
selected file is stored in the AttendantFaxes share on the CIC server. 

Caller's Fax Number frame 

These options control Fax routing. 

 

Send the fax out on this call radio button 

This option determines whether the Fax will be sent using the current call connection, or by placing a 
new call once the current call is disconnected. 

Send the fax to the fax number entered by the caller in this Caller Data Entry node: 

This option identifies the Caller Data Entry node that acquires the destination telephone number to 
Fax.  The Fax Back operation itself does not prompt the user to enter a telephone number.  You must 
collect this information using a Caller Data Entry node before invoking Fax Back. 

Action When Finished frame 
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These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves this node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server. 

 

Go back to the previous menu radio button 

This option returns control to the parent menu from which the message was played.  This sets up a 
simple loop that "reruns" the parent menu from the top. 

Disconnect radio button 

This option disconnects the call once the FAX is sent. 

Transfer to Operator Processing radio button 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location radio button 

The Jump to a custom location radio button allows you to jump to any profile, schedule, menu, or 
operation that is defined for the current server. 

Language Selection 
Language Selection operations create menus that allows callers to select a preferred language.  This 
node sets the language used to play back prompts in other menus, overriding the default language, and 
setting a new current language.  The example below allows callers to choose the language used to play 
back prompts in the Main Menu. 
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The language used to play prompts at runtime is known as the current language.  The default 
language is defined outside of Interaction Attendant in Interaction Administrator.   When you record a 
new prompt, Attendant assumes that you are recording in the default language defined for the 
server.  Prompts are played in the default language unless the current language is set to something else 
by a language selection node or a profile form.  See manage voice prompts for more information about 
mechanisms in Attendant that support multiple languages. 

To Create a Language Selection Menu 

Follow these steps to create a language selection menu. 

1. Add a new menu node by selecting Insert | New Operation | Play a Menu.  This menu should 
play a wave file that prompts users to select a language.  e.g.: "Press 1 for English, Press 2 for 
French", etc. 

2. Add a Language Selection node to the menu. 

3. Assign a digit, pick a language from the combo box, and set up an action when finished.  In most 
cases you will want to transfer control to another menu, as shown in the example above. 

4. Repeat steps 2-3 to add additional language choices as needed. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it, and establish whether or not it is 
active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign a 
digit, the list displays only available digits—those that are not already in use at this level of the tree.  If 
no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu options 
that are invoked by a routing process, rather than by a user selection.  For details, see invoke a menu 
operation automatically. 

Active check box 
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By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If you 
uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the form 
is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are invisible to callers. When a 
node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through this 
node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by default.  Enable it 
to capture the date, time and duration of time that the call remained in the node and its children.  This 
option is hidden when Attendant is connected to a server that does not have reporting installed.  For 
more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log when 
the call enters this node.  This helps track the path that a call took through Attendant.  The Interaction 
Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can enter 
multiple words and phrases for each menu item, just as callers may phrase the same request in different 
ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases to Inbound 

Call Operations. 

Language to Use for prompts frame 

The option in this frame control sets the current language to an available language. 

 

Language to use for prompts list box 

The language selected from this list becomes the current language used to play back prompts, 
presuming of course, that the caller presses a key to select this language selection node. 

Action when Finished frame 
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These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves this node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server.  In most 
cases you will want to transfer control to another menu, as shown in the figure below. 

 

Go back to the previous menu radio button 

This option returns control to the parent menu from which the message was played.  This sets up a 
simple loop that "reruns" the parent menu from the top. 

Disconnect radio button 

This option disconnects the call. 

Transfer to Operator Processing radio button 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location radio button 

The Jump to a custom location radio button allows you to jump to any profile, schedule, menu, or 
operation that is defined for the current server. 

Related Topics 

• Manage Voice Prompts 

Logging 
Logging appends information to the call's Interaction Log.  This can be free-form text (up to 1024 
characters), the value of a call attribute, the current date and time, data entered by the caller, or data 
retrieved using DB Query (CIC only).  See also: view the Interaction Log.  

Agents can View the Interaction Log in Interaction Client to reveal the path that the call (or Email) took 
through Attendant, and other data items that help the agent to discern what the caller is looking for 
without having to ask the caller questions. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it is 
active, used by default, logged, or tracked for reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign a 
digit, the list displays only available digits—those that are not already in use at this level of the tree.  If 
no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu options 
that are invoked by a routing process, rather than by a user selection.  For details, see invoke a menu 
operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If you 
uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the form 
is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are invisible to callers.  When a 
node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through this 
node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by default.  Enable it 
to capture the date, time and duration of time that the call remained in the node and its children.  This 
option is hidden when Attendant is connected to a server that does not have reporting installed.  For 
more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log when 
the call enters this node.  This helps track the path that a call took through Attendant.  The Interaction 
Log is maintained for reporting purposes.  See View the Interaction Log for details. 
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Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can enter 
multiple words and phrases for each menu item, just as callers may phrase the same request in different 
ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases to Inbound 

Call Operations. 

Logging Information frame 

The options in this section of the form control what is appended to the Interaction Log.  

 

Log this text 

When you select this option, you can enter up to 1024 characters of free-form text to the entry 
appended to the Interaction Log. 

Log this call attribute (and its value) 

Select this option to enter the name of a call attribute.  At runtime, the value of the call attribute is 
appended to the Interaction Log as follows: 

Attribute Name -> value of attribute 

Log the current date and time 

This option logs the current ISO timestamp to the Interaction Log.  The format of the time stamp is: 

YYYY-MM-DD HH:MM:SS 

Log the data retrieved by the DB query at node 

DB Query is available only in CIC and selected OEM editions of CIC.  It queries a data source to retrieve a 
value.  For example, a caller might select this operation from a menu to look up his account balance 
from your database.  This option logs the result of the DB Query performed by a particular node to the 
call's Interaction Log.  The log message is formatted as follows: 
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DB Query returned -> value 

Log the value entered by the caller at node 

This option logs data entered by the caller to the Interaction Log.  You must specify which Caller Data 
Entry node was used.  The log message is formatted as follows: 

Caller input -> value 

Action When Finished frame 

These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves this node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server. 

 

Go back to previous menu 

This option returns control to the parent menu.  This sets up a simple loop that "reruns" the menu from 
the top. 

Disconnect 

This option disconnects the call when the operation is completed successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server. 

Logical Transfer 
A Logical Transfer transfers a call to another node, based on the result of a logical expression.  This 
operation adds "branch-on-condition" capability to a menu, since it evaluates a logical expression to 
decide which node to transfer the call to.   

A "logical expression" is a set of conditions that you specify.  Expressions can be based on data entered 
by the caller, call attributes, the current time, data about a workgroup or data retrieved from a 
database. 
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These conditions determine where flow of control is passed when this operation executes.  A logical 
expression always evaluates to True or False.  For example, the statement, "Is today Saturday?" is a 
logical expression.  If today is Saturday, the expression is True.  Otherwise it is False.   

Expressions are built using a simple wizard.  An expression can be based on: 

• data previously entered by the caller 

• data about the current call 

• the current time 

• data about a particular workgroup 

• data from a database 

Note: The use of a Logical Transfer in an Expression Case can break the expected top-down 
execution order if you set the jump to location to another node in an Expression Case. 

ACD Utilization is not taken into account when determining agent availability through Attendant. 
Specifically, the 'Logical Transfer' step can be configured to do a check for the 'Number of available 
agents' within a provided workgroup. This check will return the number of agents who are 100% 
available. This means that any agent on an interaction will be considered unavailable regardless of how 
their ACD utilization is configured. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it, and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign 
a digit, the list displays only available digits—those that are not already in use at this level of the 
tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu 
options that are invoked by a routing process, rather than by a user selection.  For details, see invoke a 
menu operation automatically. 

Active check box 
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By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can 
enter multiple words and phrases for each menu item, just as callers may phrase the same request in 
different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases 

to Inbound Call Operations. 

Expression to Evaluate frame 

This frame displays the expression that will be evaluated to return a Boolean (True or False) value.  If 
no expression has been defined, it displays "No Expression Defined" and a pushbutton titled Create 
Logical Expression that opens the Expression Type wizard.  If an expression has been defined, you can 
press the button titled "Modify Logical Expression" to edit the expression. 
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Create Logical Expression button 

Opens the Expression Type wizard.  Once an expression has been defined, the button caption changes 
to "Modify Logical Expression".  If you press the button a second time, you are given the opportunity to 
change you selections. 

Transfer Location frame 

This frame sets the paths that are taken after the logical expression is evaluated.  One path is taken 
when the expression is True.  The other path is taken when the expression is False. 

 

If the above statement is true, go to... 

This list box allows you to select the path that is taken when the expression is True.  You can select any 
profile, schedule, menu, or operation that is defined for the current server. 

If the above statement is false, go to... 

This list box allows you to select the path that is taken when the expression is False.  You can select any 
profile, schedule, menu, or operation that is defined for the current server. 

Related Topics 

• Expression Type Wizard 

Multi-Action Container 
In general, Attendant forms execute without much caller intervention, in the order specified by the 
design.  However, when the Attendant tree is sorted, the nodes that execute as a block are often 
separated, making it difficult to visually analyze a process.  To avoid this problem, you can group nodes 
for a related process below a Multi-Action operation. 

A Multi-Action node groups related steps of a process together, to create a call flow routine. 

A Multi-Action node does not perform any actions itself.  It is a container for other nodes that do 
perform actions.  For instance, a common situation in Attendant is to prompt a user for his/her 
account number and then to look up a value in a database.  This requires several steps (User Data 
Entry, DB Query, Menu, etc.) to implement. 

In this example, steps can be grouped together to create a meta-node of sorts, by placing them below 
a Multi-Action node named "Get Account Data".  This makes the call flow easier to inspect, since all 
nodes for the process remain together, regardless of sort order.  Multi-Action nodes encapsulate 
other nodes into routines that are easier to understand and inspect in the tree view.  Multi-Action 
nodes also provide an intermediate level of IVR reporting capability. 
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Since the children of a Multi-Action node are not sorted, you may arrange them in the order of 
execution, or in any other order, and they will stay in that visual order when the tree is 
sorted.  However, the execution order of nodes is still controlled by the flow specified in each node's 
Action When Finished.  The actions attached to a Multi-Action node can be sequentially. See How to 
Run Actions Sequentially below. 

Multi-Action nodes work like folders to group other nodes together.  They are implemented like 
menu nodes, but provide fewer configuration options.  Each Multi-Action node is an organizational 
device only and as such it has few configurable options.  Functionality is limited to optional call 
logging, IVR reporting, and prompt playback.  

The behavior of child nodes in a Multi-Action node is slightly modified.  Child nodes cannot be 
assigned a digit, since the Multi-Action node itself is assigned a digit.  The Multi-Action node may be 
flagged as a default action for sibling nodes in the tree. 

Important: You must check "Default Action" for one child of a Multi-Action node.  Otherwise, the 
Multi-Action node will be marked in error, as the routine lacks an entry point. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not 
it is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
menu options that are invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 
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Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking the 
form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers 
can verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

Audio File frame 

 
Controls in this frame set a prompt to play when control is passed to this node.  If you do not select 
or record a prompt using the embedded audio controls, no voice prompting will occur.   See manage 
voice prompts for details. 

How to Run Actions Sequentially 

As mentioned above, the execution order of nodes is controlled by the flow specified in each node's 
Action When Finished frame.  When an operation is attached to a Multi-Action node, an additional 
flow-of-control option appears in the form's Action When Finished frame.  Jump to the next node in 
this container passes control to the node below the current node, in top-down order.  This makes it 
easy to configure sequential operations, and bypasses the need to navigate the Jump to a custom 
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location combo box.  Attendant will pass control to the next node without requiring input from the 
user. 

  

The basic rules are: 

1. If "Jump to the next node" is selected and it is the last node in the container, Attendant 
considers the configuration to be invalid. It displays an error indicator next to the node in 
the tree view. 

2. If "Jump to the next node" is selected and the node is copied or dragged out of the 
container, the Action When Finished selection reverts back to the default "Go back to the 
previous menu". 

Other Tools 
The Other Tools operation passes the call to a handler for processing.  It invokes the handler that 
you select from a list of available handlers. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not 
it is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
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menu options that are invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking the 
form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers 
can verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

Tool Selection 

This section of the form identifies the handler that will be invoked.  
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Tool list box 

This list box allows you to choose a special tool that has been created to extend Interaction 
Attendant.  All interaction with these tools is performed over the telephone.  You may not pass 
parameters (e.g. queue name, agent name, etc.) to the tool.  These tools are available by default: 

Agent Login/Logout 

Allows an agent to login or logout from a station phone. 

Append Attribute 

Appends the value of source attr (passed in ATTR_SOURCE) onto the end of the target (name 
specified in ATTR_TARGET) 

Copy Attribute 

Copies attribute value (name passed in attribute ATTR_SOURCE) to another attribute (name 
specified in ATTR_TARGET). 

Custom Group Pickup 

Allows a station to pickup an alerting call on another station. Both stations must share membership 
in a Station Group with a name that includes the string "PickupGroup". 

Fetch Result 

Returns the result from the list of results ("|" delimited) in ATTR_RESULTS at position 
ATTR_LIST_INDEX. Result returned in ATTR_RESULT. 

Great Plains Pad Number 

Puts phone number in Microsoft Great Plains Phone Number format. Modifies ATTR_GP_PHONE. 

Increment Index 

Increments the value in ATTR_LIST_INDEX by 1. 

Multi-Site 

Allows an agent to pickup an inbound multi-site call.  You must select this option if you are in a 
multi-site environment.  It tells the system to check for DTMF tones that identify a Multi-Site (EMS) 
call.  Inbound multi-site calls will be routed to the main menu if this option is not selected. 

Parse Eic SIP Headers 

In Interaction Administrator, one or more SIP headers may be defined during line configuration. 
 This tool parses those SIP Headers into a set of name-pair attributes for use in Interaction Attendant 
or in custom sub-routines.  Use this tool for SIP headers that contain name/value pair data. 
 ATTR_NAME_PAIR_DELIMITER specifies the name value pair delimiter, and 
ATTR_NAME_PAIR_SEPERATOR specifies the separator between name and value. For each SIP 
header defined in Interaction Administrator, a call attribute will be created with the value from the 
SIP header on a new inbound call on the line. The call attribute name is configured with the prefix 
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'EicSIPHeader_' followed by the name of the SIP header.  For example, a SIP header defined as "x-
channel" will result in a call attribute titled "EicSIPHeader_x-channel". 

Note: Administrators can define multiple SIP headers in Interaction Administrator. In these cases, a 
call attribute for each named header is created. Headers defined as Header1, Header2 and Header3 
would result in attributes named EicSIPHeader_Header1, EicSIPHeader_Header2 and 
EicSIPHeader_Header3. The value of these attributes are semi-colon delimited name-pair values, 
separated by an "=" sign, for example, Name1=Value1;Name2=Value2;Name3=Value3. 

Parse Name Pair Attributes 

The functionality for this option has been deprecated. 

Play TTS 

Plays the value of the string contained in ATTR_TTS_INPUT. If an ATTR should be played in line, 
include it as follows: $(ATTR_foo). The handler will remove the $(..) and replace it with the string 
contained within the ATTR. 

Station Pickup Call 

Allows an agent to pickup a call that is waiting in a queue—the call may be held, parked, or 
alerting.  The user must have "modify" rights to the queue that contains the call. 

Additional tools may be added to this list.  See add additional tools to the tool list. 

Description 

When you select a tool, a brief synopsis of the tool is displayed. (See above.) 

Action When Finished frame 

These options set the processing that occurs after the operation completes successfully, when flow 
of control leaves this node.   Some tools terminate the call.  Others pass the call object back.  The 
options in this frame select processing to perform if the tool passes the call back to Attendant when 
execution is complete. 

 

Go back to previous menu 

This option returns control to the parent menu.  This option sets up a simple loop that "reruns" the 
menu from the top. 

Disconnect 
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This option disconnects the call when the data entry operation is completed successfully. 

Transfer to Operator Processing 

Transfers the interaction to the operator for processing by the Operator call flow configuration. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server. 

Add additional tools to the Tool list box 
Additional tools can be added to the default selections listed in the Tool list. Attendant can read 
custom tool names and descriptions from a text file stored on the server. This allows a reseller or 
professional services associate to add new tools to the Other Tools form without requiring changes 
to Interaction Attendant. 

To add tools, modify the existing OtherTools.IAT text file located in the \\servername\Resources 
share on the CIC Server.  This file defines custom tools for use with Interaction Attendant's Other 
Tools node. This option is not licensed for customizations by partners or end customers. To add 
custom tool selections, the procedure is as follows: 

1. From the \\servername\Resources share on the server, open the existing OtherTools.iat text 
file. 

2. Enter the Tool Name, Handler name, and tool description, separated by vertical pipe (|) 
characters.  This file should contain one line for each new tool, with each line formatted as 
follows: 

• <tool name>|<handler name>|<description> 

 

• Tool name is the name of the tool as it should appear in the combo box of tools in the UI 

• Handler name is the name of the handler that should be executed when the tool is 
invoked.  You do not need to add an .ihd extension after the name. 

• The description is the text that describes what the tool does.  This text will appear below the 
combo box in the UI when the tool is selected. 

3. Save the file.  Thereafter, when a menu designer edits properties of an Other Tools node, he 
or she will be able to select the name of your custom tool from the list. 

Play a Menu 
A menu presents choices to the caller.  Menu choices are nodes that have been assigned a digit.  

A menu is a collection of one or more menu entries that process calls based on the keys a caller 
presses.  Each menu entry is an operation form that executes when a digit is pressed. Menu nodes 
present a list of options to the caller.  
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Callers choose an entry by pressing a key on the telephone keypad. Based on the caller's choice, an 
auto attendant can offer a submenu, transfer a call to a queue, allow callers to search an employee 
directory, send or receive a fax, or perform many other actions.  

To create a menu (or sub-menu), follow these steps: 

1. Select the node in the tree that you want to attach the menu to.  Menus are usually attached 
below schedule or Multi-Action nodes.   

2. Press the Menu toolbar button ( ), or pull down the Insert menu, select New Operation, and 
finally Play a Menu. 

3. Name the menu, and record an audio prompt that tells callers which keys they can press. 

4. Set Repetition, Extension Dialing, and Fax options as needed. 

5. Select the menu node in the tree (if it is not already selected). Then add operations to it to 
create menu choices.  Name these entries, assign digits to them, and set flow of control 
options (action when finished). 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign 
a digit, the list displays only available digits—those that are not already in use at this level of the 
tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu 
options that are invoked by a routing process, rather than by a user selection.  For details, see invoke a 
menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
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children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can 
enter multiple words and phrases for each menu item, just as callers may phrase the same request in 
different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases 

to Inbound Call Operations. 

Audio File frame 

 
Use the embedded audio controls in this frame to select or record the prompt that plays when control 
is passed to this menu.  Be sure to list all menu options in this message.  Otherwise, callers will not 
know which keys to press, and will become confused.  For procedural details, see manage voice 
prompts. 

Repetition frame 
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Controls in this frame set the number of times that the greeting will be played before control is passed 
to the schedule's error handler, or to this menu's default node if one exists, and the number of seconds 
to wait for caller input before repeating the audio prompt. 

 

Number of times to repeat this prompt spin control 

This sets the number of times that the greeting will be played before control is passed to the 
schedule's error handler, or to the current menu's default node if one exists. 

Number of seconds to wait before repeating spin control 

This control sets the number of seconds that Interaction Attendant will wait before replaying the 
menu's audio prompt.  The values set for repeat and wait time are processed, even if the audio name 
field is left blank, or its value is <None>.  For example, if the repeat count is 2 and the delay time is 10, 
the caller will hear 20 seconds of dead air before the default action or error handler is invoked. 

Extension Dialing frame 

 
These optional settings are disabled by default.  They allow you to enable auto-detection of extension 
dialing, which tells Attendant to process multiple incoming digits as extension numbers rather than as 
menu selections.  This option appears on multiple forms.  Please read listen for extension dialing 
option if you are unfamiliar with this feature. 

Fax Listener button 

 

Press this button to configure a menu to handle incoming faxes.  It opens the Fax Listener Options 
Dialog.  Menus do not listen for Fax tones by default.  When Fax Listening is enabled, incoming Faxes 
processed by the menu are routed to a mailbox. 

Play Audio 
This operation plays a wave audio (.wav) file for the caller.  You can play an existing prompt file or 
record a new one using your station phone.  You can assign node characteristics, such as the digit that 
users press to play back the message, the number of times that the message will be replayed if users 
do not make a menu selection, and the interval that Attendant will wait before replaying a message. 

Node Characteristics frame 
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Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign 
a digit, the list displays only available digits—those that are not already in use at this level of the 
tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu 
options that are invoked by a routing process, rather than by a user selection.  For details, see invoke a 
menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 
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Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can 
enter multiple words and phrases for each menu item, just as callers may phrase the same request in 
different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases 

to Inbound Call Operations. 

Audio frame 

The options in this frame determine whether audio is played from an Attendant .wav file, audio 
sources defined in Interaction Administrator, or an audio file specified by a specific interaction 
attribute. 

 

Audio Files radio button 

If you click Audio Files, the embedded audio controls allow the selection of an Attendant .wav file, and 
additional options are presented in the Repetition frame. Repetition settings optionally replay the 
prompt to the caller.  By default, the prompt plays once, and is not repeated. 

 

Number of times to repeat this prompt spin control 

This control sets the number of times that the wave file will be played before control passes to 
the destination selected in the Action When Finished frame. By default this value is set to zero, 
so that the message plays once. 
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Number of seconds to wait before repeating spin control 

This control sets the number of seconds that Interaction Attendant will wait before replaying 
the audio prompt.  The default value is zero. 

Tip—If the audio file name is left blank, or its value is <None>, control passes immediately to 
Action When Finished after the delay specified in the seconds spin control. 

Audio Source radio button 

If you click Audio Sources, the embedded audio controls allow the selection of any audio source 
defined in Interaction Administrator. Attendant will also prompt for a Timeout value that determines 
how long the audio source will play before control is passed to Action When Finished processing. 

 

Audio file specified by the following interaction attribute radio button 

If you click Audio file specified by the following interaction attribute, in the Name field enter the name 
of a custom attribute you define in the Set Attribute form, in the Results Processing Dialog of a 
Database Query, or in a Remote Data Query.   The embedded audio controls use the audio file defined 
in this interaction attribute, but it must exist in the appropriate InteractionAttendantWaves folder. 
 Attendant will also prompt for a Timeout value that determines how long the audio source will play 
before control is passed to Action When Finished processing. 

 

External audio source 

If you click External Audio Source, click the arrow at the end of the Name field dropdown list and select 
the appropriate source (for example, iPod or Pandora). Interaction Attendant will play audio from a file 
or audio source to a user in the IVR. These external audio sources must be defined and configured in 
Interaction Administrator before you can select them in the Play Audio node. 

After you select the external audio source, in the Timeout area use the up and down arrows to select 
how many seconds to play the external audio source before control is passed to Action When Finished 
processing. 



Play Audio 

208 

 

Action When Finished Frame 

These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves the node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server. 

 

Go back radio button      

The Go back to the previous menu radio button returns control to the parent menu from which the 
message was played.  Suppose, for example, that you create a menu whose prompt is: 

"Press 1 for information about product A." 

"Press 2 for information about product B." 

"Press 3 to hang up."  

If you attached two Audio Playback operations to this menu, with Go back to the previous menu 
specified as the action to perform when finished, callers will hear the original prompt again when 
Audio Playback ends.  

The Go back to the previous menu option 

Sets up a simple loop that "reruns" the parent menu from the top. 

Disconnect radio button   

This option disconnects the call after replaying the wave file the number of times that is specified by 
the repeat value. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to radio button 
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This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server.  Flow of control will pass to this destination once the wave file has been played the 
number of time specified by the repeat value. 

Play Info 
The Play Info action plays wave audio files like the Play Audio action, but adds the ability to play audio 
containing information retrieved from call attributes. You can specify an ordered sequence of audio 
bits to be played. Each audio bit can consist of an audio .wav file followed by audio generated from a 
specified call attribute. 

Any call attribute can be used, including reserved call attributes. For information about reserved call 
attributes, see Interaction Attributes Technical Reference in the PureConnect Documentation Library. 

The attributes most commonly used with this action are attributes set elsewhere in the profile, (e.g. 
through the use of Set Attribute actions, or attributes set as the result of retrieving data from a DB 
query. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
menu options that are invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 
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Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking the 
form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers 
can verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

Audio Sequence frame 

 
Use options in the Audio Sequence frame to select and order audio files to play. The list view that 
contains the audio sequence to be played contains controls for moving audio entries up or down 
allowing for easily arranging the sequence for previously configured audio bits. 

To configure options in this frame, follow this procedure: 
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1. Click Add. The Play Info Sequence dialog appears. 

 
2. Select an audio file from the Audio File drop list, or select <Not Used>. 

3. Type the name of an attribute in the Attribute field. Audio will be generated from the 
specified attribute. If this field is left blank, the system will assign <Not Used> to indicate that 
an attribute should not be played. 

4. If an attribute is specified, select the data format of the attribute using the Attribute Format 
drop list. The call attribute formats are: 

Audio File           A .wav file that exists in the appropriate InteractionAttendantWaves folder. 

Boolean             True or False. 

Custom             The Custom data format sets up a switch comparison that evaluates attribute 
values and .wav audio files to be played. If an attribute value is something other than all of the 
defined values, no audio is played. 

If you set the format to Custom, you are prompted to provide attribute value/audio file pairs 
associated with that entry as well. 
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Date                 Year, month, and day in the form: YYYY-MM-DD. 

Date Time         The date and time in one of the following forms: 

If you set the Attribute Format to Text: If you set the Attribute Format to Date: 

YYYY-MM-DD HH:MM:SS.SSS 

YYYYMMDDHHMMSS[TZ] 

YYYY-MM-DD 

yyyymmddhhmmssZ 

yyyymmddhhmmss 
yyyymmddhhmmZ 
yyyymmddhhmm 
yyyymmddZ 
yyyymmdd 

First Name         Play Info allows playback of call attribute values as either a first or last name 
data type. The 1000 most common U.S. male and female first names and the 1000 most 
common U.S. last names are supplied as wave files in a folder library. The playback will play 
from this library of names if the recorded name exists and will use text-to-speech (TTS) if not. 
Each language can have its own name library. All name libraries are extensible by adding 
additional recorded names to the recording folders. The default libraries are: 

1000MostCommonNamesMale.txt: U.S. 1000 most common male first names. 

1000MostCommonNamesFemale.txt: U.S. 1000 most common female first names. 

1000MostCommonNamesSurname.txt: U.S. 1000 most common last names. 

Last Name         See First Name. 

Monetary           A monetary value. There is a limitation on the monetary data type of 
2,147,483,647, due to the data type used. 

Numeric            A number. 

Phone Number   Telephone Number. 

Text                  Text converted to speech. 
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Time                 Plays the Time portion of a Date Time attribute. 

Unique Digits     A series of one or more digits. 

5. Click Ok to dismiss the Play Info Sequence dialog. A new entry will appear in the Audio 
Sequence list. 

6. Click Add to define additional entries as needed. 

7. Optionally use the up and down arrow buttons to change the order of entries. Entries are 
evaluated from top to bottom. 

Audio Sequence Play Mode frame 

 
Two different play modes are available: 

Immediate mode 

The audio sequence plays immediately when the action is reached in the IVR tree. In Immediate 
mode, you can configuration of number of times to repeat sequence and the amount of time to wait 
in between. 

Play at the next caller data input point 

Queues, but does not play the audio sequence when the Play Info node is reached in the IVR tree. 
Audio is played when a subsequent caller data input point (Caller data entry node or a menu node) is 
reached in the IVR tree. 

Action When Finished frame 

 

Go back to the previous menu radio button     

The Go back to the previous menu option returns control to the parent menu from which the message 
was played.  

The Go back to the previous menu option 

Sets up a simple loop that "reruns" the parent menu from the top. 
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Disconnect radio button   

This option disconnects the call after replaying the wave file the number of times that is specified by 
the repeat value. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to radio button 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server.  Flow of control will pass to this destination once the wave file has been played the 
number of time specified by the repeat value. 

Receive Fax 
This operation receives an incoming Fax, and routes it to a mailbox.  The caller is prompted to begin 
transmission of the document.  Afterwards, the node listens for FAX tones.  Once the Fax has been 
received, it is routed to the default mailbox (configured in Interaction Administrator), or to a specific 
agent or workgroup mailbox.  

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
menu options that are invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 
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By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking the 
form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers 
can verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

Send the fax to frame 

These options determine whether the FAX is received and sent to the default mailbox for fax 
recipients (as configured in Interaction Administrator), to a specific user, or to the mailbox shared by 
a workgroup. 



Remote Access 

216 

 

Default Mailbox button 

Routes the Fax to the CIC default mailbox configured in Interaction Administrator.   For more 
information, ask your CIC administrator for information about the default fax recipient, or consult 
Interaction Administrator help. 

User's mailbox combo 

Routes the Fax to the mailbox of an Interaction Client user. 

Workgroup mailbox combo 

Routes the Fax to a workgroup mailbox.  If the system cannot route the Fax to the workgroup's 
mailbox, the Fax is routed to the default user's mailbox instead. 

Remote Access 
The Remote Access operation allows a caller to retrieve voice mail from a remote location, to change 
status, or manage recorded prompts.  Once this menu entry is accessed, the caller must enter his or 
her extension and CIC password, and then press the pound (#) key. 

This is the default behavior for voice mail retrieval.  Your system administrator may have changed 
default voice mail retrieval settings.  Contact your system administrator for more information on 
Voicemail retrieval functionality and passwords. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 
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The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
menu options that are invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking the 
form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers 
can verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

Security frame 
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Access Code field 

This field allows you to specify additional digits that a caller must press to access remote Voicemail. 
For example, you may not want callers accidentally accessing your Voicemail retrieval system. Adding 
additional digits that a caller must press can make it more difficult for someone to accidentally or 
maliciously access voice mail retrieval. 

Action When Finished frame 

These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves the node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server. 

 

Go back to previous menu 

This option sets up a simple loop that "reruns" the menu from the top. 

Disconnect 

This option disconnects the call when the data entry operation is completed successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server. 

Remote Data Query 
The Remote Data Query action calls a web service to retrieve data returned in call attributes. This action 
works like a Database Query, but calls a SOAP web service to retrieve data. Also, it allows for multiple 
data items to be retrieved instead of a single item. The data items retrieved are returned in call 
attributes as specified in the configuration. 



Printed Documentation 

219 

The example configuration in this topic retrieves the current temperature for a hard-code ZIP (46278), 
and puts the value returned into a call attribute that could be played back to the caller using a Play Info 
node.  The table below lists configuration 

Example Web Service http://ws.cdyne.com/weatherws/weather.asmx 

Example SOAP Action http://ws.cdyne.com/WeatherWS/GetCityWeatherByZIP 

Example XML <?xml version="1.0" encoding="utf-8"?> 

<soap:Envelope 
xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xmlns:s="http://www.w3.org/2001/XMLSchema" 

xmlns:enc="http://schemas.xmlsoap.org/soap/encoding"> 

<soap:Body> 

<tns:GetCityWeatherByZIP 
xmlns:tns="http://ws.cdyne.com/WeatherWS/"> 

<tns:ZIP>46278</tns:ZIP> 

</tns:GetCityWeatherByZIP> 

</soap:Body> 

</soap:Envelope> 

  

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it is 
active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

http://ws.cdyne.com/weatherws/weather.asmx
http://ws.cdyne.com/WeatherWS/GetCityWeatherByZIP
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Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign a 
digit, the list displays only available digits—those that are not already in use at this level of the tree.  If 
no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu options 
that are invoked by a routing process, rather than by a user selection.  For details, see invoke a menu 
operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If you 
uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the form 
is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are invisible to callers.  When a 
node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through this 
node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by default.  Enable it 
to capture the date, time and duration of time that the call remained in the node and its children.  This 
option is hidden when Attendant is connected to a server that does not have reporting installed.  For 
more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log when 
the call enters this node.  This helps track the path that a call took through Attendant.  The Interaction 
Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can enter 
multiple words and phrases for each menu item, just as callers may phrase the same request in different 
ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases to Inbound 

Call Operations. 

Data Query Input frame 
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URL 

The URL of a SOAP web service. 

SOAP Action 

The SOAP Action to execute. A SOAP action indicates to the service what action it should perform. 

SOAP Input XML 

An XML message that contains: 

• a Header element that contains header information 

• a SOAP Envelope element that identifies the XML document as a SOAP message 

• a Body element that contains call and response information. In the example above, the zip code 
(46278) is passed in the ZIP element.  To reference a call attribute in the SOAP Input XML field, 
the Body element can contain references to call attributes in the form: $(AttributeName) 

• For example:  <tns:ZIP>$(ATTR_Zip)</tns:ZIP> 

Data Query Output frame 
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This section configures attributes that will receive the result values from the web service. To complete 
this section, click Add. You will be prompted to identify the name of the XML service result element that 
contains the data, and for the name of a call attribute to hold the data returned. 

 
You can define multiple attributes to receive additional data items returned by the service. 

Security 

Use enhanced SOAP request tool (with SSL and user authentication support) check box 

Check this option to specify that the handler should use the enhanced SOAP request tool that has 
support for SSL and user authentication. Checking this box enables use of SSL, and also enables the 
Enhanced SOAP Request Tool Configuration button, so that you can open the dialog that manages 
configuration parameters for SSL. 

Enhanced SOAP Request Tool Configuration button 

Opens SSL configuration parameters for editing in the Enhanced SOAP Tool Configuration dialog. 
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Username/Password 

Username and password for sites that require HTTP authentication.   

Certificate Subject’s Common Name 

The common name on the security certificate. The certificate common name usually matches the site 
name exactly. For example, if the site is "www.domain.com" you would enter a common name of 
www.domain.com, unless you elect to use a wild card such as *.domain.com that matches all sub-
domains of the domain.com. 

Ignore unknown SSL certificate authority 

When checked, continue processing if the SSL certificate authority is unknown.  

Ignore wrong SSL certificate usage 

When checked, continue processing if the SSL certificate is malformed (e.g. no subject name).  

Ignore SSL certificate name mismatch 

When checked, continue processing if the hostname of the visited host and the server certificate do not 
match.  

Ignore invalid SSL certificate date 

When checked, continue processing if the SSL certificate has expired or its date is invalid.  

Request Timeout 

Sets the maximum time in seconds to wait for request to be sent and response to be completely 
received. 

Connect Timeout 

Sets the maximum time in seconds to wait for connection to be established. 

DNS Resolve Timeout 

Sets the maximum time in seconds to wait for name resolution to complete. 

Timeout and Error Handling options 

 

You can set a custom timeout interval that takes the failure path if the service does not respond within a 
specific number of seconds. If you leave this value at its default value (0), the web service's timeout will 
be used. 

Error handling is also configurable. You can respond to errors by setting up a custom jump, or use the 
default error handling at the schedule level. The default error handler for the schedule is used by 
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default, but you can change the error handler to jump to a custom location by clicking the Error 
Handling button. 

 

Action When Finished frame 

 

That action when finished path is taken upon a successful call to the web service. 

Go back to previous menu 

This option sets up a simple loop that "reruns" the menu from the top. 

Disconnect 

This option disconnects the call when the operation is completed successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server. 

Run Subroutine 
This operation passes an interaction (a call or Email object) to a handler.  This node is sometimes called 
"Subroutine Initiator", since it invokes a custom handler from within Attendant.  Handlers are hidden 
programs that contain and execute the functionality configured in Interaction Attendant.  Specifically, 
Run Subroutine passes a call identifier and subroutine name to the CustomSubroutineInitiatorRouter 
handler.  

Run Subroutine is not available in all editions of CIC. 

The interaction is passed to the subroutine specified in this node and also in the 
CustomSubroutineInitiatorRouter handler.  The processing that the subroutine performs occurs is up to 
the handler author. 
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For example, if you have a handler that looks up account balances, you could send a call to that 
handler allowing the caller to enter a user ID and password. The handler would then play the account 
balance and return back to the Interaction Attendant menu it was called from. 

 

Important 

Before using Run Subroutine in Interaction Attendant, you must use Interaction Designer to modify 
the CustomSubroutineInitiatorRouter handler.  For procedural details, see modify 
CustomSubroutineInitiator.ihd.  
 
This help topic doesn't explain everything that you need to know about handlers.  For exhaustive 
information, refer to Interaction Designer's help system.  

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign 
a digit, the list displays only available digits—those that are not already in use at this level of the 
tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu 
options that are invoked by a routing process, rather than by a user selection.  For details, see invoke a 
menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 
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Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can 
enter multiple words and phrases for each menu item, just as callers may phrase the same request in 
different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases 

to Inbound Call Operations. 

Subroutine 

 

Subroutine Name 

Type the name of the subroutine that you want to run.  This subroutine name must also be defined in 
the Select step of the CustomSubroutineInitiatorRouter handler.  See modify 
CustomSubroutineInitiator.ihd.  

To pass parameters to the Handler  

Sometimes it is desirable to pass data from Attendant to a hander. There are two ways to do this. 

• You can use the Set Attribute node to assign a value to a custom attribute, and configure the 
node to jump to any profile, schedule, menu, or operation that is defined for the current 
server. If the interaction is processed by the handler later, the handler can retrieve the value 
stored in the attribute. 

• You can also invoke a handler directly from Attendant and pass the value.  To do this, use the 
Run Subroutine node to specify a subroutine to run. To pass a value, append a colon followed 
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by the parameter value to the subroutine name. For example, if the name of the subroutine is 
Voicemail and you want to pass the extension number of the end user, you would enter 
"Voicemail:133" in the subroutine field. 

Action When Finished frame 

These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves the node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server. 

 

Select the flow of control that occurs when the subroutine runs successfully and no errors are 
encountered.  However, these options are not evaluated unless your custom subroutine returns False 
in a Boolean named p_bTransferred. 

If your custom subroutine transfers the call to another thread (does not return the call to Attendant), 
the subroutine should assign False to a Boolean return value named p_bTransferred.  If the call is 
returned to Attendant, it should set p_bTransferred to True. 

 
The p_bTransferred return value is passed back to the Run Subroutine node when the custom 
subroutine finishes.  It indicates whether or not Attendant should ignore or process the flow-of-control 
selections you make in Actions When Finished frame.  If the return value is True, this tells Attendant 
that the call was transferred by the subroutine, and no actions need to be performed on the call, since 
Attendant no longer has it. 

When the custom subroutine is created in Interaction Designer, it should assign a Boolean value to 
p_bTransferred to indicate whether the call is transferred (True) or returned to Interaction Attendant 
for further processing (False). 

If the return value is True, flow-of-control settings in the Subroutine Initiator form are ignored. If the 
return value is False, the action specified in the form is processed as follows: 

Go back to previous menu 

The Go back to the previous menu radio button returns control to the parent menu.  This option sets 
up a simple loop that "reruns" the menu from the top. 
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Disconnect 

This option disconnects the call when the data entry operation is completed successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server. 

Related Topics 

• Modify CustomSubroutineInitiator.ihd 

• Other Tools 

Modify CustomSubroutineInitiatorRouter.ihd 
This procedure explains how to modify CustomSubroutineInitiator.ihd handler in Interaction 
Designer to specify a subroutine to invoke.  This must be done before you can use Run Subroutine 
nodes in your menus.  

Before performing this procedure, the subroutine to be called must exist on the server, and you must 
know its name.   It is assumed that the reader has some experience with Interaction Designer.  You 
may find it helpful to consult the Designer help system as you perform this procedure.  You may wish 
to obtain assistance from an experienced handler developer.  To modify the handler, follow these 
steps: 

1. Open Interaction Designer. 

2. Open the File menu, select Open, navigate to 
\IC\I3\IC\handlers\40handlers\CustomSubroutineInitiatorRouter.ihd, and click Open. The 
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CustomSubroutineInitiatorRouter.ihd opens. 

 
Note:  If you have multiple custom subroutines, you will have to call your own selection tool 
steps.  For example, if you have three custom subroutines, you must hook up a selection 
step and enter the appropriate name in Interaction Attendant. 

3. From the Tools tab, located at the bottom corner of the Design pallet, click the Basic 
tab and drag a Selection tool step to the Design area, and then double-click the 
Selection tool step.  The Properties of Selection dialog opens. 
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4. Click the Statements tab, and then click the Add button. The Edit Expression dialog 
opens. 

 
5. In the Condition expression, result type Boolean field, type: 

StrEqlNoCase("MySubroutineName", p_sSubroutineName) 

Note:  Replace MySubroutineName with the name of a custom subroutine you 
want to call from Attendant using a Run Subroutine node. This conditional 
expression identifies a subroutine for CustomSubroutineInitiatorRouter to 
invoke. 

6. Click OK to close the Edit Expression dialog. 

7. Click OK to close the Properties of Selection tool step. 

8. Click the Subroutines tab, located at the bottom corner of the Design palette, 
and select the Custom tab. 

9. Locate the custom subroutine whose name you specified in step 5. Drag and 
drop its tool icon into the Design window so that it is positioned to the right of 
the Selection tool step. 
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10. Connect the Selection tool to the subroutine by clicking and dragging between 
the icons.  Your screen should look similar to the following: 

 
11. Look for a green "happy face" icon in the toolbar.  Green indicates that the 

handler is ready to publish.    

Note:  If the icon is Yellow or Red, do not proceed until you have located 
the source of the error.  Consult the Designer online help for more 
information. 

12. Open the File menu and select Save. 

13. Press the Publish toolbar button, or open the File menu and select 
Publish, to republish CustomSubroutineInitiatorRouter.ihd. 

Note:  You can now use the Run Subroutine nodes in Interaction 
Attendant to call the subroutine.  If your custom subroutine 
transfers the call to another thread (e.g. does not return the call 
to Attendant), the subroutine should set a Boolean return value 
named p_bTransferred.  Set its value True if the call was 
transferred, or False if the call will be returned to Interaction 
Attendant for further processing (in other words, True indicates 
that the call was transferred).    See Run Subroutine for details. 

Related Topics 

Run Subroutine 

Screen Pop 
Screen Pop executes an action previously configured using the Actions 
container in Interaction Administrator. Actions can be thought of as a 
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direct communications link between two application programs. Data is 
passed to a third party application to perform some action. For 
example, a URL can be passed to a web browser. 

Three types of screen pop actions can be defined in Interaction 
Administrator: DDE, Web Browser Screen Pop, and Custom Screen 
Pop.  Web Browser Screen Pop uses the same internal configuration as 
a custom screen pop, but has a separate configuration dialog for easy 
configuration.  

In addition, scripts created in RightNow's ScriptAssist appear as actions 
in Interaction Administrator's Actions container. When a ScriptAssist 
script is saved, it appears in Interaction Administrator's Actions 
container, and the script is also visible to Screen Pop nodes in 
Interaction Attendant. 

Note—Interaction Attendant does not support DDE actions. 

Once actions are defined in Interaction Administrator or optionally in 
ScriptAssist, an Attendant profile can be set up to call a screen pop 
action. The default values for the selected screen pop can be 
overridden to pass different values to the application. For example, 
you might change the URL of a Web Browser Screen Pop action 
selected in Attendant, to open a different web page.  Override is 
allowed if the action is configured in Interaction Administrator to 
allow values to be changed in Attendant. 

The Interaction Administrator Help explains how to define actions. 
This topic explains how to invoke an action from Attendant. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select 
it,  and establish whether or not it is active, used by default, logged, 
or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree 
structure. 
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Digit list box 

Use this list to select the key that callers press to enter a caller data 
entry operation.  When you assign a digit, the list displays only 
available digits—those that are not already in use at this level of the 
tree.  If no digit is assigned, callers cannot invoke the operation 
directly.  It is possible to create menu options that are invoked by a 
routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction 
Attendant will process them.  If you uncheck a form's Active check 
box, the name of the node turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will 
thereafter ignore the form and its children.  Use this feature to save a 
configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree 
view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as 
the default action.  The operation defined by the default node is 
performed if the caller does not press a key within the timeout 
period specified by that menu. The icon for default forms has a green 
border in the tree structure.  Any node below a menu or schedule can 
be marked as the default action, by checking the form's default 
action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be 
collected when control passes through this node.  Several IVR Reports 
summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that 
the call remained in the node and its children.  This option is hidden 
when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR 
Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is 
appended to the call's Interaction Log when the call enters this 
node.  This helps track the path that a call took through 
Attendant.  The Interaction Log is maintained for reporting 
purposes.  See View the Interaction Log for details. 
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Configure Speech Recognition... button 

Select this button to configure words or phrases that can be 
associated with menu options. Callers can verbally indicate the 
options they want in the IVR instead of pressing a digit on the phone. 
You can enter multiple words and phrases for each menu item, just 
as callers may phrase the same request in different ways. For 
example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

Screen Pop Action and Values 

 

Screen Pop Action 

Screen Pop Action lists entries from the Actions container in 
Interaction Administrator. Since Interaction Attendant does not 
support DDE actions, those are not displayed in this list. If you add or 
update Actions in Interaction Administrator while using Interaction 
Attendant, you must restart Interaction Attendant to view changes. 

Name/Value pairs 

This list is populated if the action selected in the Screen Pop Action 
drop list contains input values to pass to the application popped. 
Depending upon the override settings set for the Action in Interaction 
Administrator, you can edit these values by typing in different values 
or select a predefined multiple-choice value. 

For example, you might change the URL of a Web Screen Pop action 
to specify a different page, or change the value of parameters used 
by script actions. 

Edit button 

Opens the selected Name/Value pair so that you can edit or select 
the value passed to the application. 
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If in Interaction Administrator, Allow override with selected values 
(Multiple Choice) was selected when the value was defined (as shown 
above) then you can select one value to pass to the application after 
clicking Edit in Interaction Attendant: 

 
Conversely, if Allow Override was selected when the entry was 
defined in Interaction Administrator, you can edit the entry by typing 
a new value manually. The image below shows a value that can be 
manually overridden in Attendant: 

 
When Edit is clicked, the dialog allows a new entry to be typed: 
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Tip: To set the URL parameter to the value of a custom call 
attribute, type $(attr_name) in the Value field, after replacing 
attr_name with the value of the custom call attribute.  This 
allows the parameter to be populated with a call attribute set 
earlier in the Attendant flow. 

For overridable or static input values, static items can be selected 
from the drop list in Attendant: 

 
These pass dynamic information to the application popped instead 
of a predefined string value. 

Action When Finished 

 
Sets the finishing path to take when this node executes successfully. 

Reset button 

For the selected action, resets any override value to the default 
value of the action. 

Reset All button 
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For all listed actions, resets any overridden value to default values. 

Go back to previous menu 

This option sets up a simple loop that "reruns" the menu from the 
top. 

Disconnect 

This option disconnects the call when the operation is completed 
successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this 
server. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or 
operation that is defined for the current server. 

Configure a Selection Node 
A Selection action branches on condition after evaluating one or 
more expression cases. This action is similar to a Logical Transfer, 
but is easier to set up when multiple expression cases must be 
evaluated. Selection nodes are easier to understand because there 
are no jumps to other nodes in the tree view. The Selection action 
works like a C++ switch statement, or a Visual Basic Select Case 
statement, if you are familiar with programming concepts. 

For example, a company which offers three levels of technical 
support (Bronze, Silver, or Gold) could store an interaction's support 
level in an attribute, and later use a Selection node to examine the 
value of that attribute to take different actions. 

 

The figure at left shows Expression Case 
nodes below the  Selection action and 
displays child operations to perform for 
each possible case. In this example: 

Default Case:  If the value of the 
attribute is not Bronze, Silver, or Gold, 
the Default Case expression case is 
selected, which in this example transfers 
the interaction to a Main Menu. 

Bronze:  An expression case was created 
to transfer Bronze interactions to a FAQ 
menu. 
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Silver:  An expression case was created 
to direct the system to send Silver 
interactions (in this example, calls) a 
customized greeting message on their 
way to the Support queue. 

Gold:  An expression case was created to 
direct the system to transfer Gold 
interactions (in this example, calls) to an 
Agent's queue after first receiving their 
own custom greeting. 

Selection actions make it easy to set up multiple branches based 
upon evaluation of flexible expression criteria. 

Configure a Selection Node 

1. Add a Selection node. In the Name field, type a meaningful 
name for the selection action. 

2. Click the Digit drop down list and select a number to assign 
to the selection action. This is the key that callers press to 
select the menu entry.  When you assign a digit, the only 
available digits are those that are not already in use at this 
level of the tree.  If you do not assign a digit, callers cannot 
invoke the operation directly. 

Note: The Digit drop down list is not available for 
e-mail interactions, and does not appear in E-mail 
Configuration files. 

3. Place a check mark in any Node Characteristics that 
apply: 

Checkbox Description 

Active By default, this field contains a check mark, which 
means the form is "on", or "active" and Interaction 
Attendant will process them.  If you un-check a 
form's Active check box, the name of the form 
turns gray in the tree to indicate that the form is 
inactive.  Interaction Attendant and its handlers 
will ignore the form and its children.  Leave the box 
unchecked to save a configuration that you are 
testing.  Inactive forms are unavailable to 
interactions 

Default Action At any given level in the tree structure, one node 
can be marked as the default action.  The 
operation defined by the default node is performed if 
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callers do not press a key within the timeout 
period specified by that menu. The icon for default 
forms has a green border in the tree 
structure.  Any node below a menu or schedule can 
be marked as the default action, by checking the 
form's default action check box. 

Note: The Default Action check box is not available 
for e-mail interactions, and does not appear in E-
mail Configuration files. 

Enable IVR 
Reporting 

This option determines whether or not reporting 
data will be collected when control passes through 
this node.  Several IVR Reports summarize this 
information.  IVR Reporting is disabled by 
default.  Place a check mark in this box to capture 
the date, time and duration of time that the 
interaction remained in the node and its 
children.  This option is hidden when Attendant is 
connected to a server that does not have reporting 
installed.  For more information about this feature, 
see IVR Reporting Option. 

Add entry to 
the Interaction 
log 

When this option is enabled, information about 
this node is appended to the interaction's 
Interaction Log when the interaction enters this 
node.  This helps track the path that an interaction 
took through Attendant.  The Interaction Log is 
maintained for reporting purposes.  See View the 
Interaction Log for details. 

Configure 
Screen 
Recognition 
button 

Select this button to configure words or phrases 
that can be associated with menu options. Callers 
can verbally indicate the options they want in the 
IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each 
menu item, just as callers may phrase the same 
request in different ways. For example, "transfer 
funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

4. For Inbound, Outbound, or Operator calls only, set 
up the expression criteria: 

a. Click Create Expression Criteria to set up 
the left hand of the expression, or what is 
evaluated.  The Expression Type Wizard 
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opens. You can create an expression using 
the following data types: 

• Data previously entered by the caller 

• Data about the current call 

• The current time 

• Data about a particular workgroup (ACD or 
Custom) 

• Data from a database 

b. Select a data type. Then click Next or Finish based 
on the options available for the data type selected. 
You may be prompted to select or enter specific 
data. For example, if you select Data about the 
current call, you must click Next to specify the name 
of a call attribute (see the following figure). 
Conversely, if you select The current time, you can 
click Finish immediately since no additional 
information must be supplied. 

 
The Call Data dialog opens when you select Data 
about the current call. 

Note: The resulting Expression Criteria will 
appear as read-only text. Note that the 
Selection node is in error until valid 
expression criteria is defined. 
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5. The next step is to add expression cases. 
 For instructions, see Configure an 
Expression Case. 

Related Topics 

• Configure an Expression Case 

Configure an Expression Case 
An Expression Case is a node that contains defined conditional processing for a parent Selection action. 
Before you can define case nodes, you must first Configure a Selection Node. 

In the tree view, Expression Cases appear as nodes underneath the Selection action. This makes it easy 
to see all of the available paths that can be taken. In addition, a Default Case appears below the 
selection node.  If all other expression cases evaluate false, routing will take the path below that case. 
Each case behaves like a multi-action container where actions can be placed underneath, and they are 
processed in top down order like that of an e-mail profile. Whenever a new selection action is added to 
the tree view, a default case is added underneath it as well. 

 

The figure at left shows Expression Case nodes below the  Selection 
action and displays child operations to perform for each possible 
case. In this example: 

Default Case:  If the value of the attribute is not Bronze, Silver, or 
Gold, the Default Case expression case is selected, which in this 
example transfers the interaction to a Main Menu. 

Bronze:  An expression case was created to transfer Bronze 
interactions to a FAQ menu. 

Silver:  An expression case was created to direct the system to send 
Silver interactions (in this example, calls) a customized greeting 
message on their way to the Support queue. 

Gold:  An expression case was created to direct the system to 
transfer Gold interactions (in this example, calls) to an Agent's 
queue after first receiving their own custom greeting. 

Configure an Expression Case 

1. Set up a Selection node. For instructions, see Configure a Selection Node. 
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2. Select the newly created selection node and under Expression Cases click Add. The Case Edit 
dialog opens. 

       

3. Set up the Expression Case: 

• To set up an expression case for Inbound, Outbound, or Operator Configurations: 

o In the Name field, type a meaningful name for the expression case and then 
click Edit Expression. The Call Properties dialog opens. 

 
o Click the The value of attribute '[attribute name]' drop down list and select one 

of the following operators: 

a. Greater than 

b. Greater than or equal to 

c. Equal to 

d. Less than or equal to 

e. Less than 

f. Before (applies to data/time criteria only) 
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g. After (applies to data/time criteria only) 

o In the field below the The value of attribute '[attribute name]' drop down list, 
enter a value against which to compare the expression criteria (in the example 
above: Bronze, Silver, or Gold). Click Finish. 

• To set up an expression case for E-mail Configurations: 

o In the Name field, type a meaningful name for the expression case and then 
click Edit Expression. The Email Conditions dialog opens. 

 
o In the Select condition(s) area, select one or more criteria to apply to the 

expression. 

o In the Edit the rule description (Click an underlined value) area, click the 
hyperlink(s) associated with each rule to specify how the e-mail is evaluated 
upon arrival. 

Note: The next dialog box to appear will differ, depending on the criteria you 
select. For example, if you select the marked with importance condition 
check box, "and marked with specific importance" appears in the Edit the 
rule description area, and the word "specific" contains a hyperlink.  When 
you click the specific hyperlink, the Importance Level dialog opens, and you 
can specify the degree of importance to place on the e-mail. 



Configure an Expression Case 

244 

o Configure each rule description and then click OK to close 
the Email Conditions dialog. 

4. Click OK to close the Case Edit dialog. 

5. To define additional cases, click the Selection node, and then click Add. 
You can only create case nodes by clicking Add on the selection node form 
view. Interaction Attendant does not contain a  toolbar or menu item for 
adding case nodes. 

6. Select an expression case and use the toolbar or Insert menu to add an 
operation node that determines what action each branch should take if an 
interaction meets the case criteria. Repeat this procedure for each 
expression case.  In the following example, Play Audio, Menu Transfer, and 
Agent Transfer nodes were added. 
      

 
7. Place a check mark in any Node Characteristics that apply: 

Checkbox Description 

Active By default, this field contains a check mark, which means the 
form is "on", or "active" and Interaction Attendant will 
process them.  If you un-check a form's Active check box, the 
name of the form turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will 
ignore the form and its children.  Leave the box unchecked to 
save a configuration that you are testing.  Inactive forms are 
unavailable to interactions 

Default Action At any given level in the tree structure, one node can be 
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marked as the default action.  The operation defined by the 
default node is performed if callers do not press a key within the 
timeout period specified by that menu. The icon for default 
forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default 
action, by checking the form's default action check box. 

Note: The Default Action check box is not available 
for e-mail interactions, and does not appear in E-
mail Configuration files. 

Enable IVR 
Reporting 

This option determines whether or not reporting data will 
be collected when control passes through this 
node.  Several IVR Reports summarize this information.  IVR 
Reporting is disabled by default.  Place a check mark in this 
box to capture the date, time and duration of time that the 
interaction remained in the node and its children.  This 
option is hidden when Attendant is connected to a server 
that does not have reporting installed.  For more 
information about this feature, see IVR Reporting Option. 

Add entry to the 
Interaction log 

When this option is enabled, information about this node is 
appended to the interaction's Interaction Log when the 
interaction enters this node.  This helps track the path that 
an interaction took through Attendant.  The Interaction Log 
is maintained for reporting purposes.  See View the 
Interaction Log for details. 

Configure 
Screen 
Recognition 
button 

Select this button to configure words or phrases that can be 
associated with menu options. Callers can verbally indicate 
the options they want in the IVR instead of pressing a digit 
on the phone. You can enter multiple words and phrases for 
each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or 
"funds transfer". See Working with Speech Recognition for 
details. 

Related Topics 

• Configure a Selection Node 

Set Attribute 
Telephones calls (and other objects in CIC) can have attributes assigned to them. 
 An attribute is a piece of information about an object that travels with it 
throughout Customer Interaction Center.  For example, one attribute of a call 
object is the telephone number of the person who placed the call.  Each attribute 
is a name/value pair.  To set an attribute, specify its name and a string value you 
wish to assign to the attribute. 

The Set Attribute operation can assign a value to any attribute, including attributes 
that are reserved for use by important handlers in the Customer Interaction 
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Center.  If you modify a reserved attribute, you can adversely affect the 
performance or reliability of the server, so you should set attributes carefully. 

The Interaction Attributes Technical Reference reports attributes that are reserved 
by CIC, including those which should not be changed. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and 
establish whether or not it is active, used by default, logged, or tracked for 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry 
operation.  When you assign a digit, the list displays only available digits—those 
that are not already in use at this level of the tree.  If no digit is assigned, callers 
cannot invoke the operation directly.  It is possible to create menu options that are 
invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will 
process them.  If you uncheck a form's Active check box, the name of the node 
turns gray in the tree to indicate that the form is inactive.  Interaction Attendant 
and its handlers will thereafter ignore the form and its children.  Use this feature to 
save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default 
action.  The operation defined by the default node is performed if the caller does 
not press a key within the timeout period specified by that menu. The icon for 
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default forms has a green border in the tree structure.  Any node below a menu or 
schedule can be marked as the default action, by checking the form's default 
action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when 
control passes through this node.  Several IVR Reports summarize this 
information.  IVR Reporting is disabled by default.  Enable it to capture the date, 
time and duration of time that the call remained in the node and its children.  This 
option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting 
Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's 
Interaction Log when the call enters this node.  This helps track the path that a call 
took through Attendant.  The Interaction Log is maintained for reporting 
purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu 
options. Callers can verbally indicate the options they want in the IVR instead of 
pressing a digit on the phone. You can enter multiple words and phrases for each 
menu item, just as callers may phrase the same request in different ways. For 
example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or 

phrases to Inbound Call Operations. 

Attribute and Value fields 

These fields identify the attribute to set, and assign a value to it.  

 

Attribute text box 

Type the name of the attribute in this text box.  This name can be anything you 
like, or it can be the name of a reserved attribute.  For more information about 
attributes, refer to the Interaction Attributes Technical Reference located in the 
PureConnect Documentation Library. 

Value 

Type the text you wish to assign to the attribute in this field. This can be anything 
you like. For example, "This interaction was processed by Attendant." 

Tips for Advanced Users 
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Some reserved attributes allow you to organize and manage characteristics 
appropriate for specific interactions.  For example, you can specify which 
workgroups or agents receive an interaction, you can combine skills to 
create a unique skill set, you can assign priority value for interactions sent to 
a workgroup, and you can define an external telephone number to which 
designated interactions are sent. 

• Eic_AttDynamicWorkgroupName. Use this attribute to organize multiple 
workgroups.  For example, you can define your workgroups by area of 
expertise, such as web service calls or custom handler calls. 

• Eic_AttDynamicWorkgroupSkills. Defines a skill set based on two or 
more defined skills.  The skills designated in this attribute must be 
separated using the pipe-delimited format.  For example, if you want to 
specify that agents assigned to this interaction attribute contain multiple 
language skills, enter the value for this attribute as 
“Spanish|French|Norweigian”. 

• Eic_AttDynamicWorkgroupPriority. Assigns priority value for interactions 
specified for a specific workgroup. 

• Eic_AttDynamicAgentName. Specifies the agent or user to which specific 
interactions are sent. 

• Eic_AttDynamicExternalNumber. Defines the external telephone number 
to which designated interactions are transferred. 

In addition, since the handler that supports Set Attribute node processes 
values through the ReplaceAttributes tool before it sets the target 
attribute, the Set Attribute node can be used to assign one attribute value 
to another, or to insert the value of an attribute along with a string literal. 
The syntax for inserting an attribute value is "$(attributename)". 
 
To copy one attribute value into another: 
 
Attribute name: SOME_ATTRIB 
Value: $(SOME_OTHER_ATTRIB) 
 
To copy literal text and an attribute value into another attribute: 
 
Attribute name: SOME_ATTRIB 
Value: The phone number is $(SOME_OTHER_ATTRIB) 

Action When Finished frame 

These options set the processing that occurs after the operation completes 
successfully, when flow of control leaves the node.  You can return control to 
the previous menu, disconnect the call, transfer to an operator profile, or jump 
to any node or action that has been defined for the current server. 
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Go back to previous menu 

This option returns control to the parent menu.  This sets up a simple loop that 
"reruns" the menu from the top. 

Disconnect 

This option disconnects the call when the data entry operation is completed 
successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to Next Node 

This choice is available when the parent node is a Multi-Action Container. It 
continues processing at the next node in the container. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that 
is defined for the current server. 

Set Advanced Statistic 
This action is used for logging report data or statistic data within an IVR. The CIC 
server generates advanced statistics about interactions and reports these 
statistics. CIC provides this functionality by using report group and statistic 
group assignments. 

The Set Advanced Statistic action in Attendant allows values to be logged in a 
report group or a statistic group. This action should be used prior to a transfer 
to a workgroup or user queue in an IVR configuration. This action is available in 
all profile types (i.e. inbound, outbound, operator, email). It provides a way to 
log actions or paths taken to arrive at (workgroup or user) queue transfers in an 
IVR for reporting purposes. 

Report Groups must be set before transferring an interaction into a queue. Do 
not set a report group after the queue transfer has been performed. 

For background information about Report groups and Statistic groups, 
see CIC Report Groups and Statistic Groups in the PureConnect Reporting 
Technical Reference in the PureConnect Documentation Library. 
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Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and 
establish whether or not it is active, used by default, logged, or tracked for 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry 
operation.  When you assign a digit, the list displays only available digits—
those that are not already in use at this level of the tree.  If no digit is assigned, 
callers cannot invoke the operation directly.  It is possible to create menu 
options that are invoked by a routing process, rather than by a user 
selection.  For details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant 
will process them.  If you uncheck a form's Active check box, the name of the 
node turns gray in the tree to indicate that the form is inactive.  Interaction 
Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are 
invisible to callers.  When a node is inactive, it appears grayed out in the tree 
view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the 
default action.  The operation defined by the default node is performed if the 
caller does not press a key within the timeout period specified by that menu. 
The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking 
the form's default action check box. 

Enable IVR Reporting 
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This option determines whether or not reporting data will be collected when 
control passes through this node.  Several IVR Reports summarize this 
information.  IVR Reporting is disabled by default.  Enable it to capture the 
date, time and duration of time that the call remained in the node and its 
children.  This option is hidden when Attendant is connected to a server that 
does not have reporting installed.  For more information about this feature, 
see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the 
call's Interaction Log when the call enters this node.  This helps track the path 
that a call took through Attendant.  The Interaction Log is maintained for 
reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with 
menu options. Callers can verbally indicate the options they want in the IVR 
instead of pressing a digit on the phone. You can enter multiple words and 
phrases for each menu item, just as callers may phrase the same request in 
different ways. For example, "transfer funds" or "funds transfer". See Add Speech 

Recognition keywords or phrases to Inbound Call Operations. 

Assign To frame 

 
Selects a group type to assign a value to. 

Statistic Group 

Allows assignment ofa value to a statistics group. The statistic value will be 
written to the IStatGroup table in the reporting database. The value will be 
written in the cName column. 

Report Group 

Allows assignment of a value to a custom report group. Data will be written to 
the IWrkGrpQueueStats and the IAgentQueueStats tables in the reporting 
database. The value will be written to the CReportGroup column. You can view 
Report group data in Report Assistant by: 

1.  Select the "Workgroup Queue Statistics (Custom Groups)" package 

2.  Select the "Report Group" field 
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3.  Select the workgroup that is referenced (i.e. calls are being 
transferred to) in the IVR configuration. 

Statistic Value 

The string value assigned to the statistic group or report group. This is arbitrary 
test that identifies the path taken by the call. 

Actions When Finished frame 

Options in this frame set the flow of control that occurs when the user escapes 
from the Workgroup Queue.  

Go back to the previous menu radio button 

The Go back to the previous menu option sets up a simple loop that "reruns" 
the parent menu from the top.  It returns control to the parent menu from 
which the message was played.  

Disconnect 

Terminates the call. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location radio button 

Use this option to jump to any profile, schedule, menu, or operation that is 
defined for the current server. 

Transfer to a Different Menu 
This operation transfers a call to another menu within the same profile or 
another profile.  (These profiles must both exist on the same server.)   For 
example, suppose you create a complex set of submenus that you will use in 
all profiles. Instead of creating the same menu structure repeatedly in every 
profile, transfer a call to this special subset. This allows a single menu to be 
shared by all profiles. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and 
establish whether or not it is active, used by default, logged, or tracked for 
reporting purposes. 



Printed Documentation 

253 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry 
operation.  When you assign a digit, the list displays only available digits—
those that are not already in use at this level of the tree.  If no digit is assigned, 
callers cannot invoke the operation directly.  It is possible to create menu 
options that are invoked by a routing process, rather than by a user 
selection.  For details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant 
will process them.  If you uncheck a form's Active check box, the name of the 
node turns gray in the tree to indicate that the form is inactive.  Interaction 
Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are 
invisible to callers.  When a node is inactive, it appears grayed out in the tree 
view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the 
default action.  The operation defined by the default node is performed if the 
caller does not press a key within the timeout period specified by that menu. 
The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking 
the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when 
control passes through this node.  Several IVR Reports summarize this 
information.  IVR Reporting is disabled by default.  Enable it to capture the 
date, time and duration of time that the call remained in the node and its 
children.  This option is hidden when Attendant is connected to a server that 
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does not have reporting installed.  For more information about this feature, 
see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the 
call's Interaction Log when the call enters this node.  This helps track the path 
that a call took through Attendant.  The Interaction Log is maintained for 
reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with 
menu options. Callers can verbally indicate the options they want in the IVR 
instead of pressing a digit on the phone. You can enter multiple words and 
phrases for each menu item, just as callers may phrase the same request in 
different ways. For example, "transfer funds" or "funds transfer". See Add Speech 

Recognition keywords or phrases to Inbound Call Operations. 

Transfer the call to this menu frame 

 

Transfer call combo box 

Select any menu defined for the current server to transfer the call to. 

Related Topics 

• Play a Menu 

Transfer to a Workgroup or Stationgroup 
This node is sometimes called "Workgroup Transfer", since it transfers a call to 
a workgroup queue or to a station group queue.  The destination workgroup is 
not caller-selectable at runtime.  

The station group list box is sometimes used to set up a night transfer, which 
sends an unanswered call to a sequential series of station phones.  You have 
the option to record or select an audio prompt that will be played before the 
call is transferred to the workgroup or station queue.  

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and 
establish whether or not it is active, used by default, logged, or tracked for 
reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry 
operation.  When you assign a digit, the list displays only available digits—
those that are not already in use at this level of the tree.  If no digit is assigned, 
callers cannot invoke the operation directly.  It is possible to create menu 
options that are invoked by a routing process, rather than by a user 
selection.  For details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant 
will process them.  If you uncheck a form's Active check box, the name of the 
node turns gray in the tree to indicate that the form is inactive.  Interaction 
Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are 
invisible to callers.  When a node is inactive, it appears grayed out in the tree 
view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the 
default action.  The operation defined by the default node is performed if the 
caller does not press a key within the timeout period specified by that menu. 
The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking 
the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when 
control passes through this node.  Several IVR Reports summarize this 
information.  IVR Reporting is disabled by default.  Enable it to capture the 
date, time and duration of time that the call remained in the node and its 
children.  This option is hidden when Attendant is connected to a server that 
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does not have reporting installed.  For more information about this feature, 
see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the 
call's Interaction Log when the call enters this node.  This helps track the path 
that a call took through Attendant.  The Interaction Log is maintained for 
reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with 
menu options. Callers can verbally indicate the options they want in the IVR 
instead of pressing a digit on the phone. You can enter multiple words and 
phrases for each menu item, just as callers may phrase the same request in 
different ways. For example, "transfer funds" or "funds transfer". See Add Speech 

Recognition keywords or phrases to Inbound Call Operations. 

Workgroup / Station Group / Attribute radio buttons 

These options identify the workgroup or station group queue to which the call 
is transferred. 

 

Workgroup radio button 

This radio button enables the workgroup drop down list. 

Workgroup drop down list 

This drop down list allows you to select the name of any workgroup queue that 
is defined for the server. The interaction will be transferred to the group you 
select. 

Station Group radio button 

This radio button enables the station group drop down list. 

Station Group drop down list 
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This list box allows you to set up a night transfer, by selecting the name of a 
station group.  A night transfer sends an unanswered call to a sequential series 
of station phones, called a station group.  A station group is a set of station 
phones (defined in Interaction Administrator) that can be called when no one 
is logged in.  A night transfer works like an ACD workgroup transfer, except 
that no one needs to be logged in to ring the station phone.  Workgroup 
transfers, on the other hand, require someone to be logged in at the station. 

Consider, for example, the needs of a security guard who must leave his desk 
to patrol a building.  If no one answers a call to the guard desk, Attendant can 
transfer the call to phones in a station group, so that the guard can receive 
calls from different locations while on patrol. 

Workgroup specified by interaction attribute radio button 

This option allows you to select a specific workgroup by the workgroup ID 
contained in the interaction attribute ‘Eic_AttDynamicWorkgroupName’ and 
defined for the server. This is particularly helpful in environments which 
contain a large number of workgroups, thereby making it cumbersome to 
select the appropriate workgroup. 

For example, you can organize workgroups according to area of expertise, such 
as web service calls, customer handler calls, etc., and assign names to the 
workgroups that help identify the specific skill.  Then, you can place the 
workgroup name in the interaction attribute ‘Eic_AttDynamicWorkgroupName 
and use that attribute for a workgroup transfer operation. 

Audio to play when the caller enters the workgroup 

 
This frame contains embedded audio controls that manage the voice prompt 
that plays when the caller enters the workgroup.  See Manage Voice Prompts. 

Escaping the Workgroup Queue (ACD Only) frame 

The options in this frame are enabled when an ACD workgroup is 
selected.  They define a key that allows the caller to exit the node 
immediately.  Control is passed to the action defined in the Actions When 
Finished frame. 
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Escape Key 

Defines a keystroke that allows the caller to exit the node immediately.  The 
pound (#) or star key (*) is commonly used for this purpose.  However, you can 
assign any available digit. 

Actions When Finished frame 

These options set flow of control that occurs when the user escapes from 
the Workgroup Queue.  

 

Go back to the previous menu radio button 

The Go back to the previous menu option sets up a simple loop that "reruns" 
the parent menu from the top.  It returns control to the parent menu from 
which the message was played.  

Disconnect 

Terminates the call. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location radio button 

Use this option to jump to any profile, schedule, menu, or operation that is 
defined for the current server. 

Advanced Workgroup Settings button 

 
This button opens the Advanced Workgroup Properties dialog, so that you can 
set call priority, needed agent skills, the length of time that the call should 
remain in the queue before timing out, and processing to perform when the 
call times out.  This button is disabled for operator profiles. 

This button is enabled for custom workgroups; however, the settings 
must be implemented manually in handlers. 

Related Topics 

• Advanced Workgroup Properties Dialog 
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Transfer to an Agent 
Agent Transfer sends a call to a specific user queue or station queue.  This 
operation is commonly used to create a menu option that allows the caller to 
speak to an operator.  

To transfer calls to a workgroup, use Group Transfer instead of 
Transfer to an Agent. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and 
establish whether or not it is active, used by default, logged, or tracked for 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree 
structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry 
operation.  When you assign a digit, the list displays only available digits—
those that are not already in use at this level of the tree.  If no digit is 
assigned, callers cannot invoke the operation directly.  It is possible to 
create menu options that are invoked by a routing process, rather than by a 
user selection.  For details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction 
Attendant will process them.  If you uncheck a form's Active check box, the 
name of the node turns gray in the tree to indicate that the form is 
inactive.  Interaction Attendant and its handlers will thereafter ignore the 
form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers.  When a node is inactive, it 
appears grayed out in the tree view. 

Default Action check box 
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At any given "level" in the tree structure, one node can be marked as the 
default action.  The operation defined by the default node is performed if 
the caller does not press a key within the timeout period specified by that 
menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the 
default action, by checking the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected 
when control passes through this node.  Several IVR Reports summarize this 
information.  IVR Reporting is disabled by default.  Enable it to capture the 
date, time and duration of time that the call remained in the node and its 
children.  This option is hidden when Attendant is connected to a server 
that does not have reporting installed.  For more information about this 
feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to 
the call's Interaction Log when the call enters this node.  This helps track the 
path that a call took through Attendant.  The Interaction Log is maintained 
for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with 
menu options. Callers can verbally indicate the options they want in the IVR 
instead of pressing a digit on the phone. You can enter multiple words and 
phrases for each menu item, just as callers may phrase the same request in 
different ways. For example, "transfer funds" or "funds transfer". See Add 

Speech Recognition keywords or phrases to Inbound Call Operations. 

Transfer To frame 

The options in this frame determine whether the call is transferred to a user 
or station queue.   In general, you should specify a user queue when you 
need to route calls to a specific person, you should specify a station queue 
when you need to route calls to a specific telephone handset, and you 
should select the 'Eic_AttDynamicAgentName' interaction attribute when 
the user or station has been defined within the interaction attribute.   

Note:  The 'Eic_AttDynamicAgentName' interaction attribute is helpful for 
environments that contain a large number of users or stations and allows 
you to designate a single user or station to the attribute, thereby alleviating 
the task of searching through the queue lists. See Set Attribute for details. 
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 User Queue radio button 

This radio button enables the User Queue drop down list. 

User Queue drop down list 

This drop down list contains the names of user queues defined for the 
current server. The queue you select becomes the destination for the call. 

Station Queue radio button 

This radio button enables the Station Queue drop down list.  

Station Queue drop down list 

This drop down list contains the names of station queues defined for the 
current server. The queue you select becomes the destination for the call. 

Agent specified by interaction attribute: radio button 

This radio button specifies the transfer recipient as defined in the 
'Eic_AttDynamicAgentName' interaction attribute.  The user defined in this 
interaction attribute becomes the destination for the call. 

Park Interaction check box 

Select this check box to allow interactions to be parked on another person's 
extension for the agent to receive when he or she has an available status. 

 

Transfer to an External Number 
This operation transfers a calls to a telephone number outside of your 
organization.  For example, you might use this option to route calls to an 
after-hours call center, or to transfer calls that come in "after hours" 
schedules to a different office.  The menu designer presets the destination 
telephone number.  The caller has no control over the destination.  

This node does not offer additional error handling options.  If the 
transfer fails, control is passed to the Schedule's error handler. 
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Node Characteristics Frame 

Options in this frame name the node, assign the digit used to select it,  and 
establish whether or not it is active, used by default, logged, or tracked for 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree 
structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry 
operation.  When you assign a digit, the list displays only available digits—
those that are not already in use at this level of the tree.  If no digit is 
assigned, callers cannot invoke the operation directly.  It is possible to 
create menu options that are invoked by a routing process, rather than by 
a user selection.  For details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction 
Attendant will process them.  If you uncheck a form's Active check box, the 
name of the node turns gray in the tree to indicate that the form is 
inactive.  Interaction Attendant and its handlers will thereafter ignore the 
form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers.  When a node is inactive, it 
appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the 
default action.  The operation defined by the default node is performed if 
the caller does not press a key within the timeout period specified by that 
menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the 
default action, by checking the form's default action check box. 

Enable IVR Reporting 
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This option determines whether or not reporting data will be collected 
when control passes through this node.  Several IVR Reports summarize 
this information.  IVR Reporting is disabled by default.  Enable it to capture 
the date, time and duration of time that the call remained in the node and 
its children.  This option is hidden when Attendant is connected to a server 
that does not have reporting installed.  For more information about this 
feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to 
the call's Interaction Log when the call enters this node.  This helps track 
the path that a call took through Attendant.  The Interaction Log is 
maintained for reporting purposes.  See View the Interaction Log for 
details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated 
with menu options. Callers can verbally indicate the options they want in 
the IVR instead of pressing a digit on the phone. You can enter multiple 
words and phrases for each menu item, just as callers may phrase the 
same request in different ways. For example, "transfer funds" or "funds 
transfer". See Add Speech Recognition keywords or phrases to Inbound Call Operations. 

Call Transfer options 

 

Transfer the call to this number 

Enter a destination telephone number in this field. It accepts string data, 
so you can type anything you like (numbers, letters, dashes, 
parenthesis).  In addition to telephone numbers, you can enter: 

• A SIP address, such as SIP:John.Doe@company.com. 

• A word-based phone number (1-800-RENT-NOW) 

• A call attribute in the form $(ATTR_NAME) replacing ATTR_NAME 
with the name of any call attribute. This allows the parameter to 
be populated with a call attribute set earlier in the Attendant flow. 
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• Invalid data, since no error checking is performed to test the 
validity of your input. 

Transfer the call to the number specified by interaction attribute... 

Select this radio button to direct the call to the destination number 
specified in the 'Eic_AttDynamicExternalNumber' interaction attribute. 
 See Set Attribute for details on how to modify an interaction attribute. 

Release call on transfer check box 

This option determines whether or not the call is released (putback) after 
it is transferred.  By default, the call is not released.  There are specific 
limits on the use of this feature. If a call is being recorded or monitored, it 
can not be removed from the xIC system using a putback. Recording or 
monitoring operations take precedence over the request for a PutBack, 
and a normal "tromboning" operation is performed instead.  When a 
putback is performed, the call is transferred to a non-IC destination using 
one trunk instead of two. 

  

Transfer to Voicemail 
This operation transfers a call to the voice mailbox of the user or 
workgroup queue you specify.  It prompts a caller that he or she is being 
transferred to the voice mail account of the specified user or workgroup 
queue. 

The caller can then leave a message for that user or workgroup queue. If 
the caller is still connected after leaving a message, he or she is returned 
to the menu from which Voice Mail Transfer was called. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and 
establish whether or not it is active, used by default, logged, or tracked for 
reporting purposes. 

 

Name field 
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The label you enter here becomes the name of the node in the tree 
structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry 
operation.  When you assign a digit, the list displays only available digits—
those that are not already in use at this level of the tree.  If no digit is 
assigned, callers cannot invoke the operation directly.  It is possible to 
create menu options that are invoked by a routing process, rather than by 
a user selection.  For details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction 
Attendant will process them.  If you uncheck a form's Active check box, the 
name of the node turns gray in the tree to indicate that the form is 
inactive.  Interaction Attendant and its handlers will thereafter ignore the 
form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers.  When a node is inactive, it 
appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the 
default action.  The operation defined by the default node is performed if 
the caller does not press a key within the timeout period specified by that 
menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the 
default action, by checking the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected 
when control passes through this node.  Several IVR Reports summarize 
this information.  IVR Reporting is disabled by default.  Enable it to capture 
the date, time and duration of time that the call remained in the node and 
its children.  This option is hidden when Attendant is connected to a server 
that does not have reporting installed.  For more information about this 
feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to 
the call's Interaction Log when the call enters this node.  This helps track 
the path that a call took through Attendant.  The Interaction Log is 
maintained for reporting purposes.  See View the Interaction Log for 
details. 

Configure Speech Recognition... button 
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Select this button to configure words or phrases that can be associated 
with menu options. Callers can verbally indicate the options they want in 
the IVR instead of pressing a digit on the phone. You can enter multiple 
words and phrases for each menu item, just as callers may phrase the 
same request in different ways. For example, "transfer funds" or "funds 
transfer". See Add Speech Recognition keywords or phrases to Inbound Call Operations. 

Transfer To frame 

Selects the user or workgroup voice mail box that the call will be 
transferred to. 

 

User's Voicemail 

This list presents user voice mailboxes. 

Workgroup's Voicemail 

This list presents workgroup mailboxes. 

Voicemail of user specified by interaction attribute: 
'Eic_AttdynamicUserVmail' 

This radio button specifies the user as defined in the 
'Eic_AttDynamicUserVmail' interaction attribute.  The voice mailbox of the 
user defined in this interaction attribute becomes the destination for the 
voicemail. 

Voicemail of workgroup specified by interaction attribute: 
'Eic_AttDynamicWorkgroupVmail' 

This radio button specifies the workgroup voice mailbox as defined in the 
interaction attribute ‘Eic_AttDynamicWorkgroupVmail’ and defined for the 
server. This is particularly helpful in environments which contain a large 
number of workgroups, thereby making it cumbersome to select the 
appropriate workgroup voice mailbox. For example, you can organize 
workgroups according to area of expertise, such as web service calls, 
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customer handler calls, etc., and assign names to the workgroups that help 
identify the specific skill.  Then, you can place the workgroup name in the 
interaction attribute ‘Eic_AttDynamicWorkgroupName and use that 
attribute to transfer the voicemail to a specific workgroup. 

Action When Finished frame 

These options set the processing that occurs after the operation completes 
successfully, when flow of control leaves this node.  You can return control 
to the previous menu, disconnect the call, transfer to an operator profile, 
or jump to any node or action that has been defined for the current server. 

 

Go back to previous menu 

This option returns control to the parent menu.  This sets up a simple loop 
that "reruns" the menu from the top. 

Disconnect 

This option disconnects the call when the data entry operation is 
completed successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this 
server. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or 
operation that is defined for the current server. 

Transfer to an Attendant Profile 
This node transfers the current call to a profile defined for this server.  It is 
available from all configuration types (inbound, outbound, or operator) 
and provides the ability to transfer the call into a profile in either of the 
other two types.  This is particularly useful when Operator processing 
needs to send the call to inbound call processing. 

Node Characteristics frame 
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Options in this frame name the node, assign the digit used to select it,  and 
establish whether or not it is active, used by default, logged, or tracked for 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree 
structure. 

Digit combo box 

This is the key that callers press to select a menu entry.  When you assign a 
digit, the only available digits are those that are not already in use at this 
level of the tree.  If no digit is assigned, callers cannot invoke the operation 
directly.  It is possible to create menu options that are invoked by a routing 
process, rather than by a user selection.  See invoke a menu operation 
automatically.  

Operator Target Handling 
 
This node can be configured to handle a caller who presses 0 to 
exit to an Operator from voice mail.  To do this, add a Transfer to 
Attendant Profile node, and set its digit to 0.  Then configure the 
node to transfer to an Operator Profile.  This allows for flexible after 
hours handling and workgroup handling of a department's 
operator needs. 
 
Likewise, you might set the digit to * to configure "escape 
processing", wherein a caller presses * to exit from a menu to the 
operator. 

Active check box 

By default, forms are "on", or "active", which means that Interaction 
Attendant will process them.  If you uncheck a form's Active check box, 
the name of the node turns gray in the tree to indicate that the form is 
inactive.  Interaction Attendant and its handlers will thereafter ignore the 
form and its children.  Use this feature to save a configuration that you 
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are testing.  Inactive forms are invisible to callers.  When a node is 
inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the 
default action.  The operation defined by the default node is performed if 
the caller does not press a key within the timeout period specified by that 
menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the 
default action, by checking the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected 
when control passes through this node.  Several IVR Reports summarize 
this information.  IVR Reporting is disabled by default.  Enable it to 
capture the date, time and duration of time that the call remained in the 
node and its children.  This option is hidden when Attendant is connected 
to a server that does not have reporting installed.  For more information 
about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to 
the call's Interaction Log when the call enters this node.  This helps track 
the path that a call took through Attendant.  The Interaction Log is 
maintained for reporting purposes.  See View the Interaction Log for 
details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated 
with menu options. Callers can verbally indicate the options they want in 
the IVR instead of pressing a digit on the phone. You can enter multiple 
words and phrases for each menu item, just as callers may phrase the 
same request in different ways. For example, "transfer funds" or "funds 
transfer". See Add Speech Recognition keywords or phrases to Inbound Call Operations. 

Transfer to profile frame 

These options determine which inbound, outbound, or operator profile 
the call will be transferred to.  The profile you select must be defined for 
this server. 
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The Inbound Profile that matches this call 

Transfers the call to the inbound profile that best matches its call 
characteristics. 

The custom Inbound Profile 

Transfers the call to a specific inbound profile.  The profile is given control 
over the call, regardless of whether or not the profile matches the its call 
characteristics. 

The Outbound Profile that matches this call 

Transfers the call to the outbound profile that best matches its call 
characteristics. 

The custom Outbound Profile 

Transfers the call to a specific outbound profile.  The profile is given 
control over the call, regardless of whether or not the profile matches the 
its call characteristics. 

Related Topics 

• Profiles 

• Call Flows 

Database Operations 

Database Operations 
Database operations query a database and can play back a field to the 
caller using text-to-speech.  These nodes can also insert a new row, or 
update a database field. 

Database Insert 

Inserts a row (record) into a database table. 

Database Query 



Printed Documentation 

271 

Returns one row (record) from your database, and plays back a single 
field to the caller using text-to-speech. 

Database Update 

Updates a single field in one database record. 

DB Insert 
This menu operation inserts a new row (record) into a database table.  This is frequently used to log 
customer activity.  To insert a new record, you must know the name of the data source, table, and 
column that data will be stored in, and which fields in the database are required when adding a new 
record.  You can insert information based upon: 

• String, numeric, or Boolean values 

• A Call Attribute (ANI, DNIS, Caller ID, Interaction ID Key, Line Name) 

• User input captured using a Caller Data Entry form 

• The result of a database query 

• The current date or current time 

• Any specified date or time 

• Flow of control options on this form determine what happens after a record is inserted.  

IMPORTANT—DB Insert in Attendant will not insert numeric values unless the Numeric 
data type of a field is defined in the SQL database to declare a nonzero value for the Scale 
parameter. 
 
The DB Insert operation in Attendant won't insert numeric values into a table unless the 
SQL data type is Real.  When using SQL, the Real data type is required for inserting 
Numeric values from handlers.  If you use the Numeric data type, numbers will be 
truncated or rounded to Integer values.  Likewise, the behavior for different "decimal 
number" data types is inconsistent from one database to another.   To avoid these 
problems, you should pay attention to the database configuration of numeric data types, 
and explicitly specify the number of digits to the right of the decimal. 
 
When you create a column in an SQL table with a Numeric data type, there is a number 
value next to the data type field called "Length."  This is the total number of digits allowed 
to the left of the decimal point.  To avoid problems, you also must set the "Scale" 
parameter to something other than the default, 0, to allow for digits to the right of the 
decimal point. 
 
If the Scale setting for Numeric fields is set to zero in the database, the DB Insert operation 
fails when it tries to insert numeric values.  Specifically, step 73 of the InAttInsert handler 
(DB Put Data List toolstep) takes the failure path since the AttrvalueList field will have a 
null value.  To resolve this problem, define the Scale of numeric fields in the SQL database 
to be > 0. 
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Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it is 
active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign a 
digit, the list displays only available digits—those that are not already in use at this level of the tree.  If 
no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu options 
that are invoked by a routing process, rather than by a user selection.  For details, see invoke a menu 
operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If you 
uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the form 
is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its children.  Use 
this feature to save a configuration that you are testing.  Inactive forms are invisible to callers.  When a 
node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through this 
node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by default.  Enable it 
to capture the date, time and duration of time that the call remained in the node and its children.  This 
option is hidden when Attendant is connected to a server that does not have reporting installed.  For 
more information about this feature, see IVR Reporting Option. 
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Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log when 
the call enters this node.  This helps track the path that a call took through Attendant.  The Interaction 
Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can enter 
multiple words and phrases for each menu item, just as callers may phrase the same request in different 
ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases to Inbound 

Call Operations. 

DB Information frame 

Options in this frame identify the data source and table that the database operation will apply to. 

 

IC Data Source 

Select the name of a database as it is defined in Interaction Administrator.  See IC Data Source 
Configuration in the Interaction Administrator help to find out data sources are defined for CIC and its 
subsystems.  Typically, this list contains I3Text White Pages, CIC Contacts, CIC Report Logging, CIC Report 
Logs, Tracker, and custom databases defined by your organization. 

Table Name 

Records will be inserted into the table whose name you enter here.  If you do not know the names of 
tables in your database, contact your CIC Administrator. 

Columns to Insert frame 

This mini-table manages entries made to identify fields and data to insert into them. The Add, Modify, 
and Remove buttons work together to define fields that will be added as a new record.  You need to 
know which fields are required when adding a record to your database.  Those fields must be defined 
here, along with any additional data items that you wish to add as part of the record.  When you define 
a field, it appears in the list.  
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Each column must already be defined in the database.  Insert adds data to existing columns in a 
database.  It does not define new columns.  If the specified column does not exist, no data is 
inserted. 

Add button 

Add opens the Column Information dialog, to define data that you want to insert, and the column 
(field) it will be inserted into. 

Modify button 

Modify populates the same dialog with the selected entry. 

Remove button 

Remove deletes the selected entry from the list.  This does not remove the field from your 
database.  Instead, it removes the option to populate a data field when a new record is added. 

Action When Finished frame 

These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves the node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server. 

 

Go back to previous menu 

This option returns control to the parent menu.  This sets up a simple loop that "reruns" the menu 
from the top. 

Disconnect 

This option disconnects the call when the database operation completes successfully. 

Transfer to Operator Processing 
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Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server. 

DB Query 
Database Query is the database operation you are most likely to use.  It allows you to query a 
particular value from a CIC data source.  For example, a caller might select this operation from a menu 
to look up his account balance from your database.  

The information returned by the query can be read back to the caller using text-to-speech 
technology.   Data can be attached to a call attribute and used for DDE operations, such as screen pops. 

You can control the type of processing that occurs if a query does not return any data.  A null result 
may not indicate an error condition.  Control can be passed to logic that provides "no record found" 
processing.  Alternately, you can treat null results as "real errors" that require standard error handling. 

Database Query returns one column (field) from your database, and reads it back to the caller.  You 
cannot play back an entire row of data. 

To Define a Query 

To create a new query, perform these steps: 

Complete the Node Characteristics section to define general characteristics, such as the digit that 
callers press to run the query. 

Identify the data source and table name.  

Press the Record Selection button to define record selection criteria.  

Press the Results Processing button to specify how results should be processed if a query result is 
returned (or not returned). 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 
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The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
menu options that are invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking the 
form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers 
can verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

DB Information frame 

Options in this frame identify the data source and table that the database operation will apply to. 
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IC Data Source 

Select the name of a database as it is defined in Interaction Administrator.  See IC Data Source 
Configuration in the Interaction Administrator help to find out data sources are defined for CIC and its 
subsystems.  Typically, this list contains I3Text White Pages, CIC Contacts, CIC Report Logging, CIC 
Report Logs, Tracker, and custom databases defined by your organization. 

Table Name 

Records will be selected from the table whose name you enter here.  If you do not know the names of 
tables in your database, contact your Database Administrator. 

Record Selection button 

 
This button opens the DB Record Selection Dialog so that you can define criteria that Attendant will 
use to select a database record.  

Query Information frame 

This section identifies the name of the column that will be retrieved from the record. 

 

Column to Retrieve 

Enter the name of the column that will be retrieved by the database query.  If you do not know its 
exact name, contact your Database Administrator. Note that the column name is case-sensitive. 

Results Processing button 

 
This button opens the Results Processing dialog, so that you can define actions to take when results 
are returned, and actions to take if no results are returned.  This dialog also determines whether the 
query result is read back to the caller. 

Action When Finished frame 
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These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves the node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server. 

 

Go back to previous menu 

This option returns control to the parent menu.  This sets up a simple loop that "reruns" the menu 
from the top. 

Disconnect 

This option disconnects the call when the database operation completes successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server. 

DB Update 
This operation updates a single field in one database record.  For example, you might create a menu 
that allows callers to update survey information in a database (1=agree, 2=disagree).  Database 
Update is limited.  It can't do more than replace the contents of a field.  For instance, it cannot add, 
subtract, increment numeric values, or update a row. 

To update a field in a database table, follow these simple steps: 

Identify the data source and table name.  

Perform Record Selection, by opening the DB Record Selection dialog to select a record to update. 

Identify the Update Action, by opening the Update Column dialog to specify which column (field) will 
be updated and the data that will be assigned to the field. 

Define flow-of-control actions that take place when this menu operation finishes. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
menu options that are invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking the 
form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 
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Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers 
can verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

DB Information frame 

 

IC Data Source 

Select the name of a database as it is defined in Interaction Administrator.  See IC Data Source 
Configuration in the Interaction Administrator help to find out data sources are defined for CIC and its 
subsystems.  Typically, this list contains I3Text White Pages, CIC Contacts, CIC Report Logging, CIC 
Report Logs, Tracker, and custom databases defined by your organization. 

Table Name 

Records will be updated in the table whose name you enter here.  If you do not know the names of 
tables in your database, contact your Database Administrator. 

Record Selection button 

 
This button opens the DB Record Selection dialog, so that you can define criteria that Attendant will 
use to select a database record.  

Update Action button 

 

Opens the Update Column dialog so that you can specify which field that will be updated, and the 
content that will be assigned to the field. 

Action When Finished frame 

These options set the processing that occurs after the operation completes successfully, when flow of 
control leaves the node.  You can return control to the previous menu, disconnect the call, transfer to 
an operator profile, or jump to any node or action that has been defined for the current server. 
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Go back to previous menu 

This option returns control to the parent menu.  This sets up a simple loop that "reruns" the menu 
from the top. 

Disconnect 

This option disconnects the call when the database operation completes successfully. 

Transfer to Operator Processing 

Transfers the call for evaluation by operator profiles defined for this server. 

Jump to a custom location 

This option allows you to jump to any profile, schedule, menu, or operation that is defined for the 
current server. 

Queue Operations 

Queue Operations 
Queue operations interact with callers who are waiting in queues.  

Queue 
Operation Description 

Continue 
waiting in this 
queue 

Allows a caller to elect to remain on hold in a queue.  

Play a message 
to the Caller 

Plays a message for a caller in a queue.  This message indicates the caller's 
position in the queue, estimated wait time, or is any custom message that you 
have recorded. 

Present a Menu 
to the Caller 

Presents the caller with menu choices while he or she waits in the queue.  A 
queue menu works like a standard menu, except that a limited set of operations 
can be attached to it. 

Repeat a 
Sequence of 

Loops back to a previous node (of type queue) during the queue processing. 
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Queue 
operations 

Transfer the call 
out of this 
queue 

Transfers a call directly to a user, workgroup, or station queue. 

Callback 
Request 

Allows a caller to request a callback.  ANI data about  the call is examined at 
runtime to capture the caller's telephone number, and a new callback request 
object is placed on the workgroup queue specified in the form.  The callback 
occurs when an agent picks up the callback from the queue.  The caller does not 
have to wait on hold or possibly incur long distance charges while waiting to 
speak with an agent. 

Queue operations are disabled until a Group Transfer node is configured to transfer the call to an ACD 
(or custom) workgroup.  Queue Stay and Queue Transfer are disabled until a Queue Menu node is 
selected.  The figure below illustrates these relationships: 

 

  

Add and Remove Skills from an In-Queue Call 
You can modify skill requirements while a call is in-queue by adding the Queue Update Skills action as 
an in-queue action under a workgroup transfer. This action allows you to add or remove skills without 
transferring the call to a different queue. 

Warning: Due to current ACD Server limitations, when you update skills in an in-queue call, 
Interaction Attendant temporarily removes the interaction from the workgroup queue when 
updating the ACD skills. The interaction is  reprocessed when Attendant returns it to the queue, 
and resets any existing ACD statistics such as Queue Timeout and the interaction's position in 
queue. 

To add or remove skills from an in-queue call: 

1. From a workgroup transfer node, click the Queue Update Skills icon or select Add/Remove 
skills for the interaction from the Queue Operations menu. The Queue Update Skills form 
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appears below the transfer action. 

 
2. In the Node Characteristics area, name the node, establish whether or not it is active, logged, 

or tracked for reporting purposes. 

• Name field.  the label you enter here becomes the name of the node in the tree structure. 

• Active check box.  By default, forms are "on", or "active", which means Interaction Attendant 
will process them.  If you uncheck a form's Active check box, the name of the node turns gray 
in the tree to indicate that the form is inactive.  Interaction Attendant and its handlers will 
therefore ignore the form and its children.  Use this feature to save a configuration that you 
are testing. Inactive forms are not visible to callers.  When a node is inactive, it appears 
grayed out in the tree view. 

• Default Action check box. At any given "level" in the tree structure, one node can be marked 
as the default action.  The operation defined by the default node is performed if the caller 
does not press a key within the timeout period specified by that menu.  The icon for default 
forms has a green border in the tree structure.  Any node below a menu or schedule can be 
marked as the default action by checking the form's default action check box. 

• Enable IVR Reporting. This option determines whether or not reporting data will be collected 
when control passes through this node.  Several IVR Reports summarize this information.  IVR 
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Reporting is disabled by default.  Enable it to capture the date, time, and duration of time 
that the call remained in the node and its children.  This option is hidden when Attendant is 
connected to a server that does not have reporting installed.  For more information, see IVR 
Reporting Option. 

• Add entry to the Interaction Log.  When this option is enabled, tracking information about 
this node is appended to the call's Interaction Log when the call enters this node.  This helps 
track the path that a call took through Attendant.  The Interaction Log is maintained for 
reporting purposes.  See View the Interaction Log for details. 

3. To add a skill to the interaction, in the Skills to Add area click to place a check mark next to 
the skill you want to add to this interaction. 

4. To remove a skill from the interaction, in the Skills to Remove area click to remove the check 
mark next to the skill you want to delete from the interaction. 

5. To add skills from a list specified by the dynamic interaction attribute 
'Eic_AttDynamicSkillsToAdd', place a check mark in the box next to this option. 

6. To remove skills from a list specified by the dynamic interaction attribute 
'Eic_AttDynamicSkillsToRemove', place a check mark in the box next to this option. 

Continue waiting in this queue 
This option allows a caller to elect to remain on hold in a queue.  This operation is disabled until you 
create a queue menu below a Group transfer.  When you select the queue menu, you will be able to 
add this operation.  This operation has no configurable options, except for general node 
characteristics.  This operation is also called Queue Stay. 

This operation must be the child of a Queue Menu node. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not 
it is active, used by default, logged, or tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 
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Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
menu options that are invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking the 
form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 
Select this button to configure words or phrases that can be associated with menu options. Callers can verbally indicate the options they 
want in the IVR instead of pressing a digit on the phone. You can enter multiple words and phrases for each menu item, just as callers may 
phrase the same request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or 
phrases to Inbound Call Operations. 

Play a Message to the caller 
This operation plays a message to a caller who is waiting in a queue.  This operation is disabled 
unless one of the other queue operations is selected in the tree view.  This operation is also called 
Queue Audio. 

Tip—Queue operations that require ACD workgroups (queue audio, queue menu, queue repeat) 
are disabled when a non-ACD workgroup queue is selected.  These operations are automatically 
enabled in toolbars and menus when an ACD workgroup is selected in the node that the 
operation is attached to.  In previous releases, it was possible to create queue nodes did not 
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execute for sequential or group workgroups.  
 
For example, one could have set a queue audio node to play a .wav file under a sequential or 
group ring group transfer node.  When a call came into that queue, the caller heard the default 
hold music while any available agents are alerted.  If the call was not answered, it was forwarded 
to the group's Voicemail.  On a sequential workgroup, when there were no available agents, the 
call went directly to Voicemail and the queue audio was never played. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or 
not it is active, logged, or tracked for reporting purposes.  You cannot configure this node as a 
default action, since this operation is not invoked in response to a key press. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
menu options that are invoked by a routing process, rather than by a user selection.  For details, 
see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the 
form and its children.  Use this feature to save a configuration that you are testing.  Inactive forms 
are invisible to callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
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structure.  Any node below a menu or schedule can be marked as the default action, by checking 
the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers 
can verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

Audio Message to play to the caller frame 

You can play a standard message that tells the caller his or her position in the queue,  or the 
estimated wait time.  Alternately, you can play a custom message to the caller. 

 

Position in Queue 

Plays a message that tells the caller his position in the queue.  

Estimated wait time 

Plays a message that tells the caller how long it may be until his call is answered.  

Custom Message 

Enables embedded audio controls in the Audio File frame, so that you can record or select a 
previously record .wav file. For procedural details, see manage voice prompts. 
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Audio Source 

When you select Audio Source, in the Audio Source Settings area optionally select the Play Source 
Continually to configure Interaction Attendant to play the audio repeatedly.  In the Timeout area, 
use the up and down arrows to select the configurable number of seconds to repeat the audio 
before exiting playback. 

 
Below the Audio Source Settings area, in the Audio area click the Name dropdown list to select any 
audio source that is defined in Interaction Administrator, or click Browse to search for the 
file.  Here, you can optionally record the audio, preview the audio, and see details about the audio 
file. 

 

External audio source 

If you click External Audio Source, in the Audio Source Settings area optionally select the Play 
Source Continually to configure Interaction Attendant to play the external audio repeatedly.  In the 
Timeout area, use the up and down arrows to select the configurable number of seconds to repeat 
the audio before exiting playback. 

 
Below the Audio Source Settings, click the arrow at the end of the Name field dropdown list and 
select the appropriate source (for example, iPod or Pandora). Interaction Attendant will play audio 
from a file or audio source to a user in the IVR. These external audio sources must be defined and 
configured in Interaction Administrator before you can select them in the Queue Audio node. 
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After you select the external audio source, in the Timeout area use the up and down arrows to 
select how many seconds to play the external audio source before control is passed to Action 
When Finished processing. 

 

Present a Menu to the caller 
This operation (also called Queue Menu) presents the caller with menu choices while he or she 
waits in the queue.  The message is configurable.  A queue menu works like a standard menu, 
except that a limited set of operations can be attached to it.  The supported operations are 
Callback Request, Disconnect, Queue Operations, Transfer to a Different Menu, Transfer to 
Voicemail, and Transfer to an Attendant Profile. 

All Queue operations are disabled until a Group Transfer node is configured to transfer to an 
ACD workgroup. This operation is disabled in the toolbar unless one of the other queue 
operations is selected in the tree view. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or 
not it is active, logged, or tracked for reporting purposes.  You cannot configure this node as a 
default action, since this operation is not invoked in response to a key press. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level 
of the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to 
create menu options that are invoked by a routing process, rather than by a user selection.  For 
details, see invoke a menu operation automatically. 
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Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore 
the form and its children.  Use this feature to save a configuration that you are testing.  Inactive 
forms are invisible to callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking 
the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the 
node and its children.  This option is hidden when Attendant is connected to a server that does 
not have reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. 
Callers can verbally indicate the options they want in the IVR instead of pressing a digit on the 
phone. You can enter multiple words and phrases for each menu item, just as callers may phrase 
the same request in different ways. For example, "transfer funds" or "funds transfer". See Add 

Speech Recognition keywords or phrases to Inbound Call Operations. 

Audio File frame 

 
The embedded audio controls in this frame manage a prompt that plays when the menu is 
invoked.  In most cases this voice prompt tells the caller which keys to press to make menu 
choices.  See manage voice prompts for procedural details. 
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Timeout frame 

 

Number of seconds to wait before continuing spin control 

This spin control sets the interval that Interaction Attendant will wait after playing an audio 
message, before moving to the next queue operation if the caller does not make a menu 
selection. 

In xIC 2.3 and later, queue operations that require ACD workgroups (queue audio, queue 
menu, queue repeat) are disabled when a non-ACD workgroup queue is selected.  These 
operations are automatically enabled in toolbars and menus when an ACD workgroup is 
selected in the node that the operation is attached to.  
 
In previous releases, it was possible to create queue nodes did not execute for sequential or 
group workgroups.  For example, one could have set a queue audio node to play a .wav file 
under a sequential or group ring group transfer node.  When a call came into that queue, the 
caller heard the default hold music while any available agents are alerted.  If the call was not 
answered, it was forwarded to the group's Voicemail.  On a sequential workgroup, when 
there were no available agents, the call went directly to Voicemail and the queue audio was 
never played. 

Repeat a sequence of Queue operations 
This operation loops back to a previous Queue Menu node in the queue processing.  This operation is 
disabled in the toolbar unless one of the other queue operations is selected in the tree.  This operation 
is also called Queue Repeat. 

Queue Repeat repeats the node it points to the number of times selected before continuing with the 
queue processing. This is typically used for things like playing 15 second hold music for 45 seconds 
before repeating the position in queue audio. 

In xIC 2.3 and later, queue operations that require ACD workgroups (queue audio, queue menu, 
queue repeat) are disabled when a non-ACD workgroup queue is selected.  These operations are 
automatically enabled in toolbars and menus when an ACD workgroup is selected in the node that 
the operation is attached to.  
 
In previous releases, it was possible to create queue nodes did not execute for sequential or group 
workgroups.  For example, one could have set a queue audio node to play a .wav file under a 
sequential or group ring group transfer node.  When a call came into that queue, the caller heard the 
default hold music while any available agents are alerted.  If the call was not answered, it was 
forwarded to the group's Voicemail.  On a sequential workgroup, when there were no available 
agents, the call went directly to Voicemail and the queue audio was never played. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, logged, or tracked for reporting purposes.  You cannot configure this node as a default action, 
since this operation is not invoked in response to a key press. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you assign 
a digit, the list displays only available digits—those that are not already in use at this level of the 
tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create menu 
options that are invoked by a routing process, rather than by a user selection.  For details, see invoke a 
menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The operation 
defined by the default node is performed if the caller does not press a key within the timeout period 
specified by that menu. The icon for default forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default action, by checking the form's default action 
check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 
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When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers can 
verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You can 
enter multiple words and phrases for each menu item, just as callers may phrase the same request in 
different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition keywords or phrases 

to Inbound Call Operations. 

Transfer the call back to this location frame 

 

Transfer list box 

Selects a queue node to transfer the call to. 

Number of times to repeat this loop spin control 

Sets the maximum number of times that the loop will be executed before control is passed to the error 
handler for the schedule. 

Related Topics 

• Queue Operations 

Transfer the call out of this queue 
This operation transfers a call directly to a user, workgroup, or station queue.  It transfers the call out 
of this queue and into another queue.  If the call is not picked up, the call will wait in the workgroup 
queue until it is answered.  This operation is also called Queue Transfer.  It is disabled in the toolbar 
unless one of the other queue operations is selected in the tree. 

This operation must be the child of a Queue Menu node. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or not it 
is active, used by default, logged, or tracked for reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level of 
the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to create 
menu options that are invoked by a routing process, rather than by a user selection.  For details, see 
invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking the 
form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 
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Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. Callers 
can verbally indicate the options they want in the IVR instead of pressing a digit on the phone. You 
can enter multiple words and phrases for each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or "funds transfer". See Add Speech Recognition 

keywords or phrases to Inbound Call Operations. 

Workgroup, Call Priority and Skill Settings 

Selects the queue that the call is transferred to, allowing you to set priority and skill settings. 

Call processing behavior after the call is transferred to a queue is affected by post-queue-transfer 
IVR handlers (handlers and subsequent handlers called from 
System_CallOfferingNonSystemQueue.ihd).  For example, if you add a workgroup queue in 
Interaction Administrator and make a call to that queue from Interaction Attendant, the call will 
not be processed unless you have modified the CustomIVRWorkgroup queue to process calls sent 
to that workgroup. In short, Interaction Attendant tells CIC that a call is being transferred to a 
non-system queue, and System_CallOfferingNonSystemQueue.ihd takes over from there. 

 

Workgroup list box 

This list box contains the names of destination workgroups.  

Set the calls priority to 

You can change the priority of the call before sending it to the queue. (0=lowest, 1000=highest).  By 
default, the call priority is 50. 

Agent Skills 

These check boxes are used in conjunction with ACD to route the call to an agent whose skills match 
the profiles you select. 

Callback Request 
The Request Callback node allows a caller to request a callback.  ANI data about  the call is examined 
at runtime to capture the caller's telephone number, and a new callback request object is placed on 
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the workgroup queue specified in the form.  The callback occurs when an agent picks up the callback 
from the queue.  Attendant currently does not allow callers to schedule callbacks to occur at a 
specific date or time. 

Callbacks increase customer satisfaction, since a caller does not have to wait on hold or possibly 
incur long distance charges while waiting to speak with an agent.  

Callers who are on hold for a workgroup can transfer to another group, disconnect, leave a 
Voicemail message, or request that an agent return the call.  If the existing call is ACD, the call will 
be replaced with a callback object, and the ACD stats will be copied over to the callback object: 
priority, time in queue, workgroup queue, and skills. This can be confirmed by examining the 
ACDServer logs. If the existing call is NOT ACD, a new callback object will be created on the 
specified workgroup queue. If the Request Callback node is not part of queue operations, you are 
presented with the option to select a target workgroup. 

>In-Queue menus 

If the Request Callback node is part of queue operations, you can configure a prompt to inform the 
caller that the system successfully processed and scheduled the callback. This frame only appears 
in an in-queue menu.   

If the Request Callback is part of an in-queue menu that includes a Caller Data Entry node, the 
caller can enter a specific telephone number during a callback request and Interaction Attendant 
will pull that number from the Caller Data Entry node when processing the callback request. In the 
Callback Number frame, select the Callback to the phone number entered by the caller in this 
Caller Data Entry node radio button and from the dropdown list select the Caller Data Entry node 
listed in the in-queue menu. 

 
Note: Make sure you also configure the Caller Data Entry node's Action When Finished 
frame to jump to the appropriate Request Callback node listed in the in-queue menu. 

Node Characteristics frame 

Options in this frame name the node, assign the digit used to select it,  and establish whether or 
not it is active, used by default, logged, or tracked for reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Digit list box 

Use this list to select the key that callers press to enter a caller data entry operation.  When you 
assign a digit, the list displays only available digits—those that are not already in use at this level 
of the tree.  If no digit is assigned, callers cannot invoke the operation directly.  It is possible to 
create menu options that are invoked by a routing process, rather than by a user selection.  For 
details, see invoke a menu operation automatically. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore 
the form and its children.  Use this feature to save a configuration that you are testing.  Inactive 
forms are invisible to callers.  When a node is inactive, it appears grayed out in the tree view. 

Default Action check box 

At any given "level" in the tree structure, one node can be marked as the default action.  The 
operation defined by the default node is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as the default action, by checking 
the form's default action check box. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the 
node and its children.  This option is hidden when Attendant is connected to a server that does 
not have reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction Log 
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When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Configure Speech Recognition... button 

Select this button to configure words or phrases that can be associated with menu options. 
Callers can verbally indicate the options they want in the IVR instead of pressing a digit on the 
phone. You can enter multiple words and phrases for each menu item, just as callers may phrase 
the same request in different ways. For example, "transfer funds" or "funds transfer". See Add 

Speech Recognition keywords or phrases to Inbound Call Operations. 

Audio File frame 

 
Controls in this frame set a prompt to play when control is passed to this form.  If you do not 
select or record a prompt using the embedded audio controls, no voice prompting will 
occur.   See manage voice prompts for details. 

Announce Callback Scheduled frame (In-Queue menus only) 

 
If the callback node is part of queue operations, you can configure a prompt that confirms to the 
caller the system processed and scheduled the callback. This frame only appears in an in-queue 
menu.   

Callback Number frame 

 
The settings in this frame determine the telephone number used to call back the user, which can 
be: 

Callback to the ANI info on this call 
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The return call will be placed to the caller's telephone number. 

Callback to the phone number entered by the call in this Call Data Entry node 

Places a call to the number entered in the selected Caller Data Entry node, which prompted the 
caller to enter a string of digits using their telephone keypad.  

Workgroup Queue (not available within In-Queue menus) 

 
If the callback node is not part of queue operations, you are presented with the option to select a 
target workgroup: 

Place this callback on this workgroup queue list box 

This list selects the queue that the callback will be placed on.  

Email Operations 

Email Operations 
The following nodes perform actions on Email objects: 

Node Action 

Build Email Reply Allows the user to configure specific attributes of a message 
that will be sent in response to the inbound email. 
Additionally, the user can select the processing that will occur 
after the reply has been built. 

Email - Disconnect Stops processing an email message. Messages can optionally 
be stored in a folder. 

Email Transfer Branches between two possible operations based upon the 
result of a rule.  A rule is a logical expression based on the 
email address, subject, or body text that evaluates to True or 
False.  If the rule evaluates as True, then the flow will jump to 
one node; if the rule is False, then the flow will jump to 
another node. 

Email - Run Subroutine Passes the current email object to a custom handler.  The 
processing that the subroutine performs occurs is up to the 
handler author. 

Email - Logging Writes free-form text, the date and time, or selected parts of 
the email to the interaction log. 



Email - Build Reply 

300 

Email - Set Attribute Assigns a named item of information to the email which 
travels with it throughout the Customer Interaction Center.  

Email – Set Routing Options These options assign required agent skills and/or queue 
priority used for Workgroup routing in advance of actually 
performing the Email Workgroup Transfer. 

Email - Transfer to an Agent Sends an email interaction to a specific user queue. 

Email - Transfer to a Different Menu Jumps to any location in the configuration tree. 

Email - Transfer to a Workgroup Transfers an email interaction to a workgroup.  If the 
destination workgroup is an ACD workgroup, you can 
optionally select skills that the Agent handling the interaction 
must have to receive the Interaction.  

Related Topics 

• Email Profiles 

• Email Schedules 

• Email Operations 

Email - Build Reply 
The Build Reply form allows the user to configure specific attributes of a message that will be sent 
in response to the inbound Email. Additionally, the user can select the processing that will occur 
after the reply has been built. 

• Send the reply and then stop processing (strictly an auto-response) 

• Send the reply and continue processing (for things like "We got your message and we will 
respond soon...") 

Email nodes are processed in top-to-bottom order under a schedule. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or 
tracked for reporting purposes. 

 

Name field 
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The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore 
the form and its children.  Use this feature to save a configuration that you are testing.  Inactive 
forms are invisible to callers. When a node is inactive, it appears grayed out in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled 
by default.  Enable it to capture the date, time and duration of time that the call remained in the 
node and its children.  This option is hidden when Attendant is connected to a server that does 
not have reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction 
Log when the call enters this node.  This helps track the path that a call took through 
Attendant.  The Interaction Log is maintained for reporting purposes.  See View the Interaction 
Log for details. 

Reply to Sender frame 

 

Reply to sender 

Sends the reply using the address of the person who sent the Email. 

Reply to all 

Sends the reply to all persons who originally received the Email. 

Reply Process frame 

 

Send reply now and disconnect 

Sends reply and terminates the interaction. No other nodes will process this Email. 
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Send reply now and continue processing 

Sends the Email but does not terminate the interaction. Control is passed to the next node 
below the current one. 

Routing and Message Body Options 

You can manually type an Email address in any of the address fields in the form 
username@somedomain.com. However, no address validation occurs unless you use the Email 
Address Selection dialog to select an address. 

 

Send Message From button 

Opens the Email Address Selection dialog, so that you can search for and select Email addresses. 
The resulting text string specifies the address that will be used as the From address. 

Reply To Address(es) button 

Opens the Email Address Selection dialog, so that you can search for and select addresses.  The 
resulting text string specifies the addresses that should be used as the Reply To address. 

margin-left: .25in; margin-right: 0in; 

Important: "Reply to Address(es)" specifies the person that the message is sent to by 
Attendant, not the original sender.  When a user opens the message in a client application, 
and chooses to reply, the Reply To address (specified in the Build Reply node) is not 
used.  The message is sent to the sender of the original Email, or to all persons who 
received the original Email, based on whether "Reply to Sender" or "Reply to all" was 
selected in the Build Reply node. 
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Add Cc: Address(es) button 

Opens the Email Address Selection dialog, so that you can search for and select addresses.  The 
resulting text string specifies address(es) that will be appended to the end of the current list of 
carbon copy (Cc) addresses for the reply. 

Add Bcc: Address(es) button 

Opens the Email Address Selection dialog, so that you can search for and select addresses.  The 
resulting text string specifies address(es) that will be appended to the end of the current list of 
blind carbon copy (Bcc) addresses for the reply. 

Include original message in reply 

Use this option to include the text of the original message in the response message. If you 
select this checkbox, 

Include original attachments in reply 

Use this option to include the original message file attachments with the response message. 

Message Text field 

The text you enter in this field becomes the body text of the reply that is being built, replacing 
the original body text of the message.  The text will appear in plain text format.  HTML tags are 
not supported and although they may work as desired, the tags will appear in the plain text 
body of the message. 

If you choose to include the original text in the message body by selecting the Include original 
message in reply check box, the text you enter into the Message Text field will be added to the 
body of the message. 

Related Topics 

• Email Profiles 

• Email Schedules 

• Email Operations 

Email - Disconnect 
The email disconnect node stops processing an email message. Messages can optionally be 
stored in a folder. 

Node Characteristics frames 

Options in this frame name the node, and establish whether or not it is active, logged, or 
tracked for reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore 
the form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers. When a node is inactive, it appears grayed out in 
the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled 
by default.  Enable it to capture the date, time and duration of time that the call remained in 
the node and its children.  This option is hidden when Attendant is connected to a server that 
does not have reporting installed.  For more information about this feature, see IVR Reporting 
Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction 
Log when the call enters this node.  This helps track the path that a call took through 
Attendant.  The Interaction Log is maintained for reporting purposes.  See View the Interaction 
Log for details. 

Action on Disconnect frame 

 

Move the e-mail to a folder 
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You can optionally move an email to a folder, rather than discard it. This option stores the 
message until it can be manually processed, and allows Attendant to be configured as a 
lightweight "spam filter".  The logic for determining what is spam must be user-configured by 
creating additional Email Profiles or by using Email Transfer nodes.  

Mailbox 

Select a destination mailbox by pressing the browse (…) button. The Mailbox Selection dialog 
will appear. Select a mailbox, and then press OK to dismiss the dialog. 

Note: If you use Microsoft Exchange Web Services, select a folder in the same mailbox from 
which the email was queued. 

Folder 

When the drop list is enabled, you can select from a list of destination folders in the selected 
mailbox.  The message will be transferred to the selected folder and processing of the 
interaction will be halted. 

Related Topics 

• Email Profiles 

• Email Schedules 

• Email Operations 

Email - Transfer 
An Email Transfer node branches between two flow of control paths based upon the result of a 
rule.  This works like a Logical Transfer for a call, except that an email message is transferred 
instead of a telephone call. A rule is a logical expression based on the email address, subject, or 
body text that evaluates to True or False.  If the rule evaluates as True, then the flow will jump 
to one node; if the rule is False, then the flow will jump to another node. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or 
tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 
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By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree to 
indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter ignore 
the form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers. When a node is inactive, it appears grayed out in 
the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled 
by default.  Enable it to capture the date, time and duration of time that the call remained in 
the node and its children.  This option is hidden when Attendant is connected to a server that 
does not have reporting installed.  For more information about this feature, see IVR Reporting 
Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction 
Log when the call enters this node.  This helps track the path that a call took through 
Attendant.  The Interaction Log is maintained for reporting purposes.  See View the Interaction 
Log for details. 

Email conditions frame 

This frame displays the rule that was previously created using the Email Rule wizard, or "No 
email conditions defined", if the rule has not been created yet. 

 

Add Email Conditions button 

Opens the Rules wizard for emails.  Once an expression has been defined, the button caption 
changes to "Modify Email Condition".  If you press the button a second time, you are given the 
opportunity to change you selections. 

Transfer Location frame 
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This frame sets the paths that are taken after the logical expression is evaluated.  One path is 
taken when the expression is True.  The other path is taken when the expression is False. 

 

If the above statement is true, go to... 

This list box allows you to select the path that is taken when the expression is True.  You can 
select any profile, schedule, menu, or operation that is defined for the current server. 

If the above statement is false, go to... 

This list box allows you to select the path that is taken when the expression is False.  You can 
select any profile, schedule, menu, or operation that is defined for the current server. 

Related Topics 

• Email Rules Wizard 

• Email Profiles 

• Email Schedules 

• Email Operations 

Email - Run Subroutine 
This node passes the current email object to a custom handler.  The processing that the 
subroutine performs occurs is up to the handler author. This node is sometimes called 
"Subroutine Initiator", since it allows a custom handler to take over processing of an 
interaction.  The custom handler usually accomplishes functionality outside of the scope of 
Attendant's built-in nodes. 

Important: Before using Run Subroutine in Interaction Attendant, you must modify the 
CustomSubroutineInitiatorRouter handler using Interaction Designer.  See Modify 
CustomSubroutineInitiator.ihd for procedural details.  Interaction Designer's online help 
provides comprehensive information about handlers and subroutines.  

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or 
tracked for reporting purposes. 
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Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree 
to indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter 
ignore the form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers. When a node is inactive, it appears grayed out 
in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled 
by default.  Enable it to capture the date, time and duration of time that the call remained in 
the node and its children.  This option is hidden when Attendant is connected to a server that 
does not have reporting installed.  For more information about this feature, see IVR Reporting 
Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction 
Log when the call enters this node.  This helps track the path that a call took through 
Attendant.  The Interaction Log is maintained for reporting purposes.  See View the 
Interaction Log for details. 

Subroutine Name 

 

Subroutine name field 

Type the name of the subroutine to run in this field. Attendant does not validate this entry, so 
be careful to enter a valid subroutine name.  At runtime, the Subroutine Initiator will pass the 
interaction's identifier and the supplied subroutine name to a handler named 
CustomSubroutineInitiatorRouter, which in turn, invokes the subroutine. 

Once control is passed to the subroutine, it does not return to Attendant. From Attendant's 
point of view, the interaction ends once the email is passed to the handler. 
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Related Topics 

• Email Profiles 

• Email Schedules 

• Email Operations 

Email – Logging 
This node writes free-form text, the date and time, or selected parts of the email message to 
the interaction log. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or 
tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree 
to indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter 
ignore the form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers. When a node is inactive, it appears grayed out 
in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled 
by default.  Enable it to capture the date, time and duration of time that the call remained in 
the node and its children.  This option is hidden when Attendant is connected to a server that 
does not have reporting installed.  For more information about this feature, see IVR Reporting 
Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction 
Log when the call enters this node.  This helps track the path that a call took through 
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Attendant.  The Interaction Log is maintained for reporting purposes.  See View the 
Interaction Log for details. 

Logging Information frame 

Options in this frame control what is written to the log file. 

 

Log this text 

Select this option to append free-form text to the interaction log. 

Log this e-mail attribute (and its value) 

This option writes one of the following attributes to the interaction log: 

Data from the 'To:' field Writes contents of the "To:" field to the log. 

Data from the 'From:' field Writes contents of the "From:" field to the log. 

Date from the 'Cc:' field Writes contents of the "Cc:" field to the log. 

The subject line of the message Writes the subject line of the email to the log. 

The text of the message Writes the entire email body to the log. 

The subject line and message 
body 

Writes the header, subject and body to the log. 

Log the current date and time 

This option appends the current date and time to the interaction log. 

Related Topics 

• Email Profiles 

• Email Schedules 

• Email Operations 

Email - Set Attribute 
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An attribute is a piece of information about an object that travels with it throughout the 
Customer Interaction Center.  Email interactions, like other objects in CIC, often have 
attributes assigned to them.  Attributes are usually assigned by handlers, but Attendant 
allows the attributes of an object to be added or updated.  

For example, one attribute of a call object is the telephone number of the person who placed 
the call.  Attributes are name/value pairs.  To set an attribute, specify its name, and a string 
value that you wish to assign to the attribute. 

Setting an attribute does not modify the email message in any way, since the attribute is 
added to the interaction object, which carries the email message as a payload. Hence, 
attributes are characteristics of the email object, but not the email message. 

The Set Attribute operation can assign a value to any attribute, including attributes that are 
reserved for use by important handlers in the Customer Interaction Center.  If you modify a 
reserved attribute, you can adversely affect the performance or reliability of the server, so 
you should set attributes carefully.  

The Interaction Attributes Technical Reference reports attributes that are reserved by CIC, 
including those which should not be changed. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or 
tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process 
them.  If you uncheck a form's Active check box, the name of the node turns gray in the tree 
to indicate that the form is inactive.  Interaction Attendant and its handlers will thereafter 
ignore the form and its children.  Use this feature to save a configuration that you are 
testing.  Inactive forms are invisible to callers. When a node is inactive, it appears grayed out 
in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes 
through this node.  Several IVR Reports summarize this information.  IVR Reporting is 
disabled by default.  Enable it to capture the date, time and duration of time that the call 



Email - Set Attribute 

312 

remained in the node and its children.  This option is hidden when Attendant is connected 
to a server that does not have reporting installed.  For more information about this feature, 
see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's 
Interaction Log when the call enters this node.  This helps track the path that a call took 
through Attendant.  The Interaction Log is maintained for reporting purposes.  See View the 
Interaction Log for details. 

Attribute and Value fields 

These fields identify the attribute to set, and assign a value to it.  

 

Attribute text box 

Type the name of the attribute in this text box.  This name can be anything you like, or it can 
be the name of a reserved attribute. For example, a custom name might be "My Email 
Attribute".  

  For more information about attributes, refer to the Interaction Attributes Technical 
Reference, which is located in the PureConnect Documentation Library. 

Value 

Type the text you wish to assign to the attribute in this field. This can be anything you like. 
For example, "This interaction was processed by Attendant." 

Tip for Advanced Users 
 
Since the handler that supports Set Attribute node processes values through the 
ReplaceAttributes tool before it sets the target attribute, the Set Attribute node can be 
used to assign one attribute value to another, or you can use it to insert the value of an 
attribute along with a string literal. The syntax for inserting an attribute value is 
"$(attributename)". 
 
To copy one attribute value into another: 
 
Attribute name: SOME_ATTRIB 
Value: $(SOME_OTHER_ATTRIB) 
 
To copy literal text and an attribute value into another attribute: 
 
Attribute name: SOME_ATTRIB 
Value: The phone number is $(SOME_OTHER_ATTRIB) 

Related Topics 
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• Email Profiles 

• Email Schedules 

• Email Operations 

Email - Set Routing Options 
This node sets required agent skills and/or queue priority used for Workgroup routing in 
advance of actually performing the Email Workgroup Transfer. This node makes it simpler 
to use the Email Logical Transfer node to determine if a call is high priority or needs certain 
skills and to route it appropriately. 

The configuration options for this node are almost identical to options in the Advanced 
Workgroup Properties Dialog (Email) dialog. The user can select a priority between 1 and 
100 to prioritize the email, and can select one or more skills that the agent taking the email 
should have.  However, this node offers these additional features: 

• A check box allows the user to control whether the message's priority should be 
set. This allows the user to set skills and leave the priority unaffected. 

• Conversely, users users can elect not not to set skills, and set only priority, or they 
can append selected skills (to add more skills to the message), or "set to the 
selected skills", overwriting whatever skills were on the message with the skills 
selected in this node. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or 
tracked for reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will 
process them.  If you uncheck a form's Active check box, the name of the node turns gray 
in the tree to indicate that the form is inactive.  Interaction Attendant and its handlers will 
thereafter ignore the form and its children.  Use this feature to save a configuration that 
you are testing.  Inactive forms are invisible to callers. When a node is inactive, it appears 
grayed out in the tree view. 

Enable IVR Reporting 
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This option determines whether or not reporting data will be collected when control 
passes through this node.  Several IVR Reports summarize this information.  IVR Reporting 
is disabled by default.  Enable it to capture the date, time and duration of time that the call 
remained in the node and its children.  This option is hidden when Attendant is connected 
to a server that does not have reporting installed.  For more information about this 
feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's 
Interaction Log when the call enters this node.  This helps track the path that a call took 
through Attendant.  The Interaction Log is maintained for reporting purposes.  See View 
the Interaction Log for details. 

Priority frame 

 

Enable priority check box 

This check box determines whether the message's priority is set.  This allows you to set 
skills and leave the priority unaffected. 

Set email priority to 

Sets the priority of the email in a queue. Valid values range from 0 (lowest priority) to 100 
(hightest priority).  The default is zero, which is the same as having no priority assigned. 

Skills frame 

 



Printed Documentation 

315 

Ignore skills 

Select this option when you want to set priority, but not skills. 

Append the selected skills 

Add the skills you have selected to skills required to receive the message. 

Set to the selected skills 

Overwrites whatever skills are on the message with the skills selected. 

Email - Transfer to an Agent 
Agent Transfer sends an email interaction to a specific user queue.  This is the email equivalent of the 
Transfer to an Agent node for calls. The difference is that email messages cannot be transferred to 
stations. 

To transfer email messages to a workgroup, use Group Transfer instead of Transfer to an Agent. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or tracked for 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers. When a node is inactive, it appears grayed out in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 
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Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Transfer To frame 

The options in this frame determine whether email is transferred to a user queue or to an agent 
defined in the 'Eic_AttDynamicAgentName' interaction attribute.   In general, you should specify a user 
queue when you need to route email to a specific person, and you should select the 
'Eic_AttDynamicAgentName' interaction attribute when the user has been defined within the 
interaction attribute.   

Note:  The 'Eic_AttDynamicAgentName' interaction attribute is helpful for environments that 
contain a large number of users and allows you to designate a single user to the attribute, thereby 
alleviating the task of searching through the queue lists. See Set Attribute for details. 

 

User Queue button 

This radio button enables the User Queue drop down list. 

User Queue drop down list 

This drop down list contains the names of user queues defined for the current server. The queue you 
select becomes the destination for the call.Use this drop list to select a destination user queue.   

Agent specified by interaction attribute radio button 

This radio button specifies the user as defined in the 'Eic_AttDynamicAgentName' interaction 
attribute.  The user defined in this interaction attribute becomes the destination for the email. 

Park Interaction check box 

Select this check box to allow email messages to be parked on another person's extension for the 
agent to receive when he or she has an available status.  

 
Related Topics 

• Email Profiles 

• Email Schedules 
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• Email Operations 

Email - Transfer to a Different Menu 
The Menu Transfer for calls allow a call to jump from one location in attendant to another. This same 
functionality is implemented for email routing tools, but, since there are no "menu" nodes in an email 
call flow, the Menu Transfer node allows the interaction to jump to any location in the configuration 
tree. 

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or tracked for 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers. When a node is inactive, it appears grayed out in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Transfer the call to this menu frame 
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Transfer the call to this menu drop list 

The node to which processing should be transferred. 

Related Topics 

• Email Profiles 

• Email Schedules 

• Email Operations 

Email - Transfer to a Workgroup 
This node transfers an email interaction to a workgroup.  If the destination workgroup is an ACD 
workgroup, you can optionally select skills that the Agent handling the interaction must have to 
receive the Interaction.  This node is sometimes called "Group Transfer", since it transfers an 
interaction to a workgroup queue.  

Node Characteristics frame 

Options in this frame name the node, and establish whether or not it is active, logged, or tracked for 
reporting purposes. 

 

Name field 

The label you enter here becomes the name of the node in the tree structure. 

Active check box 

By default, forms are "on", or "active", which means that Interaction Attendant will process them.  If 
you uncheck a form's Active check box, the name of the node turns gray in the tree to indicate that 
the form is inactive.  Interaction Attendant and its handlers will thereafter ignore the form and its 
children.  Use this feature to save a configuration that you are testing.  Inactive forms are invisible to 
callers. When a node is inactive, it appears grayed out in the tree view. 

Enable IVR Reporting 

This option determines whether or not reporting data will be collected when control passes through 
this node.  Several IVR Reports summarize this information.  IVR Reporting is disabled by 
default.  Enable it to capture the date, time and duration of time that the call remained in the node 
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and its children.  This option is hidden when Attendant is connected to a server that does not have 
reporting installed.  For more information about this feature, see IVR Reporting Option. 

Add entry to the Interaction log 

When this option is enabled, information about this node is appended to the call's Interaction Log 
when the call enters this node.  This helps track the path that a call took through Attendant.  The 
Interaction Log is maintained for reporting purposes.  See View the Interaction Log for details. 

Workgroup / Attribute radio buttons 

These options identify the workgroup or station group queue to which the call is transferred. 

 

Workgroup radio button 

This radio button enables the drop down list. 

Workgroup drop down list 

This drop down list allows you to select the name of any workgroup queue that is defined for the 
server. The email interaction will be transferred to the group you select. 

Workgroup specified by interaction attribute list box 

This option allows you to select a specific workgroup by the workgroup ID contained in the 
interaction attribute ‘Eic_AttDynamicWorkgroupName’ and defined for the server. This is particularly 
helpful in environments which contain a large number of workgroups, thereby making it cumbersome 
to select the appropriate workgroup. For example, you can organize workgroups according to area of 
expertise, such as web service calls, customer handler calls, etc., and assign names to the workgroups 
that help identify the specific skill.  Then, you can place the workgroup name in the interaction 
attribute ‘Eic_AttDynamicWorkgroupName and use that attribute for a workgroup transfer 
operation.. 

Advanced Workgroup Settings and Threaded Email Options buttons 

Use these buttons to specify advanced workgroup settings and to configure threaded email options. 

 

Advanced Workgroup Settings button 
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This button opens the Advanced Workgroup Properties Dialog (Email), so that you can set priority, 
needed agent skills, the length of time that the email should remain in the queue before timing out, 
and processing to perform if the interaction times out.  This button is disabled for operator profiles. 

Threaded Email Options button 

This button opens the Threaded Email Options dialog, where you can specify whether an email 
interaction is sent to either the first or the last workgroup that handled the email message, and how 
long it remains in the workgroup queue before it times out and returns to the workgroup queue 
specified in the Workgroup/Attribute section above.  The Threaded Email Options button is disabled if 
conversation identifier (CID) generation has not been selected in Interaction Administrator and an 
Interaction Tracker license has not been enabled. 

Related Topics 

• Advanced Workgroup Properties Dialog (Email) 

• Threaded Email Options Dialog (Email) 

Configure a Selection Node 
A Selection action branches on condition after evaluating one or more expression cases. This action is 
similar to a Logical Transfer, but is easier to set up when multiple expression cases must be evaluated. 
Selection nodes are easier to understand because there are no jumps to other nodes in the tree view. 
The Selection action works like a C++ switch statement, or a Visual Basic Select Case statement, if you 
are familiar with programming concepts. 

For example, a company which offers three levels of technical support (Bronze, Silver, or Gold) could 
store an interaction's support level in an attribute, and later use a Selection node to examine the 
value of that attribute to take different actions. 

 

The figure at left shows Expression Case nodes below the  Selection 
action and displays child operations to perform for each possible 
case. In this example: 

Default Case:  If the value of the attribute is not Bronze, Silver, or 
Gold, the Default Case expression case is selected, which in this 
example transfers the interaction to a Main Menu. 

Bronze:  An expression case was created to transfer Bronze 
interactions to a FAQ menu. 

Silver:  An expression case was created to direct the system to send 
Silver interactions (in this example, calls) a customized greeting 
message on their way to the Support queue. 

Gold:  An expression case was created to direct the system to 
transfer Gold interactions (in this example, calls) to an Agent's 
queue after first receiving their own custom greeting. 

Selection actions make it easy to set up multiple branches based upon evaluation of flexible 
expression criteria. 
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Configure a Selection Node 

1. Add a Selection node. In the Name field, type a meaningful name for the selection action. 

2. Click the Digit drop down list and select a number to assign to the selection action. This is the 
key that callers press to select the menu entry.  When you assign a digit, the only available 
digits are those that are not already in use at this level of the tree.  If you do not assign a digit, 
callers cannot invoke the operation directly. 

Note: The Digit drop down list is not available for e-mail interactions, and does not 
appear in E-mail Configuration files. 

3. Place a check mark in any Node Characteristics that apply: 

Checkbox Description 

Active By default, this field contains a check mark, which means the form is 
"on", or "active" and Interaction Attendant will process them.  If you 
un-check a form's Active check box, the name of the form turns gray in 
the tree to indicate that the form is inactive.  Interaction Attendant and 
its handlers will ignore the form and its children.  Leave the box 
unchecked to save a configuration that you are testing.  Inactive forms 
are unavailable to interactions 

Default Action At any given level in the tree structure, one node can be marked as the 
default action.  The operation defined by the default node is performed if 
callers do not press a key within the timeout period specified by that 
menu. The icon for default forms has a green border in the tree 
structure.  Any node below a menu or schedule can be marked as 
the default action, by checking the form's default action check box. 

Note: The Default Action check box is not available for e-mail 
interactions, and does not appear in E-mail Configuration files. 

Enable IVR Reporting This option determines whether or not reporting data will be collected 
when control passes through this node.  Several IVR Reports summarize 
this information.  IVR Reporting is disabled by default.  Place a check 
mark in this box to capture the date, time and duration of time that the 
interaction remained in the node and its children.  This option is hidden 
when Attendant is connected to a server that does not have reporting 
installed.  For more information about this feature, see IVR Reporting 
Option. 

Add entry to the 
Interaction log 

When this option is enabled, information about this node is appended 
to the interaction's Interaction Log when the interaction enters this 
node.  This helps track the path that an interaction took through 
Attendant.  The Interaction Log is maintained for reporting 
purposes.  See View the Interaction Log for details. 

Configure Screen Select this button to configure words or phrases that can be associated 
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Recognition button with menu options. Callers can verbally indicate the options they want 
in the IVR instead of pressing a digit on the phone. You can enter 
multiple words and phrases for each menu item, just as callers may 
phrase the same request in different ways. For example, "transfer 
funds" or "funds transfer". See Add Speech Recognition keywords or phrases to 

Inbound Call Operations. 

4. For Inbound, Outbound, or Operator calls only, set up the expression criteria: 

a. Click Create Expression Criteria to set up the left hand of the expression, or 
what is evaluated.  The Expression Type Wizard opens. You can create an 
expression using the following data types: 

• Data previously entered by the caller 

• Data about the current call 

• The current time 

• Data about a particular workgroup (ACD or Custom) 

• Data from a database 

b. Select a data type. Then click Next or Finish based on the options available for the 
data type selected. You may be prompted to select or enter specific data. For 
example, if you select Data about the current call, you must click Next to specify the 
name of a call attribute (see the following figure). Conversely, if you select The 
current time, you can click Finish immediately since no additional information must 
be supplied. 

 
The Call Data dialog opens when you select Data about the current call. 

Note: The resulting Expression Criteria will appear as read-only text. Note that 
the Selection node is in error until valid expression criteria is defined. 
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5. The next step is to add expression cases.  For instructions, see Configure an 

Expression Case. 

Related Topics 

• Configure an Expression Case 

Configure an Expression Case 
An Expression Case is a node that contains defined conditional processing for a parent Selection action. 
Before you can define case nodes, you must first Configure a Selection Node. 

In the tree view, Expression Cases appear as nodes underneath the Selection action. This makes it easy 
to see all of the available paths that can be taken. In addition, a Default Case appears below the 
selection node.  If all other expression cases evaluate false, routing will take the path below that case. 
Each case behaves like a multi-action container where actions can be placed underneath, and they are 
processed in top down order like that of an e-mail profile. Whenever a new selection action is added to 
the tree view, a default case is added underneath it as well. 

 

The figure at left shows Expression Case nodes below the  Selection 
action and displays child operations to perform for each possible 
case. In this example: 

Default Case:  If the value of the attribute is not Bronze, Silver, or 
Gold, the Default Case expression case is selected, which in this 
example transfers the interaction to a Main Menu. 

Bronze:  An expression case was created to transfer Bronze 
interactions to a FAQ menu. 

Silver:  An expression case was created to direct the system to send 
Silver interactions (in this example, calls) a customized greeting 
message on their way to the Support queue. 

Gold:  An expression case was created to direct the system to 
transfer Gold interactions (in this example, calls) to an Agent's 
queue after first receiving their own custom greeting. 

Configure an Expression Case 

1. Set up a Selection node. For instructions, see Configure a Selection Node. 
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2. Select the newly created selection node and under Expression Cases click Add. The Case Edit 
dialog opens. 

       

3. Set up the Expression Case: 

• To set up an expression case for Inbound, Outbound, or Operator Configurations: 

o In the Name field, type a meaningful name for the expression case and then 
click Edit Expression. The Call Properties dialog opens. 

 
o Click the The value of attribute '[attribute name]' drop down list and select one 

of the following operators: 

a. Greater than 

b. Greater than or equal to 

c. Equal to 

d. Less than or equal to 

e. Less than 

f. Before (applies to data/time criteria only) 
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g. After (applies to data/time criteria only) 

o In the field below the The value of attribute '[attribute name]' drop down list, 
enter a value against which to compare the expression criteria (in the example 
above: Bronze, Silver, or Gold). Click Finish. 

• To set up an expression case for E-mail Configurations: 

o In the Name field, type a meaningful name for the expression case and then 
click Edit Expression. The Email Conditions dialog opens. 

 
o In the Select condition(s) area, select one or more criteria to apply to the 

expression. 

o In the Edit the rule description (Click an underlined value) area, click the 
hyperlink(s) associated with each rule to specify how the e-mail is evaluated 
upon arrival. 

Note: The next dialog box to appear will differ, depending on the criteria you 
select. For example, if you select the marked with importance condition 
check box, "and marked with specific importance" appears in the Edit the 
rule description area, and the word "specific" contains a hyperlink.  When 
you click the specific hyperlink, the Importance Level dialog opens, and you 
can specify the degree of importance to place on the e-mail. 
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o Configure each rule description and then click OK to close 
the Email Conditions dialog. 

4. Click OK to close the Case Edit dialog. 

5. To define additional cases, click the Selection node, and then click Add. 
You can only create case nodes by clicking Add on the selection node form 
view. Interaction Attendant does not contain a  toolbar or menu item for 
adding case nodes. 

6. Select an expression case and use the toolbar or Insert menu to add an 
operation node that determines what action each branch should take if an 
interaction meets the case criteria. Repeat this procedure for each 
expression case.  In the following example, Play Audio, Menu Transfer, and 
Agent Transfer nodes were added. 
      

 
7. Place a check mark in any Node Characteristics that apply: 

Checkbox Description 

Active By default, this field contains a check mark, which means the 
form is "on", or "active" and Interaction Attendant will 
process them.  If you un-check a form's Active check box, the 
name of the form turns gray in the tree to indicate that the 
form is inactive.  Interaction Attendant and its handlers will 
ignore the form and its children.  Leave the box unchecked to 
save a configuration that you are testing.  Inactive forms are 
unavailable to interactions 

Default Action At any given level in the tree structure, one node can be 
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marked as the default action.  The operation defined by the 
default node is performed if callers do not press a key within the 
timeout period specified by that menu. The icon for default 
forms has a green border in the tree structure.  Any node 
below a menu or schedule can be marked as the default 
action, by checking the form's default action check box. 

Note: The Default Action check box is not available 
for e-mail interactions, and does not appear in E-
mail Configuration files. 

Enable IVR 
Reporting 

This option determines whether or not reporting data will 
be collected when control passes through this 
node.  Several IVR Reports summarize this information.  IVR 
Reporting is disabled by default.  Place a check mark in this 
box to capture the date, time and duration of time that the 
interaction remained in the node and its children.  This 
option is hidden when Attendant is connected to a server 
that does not have reporting installed.  For more 
information about this feature, see IVR Reporting Option. 

Add entry to the 
Interaction log 

When this option is enabled, information about this node is 
appended to the interaction's Interaction Log when the 
interaction enters this node.  This helps track the path that 
an interaction took through Attendant.  The Interaction Log 
is maintained for reporting purposes.  See View the 
Interaction Log for details. 

Configure 
Screen 
Recognition 
button 

Select this button to configure words or phrases that can be 
associated with menu options. Callers can verbally indicate 
the options they want in the IVR instead of pressing a digit 
on the phone. You can enter multiple words and phrases for 
each menu item, just as callers may phrase the same 
request in different ways. For example, "transfer funds" or 
"funds transfer". See Working with Speech Recognition for 
details. 

Related Topics 

• Configure a Selection Node 

Dialogs 

Dialogs 
This section explains dialogs that you may encounter while working in Attendant. 

• Profiles 

• Schedules 

• Operations 
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Advanced Workgroup Properties Dialog (Calls) 
This dialog appears when the Advanced Workgroup Settings button on a Group 
Transfer node is pressed. It sets interaction priority, needed skills, the length of 
time the interaction should remain in the queue before timing out, and processing 
to perform when the interaction times out. 

Properties tab 

The Properties tab allows you to assign a priority to the interaction (0= lowest, 
1000 = highest) by either setting a static value or by using the value contained in 
the ‘Eic_AttDynamicWorkgroupPriority’ interaction attribute.   

You can also request that agents who handle the interaction have particular skills, 
and you can further narrow the eligible agents by routing interactions to agents 
who have the skill set as defined in the interaction attribute 
‘Eic_AttDynamicWorkgroupSkills’.  Simply check the name of the required skill(s) 
that appear in the list. 

 

Set the interaction's priority to… 

Assigns the priority value of the interaction to any integer between 0 and 1000. 

Set the interaction's priority to the value specified by attribute… 

Assigns the priority value for the interaction to the value specified in the 
interaction attribute ‘EIC_AttDynamicWorkgroupPriority’. 
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The agent handling this interaction should have the following skill(s) 

Displays a list of skills required for the agent who receives this call.  Select the 
appropriate skill check box, or select the Skills specified by the interaction attribute 
“Eic_AttDynamicWorkgroupSkills’ check box to route interactions to agents who 
are assigned to this interaction attribute. 

Timeout tab 

The settings on this tab determine the lifetime of interactions in the queue, and 
action that occurs on timeout if the interaction is not configured to stay in the 
queue until it is answered. 

  

Timeout Style frame 

These settings determine whether the interaction stays in the queue until it is 
answered, or is transferred out after a specified timeout period. 

Stay in this queue until the call is answered 

Select this option to keep the interaction in the queue until it is answered. 

Transfer the call after a specific number of seconds 

This option sets a maximum length of time in seconds that the interaction can 
remain in this queue before it is transferred out.  You can specify any duration 
between 1 and 7200 seconds (two hours).  
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Action on Timeout frame 

You have four flow-of-control options when calls time out: 

Go back to the previous menu 

Returns flow of control to the previous menu. 

Disconnect 

Hangs up the interaction when it times out. 

Transfer to Operator Processing 

Transfers the interaction for evaluation by operator profiles defined for this server. 

Jump to a custom location 

Transfers control to any profile, schedule, menu, or operation defined for the 
current server. 

Related Topics 

• Email - Transfer to a Workgroup 

Advanced Workgroup Properties Dialog (Email) 
This dialog appears when the Advanced Workgroup Settings button is pressed on 
the Transfer to a Workgroup node for an email interaction.  This dialog allows the 
designer to set priority within the queue, needed agent skills, the length of time 
that the interaction should remain in the queue before timing out, and processing 
to perform after a time out. 

Properties tab 

The Properties tab allows you to assign a priority to the interaction (0= lowest, 
1000 = highest) by either setting a static value or by using the value contained in 
the ‘Eic_AttDynamicWorkgroupPriority’ interaction attribute.   

You can also request that agents who handle the interaction have particular skills, 
and you can further narrow the eligible agents by routing interactions to agents 
who have the skill set as defined in the interaction attribute 
‘Eic_AttDynamicWorkgroupSkills’.  Simply check the name of the required skill(s) 
that appear in the list. 
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Set the interaction's priority to… 

Assigns the priority value of the interaction to any integer between 0 and 1000. 

Set the interaction's priority to the value specified by attribute… 

Assigns the priority value for the interaction to the value specified in the 
interaction attribute ‘EIC_AttDynamicWorkgroupPriority’. 

The agent handling this interaction should have the following skill(s) 

Displays a list of skills required for the agent who receives this call.  Select the 
appropriate skill check box, or select the Skills specified by the interaction attribute 
“Eic_AttDynamicWorkgroupSkills’ check box to route interactions to agents who 
are assigned to this interaction attribute. 

Timeout tab 

The settings on this tab determine the lifetime of interactions in the queue, and 
action that occurs on timeout if the interaction is not configured to stay in the 
queue until it is answered. 
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Timeout Style frame 

These settings determine whether the interaction stays in the queue until it is 
answered, or is transferred out after a specified timeout period. 

Stay in this queue until the e-mail is answered 

Select this option to keep the interaction in the queue until it is answered. 

Transfer the e-mail after a specific number of seconds 

This option sets a maximum length of time in seconds that the interaction can 
remain in this queue before it is transferred out.  You can specify any duration 
between 1 and 7200 seconds (two hours).  

Action on Timeout frame 

You have the following flow-of-control options when email messages time out: 

Go back to the previous menu 

Returns flow of control to the previous menu. 

Disconnect 

Hangs up the interaction when it times out. 
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Jump to a custom location 

Transfers control to any profile, schedule, menu, or operation defined for the 
current server. 

Related Topics 

• Email - Transfer to a Workgroup 

Attendant In Use Dialog 

 
This dialog appears when another person is editing the configuration of the server 
you are connected to.   When you press OK to dismiss the dialog, you can use 
Attendant to view and modify the configuration, but it will not allow you to publish 
changes to the server.  

To save your edits, you must backup export the configuration to a disk file, and 
import it later when no one else is editing.  Since importing a configuration will 
overwrite all changes that the other person is making, a gentler and kinder 
approach might be to contact the person who is editing the configuration to find 
out when they will be done. 

In rare situations it may be desirable to overwrite this lock.  For example, a 
power outage might have left a lock in place.  If you set your PC clock ahead 
24 hours and restart Attendant, it will display the Stale Lock Dialog, which 
provides the option to overwrite the lock.  

Server 

The name of the server whose configuration is locked. 

User 
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The login ID of the person who is currently editing the configuration. 

Station 

The station name or telephone number where the user is working from. 

OK button 

Closes the dialog. Thereafter you may view, edit, export, but not publish 
configuration data for the server. 

Related Topics 

• Connect to a Server 

• Manage Configuration Files 

Audio File Details Dialog 
The Audio File Details dialog displays the language, playback duration, and 
encoding format of wave audio files for a prompt.  This dialog appears when the 
Details button is pressed from a set of embedded audio controls. 

Prompt Format 
 
Customers who use Interaction Attendant may choose to have their 
prompts recorded by a third party and need to know our native prompt 
format, which is: CCITT u-law, 8kHz, 8 bit, Mono for best results. 

 
The Audio File Details dialog. 

File Name 

The name of the prompt file that selected by the user. 

Language 

This column lists languages that the prompt was (or could be) recorded in. 

Length 

The duration of the prompt in seconds. 
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Format 

The encoding format of the wave audio file. 

OK button 

Closes the Audio File Details dialog. 

Related Topics 

• Manage Voice Prompts 

• Using Embedded Audio Controls 

Audio Prompt Name Dialog 

 
Attendant displays the Audio Prompt Name dialog when Record is pressed to 
create a new voice prompt file.  Use this dialog to enter a descriptive name for 
the new prompt.  It displays a list of wave audio files found in the default 
language directory under the AttendantWaves share on the server.  

If you type or select the name of an existing file, the default language version of 
the file will be replaced by your new recording.  This does not replace alternate 
language versions of the file that might exist. 

OK button 

Establishes the filename that you selected or typed and closes the dialog so that 
recording can begin. 

Cancel button 

Closes the dialog and cancels recording of the prompt. 

Related Topics 

• Manage Voice Prompts 

• Using Embedded Audio Controls 
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Call Processing Style Dialog 
Call profile forms provide a Call Processing Style button.  When pushed, it 
displays the dialog shown below.  It determines whether calls are directed to a 
menu (Auto Attendant Processing) or to a User, Station, Workgroup queue, or 
operator profile (Direct to Queue Processing).  

Auto Attendant Processing is used by default—inbound calls are directed to the 
menu attached to the best matching schedule.  In other words, Call Processing 
Style determines whether calls are directed to: 

• A menu attached to a schedule in this profile.  This is the default call 
processing behavior. 

• A user, station, or workgroup queue. 

• An operator profile. 

 

Default Processing Style frame 
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These options select the call processing style that will be used by 
default.  Inbound calls will be processed using Auto Attendant Processing or 
Direct to Queue Processing.  

Auto Attendant Processing 

Auto Attendant Processing is enabled by default, so that calls are directed to a 
menu. 

Direct to Queue Options 

When this option is selected, the call is transferred to a User queue, Station 
queue, Workgroup queue, Station Group, or to an Operator profile. 

Seconds to wait before switching to Auto-Attendant Processing 

It specifies how long (in seconds) the call alerts in the following queues before 
processing returns to the auto-attendant: 

• User 
• Station 
• Station group. A station group with a sequential setting alerts each station 

sequentially for the number of seconds indicated.   

The call will be processed using a profile that you have set up for Auto-
Attendant processing.  If that profile does not exist, the default profile is used.  

Note: This option does not apply to a workgroup queue. The time 
configured in the workgroup determines the alert time.  

Only perform "direct to queue processing" once per call check box 

If this check box is selected, a call will only follow the direct-to-queue 
processing the first time the call enters the system.  If it winds up back in that 
profile again later, it won't ring the queue.  If the check box is cleared, calls will 
follow the direct-to-queue instructions each time they pass through the 
profile. 

Related Topics 

• Profiles 

Caller Data Entry Error Handling Options Dialog 
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This dialog appears when the Advanced Error Handling button is pressed from 
a Caller Data Entry form.  It defines optional error handling that works in 
addition to the error handling provided by a Schedule form. 

Use this dialog to define the maximum length of time that Interaction 
Attendant should wait for caller data entry keystrokes before timing out and 
re-prompting the caller to start over.  It also establishes the maximum number 
of times that the prompt will be repeated before control is passed to the 
Schedule's error handler, or to a profile, schedule, menu, or operation defined 
for the current server.  

Re-prompt the Caller 

Seconds to wait (between digits) before timing out spin control 

This control sets the maximum amount of time that Interaction Attendant will 
wait between digit presses. There is an initial timeout of 20 seconds if no digits 
are pressed. 

File to play to re-prompt the caller (embedded audio controls) 

These controls manage the voice prompt played if users are re-prompted to 
enter digits.  See Manage Voice Prompts for information about voice prompts. 

Number of times to re-prompt the caller spin control 

This spin control determines the number of times that the prompt will be 
repeated before control is passed to Error Handling. If this value is set to zero, 
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Attendant does not re-prompt, so it is good practice to set this value to 1 or 
higher. 

Error Handling 

Error Handling options execute when a timeout occurs after the user has been 
re-prompted the maximum number of times. 

Use the default error handler for this schedule 

Passes control to error handling provided by the Schedule form that this caller 
data entry node is attached to. 

Jump to a custom location 

Passes control to the any profile, schedule, menu, or operation that is defined 
for the current server.  

Column Information Dialog 
This dialog defines the data to insert or update in a database.  You must specify the column (field) name 
to update, and the data that it will contain. 
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Column Name field 

Enter the exact name of the field whose data will be inserted or updated in the database.  If you don't 
know the field names that defined in the database, contact your database administrator, or the CIC 
system administrator. Column names are case-sensitive. 

Column data frame 

This frame contains options that define the data that will be inserted or updated in the database. 

This string value field 

Select this option to assign alphanumeric text to the column. 

This numeric value field 
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Select this option to assign numeric digits to the column. Do not enter alphabetic characters, such as 
commas or dashes, in this field. 

This boolean value 

Select this option to assign a Boolean (True or False) value to the column. 

This call attribute 

Assigns the call attribute that you select to the database column.   The choices are: 

• ANI—the caller's telephone number. 

• Caller ID—the caller's name. 

• DNIS—the telephone number that was dialed. 

• Interaction ID Key—a unique ID number that identifies a call.  This key is always unique, while 
Call ID number may not be. 

• Line Name—the CIC line name that the call came in on. 

Data retrieved by the DB query at node 

This option allows you to select any DB Query operation that is defined for the current server in a combo 
box.  The results of that query will be assigned to the field.  The combo box is empty unless the server 
configuration contains at least one DB Query node. 

The value entered by the user at 

This option assigns the value entered by the caller to the column.  The list box is empty unless the server 
configuration contains at least one Caller Data Entry node. 

The current date 

Assigns the current date, based upon the CIC server clock, to the column in (YYYY-MM-DD format). 

This date 

Assigns the date you select (using a popup calendar control) to the column. 

 

Current date and time 
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Assigns the current date and time to the column, based upon the CIC server clock, in ISO timestamp 
format: 

YYYY-MM-DD HH:MM:SS 

This date and time 

Assign the date and time of day that you select using spin controls. 

Ok button 

Saves the selections that you have made and closes the dialog. 

Cancel button 

Closes the dialog without saving selections. 

Related Topics 

• Database Operations 

• Database Insert 

• Database Update 

DB Record Selection Dialog 
Several database operations provide a Record Selection button that opens the Database Record 
Selection dialog shown below.  This dialog constructs the WHERE clause of a SQL query.  To use 
Interaction Attendant, no knowledge of SQL is required.  However, you do need to understand the 
layout of your database, so that you can use this dialog to define criteria that Attendant will use to 
select database records. 
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Column Name field 

Enter the exact name of the field that you wish to base the query on. If you don't know the field names 
that defined in the database, contact your database administrator, or the CIC system administrator. 
Column names are case sensitive. 

Contains data which is combo box 

This combo box allows you to select the comparison operator that will be used to compare Column 
name to some value that you select later.  The comparison operations are: 
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• greater than 
greater than or equal to 
equal to 
not equal to 
less than or equal to 
less than 

• contains 

• starts with 

• ends with 

The last three logical operators deserve special mention—"contains", "starts with", and "ends with" are 
new in Attendant 2.4.  They provide the functionality of SQL's "LIKE" operator, but without requiring any 
knowledge of SQL. 

The value radio buttons allow you to compare the field identified by Column name to different types of 
values: 

This string value 

Compares the value specified in Column Name to any string value that you enter in this field. Column 
names are case-sensitive. 

This numeric value 

Compares the value specified in Column Name to any number that you enter in this field. 

This boolean value 

Compares the value specified in Column Name to the Boolean value (True or False) that you select from 
this combo box. 

This call attribute 

Compares the value specified in Column Name to the call attribute that you select from this combo box, 
or enter manually.  The default attributes are: ANI, Caller ID, DNIS, Interaction ID Key, and Line Name. 
You can type the name of any custom attribute and use its value for database record selection. For more 
information about attributes, refer to the Interaction Attributes Technical Reference. You'll find that in 
the System APIs section of the master library on your CIC server. 

Data retrieved by the DB query at node 

This option allows you to compare the value specified by Column Name to information returned by a 
query from another node.  The combo box is empty unless the server configuration contains at least one 
Database query form. 

The value entered by the user at 

This option compares the column identified by Column Name to a string of data collected by a caller 
data entry operation.  Be careful using this option.  It can potentially allow users to delete records based 
upon a wide range of selection criteria.  
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The current date 

Compares the value specified in Column Name to the current date, using YYYY-MM-DD format. 

This date 

Compares the value specified in Column Name to the date you select in a popup calendar control. 

 

Current date and time 

Compares the value specified in Column Name to the current date and time. 

This date and time 

Compares the value specified in Column Name to the date and time you select in using spin controls.  

Ok button 

The OK button applies the selections that you have made to build a query, and closes the dialog. 

Cancel button 

Press this button to close the dialog without building a new query. 

Related Topics 

• Database Operations 

Default Error Handler Dialog (Calls) 
This dialog appears when the Schedule Error Handling button is pressed from a Call 
ScheduleXID_SCHEDULES node.  It sets up error handling to trap errors that occur when menus are 
processed.  Specifically, it defines error processing that occurs: 

• When errors are detected during the execution of a menu operation. 

• When a greeting message on a schedule form has been played the maximum number of times 
without a valid response from the user. 

• When the user presses a key that is invalid for the menu.  For example, if the user is expected to 
press keys 1, 2, or 3, and the user presses 4, Attendant ignores the invalid digit and continues to 
play menu audio.  If the desired behavior for a menu is to have an error message played for 
invalid key presses, an audio node can be set up for all unused digits which can play the error 
message and then return the caller to the menu. 
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• The error handler can optionally play a message, before disconnecting or transferring the call to 
a queue or menu. 

 

Audio File to play if an error occurs frame 

These embedded audio controls manage the message that plays when an error occurs.  See manage 
voice prompts to learn how to use these controls. 

Action frame 

Disconnect the call 

Disconnects the call. 

Transfer the call to a queue 

Enables options in the Queue Transfer frame, to allow the call to be transferred to the User Queue, 
Station Queue, Workgroup Queue, or Operator Profile that you select. 
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Transfer the call to a menu 

Transfers the call to the profile, schedule, or menu that you select. 

Queue Transfer Frame 

See Transfer the call to a queue above. 

Pushbutton Options 

OK button 

Closes the dialog and puts your settings into effect. 

Cancel button 

Closes the dialog without modifying existing error handling settings. 

Related Topics 

• Default Error Handler Dialog (Emails) 

• Schedules 

Default Error Handler Dialog (Emails) 
This dialog appears when the Schedule Error Handling button is pressed from an Email 
ScheduleXID_SCHEDULES node.  It sets up error handling to trap errors that occur when menus are 
processed.  Specifically, it defines error processing that occurs: 

• When errors are detected during the execution of a menu operation. 

• When a greeting message on a schedule form has been played the maximum number of times 
without a valid response from the user. 

• When the user presses a key that is invalid for the menu.  For example, if the user is expected to 
press keys 1, 2, or 3, and the user presses 4, Attendant ignores the invalid digit and continues to 
play menu audio.  If the desired behavior for a menu is to have an error message played for 
invalid key presses, an audio node can be set up for all unused digits which can play the error 
message and then return the caller to the menu. 

• You can set up this error handler to terminate the interaction, or transfer the Email message to 
a menu, user queue, or workgroup queue.   
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Action frame 

Disconnect the e-mail 

Discards the Email and terminates the interaction. 

Transfer the e-mail to a queue 

When this option is selected, drop lists in the Queue Transfer frame are enabled, so that you can 
transfer the Email message to the user- or workgroup queue of your choice. 

Transfer the e-mail to a menu 

Enables a drop list that allows you to select the menu that will receive the transferred Email. 

Pushbuttons 

OK button 

Closes the dialog and puts your settings into effect. 

Cancel button 

Closes the dialog without modifying existing error handling settings. 

Related Topics 

• Default Error Handler Dialog (Calls) 

• Custom Email Schedule 

• Schedules 
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Email Formatting Help dialog 
This dialog appears when the Formatting Help button is pressed on a Custom Email Profile form.  It 
displays tips for entering email addresses and for using wildcards to filter a profile based upon "To", "Cc" 
and "From" fields in an email message.  When you are finished, press OK to dismiss the dialog. 

 
Related Topics 

• Custom Email Profile 

• Profiles 

Export Wizard 
This wizard appears when an Export or Package command is issued.  It saves open call flow 
configurations as Attendant configuration (*.att) files, or the selected portion of the open call flow as an 
Attendant Package file (*.atp).  The wizard prompts you to select the amount of server-specific 
information to include in the export file.  This determines whether the file can be used as a server-
specific backup, portable "full" configuration, or as an application template.  
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1. The first step is to choose the type of export to perform.  Select the type of export to 

perform.  Then press Next to proceed. 
 
Backup 
 
This option appears when a configuration is exported, but not when some portion of a call flow 
is packaged. Backup creates a server-specific configuration file that can be imported only by the 
server from which it was exported.  This type of export saves server name, username, and 
password.  You can backup more than one server at a time.   
 
Full Configuration 
 
For Exported Configurations: A full backup exports an exact copy of one server's configuration 
that can be loaded onto any other server.  This saves the entire server configuration except for 
the server name and password.  This makes it possible to move a configuration from a test 
server to a production server.  The test server must be identical to the production server in 
terms of line names, workgroup names—everything except server name and password. 
 
When the file is imported, Attendant prompts for a server to connect to, since the file does not 
contain any information about the origin of the data.  Attendant analyzes the configuration and 
flags nodes that are in error (due to missing prompt files, differences in workgroup settings, 
etc.).  For example, if a wave file was recorded on the test server and does not exist on the 
production server, Attendant would flag that node so that you can recreate the prompt on the 
production server. 
 
For Packages: Creates a package file that contains an exact copy of the selected nodes' 
configuration. This package option is useful for moving part of a call flow from a test 
environment to a production server. 
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Configuration Template 
 
For Exported Configurations: exports a generic configuration that can be loaded onto any 
server.  This saves the general Attendant layout, but does not save server-specific information, 
such as workgroup names, user names, or audio files.  The resulting file can be loaded onto a 
server and customized to match the destination server.   This option is geared for partners and 
administrators who manage multiple sites.  It exports a general configuration that does not 
require servers to be identically configured.  
 
For example, a workgroup might be named Support on one system, and Customer Support on 
another.  When the template is imported, Attendant recreates the call flow tree exactly, but any 
piece of information that could be server-specific (user names, workgroup names, audio files, 
skills, etc.) is left blank. Incomplete nodes are flagged as errors, so that you can customize these 
nodes to match the destination server.  Configuration templates allow developers to build 
custom solutions for customers, or to deploy an IVR interaction to many servers in an 
organization. 
 
For Packages: creates a package file that contains a generic copy of the selected nodes' 
configuration. The package will contain the general Attendant layout of the selected nodes, but 
will not contain any server specific information such as workgroup or user names, or audio files. 
This option can be used to create a template call flow that can be loaded onto a server and then 
customized. 

2. If you selected Backup, you can optionally back up more than one server at a time.  Attendant 
prompts you to select servers to back up.  It lists the names of connected servers, and the call 
flow type that is open for editing.  Select server call flows to back up, and then press Next to 
proceed. 
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If you selected Full Configuration or Configuration Template back in step 1, Attendant prompts 
you to select a single call flow configuration.  At this time, inbound, outbound, and operator call 
flows must be backed up separately for those export types.  Select an item.  Then press Next to 
proceed. 
 

 

3. The last step is to set the destination path and filename of the export file.  Select the destination 
path and type a meaningful file name.  Attendant adds .att to the filename, to identify it as an 
Attendant configuration file. 

 
4. Press Finish.  Attendant creates the export file for you, replacing existing files with the same 

name, if any exist.  This file is in binary format and should not be edited manually. 

Related Topics 
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• Export a Configuration File 

• Manage Configuration Files 

Email Rules Wizard 

Email Rules Wizard 
The Rules Wizard constructs a rule that allows an Email Transfer node to direct flow of control between 
two possible destinations, after examining the contents of an email message. 

An email rule is a logical expression based upon the address, subject, or body text of an email message. 
This expression returns a Boolean (True or False) result.  If the rule evaluates as True, then the Logical 
Transfer node will pass control to the "True" transfer location; if the rule is False, then the flow will jump 
to the alternate transfer location specified in the Email Transfer node. 

To construct a rule: 

1. Check a condition in the Select Conditions list.  You can Ctrl-click to select multiple conditions. 
See Condition Types for information about these choices. 

 
2. Next, click an underlined value in the Edit the rule description list. 

 
3. Use the property editor that appears to set values for the rule to evaluate. Property editors are 

available for search words and phrases, for setting message priority (Importance), for 
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distribution lists, and attributes. 

 

Email Condition Types 

The conditions that a rule can examine after the message arrives are listed below. 

From people 

Compares email addresses in the From and CC fields to addresses you specify using the Specify Search 
Words or Phrases dialog.  A match is found when any email addresses match your search criteria. 

With any of the specific words in the subject 

Compares specific words in the Subject field to words or phrases you specify using the Specify Search 
Words or Phrases dialog.  A match is found when any words in the Subject field match your search 
criteria. 

With all of the specific words in the subject 

Compares specific words in the Subject field to words or phrases you specify using the Specify Search 
Words or Phrases dialog.  A match is found when all words in the Subject field match your search 
criteria. 

Marked with importance 

Compares the email's Importance setting (high, low, or normal) to the level you select using the 
Importance Level dialog.   

Sent to any of the people or distribution lists 

Compares contents of the From and CC fields in a message to addresses or distribution lists you specify 
using the Specify Search Words or Phrases dialog.  A match is found when any people or distribution lists 
match your search criteria. 

Sent to all  of the people and distribution lists 
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Compares contents of the From and CC fields in a message to addresses or distribution lists you specify 
using the Specify Search Words or Phrases dialog.  A match is found when all people or distribution lists 
match your search criteria. 

With any of the specific words in the body 

Compares the body text of an email message to words or phrases you specify using the Specify Search 
Words or Phrases dialog.  A match is found when any search criteria match words in the message body. 

With all of the specific words in the body 

Compares the body text of an email message to words or phrases you specify using the Specify Search 
Words or Phrases dialog.  A match is found when all search words and phrases are found in the message 
body. 

With any of the specific words in the subject or body 

Compares the subject and body text of an email message to words or phrases you specify using the 
Specify Search Words or Phrases dialog.  A match is found when any search words and phrases are found 
in the subject or message body. 

With all of the specific words in the subject or body 

Compares the subject and body text of an email message to words or phrases you specify using the 
Specify Search Words or Phrases dialog.  A match is found when all search words and phrases are found 
in the subject or message body. 

With any of the specific words in the recipients address 

Compares email recipient addresses in the message with words or phrases you specify using the Specify 
Search Words or Phrases dialog.  A match is found when any search words and phrases are found in the 
message header. 

With all of the specific words in the recipients address 

Compares email recipient addresses in the message with words or phrases you specify using the Specify 
Search Words or Phrases dialog.  A match is found when all search words and phrases are found in the 
message header. 

Where sender is in a specified distribution list 

Looks to see if the sender's email address appears in the distribution list(s) you specify using the Specify 
Distribution Lists dialog.  A match is found when the sender's name appears on one or more distribution 
lists. 

Where a specific attribute is set to a specific value 

This option looks to see if a specified custom attribute is attached to the email object. It compares the 
value of that attribute to specific values you specify. For example, you might use the Email – Set 
Attribute node to set a custom attribute at various entry points, and later use Email Transfer (with this 
option) to reroute the email interaction based on its origin. 
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To set the name and value of the attribute 

 
1. Click on a specific attribute in the rule description to set the name of the attribute. The name 

you enter in the Specify Attribute input box can be anything you like, so long as it is not the 
name of a reserved system attribute. For information about reserved attributes that are used by 
CIC, refer to the Interaction Attributes Technical Reference, in the PureConnect documentation 
Library. 

 
2. Click a specific value to Specify Search Words or Phrases. The values you provide will be 

compared to the value of this attribute in incoming email messages.  

Related Topics 

• Email Transfer 

Email Address Selection dialog 

 
This dialog searches the email server to look up and validate email addresses. To use this dialog: 
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1. Type a portion of the email address in the Enter Search String field. Then press Search. 

2. Ctrl+Click to select names from the list of results. 

3. Press the Add button. 

4. Press OK to return email address(es) to the calling dialog. 

Related Topics 

• Build Email Reply 

Expression Type Wizard 

Expression Type Wizard 
The Expression Type wizard is opened from the property sheet of a call's Logical Transfer node by 
selecting the Create Logical Expression button.  The wizard builds an expression by asking questions 
based upon the data type that you select.  

 
You can create an expression using: 

• Data previously entered by the caller 

• Data about the current call 

• The current time 

• Data about a particular workgroup (ACD or Custom) 

• Data from a database 

These options are explained in subsequent topics.  When the wizard ends, the result of your expression 
is displayed in the Expression to Evaluate frame of the Logical Transfer node.  

Related Topics 
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• Logical Transfer (Calls) 

Data previously entered by the caller 
Follow these steps to create a logical expression based upon Data previously entered by the caller: 

1. If you have not done so already, open the Expression Type wizard by pressing the Create Logical 
Expression button on a Logical Transfer node. 

 
2. Select Data previously entered by the caller.  Press Next. 
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3. Select the Caller Data Entry node that holds the data you wish to analyze.  Press Next. 

 
4. Next, decide which comparison operator should be used to compare the caller data entry result 

to a value of some sort.  Select one of the following: 

• greater than 

• greater than or equal to 

• equal to 

• not equal to 

• less than or equal to 

• less than 

The next step is to define what the caller-entered data is compared to.  You can enter a string, 
number, time, or Boolean value, or you can compare the digits entered by the caller to a 
database query result, or to data entered in another Caller Data Entry node.  
 
For example, you might define Caller Data Entry nodes to prompt the caller for user ID and PIN 
information, and then use a DB Query to look up the PIN number from a database.  Using this 
information, Logical Transfer can branch based upon whether the PIN entered by the caller 
matches the PIN stored in the file.  
 
Type a value, select a DB Query node, or select a Caller Data Entry node.  Use HH:MM:SS to 
specify a time value, and True or False to specify a Boolean value. 
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5. Press Finish.  When the wizard ends, the result of your expression is displayed in the Expression 
to Evaluate frame, back on the Logical Transfer form.  

 
Related Topics 

• Expression Type Wizard 

• Logical Transfer 

Data about the current call 
Follow these steps to create a logical expression based upon data about the current call: 

1. If you have not done so already, open the Expression Type wizard by pressing the Create Logical 
Expression button on a Logical Transfer node. 
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2. Select Data about the current call.  Press Next. 

 
3. The next step is to identify the call information to analyze.  You can examine call routing 

attributes such as ANI, DNIS, or trunk line, or a call attribute.  Select information to analyze, and 
then press Next.  

4. The dialog that appears next depends upon the type of data you chose to analyze: 

Note: You can create comparison operators for call routing attributes such as ANI, DNIS, 
trunk line, or call attributes, and compare against a value that is either a string value or a 
numeric value. 

The call's ANI info 

When you select this option, you are prompted to choose a comparison operator, a 
value, and a string or numeric data type. The value is the caller's telephone number 
entered as a string as it exists in the interaction attribute ‘Eic_LocalTn’ (set when the call 
first arrives in the system) and is typically a full SIP address, or entered as a number 
without dashes in standard numeric telephone number format. 
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The call's DNIS info 
 
When you select this option, you are prompted to choose a comparison operator,  a 
value, and a string or numeric data type. The value is the telephone number the caller 
dialed entered as a full SIP address, or entered as a number without dashes in standard 
numeric telephone number format. 
 

 
 
The call's trunk line 
 
When you select this option, you are prompted to choose a comparison operator, and the 
trunk line that the caller is on.  
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A specific call attribute 
 
When you select this option, you are prompted to enter the name of a call object 
attribute.  Press Next.  Then choose a comparison operator, enter the value of the named 
call attribute, and select a string or numeric data type.  
 

 
 
A call attribute is a piece of information about an object that travels with it throughout 
the Customer Interaction Center.   For example, one standard attribute of a call object is 
the telephone number of the person who placed the call.  A call object can have as many 
attributes as are needed.  Attributes stay with a call until it is disconnected.  
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The CIC supports application programming interfaces (API's) that provide access to call 
object attributes.  Dynamic Data Exchange (DDE) is commonly used to accomplish this, as 
is the Interaction Client Win32 COM API.  
 
Attributes typically store information that is passed to a database or a third-party 
application.  For example, CIC can be set up to "pop" a database application when an 
incoming call arrives at an agent's workstation.  
 
For information about attributes, DDE and other APIs, see the System APIs section of the 
master documentation library on your CIC server.  The Interaction Attributes Technical 
Reference describes attribute names that are reserved by CIC.  

5. Press Finish.  When the wizard ends, the result of your expression is displayed in the 
Expression to Evaluate frame, back on the Logical Transfer form.  

 
Related Topics 

• Set Attribute 

• Expression Type Wizard 

• Logical Transfer 

The current time 
Follow these steps to create a logical expression based upon the current time: 
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1. If you have not done so already, open the Expression Type wizard by pressing the Create 
Logical Expression button on a Logical Transfer node. 

 
2. Select the current time.  Press Next. 

 
3. Select a comparison operator (Before or After) and date and time values.  You must 

select a date or a time, or both. 
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4. Press Finish.  When the wizard ends, the result of your expression is displayed in the 
Expression to Evaluate frame, back on the Logical Transfer form.   

 
Related Topics 

• Expression Type Wizard 

• Logical Transfer 

Data about a particular workgroup (ACD or Custom) 
Follow these steps to create a logical expression based upon data about an ACD or custom 
workgroup: 

1. If you have not done so already, open the Expression Type wizard by pressing the Create 
Logical Expression button on a Logical Transfer node. 
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2. Select Data about a particular ACD or Custom workgroup.  Press Next. 

 
3. Select an ACD or custom workgroup to analyze. 

4. Select a Workgroup property to analyze.  Press Next to proceed.  The dialog that 
appears next differs for each property selection.  You can analyze based upon the 
number of available agents, the number of logged in agents, the number of calls in the 
queue, the average queue length, or the average wait time.  
 
When you press Next, you are prompted to select a comparison operator for the 
selected property, and to define what the property is compared to—which can be either 
a predefined value or a runtime workgroup statistic. 
 
Number of available agents 



Data about a particular workgroup (ACD or Custom) 

368 

 
 
Select a comparison operator, and then define a value or statistic to compare the 
workgroup property to. 
 
Number of logged in agents 

 
 
Select a comparison operator, and then define a value or statistic to compare the 
workgroup property to. 
 
Number of calls in the queue 
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Select a comparison operator, and then define a value or statistic to compare the 
workgroup property to.  
 
Average queue length 
The Average Queue Length is the average number of interactions waiting in the queue. 
The average is dynamically updated to reflect the number of calls currently waiting in a 
queue. This value is not the time in queue or the length of interaction. For example, you 
set this value to 10. Then if the average number of waiting interactions exceeds 10, the 
interaction transfers to the specified destination.   

 
 
Select a comparison operator, and then define a value or statistic to compare the 
workgroup property to.  
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Average wait time 

 
 
Select a comparison operator, and then define a value or statistic to compare the 
workgroup property to.  

5. Press Finish.  When the wizard ends, the result of your expression is displayed in the 
Expression to Evaluate frame, back on the Logical Transfer form.  
 

 
Related Topics 

• Expression Type Wizard 

• Logical Transfer 

Data from a database 
Follow these steps to create a logical expression based upon data retrieved from a database: 
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1. If you have not done so already, open the Expression Type wizard by pressing the Create 
Logical Expression button on a Logical Transfer node. 

 
2. Select Data from a database.  Press Next. 
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3. Identify the database query that retrieves the data to be analyzed. 

 
4. Select a comparison operator, and then define the value, query result, or call-entered 

data that the database query result will be compared to. 

5. Press Finish.  When the wizard ends, the result of your expression is displayed in the 
Expression to Evaluate frame, back on the Logical Transfer form.  

 
Related Topics 

• Expression Type Wizard 

• Logical Transfer 

Fax Listener Options Dialog 
This dialog appears when the Fax Options button is pressed from a schedule node. 
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Fax Listener check box 

When this option is enabled, Interaction Attendant listens for Fax tones, so that Fax handling is 
automatically invoked should a call arrive from a Fax machine.  If a fax tone is detected, the fax 
is received in the Default Mailbox, or in the user or workgroup mailbox that you specify. 

Send the fax to frame 

The Default Mailbox radio button 

Sends incoming Faxes to the default mailbox that was defined for the server using Interaction 
Administrator. 

User's Mailbox radio button 

Sends incoming Faxes to the user mailbox that you select. 

Workgroup's Mailbox radio button 

Sends incoming Faxes to the workgroup mailbox that you select. 

Related Topics 

• Default Inbound Call Schedule 

• Custom Inbound Call Schedule 

Formatting Help Dialog 
This dialog appears when the Formatting Help button is pressed on a call profile form.  It 
displays tips for using wildcards and for entering ranges in fields that filter a profile based upon 
DNIS or ANI values.  When you are finished, press OK to dismiss the dialog. 
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Formatting DNIS/ANI routing for SIP 
 
In a SIP/HMP environment, special care must be taken when formatting wildcards for ANI 
and DNIS profiles. Matches can fail when wildcards  are used, since Wildcard matching 
compares STRINGS and allows for ? to match. 
 
For example, 666666? does not match sip:6666666@domain.com, since the range matching 
looks at 6666666 part of the DNIS and treats it as a number. The Wildcard does not. In 
order to work correctly, the exact string needs to be entered in the DNIS routing: 
 
sip:666????@xxx.x.xx:5060 or sip:666????@domain.com:5060 
 
Range matching always works if you specify an exact telephone number (e.g. 4445555). 

Related Topics 

• Custom Inbound Call Profile 

• Custom Operator Profile 

• Profiles 

Importance Level dialog 
This dialog prompts for a level of importance to match against the Importance setting of an 
Email message.  The importance of an Email can be high, low, or normal. 
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Make a selection from the drop list. Then press OK to return your selection to the Email Rules 
Wizard. If you press Cancel, the dialog is dismissed without returning a value to the wizard. 

Related Topics 

• Email Transfer 

• Email Rules Wizard 

Logon Dialog 
The Logon dialog appears when you connect to a server.  Connecting to a server allows you to 
edit its Attendant profiles.  To put changes into effect, you must publish a configuration.   

 Username 

A valid Username for the CIC server you are connecting to. 

Password 

The corresponding password for the CIC username. 

Server 

The name of the CIC server that you are connecting to. 

OK button 

Submits login information for authentication by the system.  If the login information you enter 
is valid, the server's configuration is loaded into Interaction Attendant for editing, and a node 
for the server appears in the tree structure. 

Cancel button 

Closes the dialog without attempting to connect to a server. 

Related Topics 

• Connect to a server 

Mailbox Selection dialog 
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Mailbox selection queries CIC's configured Email server to return a list of matching mailboxes.  It allows 
the user to select a mailbox. When OK is pressed, the name of the selected mailbox is returned to the 
calling function. 

To locate a mailbox 

1. Type all or part of a mailbox name in the Enter a search string field. 

2. Press the Search button. 

3. Select a mailbox from the list of matching results. 

4. Press OK. The name of the selected mailbox will be returned to the calling dialog. 

Visual Controls 

Enter a search string field 

This field prompts for all or part of a mailbox name. 

Search button 

Queries the server to return a list of matching mailboxes. 

OK button 

Returns the name of the selected mailbox and closes the dialog. 

Cancel button 

Closes the dialog without returning a mailbox name. 

Related Topics 
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• Email - Disconnect 

Prompt Management Dialog 

 
The Prompt Management dialog contains the usual embedded audio controls, but also displays  which 
languages a prompt has been recorded in.  This makes it easy to manage multi-language prompts at a 
high level, without having to open forms. 

This dialog appears when Multi-Language Prompts is selected from the Edit menu.  Use the Prompt 
Management dialog to: 

• Select and play back a prompt in different languages. 

• Record, or re-record a prompt in any language defined in Interaction Administrator.  If you need 
to record in a language that does not appear in Interaction Attendant's list of available 
languages, see configure CIC to support additional languages. 

• Using this dialog, prompts can be recorded in additional languages.  However, the dialog does 
not determine which language is used to play a prompt in a menu.  (The current language 
setting does that.) It merely allows a language to be selected before playing back or recording a 
prompt.  

• Browse for a .wav file. 

• View audio file details. 

• When you select a prompt using the Name list box, the Status list on the left displays a list of 
languages that the prompt has been recorded in.  The "Not recorded in" list on the right 
indicates available languages for which the prompt has not been recorded.  In the example 
above, the prompt has been recorded in English, French, and German, but not Spanish. 

To Select An Existing Prompt 
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Select a prompt from the Name list box.  The list of languages that the prompt has been recorded in 
appears in the Status frame. 

To Play Back an Existing Prompt 

1. Select the name of a prompt from the Name list box.  When you make a selection, the list of 
supported languages that the prompt has been recorded in appears in the Status frame.  The list 
of languages the prompt has not been recorded in appears on the right. 

2. Select the playback language by pressing the down arrow to the right of the Play button.  Select 
an item in the list.  

3. Press the Play button.  

To Record (or Re-record) a Prompt in Another Language 

1. Select a prompt from the Name list box. 

2. Press the down arrow next to the Record button to display a drop-down list of supported 
languages. 

3. Select the language that you want to record in.  Checkboxes in the list (if any) indicate languages 
that the prompt has already been recorded in.  When you make a selection, you are prompted 
to pick up your telephone: 

4. Pick up your telephone, and press OK to proceed.  Follow verbal instructions as needed to 
complete the recording.  

To Record a New Prompt 

1. When you record a new prompt, you do not need to select a language beforehand.  The default 
language (as configured in Interaction Administrator) is associated with new prompts recorded 
in Interaction Attendant. 

2. To get started, press the Record button.  The Audio Prompt Name dialog appears, so that you 
can provide a name for the new prompt.  

3. Enter a name for the prompt.  (The .wav extension will be added if you do not type this 
in.)  Press the OK button to close the Audio Prompt Name dialog.  

4. When you press the OK button, Attendant asks you to pick up your telephone: 

5. Press OK to proceed.  Then follow verbal instructions as needed to complete the recording.  

To Browse for a Prompt File 

You can browse for an existing .wav file.  The file that you select is copied to a directory named 
C:\IC\Resources\InteractionAttendantWaves\LANGUAGE on the CIC server, where LANGUAGE is the 
name of the default language defined in Interaction Administrator.   This directory is shared as 
\AttendantWaves\LANGUAGE. 

1. Press the Browse button. 

2. Select a .wav file using the Open dialog. 



Printed Documentation 

379 

3. Press the Open button.  

Usage 

The Multi-Language Prompts command is invoked by pulling down the Edit menu and selecting Multi-
Language Prompts. 

• An easier way to manage multi-language prompts 

• Manage Voice Prompts 

Results Processing Dialog 
This dialog defines actions to take when DB Query results are returned, and actions to take if the 
query does not return a result.  It also tells the text-to-speech system how to pronounce the results of 
the query—as text, digits, a date, monetary value, etc. 

 

Action When Results Are Returned frame 

This frame controls the processing that occurs when a DB Query returns data—anything other than a 
null result.  It determines whether data is read back to the caller, and assigns the appropriate text-to-
speech pronunciation method for that data type.  You can optionally assign the query result to a call 
attribute. 

Read results to the caller check box 
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This option controls whether or not the query result will be converted to speech and read back to the 
caller. 

As a Text String radio button 

Choose this option to have the query result read back to the caller as a text string. 

As Unique Digits radio button 

If you choose "As Unique Digits", 1234 will be read back as "one two three four". 

As a Numeric Value radio button 

If you choose "As a numeric value", 1234 will be read back as one thousand, two hundred and thirty 
four". 

As a Monetary Value radio button 

If you choose, "As a monetary value", 1234 will be read back as "twelve hundred thirty four dollars and 
zero cents".  1234.50 is read back as "twelve hundred thirty four collars and fifty cents". 

As a Date radio button 

Choose this option to have the query result read back to the caller as a date.  Dates are pronounced 
using the names of months instead of numbers.  (e.g. 8/2000 is read as "August two-thousand".) 

As a Time radio button 

The query result will be read back as a time of day. 

As a boolean Value radio button 

The query result will be read back as "True" or "False". 

Assign the results to a call attribute to use for DDE Operations check box 

Optionally assigns the query result to any call attribute that you specify.  

Only the field specified by Column to Retrieve (in the DB Query form) can be assigned to a call 
attribute.  You cannot assign a row of data to a call attribute. 

An attribute is a piece of information about a call object that travels with it throughout the Customer 
Interaction Center.   For example, one standard attribute of a call is the telephone number of the 
person who placed the call.  A call object can have as many attributes as are needed.  Attributes stay 
with the call until it is disconnected.  

CIC supports application programming interfaces (API's) that provide access to call object 
attributes.  Dynamic Data Exchange (DDE) is commonly used to accomplish this, as is the Interaction 
Client Win32 COM API.  Attributes typically store information that is passed to a database or a third-
party application.  For example, CIC can be set up to "pop" a database application when an incoming 
call arrives at an agent's workstation.  

For information about attributes, DDE and other APIs, see the PureConnect Documentation 
Library.  The Interaction Attributes Technical Reference describes attribute names that are reserved by 
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CIC, including those whose value you should not change.  If you assign data to a standard CIC attribute, 
you could potentially affect the execution of a handler.  

Attribute name  field 

Enter the name of the attribute that will contain the query result.  Every attribute has a name (e.g. 
Account Number) and a value (such as the query result).  Call attribute names can contain spaces and 
special characters.  

Do not start call attribute names with the letters Eic_, unless you intend to assign the result to an 
attribute that is reserved by CIC.  The CIC uses Eic_ prefixes to identify a standard call attributes.  If you 
overwrite a standard attribute, you could accidentally interfere with normal operation of the CIC 
server.  As mentioned earlier, the Interaction Attributes Technical Reference discusses reserved 
attribute names and whether or not they are safe to update. 

Action When No Results Are Returned frame 

This frame controls the processing that occurs if a query does not return any data—a null result may 
not indicate an error condition.  Control can be passed to logic that provides "no record found" 
processing.  Alternately, you can treat null results as "real errors" that require standard error handling. 

 

Treat No Result as an error 

This option passes control to Attendant's built-in error processing if the query does not return data. 

Go back to the previous menu 

This option returns control to the menu that is the parent of this operation.  This sets up a simple loop 
that reruns the parent menu from the top. 

Disconnect 

This option disconnects the call if no query results are returned. 

Jump to a custom location 

This option passes control to any profile, schedule, menu, or operation that is defined for the current 
server. 

Ok button 

Saves the selections that you have made and closes the dialog. 
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Cancel button 

Closes the dialog without saving selections. 

Related Topics 

• Database Operations 

• DB Query 

Same User Lock Dialog 

 
This dialog appears when a second instance of Interaction Attendant connects to a server using your 
ID.  If no one else is running Attendant with your User ID (perhaps you started Attendant twice), you 
can overwrite this lock and continue safely.  

If someone else is using your ID, you should not overwrite the lock.  If you do, Attendant will allow 
both of you to publish changes that could collide logically with one another.  

Note—it's safe to run more than one instance of Interaction Attendant if you connect to different 
CIC servers.  If you connect multiple instances to the same server, Interaction Attendant won't stop 
you from saving a configuration that is open in another session.  This could potentially lose 
changes made in another instance.  To warn you of this situation, Interaction Attendant displays the 
Same User Lock dialog. 

Server 

The name of the server whose configuration is locked. 

User 
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The login ID of the person who is currently editing the configuration. 

Station 

The station name or telephone number where the user is working from. 

Overwrite the lock button 

Removes the lock applied by the other person.  Thereafter you may view, edit, export and publish 
configuration data for the server—as can the other user.  Since that could cause configuration 
conflicts, we recommend that you do not overwrite the lock.  

Do not overwrite button 

Closes the dialog without removing the lock.  Thereafter you may use Attendant to view and modify 
the configuration, but it will not allow you to publish changes to the server.  To save your edits, you 
must backup export the your configuration to a disk file, and import it later when the lock has been 
removed. 

Related Topics 

• Connect to a Server 

• Manage Configuration Files 

Save Changes Dialog 

 
The Save Changes dialog appears if configuration information has changed, when Attendant is closed 
or a server is disconnected.  It provides the opportunity to publish, discard, or export changes to a 
file, or cancel the close/disconnect operation.  

The Save Changes dialog is displayed for each connected server whose loaded configuration 
information has changed. 

Publish Configuration button 

Updates that server's configuration using the information that is currently loaded into Interaction 
Attendant. 

Export to file button 

Saves configuration information in a generic, full, or backup file.  See Manage Configuration Files. 

Do not save changes button 
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Closes the Save Changes dialog, discarding any edits that you have made for the server. 

Cancel button 

Closes the dialog without shutting down Attendant or disconnecting the server. 

Specify Search Words or Phrases to search for dialog 
In the case of the Specify email addresses to search for dialog, the search function searches for 
whole strings in the address field, not substrings. 

This dialog prompts for words or phrases for an Email rule to find in a message. It appears when a 
hyperlink is pressed in the Email Rules Wizard: 

 
Note that the dialog caption varies to prompt for different types of input. However, operation of the 
dialog is the same, regardless of Email condition type. 

Specify words or phrases to search for 

This field prompts for words and phrases to find in an Email message. In the case of the email 
message body, the search function uses substring to match words. 

Add button 

Adds a search word or phrase to the Search list 

Search list 

This field stores all search entries that you have added. 

Remove button 

Removes the item selected in the Search list. 

OK button 

Closes the dialog, and passes the Search list to the Email Rule. 

Cancel button 

Discards user input and closes the dialog 

To specify words or phrases 

1. Type a word, part of a word, or a phrase in the Specify words or phrases to search for field. 
Since the search function uses substring to match words in the message body, you can 
search for a root word and it will find variations of that word. For example, search for 
"cancel" would match on "canceled", "cancelling" or "Cancels". You can also use wildcards 
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for single (?) or multiple characters (*).  For example, to search for similar model numbers 
with one digit and letter difference you can use a question mark such as ATT?1?00. 

2. Press the Add button. 

3. Repeat steps 1 and 2 for define other search words or phrases as needed. To remove 
unwanted entries from the Search List, press the Remove button. 

4. When you are finished, press OK to close the dialog. 

Related Topics 

• Email Rules Wizard 

Specify Distribution Lists dialog 

 
This dialog prompts to select the sender's distribution list for an Email rule to find in a message. It 
appears when a distribution list hyperlink is pressed in the Email Rules Wizard: 

Search by radio buttons 

These buttons indicate whether the search string is a distribution list name, or an Email address. 

Search button 

Queries the Email server to find matching email addresses or distribution lists in the Search Results 
list. 

Search results field 

The results of searching the Email directory are listed here. 

Distribution lists field 
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This field contains items that the user has added to his search criteria. 

Add button 

Adds the item selected in the Search results list to the Distribution Lists field. 

Remove button 

Removes the item selected in the Distribution Lists field, so that it is no longer used as search 
criteria by the Email rule. 

OK button 

Closes the dialog, and passes the contents of Distribution lists to the Email Rule. 

Cancel button 

Discards user input and closes the dialog. 

To specify distribution lists or predefined Email addresses 

1. Use the radio buttons to indicate whether the search string will be a distribution list name, 
or an Email address. 

2. Type all or a portion of the distribution list or Email address in the Search by field. You can 
optionally use wildcards to specify single (?) or multiple characters (*).  For example, to 
retrieve all distribution lists that start with dev, you would type "dev*" with a wildcard. 

3. Press the Search button. 

4. Select items in the Search results list. Then press Add to move them to the list of selected 
items on the right. 

5. Repeat steps 1 through 4 to define other search criterion as needed. To remove unwanted 
entries from the Distribution lists field, press the Remove button. 

6. When you are finished, press OK to close the dialog.  The items you selected will be passed 
to the Email Rules Wizard. 

Servers Dialog 
The Servers dialog appears when Manage Servers is selected from the Edit menu, or when the 
Manage Servers toolbar button ( ) is pressed.  This dialog restricts commands to the connected 
servers that you select.  It also allows you to connect to additional servers.  
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It displays a list of servers that you are connected to, along with the type of call flow configuration 
that is open for editing.  To apply a command to one or more servers, follow these steps: 

1. Select one or more servers in the list.  Shift-click to select contiguous items in the 
list.  Control-click to select discontiguous items.  To connect to a server, you do not need to 
select items from the list. 

2. Press the button that corresponds to the command you wish to perform.  The command is 
applied to those servers that are selected in the list, rather than to all connected servers. 

• Publish saves configuration changes for the selected servers.  

• Export creates a disk file that contains the selected servers' configuration information. 

• Refresh retrieves server configuration information from each selected server.  This tells each 
server to send Interaction Attendant information about its workgroups, schedules, users, 
stations, skills, DB sources, lines, line groups, schedules, languages, and its default 
language.  These data items are defined and administered using Interaction Administrator, 
and may have changed while you were using Interaction Attendant. 

• Connect opens the Interaction Attendant login dialog. 

• Disconnect releases the Notifier connection to the selected servers.  In effect, this "logs off" 
Interaction Attendant from the selected servers. 

3. Interact with dialogs as needed to complete the command. 

4. Press OK to close the dialog. 

Scope of Publish Command 
 
Care must be taken not to publish a configuration unintentionally.  The publish command 
applies to all loaded configurations unless you use the Servers dialog to restrict publishing to 
specific servers.  
 
To publish configurations for all servers displayed in the user interface, select Publish from the 
File menu or press the  (Publish) button on the main toolbar. 
 
To publish configurations for selected servers, pull down the Edit menu and select Manage 
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Servers.  Ctrl-click in the server list to select the names of servers that you with to update.  The 
press the Publish button. 

Related Topics 

• Publish a Configuration 

• Export a Configuration File 

• Refresh Server Data 

• Connect to a Server 

• Disconnect from a server 

Stale Lock Dialog 
The Stale Lock dialog appears when the configuration of a server that you are connecting to has 
been locked for more than 24 hours. This typically indicates that the user did not shut down 
Attendant properly.   Attendant displays information about the lock, and provides the option to 
override it. 

 
Locks grow stale after Attendant is abnormally terminated by a user (due to a machine crash, 
etc.)  When you overwrite a lock, you can edit and save changes to the server configuration. 

Server 

The name of the server whose configuration is locked. 

User 
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The login ID of the person who is currently editing the configuration. 

Station 

The station name or telephone number where the user is working from. 

Overwrite the lock button 

Removes the lock applied by the other person.  Thereafter you may view, edit, export and publish 
configuration data for the server without any restrictions.  When press this button, you are 
prompted to confirm your decision: 

 
Press Yes to remove the lock.  If you press No, you can use Attendant to view and modify the 
configuration, but it will not allow you to publish changes to the server.  To save your edits, you 
must backup export the your configuration to a disk file, and import it later when the lock has 
been removed.  

Do not overwrite button 

Closes the dialog without removing the lock.  Thereafter you may use Attendant to view and 
modify the configuration, but it will not allow you to publish changes to the server.  To save your 
edits, you must backup export the your configuration to a disk file, and import it later when the 
lock has been removed. 

Related Topics 

• Connect to a Server 

• Manage Configuration Files 

Threaded Email Options Dialog (Email) 
This dialog appears when the Threaded Email Options button is pressed on the Transfer to a 
Workgroup node for an email interaction.  This dialog allows the designer to specify that email 
interactions be sent to the first or last workgroup that handled the email interaction. 

Note: This option is only available if conversation identifier (CID) generation is enabled in 
Interaction Administrator and an Interaction Tracker license is enabled.  For more information 
about these features, or if you have questions about your right to use it, see your CIC 
administrator. 
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Attempt the following Threaded Email Transfer 

Select this check box to specify email is transferred based on the settings you choose in this 
dialog. 

Transfer to drop down list 

Click the Transfer to: drop down list and choose to send the email interaction to either the First 
Workgroup or Last Workgroup that worked with the email. 

Timeout (Minutes) drop down list 

Use the up and down arrows to select the number of minutes the interaction stays in the 
selected workgroup queue until it is answered.  After the timeout limit is reached, the system 
will transfer the email message to the workgroup specified on the Transfer to a Workgroup 
node. 

Related Topics 

• Email - Transfer to a Workgroup 

Update Column Dialog 
This dialog identifies which column (field) will be updated by DB Update, and the data that will be 
assigned to the field. 
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Column to update field 

Identifies which field that will be updated in the table.  The remaining options on this dialog define the 
data to place in the field. 

This string value 

Assigns alphanumeric data to the column. 

This numeric value 

Assigns numeric data to the column updated.  

This boolean value 

Assigns a value of True or False to the column updated. 
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This call attribute 

Assigns one of the following call attributes to the column updated: 

• ANI—the caller's telephone number. 

• Caller ID—the caller's name. 

• DNIS—the telephone number that was dialed. 

• Interaction ID Key—a unique ID number that identifies a call.  This key is always unique, while 
Call ID number may not be. 

• Line Name—the CIC line name that the call came in on. 

Data retrieved by the DB query at node 

Allows you to assign the value returned by a DB Query to the column updated.  The combo box is empty 
unless the server configuration contains at least one DB Query. 

The value entered by the user at 

This option assigns a string of data collected by a Caller Data Entry operation to the column updated. 

The current date 

Assigns the current date to the column updated.  The date format is YYYY-MM-DD. 

This date 

Assigns any date that you select using a calendar field to the column updated. 

The current date and time 

Assigns the current date and time to the column in YYYY-MM-DD HH:MM:SS format. 

This time 

Assigns any date and time that you select to the column updated. 

Ok button 

Saves the selections that you have made and closes the dialog. 

Cancel button 

Closes the dialog without saving selections. 

Related Topics 

• Database Operations 

• DB Update 

General Information 
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ANI 

ANI stands for Automatic Number Identification.  ANI is often called Caller ID. All phone calls contain the 
numbers of the dialing phone. Those numbers can be displayed on a screen or used by the receiving 
phone system to tell the call recipient useful information. 

Audio Prompts 

Audio prompts are the messages (with the file extension .wav) that Interaction Attendant plays to 
callers. Examples include the greeting played for callers when the call is picked up, and any instructions 
played to describe menu options. A default set of prompts is installed with Interaction Attendant.  You 
can change these prompts and add your own. You might do this so that all prompts are spoken in the 
same voice. 

Attendant Configuration File 

Attendant Configuration (.att) files contain all of the information that is associated with a server profile, 
including its schedules, and settings affecting operations.  Attendant Configuration files make it quick 
and easy to back up or restore a particular server configuration.  The File | Import File command reads 
in an .att configuration file.  Likewise, the File | Export File command saves an .att configuration file for 
the all connected servers. 

Audio Playback 

Audio playback plays a .wav file to caller. You can use the .wav files that are installed with Interaction 
Attendant, or you can record your own .wav files and store them in a language-specific folders below 
the AttendantWaves share on the CIC server. 

Auto Attendant 

Auto attendant is a shortened name for automatic attendant. An auto attendant is a device that 
automatically answers a call, prompts a caller to make menu choices, and routes a call according to that 
caller's choice. Callers choose options by pressing keys on their telephone. Based on the caller's choice, 
an auto attendant will offer a sub menu, transfer a call to a queue, allow callers to search an employee 
directory, send or receive a fax, or perform many other actions. Interaction Attendant is the tool for 
configuring CIC's auto attendant. 

Auto Attendant Processing 

Auto Attendant Processing is a call processing style that interacts with the caller using menus.  See also: 
Direct to Queue Processing. 

Backup Export 

A export option that saves server-specific information that must be imported by the same server. 

Call Attribute 

A call attribute is a piece of information about an object that travels with it throughout the Customer 
Interaction Center.   For example, one standard attribute of a call object is the telephone number of the 
person who placed the call.  A call object can have as many attributes as are needed.  Attributes stay 
with a call until it is disconnected.  The CIC supports application programming interfaces (API's) that 
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provide access to call object attributes.  Dynamic Data Exchange (DDE) is commonly used to accomplish 
this, as is the Interaction Client Win32 COM API.  Attributes typically store information that is passed to 
a database or a third-party application.  For example, the CIC can be set up to "pop" a database 
application when an incoming call arrives at an agent's workstation.  For more information about 
attributes, DDE and APIs, see the PureConnect Documentation Library.  The Interaction Attributes 
Technical Reference describes attribute names that are reserved by CIC.   If you assign data to a standard 
CIC attribute, you could potentially affect the execution of a handler.  The Interaction Attributes 
Technical Reference identifies attributes whose value you should not change. 

Call Flow Configuration 

A call flow configuration processes inbound calls, outbound calls (those placed by Interaction Dialer), or 
calls to the Operator.  Attendant displays each call flow in its own tree view.  Tabs below the tree view 
allow you to switch to a different call flow configuration.  The call flow and tabs that you see (if any) are 
determined by whether or not you have rights to view or modify a given call flow type, and by command 
line switches that specify which call flows you want to see. 

Call Processing Style 

Call processing styles determine whether Auto Attendant Processing or Direct to Queue Processing are 
used to process an inbound telephone interaction. 

Current Language 

The language used to play back a voice prompt.  The current language is set using profile forms, or by 
allowing callers to select a language from a menu (using Language Selection operations).  Attendant 
plays back voice prompts and performs text-to-speech operations in the appropriate language based 
upon this information. 

Customer Interaction Center (CIC) 

The Customer Interaction Center (CIC) is designed for sophisticated contact centers managing inbound, 
outbound, or blended interactions. CIC provides skills-based routing not only for telephone interactions, 
but faxes, Emails, text chats, Web call-back requests, and voice over IP calls. CIC can support up to 
several hundred agents per site, and offers optional pre and post-call routing across multiple locations. 
And it makes screen popping a breeze, with easy interfaces to products from leading CRM vendors such 
as Siebel, Pivotal, Onyx, Peoplesoft, and many more. 

Default Action 

The operation defined by the default node that is performed if the caller does not press a key within the 
timeout period specified by that menu. The icon for default forms has a green border in the tree 
structure. 

Default Language 

The names of supported languages (e.g., English, French, Spanish, etc.) are defined on each CIC server 
using Interaction Administrator.  Handlers that play voice prompts use these language attributes 
internally.  The default language is used to play system prompts when no other language attribute is 
specified. 
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Default Node 

The form whose default action check box is checked. 

Dial by Name 

Dial by Name allows a caller to enter the first three characters of a Interaction Client user's last 
name.  Dial by Name then searches for the extension and transfers the call to that user. 

Direct to Queue Processing 

Direct to Queue Processing is a call processing style that sends a call to the user queue, station queue, or 
workgroup queue specified in the profile.  Users may be returned to Auto Attendant processing if the 
call is not picked up from a queue in a specified number of seconds.  

Direct to Queue performs special processing for each of the supported queue types.  The call is trapped 
before normal queue processing takes place so that the Attendant handlers can maintain control.  All 
custom prompts, call coverage options, and thin client rules are bypassed while direct to queue 
processing is in effect. 

DNIS 

Dialed Number Identification Service (DNIS) is a feature of digital T-1 and ISDN lines (like 800 and 900 
lines) that provides the number the caller dialed.  DNIS is a system by which CIC can determine what 
number a caller dialed. Knowing that dialed number allows Interaction Attendant to perform unique 
processing on that call, such as playing special messages or offering special menu choices. For example, 
a company has two levels of technical support, silver and gold. Silver members call 555-1111, and Gold 
members call 555-2222. In Interaction Attendant you can create a profile for each number. When callers 
dial 555-2222, they hear the profile for gold support. When callers dial 555-1111, they hear the profile 
for the silver.  The Default Inbound Call Profile is used when no DNIS information accompanies the call, 
or when the DNIS is not recognized. 

Full Export 

A export option that saves all configuration data that is not tied to a server to an Attendant 
configuration file.  This allows an  exact copy of one server's configuration to be loaded on to an 
identically configured server.  It is frequently used to move a configuration from a test server to a 
production server.  The source server must be identical to the destination server in terms of line names, 
workgroup names—everything except server name and password. 

CIC Server 

The Customer Interaction Center (CIC) is a client/server software product that transforms a Windows NT 
server into a comprehensive communications system. The CIC server answers and processes calls. The 
profiles you create in Interaction Attendant are saved to the CIC Server where they are executed when a 
call is picked up. 

Dial Extension 

Allows a caller to dial an Interaction Client user's extension. If a match is found, the call is transferred; if 
not, the caller is returned to the menu from which Dial Extension was called.  See the Dial Extension 
operation. 
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External Transfer 

This operation transfers a call to specified telephone number outside of the CIC. 

Fax Back 

Allows a caller to request a fax and send it to a fax number that the caller specifies. Fax Back 
functionality in Interaction Attendant requires some handler modification. 

Handler 

Handlers are programs that the CIC Server executes to respond to an event, such as an incoming 
call.   Handlers are created using Interaction Designer, the visual programming tool included with 
Customer Interaction Center.  Few users of Interaction Attendant ever need to create or modify 
handlers.  The sophisticated handlers included with Interaction Attendant are sufficient to meet all but 
the most extraordinary needs. However, it is important to understand that handlers work behind the 
scenes to implement the profiles and menus that you create using Interaction Attendant.  

A handler performs an action or actions in response to the occurrence of some event. A handler is 
simply a collection of steps that are organized and linked to form a logical flow of actions and decisions.  

Incoming Call Selection 

Incoming Call Selection is enabled on custom profile forms.  You can filter calls to various schedules 
based upon the line or line group used, the number dialed (DNIS), or the caller ID (ANI).  A server's 
default profile does not support this feature, since the default profile is intended as a catch all.  

Interaction Attendant 

The graphical tool for configuring and maintaining CIC's auto attendant. 

Interaction Designer 

The CIC graphical application development tool for creating, debugging, editing, and managing handlers 
and subroutines. 

Interaction ID Key 

Interaction ID Key is a unique ID number that identifies a call.  This number is always unique, while Call 
ID numbers may not be. 

IVR 

Interactive Voice Response (IVR) allows phone users to use their telephone keypad as a keyboard to 
input values in response to voice prompts played by a computer. 

Line Name 

Every line coming into CIC has an assigned line name. You can view and change these line names in the 
Lines container in Interaction Administrator.   In Interaction Attendant, line names can be assigned to a 
profile form.  Any call that comes in on the named line is processed by that profile. When assigning line 
names to profiles, refer to the Interaction Administrator lines container for a list of line names.  
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Menu 

The group of operations that Interaction Attendant performs, based upon user selections, are 
collectively called a menu.  A menu is a set of operations that appear below a schedule or another menu 
in the tree structure.  A caller selects menu entries by pressing keys on a telephone. Based on the 
caller's choice, an auto attendant can offer a submenu, transfer a call to a queue, allow a caller to search 
an employee directory, send or receive a fax, or perform many other actions.  Each menu is owned by a 
single schedule.  Menus become active when the conditions stipulated by the schedule form are met.  In 
other words, a menu is not available to callers unless its parent schedule is active.   

Menu Entry 

A menu entry is an action that is assigned to menus. The action associated with that menu entry is 
executed when the caller presses the assigned key. 

Menu Transfer 

Transfers a call to another menu within the same profile or a different profile. For example, suppose you 
create a complex set of submenus that you will use in all profiles. Instead of creating the same menu 
structure repeatedly in every profile, transfer a call to the special menu. This allows a single menu to be 
shared by all profiles. 

Node 

A node is an item in the tree that you can select for editing. 

Notifier 

The Notifier is an CIC module that acts as a communication center for all other modules.  It listens for 
events generated by other modules and notifies other interested modules that the event has occurred. 

Operations 

Operations are actions that Interaction Attendant can perform when a user makes a menu selection.  

Profile 

Attendant compares call characteristics to predefined profiles for that server.  It gives control over the 
call to the profile that most closely matches the call.  Calls come into a server and are filtered by a 
profile.  Profiles filter calls by DNIS, ANI and/or line or line group information.  Wildcards can be used in 
matching.  Calls that don't match a user-defined profile are processed by the default profile.  Each 
profile contains a collection of one or more schedules. Profiles can be scheduled to run at certain times. 
A profile can also be configured to start for a specific ANI, DNIS or Line Name entry so that callers who 
dial specific numbers hear specific profiles. 

Profile Telephone Number 

A telephone number that matches DNIS criteria defined in an Attendant profile (either explicitly or using 
wildcards) that is used for special routing purposes. 

Queue 
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Queues are containers for calls and other types of interactions that can be processed.  Each Interaction 
Client user has a user queue. Each workgroup, such as marketing or support, has a workgroup queue. 
Stand-alone phones not connected to PCs and fax machines have station queues. 

Queue Transfer 

Transfers a call directly to a user, workgroup, or station queue. 

Receive Fax 

Allows a caller to send a FAX to a specific user or workgroup. 

Remote Voice Mail 

Allows Interaction Client users to retrieve their voice mail remotely. 

Schedule 

A schedule is a special form associated with each profile that allows you to control when menus 
contained within the profile become active.  A schedule stipulates when a menu can run. 

Station Groups 

Station groups are groups of phones in break rooms, conference rooms, and other public areas. 

Station Queue 

A queue where interactions are placed when they are to be processed by a station. 

Submenu 

Submenus are menus within menus. They allow you to add branches to your auto attendant. For 
example, you can set up a submenu for each workgroup in your company, allowing callers to perform a 
variety of actions within each workgroup. Submenus also allow you to re-use the keys that are used in 
higher menus. For example, pressing 4 in the top level menu might allow callers to enter a Support 
submenu. In the Support submenu, callers might press 4 to send a fax.  

Subroutine Initiator 

Allows you to add your own custom functionality to a menu entry. Using the Subroutine Initiator menu 
entry requires some handler modification. 

Template Export 

A export option that saves generic configuration data that can be loaded onto any server.  The resulting 
Attendant configuration file contains the general Attendant layout, but without server-specific 
information, such as workgroup names, user names, or audio files.  The resulting file can be loaded onto 
a server and customized to match the destination server.   This option is geared for partners and 
administrators who manage multiple sites.  It does not require servers to be identically configured. 

Trunk 
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A trunk is a communications line that connects two switching systems, such as the equipment in a 
telephone company's central office, and the PBX in a company. 

User Queue 

A queue where interactions (such as calls and chat sessions) intended for an individual user are routed. 

Voice Mail Transfer 

Allows a caller to leave a voice mail for a specific queue. 
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A 
ANI: ANI stands for Automatic Number Identification. ANI is often called Caller ID. All phone calls contain 

the numbers of the dialing phone. Those numbers can be displayed on a screen or used by the 
receiving phone system to tell the call recipient useful information. 

Attendant Configuration File: Attendant Configuration (.att) files contain all of the information that is 
associated with a server profile, including its schedules, and settings affecting operations. 
Attendant Configuration files make it quick and easy to back up or restore a particular server 
configuration. The File | Import File command reads in an .att configuration file. Likewise, the 
File | Export File command saves an .att configuration file for the all connected servers. 

Audio Playback: Audio playback plays a .wav file to caller. You can use the .wav files that are installed 
with Interaction Attendant, or you can record your own .wav files and store them in a language-
specific folders below the AttendantWaves share on the Interaction Center server. 

Audio Prompts: Audio prompts are the messages (with the file extension .wav) that Interaction 
Attendant plays to callers. Examples include the greeting played for callers when the call is 
picked up, and any instructions played to describe menu options. A default set of prompts is 
installed with Interaction Attendant. You can change these prompts and add your own. You 
might do this so that all prompts are spoken in the same voice. 

Auto Attendant: Auto attendant is a shortened name for automatic attendant. An auto attendant is a 
device that automatically answers a call, prompts a caller to make menu choices, and routes a 
call according to that caller's choice. Callers choose options by pressing keys on their telephone. 
Based on the caller's choice, an auto attendant will offer a sub menu, transfer a call to a queue, 
allow callers to search an employee directory, send or receive a fax, or perform many other 
actions. Interaction Attendant is the tool for configuring IC's auto attendant. 

Auto Attendant Processing: Auto Attendant Processing is a call processing style that interacts with the 
caller using menus. See also: Direct to Queue Processing. 

B 
Backup Export: A export option that saves server-specific information that must be imported by the 

same server. 

C 
Call Attribute: A call attribute is a piece of information about an object that travels with it throughout 

the Interaction Center. For example, one standard attribute of a call object is the telephone 
number of the person who placed the call. A call object can have as many attributes as are 
needed. Attributes stay with a call until it is disconnected. The IC supports application 
programming interfaces (API's) that provide access to call object attributes. Dynamic Data 
Exchange (DDE) is commonly used to accomplish this, as is the Interaction Client Win32 COM 
API. Attributes typically store information that is passed to a database or a third-party 
application. For example, the IC can be set up to "pop" a database application when an incoming 
call arrives at an agent's workstation. For more information about attributes, DDE and APIs, see 
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the System APIs section of the master documentation library on your IC server. The Interaction 
Attributes Reference Guide describes attribute names that are reserved by IC. If you assign data 
to a standard IC attribute, you could potentially affect the execution of a handler. The 
Interaction Attributes Reference Guide identifies attributes whose value you should not change. 

Call Flow Configuration: A call flow configuration processes inbound calls, outbound calls (those placed 
by Interaction Dialer), or calls to the Operator. Attendant displays each call flow in its own tree 
view. Tabs below the tree view allow you to switch to a different call flow configuration. The call 
flow and tabs that you see (if any) are determined by whether or not you have rights to view or 
modify a given call flow type, and by command line switches that specify which call flows you 
want to see. 

Call Processing Style: Call processing styles determine whether Auto Attendant Processing or Direct to 
Queue Processing are used to process an inbound telephone interaction. 

Current Language: The language used to play back a voice prompt. The current language is set using 
profile forms, or by allowing callers to select a language from a menu (using Language Selection 
operations). Attendant plays back voice prompts and performs text-to-speech operations in the 
appropriate language based upon this information. 

Customer Interaction Center (CIC): The Customer Interaction Center (CIC) is designed for sophisticated 
contact centers managing inbound, outbound, or blended interactions. CIC provides skills-based 
routing not only for telephone interactions, but faxes, Emails, text chats, Web call-back 
requests, and voice over IP calls. CIC can support up to several hundred agents per site, and 
offers optional pre and post-call routing across multiple locations. And it makes screen popping 
a breeze, with easy interfaces to products from leading CRM vendors such as Siebel, Pivotal, 
Onyx, Peoplesoft, and many more. 

D 
Default Action: The operation defined by the default node that is performed if the caller does not press 

a key within the timeout period specified by that menu. The icon for default forms has a green 
border in the tree structure. 

Default Language: The names of supported languages (e.g., English, French, Spanish, etc.) are defined 
on each IC server using Interaction Administrator. Handlers that play voice prompts use these 
language attributes internally. The default language is used to play system prompts when no 
other language attribute is specified. 

Default Node: The form whose default action checkbox is checked. 

Dial by Name: Dial by Name allows a caller to enter the first three characters of a Interaction Client 
user's last name. Dial by Name then searches for the extension and transfers the call to that 
user. 

Dial Extension: Allows a caller to dial an Interaction Client user's extension. If a match is found, the call 
is transferred; if not, the caller is returned to the menu from which Dial Extension was called. 
See the Dial Extension operation. 

Direct to Queue Processing: Direct to Queue Processing is a call processing style that sends a call to the 
user queue, station queue, or workgroup queue specified in the profile. Users may be returned 
to Auto Attendant processing if the call is not picked up from a queue in a specified number of 
seconds. 
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DNIS: Dialed Number Identification Service (DNIS) is a feature of digital T-1 and ISDN lines (like 800 and 
900 lines) that provides the number the caller dialed. DNIS is a system by which IC can 
determine what number a caller dialed. Knowing that dialed number allows Interaction 
Attendant to perform unique processing on that call, such as playing special messages or 
offering special menu choices. For example, a company has two levels of technical support, 
silver and gold. Silver members call 555-1111, and Gold members call 555-2222. In Interaction 
Attendant you can create a profile for each number. When callers dial 555-2222, they hear the 
profile for gold support. When callers dial 555-1111, they hear the profile for the silver. The 
Default Inbound Call Profile is used when no DNIS information accompanies the call, or when 
the DNIS is not recognized. 

E 
External Transfer: This operation transfers a call to specified telephone number outside of the IC. 

F 
Fax Back: Allows a caller to request a fax and send it to a fax number that the caller specifies. Fax Back 

functionality in Interaction Attendant requires some handler modification. 

Full Export: A export option that saves all configuration data that is not tied to a server to an Attendant 
configuration file. This allows an exact copy of one server's configuration to be loaded on to an 
identically configured server. It is frequently used to move a configuration from a test server to 
a production server. The source server must be identical to the destination server in terms of 
line names, workgroup names—everything except server name and password. 

H 
Handler: Handlers are programs that the IC Server executes to respond to an event, such as an incoming 

call. Handlers are created using Interaction Designer, the visual programming tool included with 
Interaction Center. Few users of Interaction Attendant ever need to create or modify handlers. 
The sophisticated handlers included with Interaction Attendant are sufficient to meet all but the 
most extraordinary needs. However, it is important to understand that handlers work behind 
the scenes to implement the profiles and menus that you create using Interaction Attendant. 

I 
IC Server: The Interaction Center (IC) is a client/server software product that transforms a Windows NT 

server into a comprehensive communications system. The IC server answers and processes calls. 
The profiles you create in Interaction Attendant are saved to the IC Server where they are 
executed when a call is picked up. 

Incoming Call Selection: Incoming Call Selection is enabled on custom profile forms. You can filter calls 
to various schedules based upon the line or line group used, the number dialed (DNIS), or the 
caller ID (ANI). A server's default profile does not support this feature, since the default profile is 
intended as a catch all. 

Interaction Attendant: The graphical tool for configuring and maintaining IC's auto attendant. 
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Interaction Designer: The IC graphical application development tool for creating, debugging, editing, 
and managing handlers and subroutines. 

Interaction ID Key: Interaction ID Key is a unique ID number that identifies a call. This number is always 
unique, while Call ID numbers may not be. 

IVR: Interactive Voice Response (IVR) allows phone users to use their telephone keypad as a keyboard to 
input values in response to voice prompts played by a computer. 

L 
Line Name: Every line coming into IC has an assigned line name. You can view and change these line 

names in the Lines container in Interaction Administrator. In Interaction Attendant, line names 
can be assigned to a profile form. Any call that comes in on the named line is processed by that 
profile. When assigning line names to profiles, refer to the Interaction Administrator lines 
container for a list of line names. 

M 
Menu: The group of operations that Interaction Attendant performs, based upon user selections, are 

collectively called a menu. A menu is a set of operations that appear below a schedule or 
another menu in the tree structure. A caller selects menu entries by pressing keys on a 
telephone. Based on the caller's choice, an auto attendant can offer a submenu, transfer a call 
to a queue, allow a caller to search an employee directory, send or receive a fax, or perform 
many other actions. Each menu is owned by a single schedule. Menus become active when the 
conditions stipulated by the schedule form are met. In other words, a menu is not available to 
callers unless its parent schedule is active. 

Menu Entry: A menu entry is an action that is assigned to menus. The action associated with that menu 
entry is executed when the caller presses the assigned key. 

Menu Transfer: Transfers a call to another menu within the same profile or a different profile. For 
example, suppose you create a complex set of submenus that you will use in all profiles. Instead 
of creating the same menu structure repeatedly in every profile, transfer a call to the special 
menu. This allows a single menu to be shared by all profiles. 

N 
Node: A node is an item in the tree that you can select for editing. 

Notifier: The Notifier is an Interaction Center module that acts as a communication center for all other 
modules. It listens for events generated by other modules and notifies other interested modules 
that the event has occurred. 

O 
Operations: Operations are actions that Interaction Attendant can perform when a user makes a menu 

selection. 

P 
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Profile: Attendant compares call characteristics to predefined profiles for that server. It gives control 
over the call to the profile that most closely matches the call. Calls come into a server and are 
filtered by a profile. Profiles filter calls by DNIS, ANI and/or line or line group information. 
Wildcards can be used in matching. Calls that don't match a user-defined profile are processed 
by the default profile. Each profile contains a collection of one or more schedules. Profiles can 
be scheduled to run at certain times. A profile can also be configured to start for a specific ANI, 
DNIS or Line Name entry so that callers who dial specific numbers hear specific profiles. 

Profile Telephone Number: A telephone number that matches DNIS criteria defined in an Attendant 
profile (either explicitly or using wildcards) that is used for special routing purposes. 

Q 
Queue: Queues are containers for calls and other types of interactions that can be processed. Each 

Interaction Client user has a user queue. Each workgroup, such as marketing or support, has a 
workgroup queue. Stand-alone phones not connected to PCs and fax machines have station 
queues. 

Queue Transfer: Transfers a call directly to a user, workgroup, or station queue. 

R 
Receive Fax: Allows a caller to send a FAX to a specific user or workgroup. 

Remote Voice Mail: Allows Interaction Client users to retrieve their voice mail remotely. 

S 
Schedule: A schedule is a special form associated with each profile that allows you to control when 

menus contained within the profile become active. A schedule stipulates when a menu can run. 

Station Groups: Station groups are groups of phones in break rooms, conference rooms, and other 
public areas. 

Station Queue: A queue where interactions are placed when they are to be processed by a station. 

Submenu: Submenus are menus within menus. They allow you to add branches to your auto attendant. 
For example, you can set up a submenu for each workgroup in your company, allowing callers to 
perform a variety of actions within each workgroup. Submenus also allow you to re-use the keys 
that are used in higher menus. For example, pressing 4 in the top level menu might allow callers 
to enter a Support submenu. In the Support submenu, callers might press 4 to send a fax. 

Subroutine Initiator: Allows you to add your own custom functionality to a menu entry. Using the 
Subroutine Initiator menu entry requires some handler modification. 

T 
Template Export: A export option that saves generic configuration data that can be loaded onto any 

server. The resulting Attendant configuration file contains the general Attendant layout, but 
without server-specific information, such as workgroup names, user names, or audio files. The 
resulting file can be loaded onto a server and customized to match the destination server. This 
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option is geared for partners and administrators who manage multiple sites. It does not require 
servers to be identically configured. 

Trunk: A trunk is a communications line that connects two switching systems, such as the equipment in 
a telephone company's central office, and the PBX in a company. 

U 
User Queue: A queue where interactions (such as calls and chat sessions) intended for an individual user 

are routed. 

V 
Voice Mail Transfer: Allows a caller to leave a voice mail for a specific queue. 
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